Oracle Engagement Cloud
Using Sales
# Contents

## Preface

<table>
<thead>
<tr>
<th></th>
<th>i</th>
</tr>
</thead>
</table>

## About This Guide

<table>
<thead>
<tr>
<th></th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audience and Scope</td>
<td>1</td>
</tr>
<tr>
<td>Related Guides</td>
<td>1</td>
</tr>
</tbody>
</table>

## Getting Started

<table>
<thead>
<tr>
<th></th>
<th>3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using Your Sales Application: Overview</td>
<td>3</td>
</tr>
<tr>
<td>Exploring Work Areas</td>
<td>5</td>
</tr>
<tr>
<td>Using Applications Help</td>
<td>7</td>
</tr>
<tr>
<td>Using the Oracle Help Center</td>
<td>8</td>
</tr>
</tbody>
</table>

## Managing Resources

<table>
<thead>
<tr>
<th></th>
<th>11</th>
</tr>
</thead>
<tbody>
<tr>
<td>Managing Resources: Explained</td>
<td>11</td>
</tr>
<tr>
<td>Resource Directory: Explained</td>
<td>11</td>
</tr>
<tr>
<td>Viewing Resource Information: Procedure</td>
<td>12</td>
</tr>
<tr>
<td>Proxies: Explained</td>
<td>13</td>
</tr>
<tr>
<td>FAQs for Managing Resources</td>
<td>13</td>
</tr>
</tbody>
</table>

## Using Search

<table>
<thead>
<tr>
<th></th>
<th>17</th>
</tr>
</thead>
<tbody>
<tr>
<td>Searching Your Sales Application</td>
<td>17</td>
</tr>
<tr>
<td>Tips for Searching</td>
<td>21</td>
</tr>
<tr>
<td>What’s the difference between the global search and the work area searches in my sales application?</td>
<td>30</td>
</tr>
<tr>
<td>Creating Your Own Personal List</td>
<td>31</td>
</tr>
<tr>
<td>Deleting or Hiding a List: Procedures</td>
<td>32</td>
</tr>
<tr>
<td>How can I create saved searches with just one administrator-defined field?</td>
<td>33</td>
</tr>
</tbody>
</table>
5 Managing Activities and Calendar 35
Managing Activities: Overview 35
Getting Started with Activities 35
Managing Activities 39
Creating Lists: Explained 40
Creating Tasks from a Task Template: Procedure 41
Selecting Addresses for Activities 42
Activity Notification: Explained 42
Using Notifications to Drill Down to Transactions 43
Applying Mass Update to Activities 44
My Calendar: Explained 44
Setting Up Appointment Visibility: Worked Example 46
Integrating Assets with Activities: Overview 46
Using Asset Calendars: Overview 46
Adding Assets to Activities 47
Creating an Asset Calendar View 47
FAQs for Managing Activities and Calendar 48

6 Maintaining Account, Contact, and Household Information 51
Accounts, Contacts, and Households: Overview 51
Managing Account Information 51
Managing Contact Information 58
Managing Household Information 61
Account, Contact, and Household Searches 64
Merging Information 69
Enriching Accounts and Contacts 70
Managing Business Plans 77
Managing Assets 80
Mass Updating Accounts and Contacts 83
Deleting Accounts and Contacts 85
7 Managing Sales Campaigns

Sales Campaigns: Overview
Creating a Sales Campaign
Working with Sales Campaigns
FAQs for Managing Sales Campaigns
Understanding Marketing Content
FAQs for Understanding Marketing Content
Marketing Campaigns
FAQs for Marketing Campaigns

8 Managing Leads

Lead Management: Overview
Lead Processing
Lead Follow Up
Lead Qualification
FAQs for Managing Leads

9 Understanding Responses

Response Management: Overview
Differences Between Response, Lead, and Opportunity: Explained
What’s the difference between a response and an interaction?
What happens when I convert a response to a lead?

10 Managing Opportunities

Opportunities: Overview
Working with Opportunities
Recommended Actions for Opportunities
FAQs for Recommended Actions for Opportunities
Adding Team Members to Opportunities
Using Sales Coach
Access to Opportunities
Managing Sales Competitors
FAQs for Managing Sales Competitors
Assigning Opportunities
Closing Opportunities
Performing Assessments
<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>11</strong></td>
<td>Managing Opportunity Products and Revenue</td>
<td>159</td>
</tr>
<tr>
<td></td>
<td>Opportunity Products and Revenue</td>
<td>159</td>
</tr>
<tr>
<td></td>
<td>Working with Opportunity Products</td>
<td>159</td>
</tr>
<tr>
<td></td>
<td>Managing Recurring Products</td>
<td>161</td>
</tr>
<tr>
<td></td>
<td>Managing Sales Credits</td>
<td>164</td>
</tr>
<tr>
<td></td>
<td>Understanding Product Attribute Synchronization</td>
<td>167</td>
</tr>
<tr>
<td><strong>12</strong></td>
<td>Using Actionable Infolets</td>
<td>171</td>
</tr>
<tr>
<td></td>
<td>Overview of Actionable Infolets</td>
<td>171</td>
</tr>
<tr>
<td></td>
<td>Get Started with Actionable Infolets</td>
<td>171</td>
</tr>
<tr>
<td></td>
<td>Personalize Actionable Infolets</td>
<td>174</td>
</tr>
<tr>
<td></td>
<td>FAQs for Using Actionable Infolets</td>
<td>178</td>
</tr>
<tr>
<td><strong>13</strong></td>
<td>Managing Forecasts</td>
<td>179</td>
</tr>
<tr>
<td></td>
<td>Sales Forecasting Features: Overview</td>
<td>179</td>
</tr>
<tr>
<td></td>
<td>Adding Opportunity Items to Your Forecast</td>
<td>180</td>
</tr>
<tr>
<td></td>
<td>About Forecasting by Territory, Product, or Unit</td>
<td>180</td>
</tr>
<tr>
<td></td>
<td>Managing Your Forecast</td>
<td>181</td>
</tr>
<tr>
<td></td>
<td>Sales Forecast Adjustments: Explained</td>
<td>183</td>
</tr>
<tr>
<td></td>
<td>Copying the Prior Forecast: Explained</td>
<td>184</td>
</tr>
<tr>
<td></td>
<td>Forecasting Actions and Consequences: Explained</td>
<td>184</td>
</tr>
<tr>
<td></td>
<td>Forecasting: Available Metrics</td>
<td>186</td>
</tr>
<tr>
<td></td>
<td>FAQs for Managing Forecasts</td>
<td>187</td>
</tr>
<tr>
<td><strong>14</strong></td>
<td>Using Sales Prediction</td>
<td>189</td>
</tr>
<tr>
<td></td>
<td>Sales Prediction: Overview</td>
<td>189</td>
</tr>
<tr>
<td></td>
<td>Understanding Buying Patterns of Your Customer: Overview</td>
<td>189</td>
</tr>
<tr>
<td></td>
<td>Sales Prediction Rules: Explained</td>
<td>190</td>
</tr>
<tr>
<td></td>
<td>Reviewing and Modifying Prediction Rules: Explained</td>
<td>190</td>
</tr>
<tr>
<td></td>
<td>Selecting Products for Recommendations: Points to Consider</td>
<td>191</td>
</tr>
<tr>
<td></td>
<td>FAQs for Using Sales Prediction</td>
<td>192</td>
</tr>
<tr>
<td></td>
<td>White Space Analysis</td>
<td>193</td>
</tr>
<tr>
<td></td>
<td>Using the White Space Analysis Report for Cross Sell or Up Sell</td>
<td>196</td>
</tr>
<tr>
<td></td>
<td>FAQs for Using White Space Analysis</td>
<td>197</td>
</tr>
</tbody>
</table>
## Using Gmail

- Overview of Oracle Sales Cloud for Gmail
- Installing and Configuring Oracle Sales Cloud for Gmail: Explained
- Creating Contacts from the Oracle Sales Cloud for Gmail Side Panel: Procedure
- Creating Contacts Using Oracle Sales Cloud for Gmail: Examples
- Sharing Your Email with Sales Application Users: Example
- Synchronization Settings: Explained
- Sales Application and Gmail Synchronization: Explained

## Using Mobile Applications

- Using Mobile Applications: Overview
- Oracle CX Cloud Mobile
- Sales Cloud Mobile

## Using Social Networking

- Social Networking: Overview
- Adding Oracle Social Network: Overview
- Sharing Information Using Oracle Social Network

## Managing Service Requests

- Service Request Management: Overview
- Service Request User Tasks: Overview

## Using Sales Lightbox

- Sales Lightbox: Overview
- Available Lightbox Actions for Different Content Types
- Creating Content
- Uploading Content
- Updating Content
- Searching for Content
- Downloading and Opening Content
- Sharing Content
- Working with Thumbnail Images
- Deleting Content
Preface

This preface introduces information sources that can help you use the application.

Using Oracle Applications

Using Applications Help

Use help icons to access help in the application. If you don't see any help icons on your page, click your user image or name in the global header and select Show Help Icons. Not all pages have help icons. You can also access Oracle Applications Help.

Watch: This video tutorial shows you how to find help and use help features.

You can also read Using Applications Help.

Additional Resources

- **Community:** Use Oracle Cloud Customer Connect to get information from experts at Oracle, the partner community, and other users.
- **Guides and Videos:** Go to the Oracle Help Center to find guides and videos.
- **Training:** Take courses on Oracle Cloud from Oracle University.

Conventions

The following table explains the text conventions used in this guide.

<table>
<thead>
<tr>
<th>Convention</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>boldface</strong></td>
<td>Boldface type indicates user interface elements, navigation paths, or values you enter or select.</td>
</tr>
<tr>
<td><strong>monospace</strong></td>
<td>Monospace type indicates file, folder, and directory names, code examples, commands, and URLs.</td>
</tr>
<tr>
<td><strong>&gt;</strong></td>
<td>Greater than symbol separates elements in a navigation path.</td>
</tr>
</tbody>
</table>

Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program website.

Videos included in this guide are provided as a media alternative for text-based help topics also available in this guide.
Contacting Oracle

Access to Oracle Support
Oracle customers that have purchased support have access to electronic support through My Oracle Support. For information, visit My Oracle Support or visit Accessible Oracle Support if you are hearing impaired.

Comments and Suggestions
Please give us feedback about Oracle Applications Help and guides! You can send an e-mail to: oracle_fusion_applications_help_ww_grp@oracle.com.
1 About This Guide

Audience and Scope

If you are looking for information about performing day-to-day tasks in your sales applications, then this guide is for you. The information is primarily aimed at salespeople, sales managers, and other sales users who form part of your sales organization. This guide describes how to:

- Manage customers and contacts.
- Log sales calls.
- Manage calendars and activities.
- Create and update sales campaigns and sales leads.
- Create, monitor, and update opportunities.
- View and perform actions from within actionable infolets.
- Create and update territories and quotas.
- Participate in social conversations.
- Generate leads from predictive analysis recommendations.
- Use mobile applications with your sales application.
- View key metrics, such as pipeline revenue and quota performance, at a glance.

\textbf{Note:} With release 19A (11.13.19.01.0), "Oracle Sales Cloud" has been incorporated within "Oracle Engagement Cloud." Existing Oracle Sales Cloud users will retain access to Oracle Sales Cloud features under their preexisting licensing agreements. Any new users created within your current Oracle Sales Cloud license count will also retain the same access to Oracle Sales Cloud. Users may obtain access to additional Oracle Engagement Cloud features by renewing their subscriptions under the Oracle Engagement Cloud SKU.

This document describes features available to users under both Oracle Sales Cloud and Oracle Engagement Cloud licensing agreements.

Related Guides

You can refer to the following related guides to understand more about the user tasks covered in this guide.

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle Applications Cloud Using Common Features</td>
<td>Describes user tasks and features that are common across Oracle Applications Cloud.</td>
</tr>
<tr>
<td>Oracle Engagement Cloud Using Incentive Compensation</td>
<td>Describes the user tasks for the incentive compensation business process, from creating and managing compensation plans to reviewing and monitoring incentive plans and performance data.</td>
</tr>
<tr>
<td>Title</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>Oracle Engagement Cloud Using Customer Data Management</td>
<td>Describes user tasks to manage customer information and customer data quality.</td>
</tr>
<tr>
<td>Oracle Engagement Cloud Using Customer Contracts</td>
<td>Describes user tasks for customer contracts including creating customer contracts, authoring of contract terms, and maintenance and configuration of contracts.</td>
</tr>
<tr>
<td>Oracle Engagement Cloud Creating and Administering Analytics</td>
<td>Provides advanced instruction on creating and modifying analytics and reports.</td>
</tr>
<tr>
<td>Oracle Engagement Cloud Using Partner Relationship Management for Channel Managers</td>
<td>Describes user tasks to help channel sales managers, channel account managers, and channel operations managers perform day-to-day business tasks.</td>
</tr>
<tr>
<td>Oracle Engagement Cloud Using Partner Relationship Management for Partners</td>
<td>Describes user tasks to help partner sales managers, partner salespeople, and partner administrators perform day-to-day business tasks.</td>
</tr>
<tr>
<td>Oracle Engagement Cloud Using Service in Engagement Cloud</td>
<td>Contains information to help service managers, service personnel, and other service end users to perform day-to-day business tasks using Oracle Engagement Cloud.</td>
</tr>
<tr>
<td>Oracle Engagement Cloud Using Knowledge</td>
<td>Describes how administrators, agents, authors, and other knowledge base contributors can implement and use Knowledge in Engagement Cloud.</td>
</tr>
<tr>
<td>Oracle Engagement Cloud Deploying Sales for Outlook</td>
<td>Describes how users can install, uninstall, configure, administer, and upgrade Oracle Engagement Cloud for Outlook.</td>
</tr>
<tr>
<td>Oracle Engagement Cloud Using Sales for Outlook</td>
<td>Describes user tasks that are related to managing and using Oracle Engagement Cloud data within Microsoft Outlook.</td>
</tr>
</tbody>
</table>

**Related Topics**
- Oracle Help Center
2 Getting Started

Using Your Sales Application: Overview

Your sales application from Oracle gives you a single interface to perform a variety of key sales tasks. The easy-to-use design means less time training, so you get up-to-speed quickly. In addition to presenting core tasks in a simple UI, the application features analytics that provide information when and where you need it. Here’s a summary of the key tasks you can accomplish with the applications:

- Manage accounts, households, and contacts.
- Create business plans and manage customer assets.
- Log sales calls and follow up on tasks.
- Manage calendars and appointments.
- Send out sales campaigns.
- Create and update leads and convert them to opportunities.
- Create, monitor, and update opportunities.
- View competitor information.
- Create and manage service requests.
- Create and update territories and quotas.
- Manage sales forecasts.
- Participate in social conversations.
- Use and share documents in the Lightbox content library.
- Manage partner information.
- Use the mobile application to manage customer information, leads, and opportunities.
- View sales metrics, such as pipeline revenue and quota performance, at a glance.

Getting to Know the UI and Features

Understanding the main areas of the UI and core features helps you as you work within the sales applications. UI and features include:

- Home page:
  - The home page offers a central location from which you can navigate to complete important tasks, like updating contact, account, lead, or opportunity information.
  - The home page contains a springboard and a panel that, based on setup, shows either company announcements or social networking conversations.

- Springboard:
  - The springboard is the area that contains a set of functional area icons.
  - The springboard provides icons that you can use to open pages and applications.
• Accounts and contacts:
  o Create and manage accounts, contacts, and households for B2B selling.
  o View and manage associated items, such as interactions, leads, opportunities, and appointments.

• Scheduling and calendars:
  o Calendars and tasks are available within the Activities area.
  o Create and manage appointments and tasks, and associate them with the contacts, leads, and opportunities you’re working on.
  o Manage team calendars and respond to autogenerated tasks.

• Leads:
  o View and edit lead information, including products, budget, and deal size.
  o Create, qualify, and convert leads.

• Sales campaigns:
  o Create sales campaigns to target contacts from multiple sources including the contact repository and previous campaigns.
  o Manage all the information related to your sales campaign such as monitoring responses.

• Opportunities:
  o Create and manage opportunity information, such as owner, product revenue, win probability, sales stage, and more.
  o Manage all the information related to your opportunities like relationships, contacts, appointments, and sales team members from one, convenient portal.

• Sales forecasting:
  o View forecast, pipeline, and won amounts for current, past, and upcoming quarters.
  o See forecast trends over time.

• Partner management:
  o Manage partners, including their leads and opportunities.
  o Review notification requests and manage activities and notes related to partners.
  o Manage partner enrollments.

• Social:
  o Participate in conversations with other sales team members.
  o Associate conversations with sales business objects, such as accounts, contacts, leads, and opportunities.

• Sales analytics:
  o Predefined infolets contain key metrics, such as Top Open Deals or Stalled Deals. You navigate to the infolets using the pagination controls (clickable dots).
  o Gain insight into your performance against your quota.
  o View your pipeline, including total opportunity revenue, revenue per sales stage, and opportunity count in the pipeline.
• Additional configuration (administrators only):
  ◦ Set any one of several different themes to change look and feel.
  ◦ Change icon style, button shape, and logo to personalize the user experience.
  ◦ Configure news and announcements on the home page.

For more information see the related topics and the online help.

Configuring the UI

Several configuration options are available for administrators to tailor the UI to company business needs, such as:

• Modify tables and forms
• Add, remove, and reorder subtabs
• Show or hide predefined fields
• Add and remove company-defined fields
• Change field names and make fields read-only
• Create dynamic lists
• Specify whether changes are available for users with a particular role or to all users
• Add and remove infolets that present analytics

Administrators use Application Composer and Page Composer to modify UI elements. For more information about modifying the UI, see the Extending Sales and Service guide. Also read the topic, Understanding Default Navigation Components, in the Implementing Sales guide.

Related Topics

• Signing In and Getting Started: Explained
• Help Center

Exploring Work Areas

Video

Watch: This tutorial shows you examples of work areas and explains how to get started using them. The content of this video is also covered in text topics.
Overview

A work area is a set of pages with everything you need to accomplish a business goal. Each work area has a landing page that you open when you navigate to the work area, for example from the Navigator, springboard, or filmstrip. There are different types of landing pages, and they usually provide ways for you to open other pages within the work area.

General Page Features

Many landing pages and other pages in work areas have one or more of the following:

- Search features that you can use to find records, with results displayed on the page
- Tabs that take you to another page in the work area, or to another part of the page you're on
- Panel tabs that provide additional tools, for example links to tasks related to the work area

Grid and List Views

Some landing pages have a Grid icon and a List icon. Click these icons to determine how to view the records on the page.

- **Grid**: Display each record as a card, laid out in a grid. A card is similar in appearance to a business card, with a default front side and possibly also a back side. Each side displays a summary view of a single object and may include text, links, and graphics, such as icons, photos, and analytics.
- **List**: Display the same records in a table, with data comparable to what you see on the cards.

In either view, you can usually select actions to take on specific records, or open up the record to see or edit details on another page.

Infotiles

Some landing pages have a row or column of multiple infotiles. An infotile is a container that displays key information about a topic or object. When you select a specific infotile, related information appears on the rest of the page, usually a list of records in a table.

- Many infotiles have links or other elements that you can click to filter the table. For example, a tile displays information about the number of transactions in a certain status:
  - 5 Open
  - 7 Pending Approval
  - 10 Approved

  Each status is also a link, so you can click 10 Approved to see just the ten approved transactions in the table.
- From the table, you can usually perform actions on selected records, or open them up to see or edit details on another page.

Infolets

Some landing pages consist of only infolets. Each infolet is a small, interactive widget that gives you key information and actions for a specific subject related to the work area. Infolets have a front view and possibly also a back and expanded view.

From an infolet, you can usually open other pages in the same work area or another work area. You can also personalize the infolet page by moving or hiding infolets.
Related Topics

- Signing In and Getting Started
- Using Tables: Explained
- Using Filters with Keyword Searches: Procedure
- Using Wildcards and Quotation Marks for Searches on the Page: Examples

Using Applications Help

Video

Watch: This video tutorial shows you how to find help and make the most of the help features. The content of this video is also covered in text topics.

Procedure

Find help in the Applications Help site, or from help windows that are available on many of the pages you use. To open Applications Help at any time, click your user image or name in the global header and select Applications Help.

Using Help Windows

Use help icons on the page to open help windows that give you information about the whole page or part of the page. The window can contain informational text, links to help content, or both.

1. If you don’t see help icons, click your user image or name in the global header and select Show Help Icons to display them on all pages where available.
2. Click a help icon. If the icon isn’t next to the page title, then the help window contains information specific to the part of the page you’re on.
3. On the help window, click the link of a title, if any are available, to see a summary of the corresponding help content. If the help is a video, then the video plays automatically in the window.
4. Click the More link at the end of the summary to see the full help content.
5. Click the More Help link at the bottom of the help window to open Applications Help. You land on search results showing help that’s related to what you’re working on.

Searching and Browsing in Applications Help

In Applications Help, you can set the scope of your search.

- Use the Applications Help home page to search across all help content. To return to the home page at any time, click Home in the global header.
- Use the springboard or filmstrip in Applications Help to open landing pages for specific product families. Use the search on those pages to find help relevant to the product family.

Tip: Put quotation marks around what you enter in the search field, to search on the exact phrase.
Use the landing pages to browse for help relevant to the product family. For example, you can find:

- **Getting Started**: Information that’s helpful to new users
- **Role**: Help that’s specific to the roles you have
- **Learning Resources**: Guides and other materials on Oracle websites

**Filtering Your Search Results**

To narrow your results in Applications Help, use filters such as Task, Product, Help Type, or Role. For example, use the Help Type filter to see only videos, or the Role filter to see only what’s relevant to you as an employee. If your organization has added help to the help site, then the Source filter is available for you to focus on just those files.

**Related Topics**

- How can I find help for my country and language
- Help Types: Explained

**Using the Oracle Help Center**

**Video**

**Watch**: This video tutorial shows you how to find guides, videos, release readiness content, and other resources for SaaS applications in Oracle Cloud. The content of this video is also covered in text topics.

**Procedure**

The Oracle Help Center (https://docs.oracle.com) contains guides, videos, release content, and other resources for Oracle Applications Cloud. You can use the URL to open the Oracle Help Center home page, or get to the Help Center from Applications Help.

**Navigating in the Help Center**

To find guides and other materials for a specific cloud service:

1. On the Oracle Help Center home page, click **Cloud**. You can also open the Cloud Documentation page from Applications Help by clicking **Navigator > Documentation Library**, if the menu item is available based on setup.
2. In the Get Started with Oracle Cloud Services section on the Cloud Documentation page, click **Software as a Service**.
3. Click the name of your cloud service. You can also open the cloud service page from Applications Help:
   a. On the Applications Help home page or filmstrip, click the icon for your cloud service.
   b. On the landing page for the cloud service, in the Learning Resources panel, click links that contain **Documentation**.
4. Select a release for the cloud service, as needed.
5. To navigate to a specific guide, video, or other resource, you can:
   - Browse for information on the cloud service page. For example, in the:
     - **What's New panel**: Learn about new features and other changes for the release.
     - **Tasks section in the navigation pane**: Click a task category and then a specific task, to open the guide that covers the task.
     - **REST API section in the navigation pane**: Get reference information about REST APIs, if available.
   - Click the Videos or Books link in the navigation pane to get all the videos or guides for the cloud service.
      - On the Videos or Books page, you can use the View list to filter by category.
      - Most guides are available in multiple formats, for example HTML and PDF.

6. When you have a guide open, use the links on the Table of Contents tab to navigate to other parts of the guide.

💡 **Tip**: Use the breadcrumbs that are available on most Help Center pages, or available when you have a guide open, to navigate to other parts of the Help Center.

### Searching in the Help Center
The scope of the search depends on where you're at in the Oracle Help Center. For example, on the Cloud Documentation page, you search across all cloud services in Oracle. On the pages for a specific cloud service, you search only within that service.

To search within a guide:

1. Open any HTML page within the guide.
2. Open the Search tab.
3. With the **Search this book** option selected, enter your keywords and run the search.
4. In the new browser tab containing the search results, click one of the two links available for your desired search result.
   - The first link takes you to the beginning of the relevant chapter.
   - The second link takes you directly to the part of the chapter that contains the summary text displayed in the search result.

### Related Topics
- Oracle Help Center
Managing Resources: Explained

Managing resources involves viewing and modifying a resource’s profile, organization membership, role assignment, skills, additional contact information, and salesperson information.

All the resources within the deploying company can view any resource’s profile. However, only the administrator can modify a resource’s profile, organization and team membership, and role assignment. Managers can modify the skill information of their direct and indirect reports. However, resources can only modify their own profiles, skills, and additional contact information.

Managing Resource Profiles

Resource profile management involves managing a user’s profile, including the resource’s core skills, photo, time zone, additional contact information, and so on. As part of managing a resource’s profile, the administrator specifies the dates between which the resource is available to the organization. The administrator also ensures that role assigned to the resource is within the period mentioned in the profile.

Managing Organization Membership

At any point in time, a resource belongs to an organization, and the administrator can assign this resource to any other organization within the deploying company.

Managing Resource Role Assignment

The administrator or the organization manager can assign or modify resource roles within an organization, with one role assigned to a resource at a time. However, administrators can also assign multiple roles to resources outside an organization.

Note:

- The dates of the resource role assignment must be within the date range during which the resource is active in the deploying organization.
- An organization can have only one manager.

Configuring Extensible Resource Pickers

An administrator can configure extensible resource pickers enabling Sales users to search and associate users to business objects relevant to their business flows. For more information about configuring the resource search, see the Related Topics section.

Related Topics

- Configuring Resource Search: Explained
- Configuring Resource Search: Procedure
Resource Directory: Explained

This topic explains the Resource Directory and how you can use it.

The Resource Directory offers detailed information about all the resources within the deploying organization. The Resource Directory also enables you to find and communicate with other resources, and to network and collaborate with them.

You can access the Resource Directory using the following path: Navigator > Resource Directory. You can also perform some of the functions of the resource directory using the Manage Resources setup task.

You use the Resource Directory to perform the following tasks:

- View and modify your profile
- View your organization information
- View information related to other organizations
- View the profiles of other resources
- Communicate with other resources

Note: To enable desktop pages for Resource Directory in Application Composer, set the profile option HZ_RESOURCE_ALLOW_CUSTOMIZATION to Yes. The default value of this profile option is No.

Viewing Resource Information: Procedure

The Resource Directory provides detailed information about the resources in an organization. Resources, such as sales representatives, can view the profile details of the resources within their organization. They can also modify part of their own profile, skills, and additional contact information. Sales managers can modify the skill information of their direct and indirect reports.

To view the details of a resource:


   The page displays the organizational structure between you and your manager.

2. Do one of the following:
   - Click Tasks > View Resource Details to view your details.
     The Resource page with your details appears.
   - Click Tasks > View Resources to view the profile information of another resource.
     The View Resources page appears. Search for the required resource and click on the resource name in the search results to view the details of the resource.

   The Resource page displays the details about the resource, such as usages, registry ID, manager, job title, department, roles, mail stop, phone, email, address, and time zone.
3. Click the following tabs on the Resource page to view additional information:

- **Organizations**: Displays the organization membership details of the resource such as role, organization, usage, and manager.
- **Teams**: Displays the team information of the resource, such as role, team, team usage, and team manager.
- **Roles**: Displays the role information of the resource, such as role name, member, manager, administrator, and lead.
- **Skills**: Displays the skills of the resource, such as accomplishments, skills, competencies, degrees, honors and awards, languages, licenses and certifications, problem codes, and work requirements.
- **Additional Contact Information**: Displays additional contact point information such as phone, email, social network, web, and contact preferences.

4. Click **Save** if you made any updates, or else click **Cancel**.

**Proxies: Explained**

You can designate another user as a proxy to sign in to the application and perform tasks on your behalf. Proxies are helpful when you can’t perform the tasks in person during a specific period.

> **Note**: This functionality is currently not available for Oracle HCM Cloud users.

In the global header, click your name, and from the Settings and Actions menu, select **Set Preferences**. On the Preferences page, click **Proxies**.

**Impersonation**

When your proxies sign in to the application on your behalf, they would be working in an impersonation session. During that period, your proxies have unrestricted access to your account, except that they can’t change your preferences. The application supports a scenario where you and your designated proxies can sign in at the same time.

When you sign in, you would see all the work your proxies did on your behalf.

**Security**

You don’t need to share your password with your proxies. While signing in to your account, your proxies must enter their password to verify their identity.

**FAQs for Managing Resources**

**How can I perform tasks on behalf of another user?**

To work in the application as another user:

> **Note**: This functionality is currently not available for Oracle HCM Cloud users.

1. Click your user name or image in the global header.
2. Click the **Switch To** button and select the user.

3. Enter your password.

After you’re done working as that user, switch to another assigned account, or sign out and sign in again to your own account.

As a proxy for the selected user, you can access all the data and tasks that the actual user is entitled to. But, you can’t change the user’s preferences.

> **Note:** All tasks that you perform are logged as though the actual user performed them.

### How can I search and view resource information from other sources?

You can search for resources and view their public profiles using the Resource Directory. You can search for resources either by name or organization, or by the names of the teams to which they belong.

The Resource Directory enables you to view the following details of a resource’s profile:

- Key profile information, including the resource’s name, manager’s name, job title, contact information, and so on.
- Organization membership information
- Roles of the resource
- Key skills of the resource
- Additional contact information
- Salesperson details, if applicable.

You can search for organizations or teams, instead of searching for users. Then, you can view the list of resources that belong to an organization or team, and view the profiles of any resource listed.

### Can I add resources outside my reporting hierarchy to my social network?

Yes. Use the Resource Directory to view the public profile of all active resources within the deploying company and to add them to your social network.

You can add a resource to your social network using the **Contextual Action** interface. Search for the resource with whom you want to make a connection, view the resource’s detailed profile, and then add the resource as a connection. Once the resource accepts your connection request, the resource becomes a part of your social network.

### Why am I unable to view the resource hierarchy for my organization?

For a resource or reporting hierarchy to be visible, it is necessary to have a reporting structure enabled in your organization. If there is no manager defined for an organization, the reporting hierarchy of the organization cannot be constructed. Verify if your organization has been assigned a manager in Resource Management.
Can I view a resource organization hierarchy version as of a particular date?

Yes. Unless otherwise specified, organization hierarchies are active from the date they are created. Navigate to the View Organization Hierarchies page from the Resource Directory to view the hierarchy of a resource organization at a specific date. Search and select the organization hierarchy whose details you want to view. This displays the concerned organization’s active hierarchy. A drop-down list displays the date from which the current organization hierarchy has been active. To view the organization hierarchy for a particular date, select the required date from the drop-down list.
4 Using Search

Searching Your Sales Application

There are two different ways of searching your sales application:

- You can use the global search located at the top of the application page to search across objects in the application. The following figure shows a screen capture of the Search box.

- You can navigate to the work area of the object you are looking for and search for it there by name or using multiple search criteria. The following figure shows a screen capture of the search region on the Opportunities work area landing page.

Global Search

Enter your search term in the global search box located at the top of each page to find all the records related to that search term. For example, entering the name of a contact as a search term retrieves not only the information about the contact herself, but also all of the opportunities, leads, and activities that mention that contact.

Global search makes it possible to search all the key fields in the following objects. Your application administrator determines which of these objects are available for search in your implementation.

- Accounts
- Activities
- Campaigns
- Contacts
- Forecasts
- Households
Not all objects or fields are searchable. Global search does not permit searches of child objects, or through notes or presentations you have uploaded, for example. Attachment searches are restricted to the attachment file names. Nor can you use global searches to find calculated values, such as the currency value of an opportunity or the due date of an activity. While the application administrator can make your modified objects searchable, you cannot search modified child objects. Modified objects have their own work areas. Modified child objects appear as tabs of other objects.

Global search depends on an indexing process to make new records available for search. Your application administrator schedules a separate process to periodically index each application object. The indexing processes are usually scheduled to run once a day in off-peak hours to minimize performance impact. Any new record you create is not available to search by you or by others until the indexing process has run.

Searching in the Work Areas

Use the search in the different work areas to quickly find a particular object you are looking for in one of three ways as highlighted in the following figure:

- By typing the object name in the **Find** box.
  
  As you type, the application matches the search term to the records you accessed, created, or updated recently and displays them in the Recent Items window.

- By selecting a list. A list displays records using search criteria you or an administrator saved previously.

- By clicking **Show Advanced Search** (the filter icon) and entering your search criteria in the Advanced Search panel.

The following figure shows a screen capture of the Opportunity work area search. Callouts identify the different search elements listed in the table.

<table>
<thead>
<tr>
<th>Callout</th>
<th>Search Element</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Find box</td>
</tr>
<tr>
<td>2</td>
<td>List selection</td>
</tr>
<tr>
<td>3</td>
<td>Advanced search icon</td>
</tr>
</tbody>
</table>
Searching Using the Advanced Search Panel in Work Areas

When you click the **Show Advanced Search** icon (filter icon) in the work area landing pad, the application displays the Advanced Search panel showing the search criteria for the list displayed on the page. You can modify the existing search criteria for the list, add additional search terms, or select a different list (saved search) as the basis of your search.

*Note:* The Advanced Search panel uses the term **Saved Search** instead of **List**.
The following figure shows a screen capture of the Advanced Search panel in the Opportunities work area landing pad. It shows the search criteria for the My Open Opportunities list. The search criteria are: the Record Set equals Records I own; Status equals Won; Close Period equals Current Fiscal Quarter; and the Close date falls between 7/1/15 and 9/30/15.

Clicking **Search** initiates the search. Clicking **Save** saves your changes or creates new list, as described in related topics.

**Finding the Most Recent Records Created in the Application**

Searches depend on two indexing processes that are set up by the application administrator to run periodically, one for the work area searches and another for the global search. Work area searches are indexed every five minutes, so use this type of search for finding the most up-to-date information. You will want to use the work area search to find the latest information...
about a customer appointment, for example. Oracle recommends global searches be indexed once every day, so use global searches for finding information across different objects.

Even though new records you create are unavailable for search until they indexed by each search, they are always available for you from the Recent Items list. As you enter a search term in either the global and work area searches, the application automatically displays a list of records you personally created, edited, or accessed in the last 30 days (or another interval configured by the administrator). Each search maintains its own list of Recent Items. When you use the global search, you do not see the recent items from the work areas.

**Tips for Searching**

**Video**

*Watch:* This tutorial provides tips for searching accounts, opportunities, leads, and other sales objects. The content of this video is also covered in text topics.

**Procedure**

Here are some tips on using global search.

**Select from the List of Recent Items**

Start typing any one of the words in the search term. Capitalization doesn’t matter. As you type, the application matches your entry to your recent searches and any records you accessed and displays them in a list under the Recent Items heading. If you see what you are looking for, just select it from the list.
The following figure shows a screen capture of the global search box as you type the letters gr in a demonstration environment. The matching object, the opportunity Eagle Green Server for the Eagle Green Server account, based in Board Camp, US, is listed under the Recent Items heading. The Recent Searches heading lists recent searches and filters.

Search Complete Words

If you don’t find what you are looking for among the Recent Items, then:

1. Finish typing the complete search term.
2. To speed up your search, you can narrow the list of objects searched, by clicking Personalize (the gears icon) and selecting the objects you want to search.

   The following figure shows a screen capture of the global search highlighting the location of the Personalize icon.

   3. Click Search (the magnifying glass icon).

   The application displays a list of records that contain your search term. If there is a search term with similar spelling, then the application displays the term above your results.
Refining Your Search Using Filters

Click **Show Filters** to display the filters available for refining your search. You can filter by object or date by clicking the **All** link.

The following figure shows a screen capture of the Global Search page with the Filters panel open. Clicking the **All** link for the **Last Updated Date**, for example, enables you to select the range of dates for your search. Callout 1 in the figure shows the location of the **All** link. Callout 2 shows the location of the **Hide Filters** button. When the Filters page is open, the Show Filters button becomes the Hide Filters button.
Searching Partial Words and Exact Phrases

You can use quotation marks around your search terms to search for exact phrases.

You can also search for partial words.

- Put an asterisk (*) after two or more letters, and you get all the names with words that start with those letters.

  For example, searching on pin*, returns Pinnacle Technologies and All Pines Furniture.

- Put the asterisk in the middle of the word to indicate any number of letters. For example pi*acle, returns both Pinnacle and Pinacle.

*Note:*

- You cannot use the asterisk at the beginning of a search term in global searches.
- Using the asterisk can slow your searches, so enter a whole word if you know it.

Searching for Objects in Their Work Areas: Explained

This topic describes how to search quickly for accounts, opportunities, leads, and other objects.

Use the following methods for searching:

- Start typing the object name and select the item from the list of recent items.
- Search for names using complete words or phrases.
- Search for partial words using the percentage sign (%) to stand for missing characters or words.
- Select a list, click the **Show Advanced Search** (the filter icon), and modify the search criteria.
- Search for the account itself first to find activities, leads and other objects related to an account.

Typing the Object Name and Reviewing the List of Recent Items

To search for an object by name, navigate to the object you want to search, click in the **Find** field, and start typing any one of the words in the name. Capitalization doesn’t matter.

As you type, the application matches your entry to the records you accessed, created, or updated recently and displays them in the Recent Items window. If you see what you are looking for, just select it.
The following figure shows a screen capture of a search in the Opportunities work area. In this example, entering Server in the Find search box, returns two items under the Recent Items heading: Opportunities: Green Server (Blade) 6000 and Opportunities: Server Upgrade Opportunity.

Searching by Object Name Using Complete Words or Exact Phrases
If you don’t find what you are looking for among the Recent Items, then finish typing the word and click Search (the magnifying glass icon). The application displays a list of records with names that contain your search term, followed by records with related words, just in case you didn’t type the word correctly. For example, if you are searching for accounts using the word software, then the application first displays the account names that contain that word, such as Compucon Software and Forte Software Inc, followed by names with similar spellings, such as Softgear Inc.

⚠️ Note: The application administrator can turn off the display of search results with similar spellings by setting the Include Similar Results in Searches profile option.
The following figure shows a partial screen capture of the Accounts work area landing page. The page shows the sample search for the word **software**. Callout 1 highlights the location of the two account names that include the exact spelling of the word in the name. Callout 2 shows the location of the account name with a similar spelling.

If you want to find the exact name you are searching for, then put quotation marks around your search terms. For example, **"Forte Software Inc"**, returns just that one record.

**Searching for Partial Words in a Name**

You can also search for partial words.

- Put a percent (%) sign after two or more letters, and you get all the names with words that start with those letters.
  
  For example, searching on **pint**, returns Pinnacle Technologies and All Pines Furniture.

- Put the percent sign at the front of the term, and you get records that end with your term. For example, searching for **%ard**, returns The Board of Education and Edward Ward and Co.

- Put the percent sign at both ends, and you get all the customer names with words that include those letters.

**Note:** You can use the percent (%) sign at the beginning of your search term only in the **Find** field on the main page of each object.

Using the percent (%) sign can slow your searches, so enter a whole word if you know it.
Searching Using Predefined Lists and Modifying the Search Criteria

Searching by name is not the only way to find what you need. You can search by selecting one of the lists you or an administrator has created from the List field. You can use the following procedure to modify the search terms.

1. Click **Show Advanced Search** (the filter icon).

   The following figure shows a screen capture of the Opportunities work area search region highlighting the location of the Show Advanced search icon.

   ![Opportunities search region](image)

   The Advanced Search window appears, showing the current search criteria for the list that is displayed on the page.

   The following figure shows a screen capture of the Advanced Search panel highlighted.
2. You can choose different search criteria by selecting a different list from the **Saved Search** list.

3. You can modify your search as follows:

   - Select a different record set to change the scope of your search. For example, selecting **My territory hierarchy** searches all the records in your territories and their subordinate territories. The available record sets vary from object to object.

   To improve saved search performance, restrict your saved searches to smaller record sets. For example, rather than searching all the records you can see, search all the records in your territory hierarchy. Or restrict your searches to a smaller geographical area. For example, search all the accounts in one state instead of the whole country.
Add additional fields to the search by clicking Add.

Select different operators for the fields in your search. While most of the operators, which differ field by field, are self-explanatory, here are some notes on the more complex:

- **Between**
  
  Selecting the Between operator for a date field, prompts you to enter a specific date range for the search.

- **Rolling-time operators**, including Yesterday, Today, Tomorrow, Last Week, This Week, Next Week, Last Month, This Month, and Next Month
  
  Searching for opportunities created this month, for example, returns opportunities created in the current calendar month. The rolling-time filters use the time zone of the signed-in user for the calculation.

- **Current User**
  
  Including the Current User operator in the Last Updated By and Created By fields displays only the records relevant to you, the signed-in user. For example, when you search for opportunities last updated by the current user, you get a list of opportunities last updated by you.

- **Is Blank, Is Not Blank, and Does Not Equal**
  
  Selecting the Is Blank operator, makes it possible to search for records missing values in a text field or a field validated by a list of values, for example. Administrators must make these operators available by setting two system profile options. The Enable Additional Search Operators for Text Fields (ZCA_ENABLE_ADDITIONAL_TEXT_OPERATORS) profile option enables the Is Blank and Is Not Blank operators in text field searches. The Enable Additional Search Operators for List of Values (ZCA_ENABLE_ADDITIONAL_LOV_OPERATORS) enables the Is Blank, Is Not Blank, and Does Not Equal operators on fields validated by list of values (both fixed choice and dynamic choice list fields).

Specify which attributes you want to display in the search results table by selecting Columns from the View menu.

You can select specific columns or display all columns.

Reorder the filter conditions by clicking Reorder.

Delete any fields you added to the search.

You cannot delete the fields provided by Oracle. You can only delete fields you added.

4. Click Search.

   The application displays the search results.

5. To save your modified search as a new saved search (list) do the following:

   a. Click Save.
The Create Saved Search window appears. The following figure shows a screen capture of the Create Saved Search window.

![Create Saved Search window](image)

b. Enter a new name for the saved search.

c. Optionally, you can set this search to be the list that appears whenever you navigate to the work area by selecting the **Set as Default** option.

d. Click **OK**.

**Searching for the Account to Access Opportunities and Other Related Objects**

Search for the account and then drill down to the object from the Account Overview page. Whatever search method you use, always remember that you may not have permission to access all information in the application. For example, to see an opportunity, you may have to own the sales territory, be on the sales team, or manage someone who is.

There may be a delay of a few minutes between the time you create or update a record and when you and others can search for it. That’s because the application must update an index to enable searches. You can access newly-created items from the Recent Items list in the meantime.

**What's the difference between the global search and the work area searches in my sales application?**

Global search, located at the top of the page, makes it possible for you to search across multiple sales objects. The searches available on the different work area landing pads search for a single object.

The following table details the key differences between the two search methods.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Global Search</th>
<th>Work Area Searches</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search Scope</td>
<td>Searches key fields in multiple sales objects.</td>
<td>Makes it possible for you to search for an object by name or by using multiple search criteria.</td>
</tr>
<tr>
<td></td>
<td>Searching on a contact name retrieves not just the contact record, but also related opportunities, leads, activities, and other objects.</td>
<td></td>
</tr>
</tbody>
</table>
### Creating Your Own Personal List

#### Video

Watch: This tutorial shows you how to create your own personal list in sales work areas. The content of this video is also covered in text topics.

#### Procedure

You can create your own personal list in any of the work areas that support lists, including, opportunities, leads, and accounts, by modifying one of the lists supplied by Oracle. The list details differ for each object, but the principles are the same. You can use this example, which shows how to create a list to display all accounts you can view in the state of New York, to learn how to create a new list in any work area.

You can create new lists to search by multiple fields, including fields created by the administrator, by copying and modifying the search criteria for lists supplied by Oracle. For optimal search performance, the administrator-created fields used in search must be indexed fields.

The lists you create are available to you only. However, sales administrators can create lists for different sets of users by using the same sets of steps outlined in this topic while working in Page Composer.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Global Search</th>
<th>Work Area Searches</th>
</tr>
</thead>
<tbody>
<tr>
<td>Indexing Frequency</td>
<td>Usually once a day.</td>
<td>Usually every five minutes.</td>
</tr>
<tr>
<td></td>
<td>Until a new record is indexed, it is not available for search.</td>
<td></td>
</tr>
<tr>
<td>List of Recent Items</td>
<td>Displays recent items for all of the objects you enabled in the search.</td>
<td>Displays the recent items relevant the work area.</td>
</tr>
<tr>
<td></td>
<td>Lists records you recently created, edited, or accessed. This includes records that haven't been indexed yet.</td>
<td></td>
</tr>
<tr>
<td>Wild Cards</td>
<td>Use an asterisk (*) at the end or middle of a word to indicate missing letters.</td>
<td>Use a percent sign (%) at the beginning, end or middle of a word to indicate missing letters.</td>
</tr>
<tr>
<td>Saved Searches (Lists)</td>
<td>Saved searches are not available unless specially configured by your application administrator.</td>
<td>You can search using one or more fields by creating saved searches (lists). For example, you can create a saved search to display a list of all active accounts in New York. Application administrators can create saved searches for others in the organization.</td>
</tr>
</tbody>
</table>
Tip: To improve saved search performance, restrict your saved searches to smaller record sets. For example, rather than searching all the records you can see, search all the records in your territory hierarchy. Or restrict your searches to a smaller geographical area. For example, search all the accounts in one state instead of the whole country.

Creating the List

1. In the work area landing pad, click Show Advanced Search (the filter icon) to the right of the List field.
   The Advanced Search panel appears on the left side of the page.
2. From the Saved Search list, select the saved search you want to use as the basis of your new saved search. In this example, you are creating a list of all accounts in New York, so you can use the default My Accounts saved search.
   
   Tip: To create a saved search entirely with your own fields, select Account Name.

3. In this example, you want to display all of the New York accounts you can access, so select All records I can see from the Record Set list.
   The record set specifies the set of records to be searched. To improve search performance, you want to restrict your searches to a smaller record set. In this example, however, you can select All records I can see because you are restricting the number of records searched by adding the state field.

4. Click Add.
5. Select State from the list.
6. Enter NY in the State field.
7. Click Save.
   The Create Saved Search window appears.
8. Enter a new name.
9. If you don’t want the new search to become the default, deselect the Set as Default option.
10. Make sure the Run Automatically option remains selected. This selection runs the query each time you select the list in the UI.
11. Enter a new name, for example, NY Accounts.
12. Click OK.
   The work area landing pad and the Advanced Search Panel display the new search and the search results.

Deleting or Hiding a List: Procedures

Use the procedures in this topic to learn how to delete any work area lists you created. You can only hide the lists supplied by Oracle unless you are a sales administrator. If you hide a list, you are affecting your own UI only.

Deleting Lists You Created

Use these steps to delete any lists you created.

1. On the work area landing pad, click Show Advanced Search (the filter icon).
   The Advanced Search panel appears on the left side of the page.
2. Select **Personalize** from the **Saved Search** list.

   The Personalize Saved Searches window appears.

3. Click **Delete**.
4. Confirm your deletion by clicking **Yes** on the warning.

### Hiding Saved Searches Supplied by Oracle

1. On the work area landing pad, click **Show Advanced Search** (the filter icon).

   The Advanced Search panel appears on the left side of the page.

2. Select **Personalize** from the **Saved Search** list.

   The Personalize Saved Searches window appears.

3. Select the saved search you want to hide and deselect the **Show in Search List** option.
4. Click **OK**.

   A saved search supplied by Oracle remains available for future use but does not display in the work area. You can restore the saved search to the list in the future by selecting the **Show in Search List** option.

### How can I create saved searches with just one administrator-defined field?

You can create a saved search using an administrator-defined field by editing one of the two single-field saved searches provided by Oracle: Name and Close Date. For opportunities and leads, use the Close Date list. For all other objects, including accounts, use the Name list, for example, the Account Name list or the Contact Name list. You can only create a new search by editing an existing saved search and you cannot delete any of the existing fields. However, you can leave the value of some fields blank, effectively enabling you to search the one administrator-defined field. For optimal search performance, the administrator-defined fields used in a search must be indexed for search.

For example, follow these steps to create a saved search for all accounts with a particular value for a field you created.

1. On the work area landing pad page such as Accounts, click **Show Advanced Search** (the filter icon).

   The Advanced Search panel appears on the left side of the page.

2. Select **Account Name** from the **Saved Search** list.
3. Click **Add** and select the administrator-defined field.
4. Enter a value in the administrator-defined field.
5. Click **Save**.

   The Create Saved Search window appears.

6. Enter a new name for your search.
7. If you want the new search to become the default, select the **Set as Default** option.
8. Make sure the **Run Automatically** option remains selected. Selecting this option runs the query each time you select the list in the UI.
9. Click **OK**.
5 Managing Activities and Calendar

Managing Activities: Overview

As a sales representative, you typically check your calendar for appointments that you have on any particular day before you begin your retail visit.

You can plan your day based on the appointments and the notes if any that you have or want to include in your appointment. Here’s what you can do when you work with appointments:

- Add resources to an appointment.
- Use appointments to check your schedule and the visits that you need to make.
- Review the details of the visits for an account and plan your tasks for the day.
- Add an account to an appointment and the appointment is assigned to a field sales representative who is the owner of that account and appears on the assignee’s calendar.
- Create notes for any additional information that you may need to record regarding your retail visit.

Getting Started with Activities

Overview

Activities help you keep track of things you plan to do, like tasks and appointments, or things that you need to track, like customer calls.

Types of Activities

There are three types of activities:

- Tasks are to-do items assigned to people or groups. Tasks are also used to record completed customer interactions that are not scheduled in your calendar as appointments.
- Appointments are calendar events, for example, a meeting with another person or a scheduled phone call.
- Call reports are created to record a brief summary of a call. They can be created from an appointment, a task, or standalone from the Activities list page. When created from a task or appointment, the application automatically populates all pertinent data into the call report.
Collectively called “activities”, tasks and appointments can be meetings, calls, demonstrations, events, and so on. The difference between a task and an appointment is that a task appears in a task list and has a due date and status, while an appointment is scheduled on your calendar with a specific date and time. For all activities, the Type field lets you categorize the item. For example, when you create a task you can set the type as a Call or a Meeting.

Accessing a List of Activities
Use the Activities landing page to access your activities. Use the search utility to find both tasks and appointments in the same search.

In the Activities landing page, information appears in columns only when applicable. For example, some fields apply only to tasks and some only to appointments; thus, blank fields appear when there is nothing relevant to display. Appointment and task icons make it easy to differentiate between the different types of activities.

To access the Activities landing page:
1. Sign in to a sales application as a salesperson.
2. On the home page, click **Sales > Activities**. The My Calendar page appears.
3. Click the **Activities** tab. The Activities landing page appears.

Understanding the Activities Pages
The activities pages include the My Calendar, My Tasks, and Activities pages. You use these pages to manage tasks, appointments, and call reports outside the context of a particular record. Within an activity, you can associate the activity itself with a record, such as a lead or opportunity. Additionally, in some of the sales applications, you can manage activities within the records themselves.

In the Activities pages, you can:
- Create new tasks and appointments.
- Search for and view tasks and appointments.
- Edit existing tasks and appointments.
- View reports and analytics information.
- Manage your calendar.
- View other sales users’ calendars, as well as team calendars, with permission.
- View at-a-glance which tasks are overdue.

Creating New Tasks and Appointments
You can create new tasks and appointments in several ways:
- In the My Calendar page, click **Create Appointment** to create a new appointment.
- In the My Tasks page, click **Create Task** to create a new task.
- In the Activities page, click **Create Task** or **Create Appointment**.
- Create follow-up tasks or appointments from existing ones: In the Actions menu for the existing task or appointment, select **Create Follow-Up Task** or **Create Follow-Up Appointment**.
- Create tasks or appointments related to opportunities or leads: Navigate to a lead or opportunity and click the **Activities** tab. Tasks or appointments you create automatically are associated with the related record.
Managing Your Calendar

Use the Calendar pages to keep track of all your appointments. You can:

- View your appointments in a daily, weekly, or monthly format, and either in a calendar view or as a list.
- Move appointments from one time and day to another day or time.
- Create new appointments, including recurring appointments.
- View and edit existing appointments.
- View your colleagues’ appointments, if you have permission.
- Access additional calendars. Additional calendars, if enabled, are available after you click the Manage My Calendar icon.

Managing Your Tasks

The Tasks landing page displays your tasks that include a due date, allowing you to see at-a-glance which ones are due on which dates. Icons help you spot overdue tasks quickly. You can use the My Tasks list to sort tasks by due date, subject, or priority.

Delegating Activities

When you create an activity, such as an appointment or task, you are the owner by default. However, you can delegate activities other users, if the administrator has enabled delegation. After you delegate a task to another user, both the owner and the person to whom the activity is delegated can edit or update the activity. You can delegate an activity for tasks and appointments. The steps to delegate an activity are the same for tasks and appointments.

To delegate an activity:

1. Sign in to a sales application as a salesperson.
2. On the home page, click Sales > Activities.
   
   The My Calendar page appears.
3. Click an appointment on your calendar that you want to delegate.
   
   The Edit Appointment page opens.
4. From the Owner field drop-down list, search and select a resource to delegate your appointment.
5. Click Save.
   
   The appointment appears on the new owner’s calendar and your name is automatically entered into the Delegated By field.

Alternatively, you can also delegate an activity by updating the activity owner from the resource team. Use the following procedure.

1. Sign in to a sales application as a salesperson.
2. On the home page, click Sales > Activities.
   
   The My Calendar page appears.
3. Click an appointment on your calendar that you want to delegate.
   
   The Edit Appointment page opens.
4. Click the Resources tab.
5. Update the owner of the activity by selecting another resource in the Owner field.
6. Click Save.
The administrator must enable activity delegation. After delegation is enabled, if you modify the owner:

- The Delegated By field is automatically updated.
- The replaced owner is removed from the activities Resources table.

Call Reports: Explained

A call report is a central place for salespeople to capture what happened in a sales activity, make related changes, and track key updates. Call reports can boost salespeople’s productivity by saving time, increasing visibility into their business, and selling more in less time.

A call report is a type of activity like tasks and appointments. You can create call reports for scheduled appointments or ad hoc call reports from the Activities tab. Each scheduled appointment can have multiple call reports, created by different salespeople. The call reports for an appointment are listed in and viewed from that appointment. Salespeople can also create ad hoc call reports to report sales activities that are not scheduled on their calendar.

**Note:** The administrator must use Application Composer to enable the Create Call Reports button on the Activities tab, the Activities list, and the Tasks tab.

Call reports record a snapshot of the outcome of the sales activity and key changes, including:

- Outcome summary, meeting minutes, complete objectives, attendees, attachments, notes, and so forth.
- Related objects, such as appointments, accounts, opportunities, and leads

Appointment resources and others who have access to an appointment can create a call report from it. Multiple call reports can be created from one appointment.

Adding and Removing Objectives

Appointment objectives are copied over to the call report by default. You can add additional objectives, or remove existing ones.

To add objectives, you can either select them from a predefined list or type free text to add new ones. Predefined objectives include:

- Demo product
- Determine next steps
- Discuss proposal
- Identify stakeholders
- Review RFP or RFI (Review Request for Proposal or Request for Information)

You can check an objective in a call report to mark it as complete, or deselect it to mark it incomplete. Objectives copied over from the appointment or added by user are deselected by default.

Appointment Contacts and Resources

Appointment contacts and resources are copied to the call report. You can add or remove contacts and resources. You can also check or deselect a contact or resource’s attendance status to indicate whether he or she attended the meeting.

- Contacts that are defaulted from the appointment are marked as attendees by default.
- Resources that are defaulted from the appointment are marked as attendees by default if the resource’s response in the appointment is not Declined.
Resources and contacts that are not defaulted from the appointment and added by the user are marked as attendees by default.

Appointment Outcome
You can select an appointment outcome from a list of predefined values. Your sales administrator can add or remove values from this list as needed. Default values are:

- Call answered
- Call transferred
- Captured issue
- Failed
- Left message
- Not available
- Provided information
- Successful
- Incomplete
- At risk
- Customer undecided

Attachments and Notes
You can add attachments to a call report in the same way that you add them to other objects.

Anyone who has access to the call report can create notes on it. Call reports support both internal and external notes. You can use external notes to share with external contacts.

Any user who can view the call report can see non-private notes, but only the note creator can see private notes.

Call Report Security
Call reports include a Private setting, which determines who can view it:

- If the call report is set to Private, then only the call report resources can view it.
- If the call report is not set to private, then anyone who can view the related appointment can view the call report.

Call Reports and Oracle Social Network
You can share a call report on the call report Oracle Social Network wall. In Manage Oracle Social Network Objects setup, you can enable Activity on Oracle Social Network and configure the attributes that can be shared on Oracle Social Network.

Managing Activities

Video

Watch: This video tutorial shows you how to manage your activities using the Activity component. The content of this video is also covered in text topics.
Procedure

You can create your own list of activities. For creating your own lists you must set your search criteria and save the list. You can view your list in the List field.

To create your own lists:

1. Sign in as a sales representative.
2. On the home page, click **Sales > Activities**.
   
   The My Calendar page appears.
3. Click the **Activities** subtab.
   
   The Activities landing page appears.
4. Click the **Show Advanced Search** icon.
   
   The Advanced Search pane appears.
5. In the Advanced Search pane, select **I Own** in the Record Set field.
6. Click **Save**.
   
   The Create Saved Search dialog box appears.
7. Name the list.
8. Click the **Run Automatically** check box, and click **OK**.
9. View the list in the Saved Search field.

Procedure

Use the Show filter in activities when you want to:

- Create saved searches for activities.
- Search for activities in associated objects, such as opportunities or accounts.

When the Show filter is set to All or Completed, the sort order displays your future activities first, followed by the historic activities. To view future activities:

1. Sign in to **Sales > Activities**.
2. Navigate to **Sales > Activities**.
   
   The My Calendar page appears.
3. Click the **Activities** subtab.
   
   The Activities landing page appears.
4. Click the **Show Advanced Search** icon.
   
   The Advanced Search pane appears.
5. In the Advanced Search pane, select **My Open Activities** from the Saved Search drop-down list.
6. Select **Complete** or **All** from the Show field.
   
   A list of all the future appointments and open tasks appears.
Creating Lists: Explained

You can refine your list of activities by creating lists from Activities using Saved Search in the Advanced Search pane. For example, you can create a list of all completed tasks you own. A date range is required when using the Saved Search (list) pane. The available Show filters are Open, All, Completed.

<table>
<thead>
<tr>
<th>Show Filter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>Displays all appointments that have a start date of today or in the future within defined date range, all open tasks with a due date in the defined date range, and open tasks with no due date.</td>
</tr>
<tr>
<td>All</td>
<td>Displays all appointments within the defined date range, open tasks with no due date or with a due date within the defined date range, and closed tasks with an end date in the defined date range.</td>
</tr>
<tr>
<td>Completed</td>
<td>Displays appointments in the past with a start date that falls within the defined date range, and tasks having been completed within the defined date range.</td>
</tr>
</tbody>
</table>

Creating Tasks from a Task Template: Procedure

Sales representatives can create tasks for a business object from a task template. First select a set of tasks for a template task and then create tasks. In this topic, the opportunity business object is used as an example. However, the procedure to create task templates is the same for all objects.

**Note:** Tasks can be autogenerated from a task template and displayed in the Activities subtab. For example, a task template is associated with a sales stage. On updating the sales stage, the autogenerated tasks appear in the opportunity Activities tab.

To create tasks from a task template:

1. From the Navigator, click **Opportunities**.
2. Select the opportunity for which you want to create a task.
   
   The Edit Opportunity page opens.
3. Click the **Activities** subtab.
4. Click **Create Tasks from a Template**.

**Note:** If the administrator hasn’t set up task templates, a warning appears.

5. Select the template name from the available task templates.
6. (Optional) Enter the name of the owner of the task. If the field is blank, the signed-in user is set as default as the owner of the task.
7. Click **Save and Close**, on the Create Tasks from a Template page.

   The tasks are created from the template.
Related Topics

- Defining Tasks: Points to Consider

Selecting Addresses for Activities

If the administrator has exposed the address selector on the Activity UI, you can associate an address with an activity’s account or contact. The association enables sales managers to audit and relate call report contact or account location with sales. Managers can also audit trail the customer visits of a sales person. On a call report the address selector helps to automatically populate the address of the account or contact.

Remember the following rules:

- You can change the selected address as needed, except after a call report is submitted.
- The addresses are available for accounts, if both accounts and contacts are defined for the activity.
- If only contacts are defined for an activity, but not an account, then the address shown is related to the primary contact.

An address selector can be enabled for call reports, appointments, and tasks. Using the address selector on a call report is used as an example in the following procedure. To select an address:

1. Open an appointment or a task to access a call report.
2. Click Create Call Report or open an existing Call Report.
3. Select an account.
4. Select an address related to the account from the Addresses section.
5. Click Save and Close.

For more information, see Exposing the Address Selector on Activity Pages, in the Implementing Sales guide.

Activity Notification: Explained

Activities generate notifications when you perform various tasks or make certain updates. This topic explains how the notification process works.

Notification Events

Notifications are sent by email or on a global notification list (also called a bell notification list). You can choose whether to receive email, a notification in the notification list, or both. Notifications are triggered when a change is saved. Notifications can be sent when an appointment or task is created, updated, or deleted. You can also send notifications as a reminder for appointments.

Note: For updates, notifications are triggered on any update except the settings and values specific to each individual user:

- Show Time As
- Reminder
- Response
Notification messages are displayed only on the bell notification list. The messages are not displayed in the Worklist for
notifications and approvals.

Using Notifications to Drill Down to Transactions

You can opt in to use the capability to drill down and act from activity notifications and receive notifications through
notification lists and email. If you opt in to receive notifications, then list and email notifications are generated when you create
or update appointments and tasks. Each notification includes a link that you can drill down on to view the record details
before you approve or reject the request. You can accept or decline appointments and complete tasks from notifications. You
can decide whether to use the enhanced notifications with drill-down capability or continue to use the earlier option with no
drill-down capabilities.

To receive notifications, you must set a preference in your Preferences page. See the section in this topic, Setting the
Preference to Receive Notifications, for more information. After you opt in, you receive two types of notifications: Action
Required and FYI. In the Pending Notifications window, you can act on each notification by clicking Accept or Decline.

Appointments and tasks have the following set of fields that appear by default in the email notifications:

- Task
- Due Date
- Owner
- Status
- Assigned to

Each appointment notification has the following default fields:

- Subject
- Date
- Location
- Invitees

In addition, all email notifications include the following fields, if they are defined on an activity.

- Account
- Opportunity
- Lead
- Asset
- Description

To drill down into an activity, click the subject or task link in the appointment notification. You can also accept or decline an
appointment or complete a task from the email notification.

Setting the Preference to Receive Notifications

Perform the following steps to receive notifications by email and lists:

1. Sign in as a sales representative.
2. Click Setting and Actions > Set Preferences in the global header.
3. Click Calendar and Appointment Preferences.
The Calendar and Activity page appears.

4. In the Appointments and Task sections, select the **Notify me by** check box.

5. Click **Save**.

### Applying Mass Update to Activities

The mass update feature enables you to select multiple activity records and update all of them to the same value for a field. An administrator must enable the update action using Application Composer.

### Updating Activities in Bulk

To apply mass updates to activities:

1. Navigate to the **Activities** landing page.
2. Enter the search criteria for the activities that you want to update, and click **Search**.

   The application returns a list of results based on your search criteria.

3. Select the activities that you want to update at the same time.
4. Click **Update** from the **Actions** menu.

   To select or deselect activities, click a record in the list. Use the select all and deselect all links to select or deselect all activities.

   **Note:** By default, all the attribute fields on the Mass Update dialog box are read-only until you select to update them.

5. Select the attributes that you want to update and assign a value for each of the selected attributes.

   The default values are displayed. The text fields are blank by default.

6. Click **Save and Close**.
My Calendar: Explained

Use the My Calendar page within Activities to manage calendar views.

Viewing Calendars

You can view calendars by day, week, month, or agenda. You can view the status of other deals by selecting a different calendar listed in the side panel. The steps to view a calendar using the side panel are the same for opportunity and account. In the following procedure, account is used as an example.

Weekly View

The default calendar view is the Weekly View. From here, you can see all of the items on your calendar for the week. On the left, each user added to the team calendar is displayed (by default only the signed-in user is displayed, as in single calendar mode). Each day shows:

- Start time of appointment, with recurrence icon (if applicable)
- Whether the appointment is multi-day (indicated by an arrow)
- Appointment subject

You can view and edit the recurrence information in the Add: Recurrence dialog box that appears when you click the Recurrence button. Nonrecurring appointments display the edit page for the appointment.

*Note:* The appointment time isn’t reset when the All Day check box is cleared.

You can only edit your own appointments. Even if your peers have given you permission to view theirs, you can’t edit them. Appointments marked by others as Private display as Busy on their calendar entry, and do not include details.

Day View

On the Day View, you can see all of the items on your calendar for the current day. On the left, each user added to the team calendar is displayed (the default only shows the signed-in user).

Along the top are the hours of each day, where the calendar entries are displayed. Each day shows:

- Start time of appointment, with recurrence icon (if applicable)
- Whether the appointment is multi-day (indicated by an arrow)
- Appointment subject

You can view and edit the recurrence information in the Recurring Appointments dialog box. Nonrecurring appointments display the edit page for the appointment.

You can only edit your own appointments. Even if your peers have given you permission to view theirs, you can’t edit them. Others who can edit other users’ appointments include:

- The administrator.
- The user’s manager, if the person is in their resource hierarchy and the manager has the Sales Manager duty role.

Appointments marked by others as Private display as busy on their calendar entry, and do not include details.
Appointment Colors
The legend at the bottom of the calendar displays the colors associated with different appointment types. If an appointment is of one of these types, the appointment box in the calendar is displayed in that color. You can change these colors using Setup Manager.

Appointments that show a user as busy don’t display any details because you don’t have access to their record.

Adding Appointments
To add new appointments to the calendar click Create Appointment. Selecting the check boxes next to the user names in your team calendar automatically adds those users as resources to the new appointment.

Setting Up Appointment Visibility: Worked Example
You can let other users access your calendar appointment details by giving them permission to view them.

Setting Up Appointment Visibility
Use the following procedure to give others permission to view your appointments.

1. In the global header, within the Settings and Actions menu, click your user name and select Set Preferences under Personalization.
2. Select Calendar and Appointment Preferences. The Calendar and Activity page appears.
3. In the Additional Calendar Sharing Levels with Specific Resources section, add a row to the table. Select the individuals that you want to share your appointment details with.
4. Set the Access Level value to Show appointment details.
5. Save your changes.

The users you select can access your calendar appointment details from the Calendar page by selecting your name in the Resource list.

Integrating Assets with Activities: Overview
After the administrator enables the functionality, salespeople can associate assets with activities, including appointments, call reports, and tasks.

Associating an asset with an activity and then viewing the asset calendar helps salespeople manage their appointments. Salespeople can view all the related appointments in a single place. After someone in the organization associates an asset with an appointment, then the asset calendar is enabled.

For more information about setup details, see Enabling Assets in Activities, in the Implementing Sales guide.
Using Asset Calendars: Overview

Use your calendar to manage assets. An asset calendar displays the appointments relevant to your assets. Team members view all upcoming appointments related to an asset in the calendar and coordinate their activities for the asset.

You can create an asset calendar for:

- Assets that you can access
- One asset at a time

The asset calendar displays all appointments for the asset and private appointments. The asset calendar identifies the owners of the appointment with a picture or icon with the user initials or name. With the asset calendar you can:

- View all appointments related to an asset in a single calendar view.
- View all the owners of appointments related to an asset.
- Hide or show appointments of individual or multiple appointment owners.
- Save asset calendars to a list and access the calendar that you want.
- Determine the owner of each appointment on the calendar.
- Switch between all calendar views: day, week, month, and agenda.

Adding Assets to Activities

If the functionality is enabled by the administrator, you can add assets to all types of activities, including appointments, call reports, and tasks. You can add assets to new and existing activities, using the activity create and edit pages. After you add an asset to an activity, then you can view the asset on that activity’s page.

After an asset is associated with an appointment, you can view the asset calendar from the Manage My Calendar window available on the My Calendar page. For more information, see the related topics.

To add an asset to an appointment:

1. Access the activity page where the Assets list if enabled. For example, click Create Appointment in the My Calendar page.
2. Click Search in the Asset drop-down list.
   The Select: Asset page appears.
3. Click Search.
   The search results appear.
4. In the search results, select an asset and click OK.
   The Create Appointment page appears.
5. The asset number and asset serial number of the selected asset, if available, are automatically populated.
6. Click Save and Continue in the Create Appointment page.
   The asset appears as a link.
7. Click Save and Close.
Creating an Asset Calendar View

An asset calendar displays the appointments relevant to your assets. After an appointment is associated with an asset, you can create an asset calendar view from the My Calendar page. The asset calendar is available to the whole organization as soon as one person across an organization associates an appointment with an asset.

The asset calendar displays:

- All appointments that are associated with an asset.
- All owners of appointments associated with an asset. The appointments can be owned by different people.

To create an asset calendar view:

1. Click the Manage My Calendar icon on the My Calendar page.
2. Click Other Calendars.
3. Click Create Asset Calendar View.

The Create Asset Calendar page appears.

Tip: Remember, an asset calendar can only be enabled after an appointment is associated with an asset.

4. Click Search in the Asset field.

The Select: Asset page appears.

5. Search for and select an asset. Alternatively, you can create an asset to use.

6. Click OK.

The name of the asset is automatically populated as the calendar name, but you can change it if needed.

7. Save your changes.

You can access the asset calendar from the My Calendar page by clicking Manage My Calendar > Other Calendars. You can filter the calendar to view appointments associated with a particular owner.

Related Topics

- Sales Assets: Overview

FAQs for Managing Activities and Calendar

What activities does selecting My Open Activities display?

When you select the My Open Activities list in the Activities work area, the application displays a list of all of the future appointments and open tasks where you are listed as a resource. You are automatically a resource if you created the activity or you can be assigned as a resource by another resource or an automated process.
What activity records do the different record sets permit you to search?

The different record sets provided in the Saved Searches window restrict your saved searches to different sets of activities. The following table lists and describes the record sets for activities. Not all record sets are available to all users. For example, the record set involving subordinates is available only to managers.

**Tip:** To improve saved search performance, restrict your saved searches to smaller record sets. For example, rather than searching all the records you can see, search all the records you and your subordinates own. Or restrict your searches to a smaller geographical area. For example, search all the activities in one state instead of the whole country.

<table>
<thead>
<tr>
<th>Record Set Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>I own</td>
<td>Activities you either created or ownership was assigned to you.</td>
</tr>
<tr>
<td>I am a resource</td>
<td>Activities where you are a resource.</td>
</tr>
<tr>
<td>My subordinates own</td>
<td>Activities owned by you and your subordinates.</td>
</tr>
<tr>
<td>All records I can see</td>
<td>Activities that you can view based on your resource team membership, sales territory assignments, your position in the organization, and security permissions. This set of records is available only if the administrator enables the profile option to Yes.</td>
</tr>
</tbody>
</table>

How does the Show filter refine my activity list?

The Show filter displays activities based on certain criteria. The following table lists the show filter criteria for activities:

<table>
<thead>
<tr>
<th>Show Filter</th>
<th>Tasks</th>
<th>Appointments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>All open tasks with a due date in the defined date range, and open tasks with no due date</td>
<td>All appointments that have a start date of today or in the future within a defined date range</td>
</tr>
<tr>
<td>All</td>
<td>Open tasks with no due date or with a due date within the defined date range. Closed tasks with an end date in the defined date range</td>
<td>Open tasks with no due date or with a due date within the defined date range. Closed tasks with an end date in the defined date range</td>
</tr>
<tr>
<td>Completed</td>
<td>Tasks that are completed within the defined date range</td>
<td>Appointments in the past with a start date that falls within the defined date range</td>
</tr>
</tbody>
</table>
How can I view activities that are set as private?

You can only view activities that are set as private if you are the owner of the activity, are delegated by other users to view it, or are a resource or contact of the activity.

**Tip:** The Private check box is hidden by default in the tasks pages. Administrators can use Application Composer to display the check box and enable you to set a task as private.

How can I track customer-facing activities?

You can define your own criteria for an interaction using the Activities feature. Customer interactions are logged either as completed tasks or as appointments using the activity types you want to report on. To track your customer-facing interactions, generate a report to retrieve activities of a specific type with accounts or contacts associated. For example, you can list all calls with an associated contact. To track a completed task, go to the Activities page from the Customer, Opportunity, or Lead page, and click Log a Call.

How can I view my appointment in a different time zone?

You can use the time zone drop-down list to view the appointment time in a different time zone. The time zone for users is defined in the Regional area within Set Preferences. If no time zone is defined, the appointment time zone displays as null, and appointments are created based on Universal Time Coordinated (UTC) time. You cannot change the default time zone.

When appointments include attendees from a different region, the appointment time zone drop-down list can be used to define an attendee-friendly time. For example, a user in Chicago selects 9 A.M., and sets the time zone to Cairo, Egypt time zone. Upon saving, the appointment displays to the Chicago user as 2 A.M., and the time zone drop-down list has the Chicago value.

What's the difference between a task, an interaction, and an appointment?

A task is a unit of work to be completed by one or more people. Tasks are related to business objects such as opportunities or contacts, and can include attachments.

An appointment is a calendar entry related to a business object such as an opportunity or a customer. Appointments can include attachments.

An interaction provides a historical view of all communications initiated by you to a customer, or by a customer to you. Interactions do not document internal communications.
6 Maintaining Account, Contact, and Household Information

Accounts, Contacts, and Households: Overview

The Accounts pages let you manage the information related to your sales accounts, including customers, prospective customers, individual contacts, and households.

Use the account data management capabilities to:

- Create and update accounts, prospective accounts, contacts, and households
- Maintain account data and view data in hierarchical fashion
- View household relationships
- Enrich customer data

As your work with the account management application, keep in mind the following terminology:

- Account: An account is an organization that a salesperson sells to. Accounts can be prospects or customers.
- Contact: A contact is a single person. A contact need not be related to a customer. A person may also be both a customer as well as a contact of another customer.
- Customer: A customer is someone with whom you have a selling relationship. The selling relationship can result from the purchase of products and services, or from the negotiation of terms and conditions that provide the basis for future purchases.
- Household: A household is a group of contacts with whom you have a selling relationship. Households provide valuable segmentation information about the household as a whole, as well as summary of information about the household member contacts. Usually all the contacts reside at the same address and have a similar set of attributes that accounts do, such as team members, territories, and contacts.
- B2B and B2C: Business-to-business and business-to-consumer, or B2B and B2C, are terms that indicate the type of customer relationship:
  - B2B: The customer is a business rather than an individual consumer.
  - B2C: The customer is an individual consumer rather than a business.

For more information on accounts, contacts, and households, see the related topics.

Managing Account Information

Accounts: Explained

An Account refers to an organization that a salesperson sells to and that can be maintained as a prospect or customer.
Creating Accounts
You can create accounts in the following ways:

- Create them in the Accounts page
- Import them using file-based data import
- Use web services to create an account

Overview of Account Management
Use account management capabilities to search for, create, update, delete, merge, and enrich accounts.

The following table lists the Account areas you use to manage accounts.

<table>
<thead>
<tr>
<th>Account Tabs</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>Provides a general overview of customer or prospect, opportunities, leads, active contracts, assets and recommendations, and activities.</td>
</tr>
<tr>
<td>Profile</td>
<td>Provides details of the account such as address and contacts. Here you can also:</td>
</tr>
<tr>
<td></td>
<td>- Create and manage account hierarchy</td>
</tr>
<tr>
<td></td>
<td>- Update and verify account address</td>
</tr>
<tr>
<td></td>
<td>- Add industry codes and organization types.</td>
</tr>
<tr>
<td></td>
<td>Use this tab to add the primary contact to the account.</td>
</tr>
<tr>
<td>Team</td>
<td>Shows team members and territories that are part of your account. Here you can also:</td>
</tr>
<tr>
<td></td>
<td>- Add team members</td>
</tr>
<tr>
<td></td>
<td>- Add territories</td>
</tr>
<tr>
<td></td>
<td>You can manually run territory assignment for the account through the Run Assignment process. For example, a sales administrator can manually assign a specific account to verify that expected territories are assigned after territory realignment.</td>
</tr>
<tr>
<td></td>
<td>The assignment action is enabled for the type of account enabled for assignment. If you have enabled assignment for account of type customer, then the assignment object is shown as:</td>
</tr>
<tr>
<td></td>
<td>- Enabled for customer account</td>
</tr>
<tr>
<td></td>
<td>- Disabled for prospect account</td>
</tr>
<tr>
<td>Contacts</td>
<td>Enables you to add and view contacts for the account. Review contacts in the following views:</td>
</tr>
<tr>
<td></td>
<td>- Table view</td>
</tr>
<tr>
<td></td>
<td>- Hierarchy view</td>
</tr>
<tr>
<td></td>
<td>The hierarchy view shows how the contacts are related to each other. Here you can manage reporting relationships and drill into contact details.</td>
</tr>
<tr>
<td></td>
<td>Use this tab to add additional contacts to the account. You must have edit access on the Account to add contacts. To add a contact, you can search by an account. The search results show the contacts and their primary customers and account.</td>
</tr>
</tbody>
</table>
## Maintaining Account, Contact, and Household Information

### Account Tabs

<table>
<thead>
<tr>
<th>Account Tabs</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Opportunities</td>
<td>Enables you to add and view opportunities for the account.</td>
</tr>
<tr>
<td>Quotes and Orders</td>
<td>Enables you to add and view quotes and orders for the account.</td>
</tr>
<tr>
<td>Leads</td>
<td>Enables you to add and view leads for the account.</td>
</tr>
<tr>
<td>Recommendations</td>
<td>Provides a list of products recommended for this account.</td>
</tr>
<tr>
<td>Contracts</td>
<td>If your administrator has enabled this view, then you can view contracts associated with the account. Depending on your access, you can also preview the contract in a PDF format.</td>
</tr>
<tr>
<td>Notes</td>
<td>Enables you to add and view notes for the account.</td>
</tr>
<tr>
<td>Assessments</td>
<td>Enables you to add and view assessments for the account.</td>
</tr>
<tr>
<td>Activities</td>
<td>Enables you to add and view appointments, tasks, and call logs.</td>
</tr>
<tr>
<td>Assets</td>
<td>Shows a list of assets for this account.</td>
</tr>
<tr>
<td>Relationships</td>
<td>Enables you to add account relationships to other account or contacts that are not directly related to the account but are influential. You can add the same contact to multiple accounts using different relationships. You must add your first contact from the Contact subtab and add your subsequent contacts here. Review the relationships in the following views:</td>
</tr>
<tr>
<td></td>
<td>• List view</td>
</tr>
<tr>
<td></td>
<td>• Diagrammer view</td>
</tr>
</tbody>
</table>

**Note:** You cannot edit a role after you have added a relationship. To update the role, delete the existing relationship and create another relationship with the role that you want.

### Managing Multiple Classification Codes: Explained

If your administrator has enabled the Multiple Classification Codes option and you have edit access to your account, then you can add or remove multiple industries and organizations for your account. This gives you the flexibility to assign the most accurate industry and organization type to your account that provides greater accuracy for account qualification and territory assignment.

You can assign primary as well as secondary industry and organization type values to your account. You can also load your own industry and organization classifications and use them to qualify your accounts. When an account is assigned multiple classification values, you have the option to use all the values to determine territory and rule-based assignment for accounts, or you can use only the primary account classification.
When you remove the primary organization type, then the application sets the next available organization type in the hierarchy as the default organization type. If there isn't any organization available, then there is no default organization attached to your account. Similarly, when you remove the primary industry code, then the application sets the next available industry code in the hierarchy as the default industry. If there isn’t any industry code available, then there is no default industry attached to your account.

What happens when I remove the primary industry code?

The application sets the next available industry code in the hierarchy as the default industry. If there isn’t any industry available, then there is no default industry attached to the account.

What happens when I remove the primary organization type?

The application sets the next available organization type in the hierarchy as the default organization. If there isn’t any organization available, then there is no default organization attached to the account.

Viewing and Managing Account Hierarchies: Explained

You can use sales applications to view and manage your accounts hierarchically. On the Profile page for a selected account, you can indicate a parent account, and you can create an account hierarchy if one doesn’t already exist or manage the existing account hierarchy.

To access the Profile page, click Accounts, select an account to edit, and click Profile.

In the sales application, you can view both a graphical chart view and a table view for account hierarchies. You can click the view icons on the Create Hierarchy page to alternate between views. The following tables describes chart and table views:

<table>
<thead>
<tr>
<th>Chart View</th>
<th>Table View</th>
</tr>
</thead>
<tbody>
<tr>
<td>See the hierarchy and the current active hierarchy version.</td>
<td>See the hierarchy and the current active hierarchy version.</td>
</tr>
<tr>
<td>Use the Control Panel tools to change the hierarchy layout, move the hierarchy around, center the hierarchy in the view, and increase or decrease the amount of zoom.</td>
<td>See the transactions associated with each node in the hierarchy. The transaction details region shows a list of associated contacts, open opportunities, open leads, team members, and assets.</td>
</tr>
<tr>
<td>Use the scroll arrows to see the following customer information:</td>
<td>Add or remove a node from the hierarchy (with the exception of the currently selected account).</td>
</tr>
<tr>
<td>• Number of open opportunities</td>
<td></td>
</tr>
<tr>
<td>• Number of won opportunities</td>
<td></td>
</tr>
<tr>
<td>• Number of leads</td>
<td></td>
</tr>
<tr>
<td>• Number of contacts</td>
<td></td>
</tr>
<tr>
<td>• Number of team members</td>
<td></td>
</tr>
<tr>
<td>• Number of assets (value)</td>
<td></td>
</tr>
<tr>
<td>• Customer type</td>
<td></td>
</tr>
</tbody>
</table>
### Adding a Parent Account
Adding a parent account creates a parent-to-child hierarchy between the two accounts. Use the following steps to add a parent account to a selected account:

1. Click Accounts, and select an account to edit from the list.
2. On the Edit Account page, click the Profile tab.
3. Click the Search icon next to the Parent Account field.
4. On the Select Parent Account page, search for and select the account that you want to add as a parent.
5. Click OK.

**Tip:** The account appears as a link in the Parent Account field.

You return to the Profile page and the selected account appears in the Parent Account field.

### Creating an Account Hierarchy
Use the following steps to create a hierarchy for your selected account:

1. Click Accounts, and select an account to edit from the list.
2. On the Edit Account page, click the Profile tab.
3. Under the Parent Account field, click the Manage Account Hierarchy link.
   
   The Create Hierarchy page appears, displaying the selected account in chart view. You can use the view icons to switch between Chart and Table views.
4. From the Action menu, select Add Child.
5. Search for and select the child account you want to add.
6. Continue adding accounts to your hierarchy.
7. Click OK, then click Save and Close to save your changes and return to the Profile page for the selected account.
Can I delete accounts that belong to a hierarchy?

You cannot delete an account if the account is the ultimate parent (the root node) in an account hierarchy. However, you can remove the account as the ultimate parent in the hierarchy and then delete the account. To do so, you must first delete the sub accounts before deleting the ultimate parent account.

You can delete an account that is in the middle or at the lowest subsidiary (the leaf node) of an account hierarchy. The deleted account is no longer shown in the account hierarchy. The deleted account’s sub accounts, if any, become separate hierarchies.

Managing Account Contacts: Explained

When creating an account, you can select a contact as the primary contact. This contact is shown in the **Contacts** tab. You can add or view the contacts in the following ways:

<table>
<thead>
<tr>
<th>View</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>List View</td>
<td>Shows the available contacts in a tabular format. Each line represents an account and the table structure represents the hierarchy. By default, the hierarchy shows all the parent levels and the immediate children of the account.</td>
</tr>
<tr>
<td>Diagrammer View</td>
<td>Shows the available contacts in a graphical view in a hierarchical format. You get a quick snapshot of how these contacts are related to each other in the organization. The node that represents the current account is emphasized. By default, the hierarchy shows the immediate parent and children of the account.</td>
</tr>
</tbody>
</table>

Manage Hierarchy

Viewing the account hierarchy enables you to see the complete details of a selected account and its connection with other accounts.

Use the account hierarchy to:

- Add a child account and subsequent child accounts and create a hierarchy
- Remove a child account
- Remove a parent account

Managing Account Team Territories

**Account Territory Member Access: Explained**

Access for the territory owners and members are the same as that of the team members. These access levels control the internal and partner territory privileges for the account:

- Internal territory owner: Full access
- Internal territory members (nonowner): Edit access
• Partner territory owner and members: View-only access

Note: You must implement Territory Management before you can access territory owners.

Account Team Member Access Levels: Explained
Access levels control the team member’s privileges for the account.
There are three types of account team membership access levels:

• View Only
• Edit
• Full

When you add a resource to the account team, a profile option setting determines the member’s default access level. If the member is removed from the account team, then that member no longer has access to the account. Only a member of a territory who is assigned to an account retains access. Resources in the management hierarchy of a newly added team member inherit the same access level of the subordinates. Resources in the management hierarchy of a newly added team member inherit the same access level of the subordinates.

View Only
View Only is the minimum level you can assign to team members. Team members with View Only access can view details of the account, such as: account team, snapshot, assessments, discussion forums, notes, and activities. The team member’s resource role does not provide functional access to view a particular child attribute of an account. Without functional access a member cannot view the attribute, regardless of their account team access level. The data security inherent on objects, such as leads and opportunities, determines whether team members can view details of that business object.

Edit
Team members with the Edit access can view and edit all customer-related objects. The data security inherent on objects, such as leads and opportunities, determines whether team members can view details of that business object. They can also run the territory reassignment process, but they cannot change the composition of the account team.

Full
With Full access, team members can perform edit access functions and also change the composition of the account team. Initially, only the account owner and sales administrators have Full access, but they can grant Full access to other team members. Team members with Full access can do the following for other members:

• Manually add and remove other team members
• Change a member’s access level
• Mark the lock assignment setting

Note: Team members must have Full Access to edit Account Profile and Household Profile pages.

What are favorite accounts?
Favorite accounts are those that you want to focus on because of business or other reasons. Tag accounts as favorites when creating or updating accounts, or when viewing the account list. Optionally, create a saved search based on your favorite accounts.
Managing Contact Information

Contacts: Explained

Any person can be a contact and that person doesn’t have to be related to an account.

Creating Contacts

You can create contacts in the following ways:

- Create directly in sales applications
- Import contacts using file-based import
- Use web service to create a contact

Note: If your sales application is integrated with Microsoft Outlook and IBM Notes, then you can also create contacts using these applications.

When you create a contact, existing contacts are checked for duplicate entries. If there is a match, you can select from the duplicate or continue creating the new contact. You can also search for relationships and edit them.

When you create or update a contact, the address field is not mandatory by default. Depending on the country that you choose, some fields are made mandatory. For example, if you select United States, then you must enter Address Line.

Managing Contacts

Use contact management capabilities to search for, create, update, delete, merge, and enrich contacts.

The following table lists the tabs on the Contacts Overview page and describes what they do.

<table>
<thead>
<tr>
<th>Contact Tabs</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>Provides a general overview of the contact, open opportunities, quotes, open leads, active contracts, assets and recommendations, and activities.</td>
</tr>
</tbody>
</table>
| Profile      | Gives a complete picture of the contact including all the customer relationships and associated with the contact. When a customer has multiple contacts, you can designate which contact is the primary contact from the customer’s profile page. This designation means that the selected contact is the primary means of communication to the customer. You can also include a picture of the contact in the Additional Details region. Here you can also:
  - Add account
  - Update and verify address
  - Mark as favorite contact |
| Team         | Enables you to view and add team members. For a B2C account, you can also see and add territories. |
Contact Tabs | Description
---|---
You can manually run territory assignment for the contact through the Run Assignment process. The assignment action is enabled for the type of contact enabled for assignment.

Assets | Shows a list of assets for the contact.

Contracts | If your administrator has enabled this view, then you can view contracts associated with the contact. Depending on your access, you can also preview the contact in a PDF format.

Opportunities | Enables you to add and view opportunities for the contact.

Leads | Enables you to add and view leads for the contact.

Relationships | Enables you to add account relationships to other account or contacts that are not directly related to the account but are influential. You can add the same contact to multiple accounts using different relationships.

Review the relationships in the following views:
- List view
- Diagrammer view

You cannot edit a role after you have added a relationship. To update the role, delete the existing relationship and create another relationship with the wanted role.

Notes | Enables you to add and view notes for the contact.

Assessments | Enables you to add and view assessments for the contact.

Activities | Enables you to add and view appointments, tasks, and call logs.

Related Topics
- Understanding File-Based Data Import and Export

How can I designate a contact as primary?

You designate a contact as primary from the customer account. On the customer’s Contacts page, you can click the check icon in the Primary column for the contact you want to be the primary contact. You cannot edit the primary contact designation from the contact’s Profile page. You must make changes in the customer’s Contacts page.

For example, you can have more than one contact point, such as phone number and e-mail address, for the same customer. In this example, a contact is related to customers Acme 1 and Acme 2. This contact has work phone 1 and mobile phone 1 for customer Acme 1, and work phone 2 and mobile phone 2 for customer Acme 2. You can designate work phone 1 as the primary contact point for customer Acme 1, and mobile 2 as the primary contact point for customer Acme 2.
How can I specify the customer relationships for my contacts?

You add relationships for a contact in the contact’s Relationships tab. If the contact is associated to a customer, you can also add relationships for the contact from the customer’s Contacts page by clicking the contact name and accessing the contact’s Relationships tab.

What's the difference between a primary contact, an overall primary contact point, and a relationship associated primary contact?

The primary contact point is the specific phone, e-mail or other means of communication with a customer that a contact prefers. If there is only one contact point entry, it is the primary contact point. Contact points can have multiple entries. On the Edit Contact: Profile page, you can designate a primary contact for each type of contact point.

An overall primary contact point is the first entry for each type of contact point for a contact. If no customer is associated with the contact, the primary contact point is the overall primary contact point.

If a customer is associated with the contact, the primary contact point becomes the relationship-associated primary contact point. A relationship-associated primary contact point is the first of multiple records for a contact’s customer relationship. You can change the primary on the Edit Customer: Contact page. Since the contact is related to a customer in this case, the relationship-associated primary contact is also the overall primary contact.

Using Personally Identifiable Information

The data or information that is used to uniquely identify a contact or locate a person is called personally identifiable information (PII). The information includes social security numbers, addresses, bank account numbers, phone numbers, and so on.

PII is considered confidential and sensitive and is protected to prevent unauthorized use of personal information. Sensitive PII information which, when disclosed, could result in harm to the individual whose privacy has been breached. Aspects of protecting PII include legal regulation, financial liability, and personal reputation. In the sales application, the PII data is secured and only authorized users can access sensitive information. For example, only authorized users are granted access to the social security numbers of people stored in the database. Administrators can find setup information about PII in the Implementing Sales guide.

Related Topics

- Managing Personally Identifiable Information

Using the LinkedIn Sales Navigator

The LinkedIn Sales Navigator is a social tool from LinkedIn that can boost your sales performance. Use the LinkedIn Sales Navigator from the Profile page of a contact to:

- Search accurate and timely information about a contact
- View real-time, sales-related updates from contacts using the activity stream
• View information related to how you’re connected to the contact directly or indirectly
• Connect or communicate with contacts, or get introduced to contacts, through common connections

Before you can use the LinkedIn Sales Navigator, your administrator must enable it and you must have the required license (Team and Enterprise) to use it. Use your LinkedIn credentials to view the LinkedIn profile details. The following table lists the tasks that you can perform using the LinkedIn Sales Navigator.

You access the contact’s information in the LinkedIn Sales Navigator region on the Edit Contact: Profile page for a contact.

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Profile</td>
<td>View the complete LinkedIn profile details of a contact.</td>
</tr>
<tr>
<td>Connect</td>
<td>Request to connect on LinkedIn by sending an invite.</td>
</tr>
<tr>
<td>Send Message or Send InMail</td>
<td>Send messages to first-level connections. Alternatively, use an InMail to connect with contacts at other levels.</td>
</tr>
<tr>
<td>Icebreakers</td>
<td>Explore common interests and conversation starters with the selected contact.</td>
</tr>
<tr>
<td>Get Introduced</td>
<td>Request an introduction through a mutual connection.</td>
</tr>
<tr>
<td>Match Profile</td>
<td>Associate an accurate profile when LinkedIn suggests multiple profiles that match with a contact. Once associated, you can see the matched LinkedIn profile in your contact records.</td>
</tr>
<tr>
<td>Not this person</td>
<td>Use this option if LinkedIn displays profiles that don’t belong to the selected contact.</td>
</tr>
</tbody>
</table>

> **Note:** You must add LinkedIn to your list of trusted sites, if you use Internet Explorer as your browser.

How can I add LinkedIn to my list of trusted sites in Internet Explorer?

Perform the following steps to add LinkedIn to your list of trusted sites:

1. Open Internet Explorer.
2. Press the Alt key to view the Tools menu.
3. In the menu, click Tools.
4. Click Internet Options.
5. Click the Security tab.
7. Click Sites.
8. Enter https://*.linkedin.com
9. Click Add to add the site.
10. Close Trusted Sites and Internet Options.
Managing Household Information

Households: Explained

A household is a group of contacts generally sharing a common link or association.
Households provide valuable segmentation information about the household as a whole, as well as summary of information about the household member contacts. Usually all the contacts reside at the same address and have a similar set of entities that accounts do, such as team members, territories, and contacts.

Creating Households

You can create households in the following ways:

• Create directly in sales applications
• Import households using file-based data import
• Create households using Web Services

Managing Households

Use household management capabilities to search for, create, update, and delete households.

Households Overview presents you with the following information:

<table>
<thead>
<tr>
<th>Household Tabs</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>Provides a general overview of the household, opportunities, active contracts, open leads, products, and activities.</td>
</tr>
<tr>
<td>Profile</td>
<td>Provides household-related details such as address and contacts. Here you can also:</td>
</tr>
<tr>
<td></td>
<td>• Assign head of the household</td>
</tr>
<tr>
<td></td>
<td>• Update and verify household address</td>
</tr>
<tr>
<td>Team</td>
<td>Shows team members and territories that are part of the household. Here you can also:</td>
</tr>
<tr>
<td></td>
<td>• Add team members</td>
</tr>
<tr>
<td></td>
<td>• Add partner territories</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You can manually run territory assignment for the household through the Run Assignment process. The assignment action is enabled for the type of household enabled for assignment.</td>
</tr>
<tr>
<td>Assets</td>
<td>Enables you to add and view assets for the household.</td>
</tr>
<tr>
<td>Opportunities</td>
<td>Enables you to add and view opportunities for the household.</td>
</tr>
<tr>
<td>Household Tabs</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Leads</td>
<td>Enables you to add and view leads for the household.</td>
</tr>
</tbody>
</table>
| Relationships  | Enables you to add relationships to other households or contacts that are not directly related to the household but are influential. Review the relationships in the following views:  
  - List view  
  - Diagrammer view |
| Notes          | Enables you to add and view notes for the household. |
| Assessments    | Enables you to add and view assessments for the household. |
| Activities     | Enables to add and view appointments, tasks, and call logs. |
| Contracts      | If your administrator has enabled this view, then you can view contracts associated with the household.  
  If you have the appropriate access, then you can also preview the contract in a PDF format. |

**Related Topics**

- Understanding File-Based Data Import and Export

What happens when I create an account or household that has the same name and address as the existing account or household?

The new account or household is suffixed by null and a random number to make the whole name unique. The suffix of an account or household’s unique name is generated from its primary address, which is based on the Party Suffix style. When the Party Suffix style formats are set to empty in the Manage Address Formats task, then null and a random value is suffixed.

**Household Relationships: Explained**

Relationships can be household contacts, such as parent, spouse, or child. Relationships can also be of other types, for example a bank that has a financial dealing with the contact and so on. The other relationships can be of type person, group, or organization.

The Relationships tab includes:

- Contacts: household members as the immediate beneficiaries.

  > **Note:** If you have selected a primary contact, then it is included as a household contact, by default.

- Other relationships: other relationships of type person, group, or organization.
Review relationships in the following views:

- **List view**: This view shows the available relationships in a tabular format.
- **Diagrammer view**: This view shows network visualization of the relationships. The visualization can show up to four levels of connections. By default, the connections are shown up to the second level.

  Your administrator must enable this view.

**List View**

The list view is the default view. It contains two tables; Household Contacts and Other Relationships.

The list view table displays household members who are your immediate beneficiaries. The other relationships table shows other relationships that may not be your direct beneficiary. By default, both the tables are sorted by name.

**Diagrammer View**

Diagrammer shows a graphical representation of the contacts and other relationships that the household has.

The visualization can display up to four levels of connections. By default, the connections are shown up to the second level. Each node in the graph represents an account or a household and each link between nodes represents a connection between them.

**Account, Contact, and Household Searches**

**Managing Contact Saved Search Lists: Explained**

This topic explains how to manage your contact saved search lists in the Contacts page.

You can't edit or delete the preconfigured saved lists or any user-defined lists added by your administrator. You can modify these saved searches to match your requirements, and then create a new saved search.

The Contacts page includes four predefined saved searches that let you filter the contacts you view in the page:

- **My Contacts**: Displays all contacts, of the type sales account, that you are an owner of.
- **My Favorite Contacts**: Displays all your favorite contacts.
- **My Team and Territory Contacts**: Displays all contacts, of the type sales account, where you are on the account team member or you are on the account territory resources.
- **My Business Contacts**: Displays all contacts belonging to all the accounts you own.

**Creating a Saved Search**

Use the following steps to create a saved search:

1. From the List menu, select Create or Edit Lists.
2. In the Saved Searches window, use the filters to modify your search, and click Search.
3. Click Save.
4. In the Create Saved Search window, enter a name for the saved search.
5. Click OK.
Using Search Mode on Account or Contact Creation Page

Salespeople can verify an address in the search mode while creating a new account. You can search and select from multiple similar addresses when verifying account or contact addresses using Data Cloud Address Verification Service. You can select the most appropriate address from a list of similar verified addresses.

To verify an address:

1. On the Contacts landing page, click **Create Contact**.
2. Enter the name, address lines, state and pin code.
3. Click **Verify Address**.

   A list of similar verified addresses appears.

For more information, see Verify Search Mode on Account or Contact Creation Page, in the Getting Started with Your Customer Data Management Implementation guide.

**Related Topics**

- Getting Started with Your Customer Data Management Implementation
Using Standard Fields to Search Records: Explained

You can search and associate records for account, contact, household, and asset with a list of values and use data that is relevant to their business. You can use standard fields to search and view them in the search results, which allows you to find and select the relevant record.

Viewing Only Primary Names for Address Geography Selection

Your administrator sets up primary names for geographies. When you enter the postal code on the Create Account page, the list of values for address selection displays only primary names for address geographies.

What account records do the different record sets permit you to search?

The different record sets provided in the Saved Searches window restrict your saved searches to different sets of accounts. For example, the default **My Accounts** saved search, searches the **Records I own** record set, listing all of the accounts you created or were assigned to as an owner.

The following table lists and describes the record sets for accounts. Not all record sets are available to all users. For example, the record sets involving subordinates are available only to managers.

 Tip: To improve saved search performance, restrict your saved searches to smaller record sets. For example, rather than searching all the records you can see, search all the records in your territory hierarchy. Or restrict your searches to a smaller geographical area. For example, search all the accounts in one state instead of the whole country.

<table>
<thead>
<tr>
<th>Record Set Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Records I own</td>
<td>Accounts you own. You are the account owner if you created the account or if ownership was assigned to you.</td>
</tr>
</tbody>
</table>
### Record Set Name | Description
---|---
I am on the team | Accounts where you are on the account team. You are on the account team if you are the account owner or were added as a member by another team member.
My territory | Accounts in your sales territories.
My subordinates own | Accounts owned by you and your subordinates.
My subordinates are on the team | Accounts where you or your subordinates are on the account team.
My territory hierarchy | Accounts in your sales territories and all of their subordinate territories in the sales territory hierarchy.
i am on the team or territory | Accounts where you are either on the account team or a member of the sales territory.
My subordinates are on the team or territory | Accounts where you or your subordinates are either on the account team or the sales territory.
All records I can see | Accounts that you can view based on your account team membership, sales territory assignments, your position in the organization, and security permissions.

### What contact records do the different records sets permit you to search?

The different record sets provided in the Saved Searches window restrict your saved searches to different sets of contacts. For example, the default **My Contacts** saved search, searches the **Records I own** record set, listing all of the contacts you created or were assigned to as an owner.

The following table lists and describes the record sets for contacts. Not all record sets are available to all users. For example, some record sets are available only if you sell to consumers. Record sets involving subordinates are available only to managers.

<table>
<thead>
<tr>
<th>Record Set Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Records I own</td>
<td>Contacts you own. You are the contact owner if you created the contact or if ownership was assigned to you.</td>
</tr>
<tr>
<td>Records where I am on the team</td>
<td>Contacts where you are on the contact team. You are on the contact team if you are the contact owner or were added as a member by another team member.</td>
</tr>
<tr>
<td>Records my subordinates own</td>
<td>Contacts owned by you and your subordinates.</td>
</tr>
<tr>
<td>Records where my subordinates are on the team</td>
<td>Contacts where you or your subordinates are on the contact team.</td>
</tr>
<tr>
<td>All records I can see</td>
<td>Contacts that you can view based on your contact team membership, sales territory assignments, your position in the organization, and security permissions.</td>
</tr>
</tbody>
</table>
## Maintaining Account, Contact, and Household Information

### Record Sets

<table>
<thead>
<tr>
<th>Record Set Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Records in accounts I own</td>
<td>Contacts in the accounts you own. You are the account owner if you created the account or ownership was assigned to you.</td>
</tr>
<tr>
<td>Records in accounts where I am on the account team or territory</td>
<td>Contacts in the accounts where you are on the account team or sales territory.</td>
</tr>
<tr>
<td>Records in my territory</td>
<td>Contacts in your sales territories.</td>
</tr>
<tr>
<td>Records in my territory hierarchy</td>
<td>Contacts in your sales territories and all of their subordinate territories in the sales territory hierarchy.</td>
</tr>
<tr>
<td>Records where I am on the team or territory</td>
<td>Contacts where you are either on the contact team or the sales territory.</td>
</tr>
<tr>
<td>Records where my subordinates are on the team or territory</td>
<td>Contacts where you or your subordinates are either on the contact team or the sales territory.</td>
</tr>
</tbody>
</table>

### What household records do the different record sets permit you to search?

The different record sets provided in the Records field of the Saved Searches window restrict your saved searches to different sets of households. For example, the default **My Households** saved search, searches the **I own** record set, listing all of the households you created or were assigned to as an owner.

The following table lists and describes the record sets for households. Not all record sets are available to all users. For example, the record sets involving subordinates are available only to managers.

**Tip:** To improve saved search performance, restrict your saved searches to smaller record sets. For example, rather than searching all the records you can see, search all the records in your territory hierarchy. Or restrict your searches to a smaller geographical area. For example, search all the households in one state instead of the whole country.

<table>
<thead>
<tr>
<th>Record Set Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>I own</td>
<td>Households you own. You are the household owner if you created the household or if ownership was assigned to you.</td>
</tr>
<tr>
<td>I am on the team</td>
<td>Households where you are on the household team. You are on the household team if you are the household owner or were added as a member by another team member.</td>
</tr>
<tr>
<td>My territory</td>
<td>Households in your sales territories.</td>
</tr>
<tr>
<td>My subordinates own</td>
<td>Households owned by you and your subordinates.</td>
</tr>
<tr>
<td>My subordinates are on the team</td>
<td>Households where you or your subordinates are on the household team.</td>
</tr>
<tr>
<td>Record Set Name</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>My territory hierarchy</td>
<td>Households in your sales territories and all of their subordinate territories in the sales territory hierarchy.</td>
</tr>
<tr>
<td>I am on the team or territory</td>
<td>Households where you are either on the household team or a member of the sales territory.</td>
</tr>
<tr>
<td>My subordinates are on the team or territory</td>
<td>Households where you or your subordinates are either on the household team or the sales territory.</td>
</tr>
<tr>
<td>All records I can see</td>
<td>Households that you can view based on your household team membership, sales territory assignments, your position in the organization, and security permissions.</td>
</tr>
</tbody>
</table>

### Merging Information

#### Resolving Duplicate Accounts and Contacts

You can resolve duplicate records as you create accounts and contacts, if the administrator has enabled the functionality. Resolving duplicate records ensures that clean customer data is available as you create, maintain, and use customer records.

Since multiple salespeople can create and update the same accounts and contacts, the potential exists for duplicate records in the application. You can view and act upon duplicate accounts and contacts as you create new records, if the ability is enabled by your administrator.

When you create an account or a contact, the application searches for duplicate accounts or contacts based on one of these conditions:

- The data quality rules established for accounts and contacts
- An exact name match

If the application finds duplicate accounts or contacts, then the application displays the records in the duplicate notification page. You can either ignore the duplicate accounts and contacts and continue creating the record, or you can select the correct account or contact from the list that’s displayed.

#### How can I make merge requests?

You can create a merge request when you have duplicate records pointing to the same customer, and you want to consolidate those records into one. An approved merge request results in one surviving record. The status of all other duplicate records changes to Merged. You can select to merge two or more customer records from the customer list on your Customer home page or in the customer search results.

Since the sales application Customer Data Hub processes all merge requests, you must implement Customer Data Hub and set the profile option Merge Request Enabled to **YES** to make this feature available.
Can I specify multiple accounts or contacts that I want to merge?

Yes. You can select and submit a request to merge multiple accounts or contacts into a single surviving record.

Use the landing page for accounts or contacts to submit a merge request.

Enriching Accounts and Contacts

Account and Contact Enrichment: Overview

A key requirement in the lifecycle of a customer record is keeping the data clean, accurate, relevant, and easily accessible. Oracle DaaS for Sales provides rich data and insights about common business entities, such as businesses, people, and products. This information comes from commercial data sources such as Dun & Bradstreet Corporation.

You can use Oracle Data Cloud Service to enrich account and contact data in sales applications, including:

- Individual accounts and contacts
- Lists of accounts and contacts
- New contacts for an account as you import them into the account

When a company-defined field is mapped to Data Cloud social attributes, then sales accounts are enriched with the social data. For more information on enriching sales data with social attributes, see the topics on adding social attributes in the Using Customer Data Management guide.

Enriching Single Accounts and Contacts

You can enrich a single account and the contacts associated with that account from within Sales. The Actions menu in the account or contact’s profile page provides access to the enrichment capabilities.

When you enrich a single account or contact, the application displays a list of attributes available for that record with side-by-side values for both Sales and the Data Cloud Service.

Predefined attributes available for accounts include the following:

- Company Name (not Sales Account Name)
- Current Fiscal Year Potential Revenue
- Primary Street Address
- Duns Number
- Line of Business
- Public Private Ownership Mark
- Stock Symbol
- Year Established
- Location Type
- Primary Address 1
• Primary Address 2
• Primary City
• Primary County
• Primary State
• Primary Postal Code
• Primary Postal Plus-4 Code
• Mailing Address 1
• Mailing Address 2
• Mailing City
• Mailing State
• Mailing Postal Code
• Mailing Postal Plus-4 Code
• Phone
• Fax
• URL
• Trade Style Name
• Major Industry
• North American Cartographic Information Society (NACIS) Classification
• SIC Classification

Predefined attributes available for contacts include the following:

• Prefix
• First Name
• Middle Name
• Last Name
• Job Title
• Gender
• Suffix
• Work Street Address 1
• Work City
• Work State
• Work Postal Code
• Work Postal Plus-4 Code
• Work Country
• Contact Work Phone
• Contact Phone Extension
• Email Address
• Department
While viewing the data, you can accept all attribute values from Oracle DaaS for Sales or only specific values. The application updates the account or contact information with the information selected.

**Enriching Multiple Accounts or Contacts**

You can enrich multiple accounts and the contacts associated with the accounts, from within Sales. You use the Actions menu on the Accounts and Contacts landing (list) pages to gain access to the enrichment capabilities.

Instead of showing you a comparison of attribute values between Sales and Oracle DaaS for Sales, as in the single account enrichment, when you select multiple accounts or contacts for enrichment, you see an indicator showing enrichment progress.

As you enrich multiple accounts or contacts, you can’t select which attributes to enrich like you can when you enrich a single account or contact. Administrators can use the Manage Social Data and Insight Cloud Service Attribute Mapping and Preferences task to determine which attributes to enrich.

After completion, review the enrichment summary report for details about:

- Records Selected
- Records Enriched
- Record with Multiple Matches
- Records with No Match
- Records Failed

> **Note:** When you enrich a large number of accounts or contacts, the enrichment process can place a heavy load on the environment. Therefore, limits may be set on the number of accounts or contacts you can enrich at one time.

**Adding Enriched Contacts to an Account**

You can add new contacts to a previously enriched account in the Sales application. You add these new contacts in the Contacts tab, by either clicking **Get Contacts** or selecting **Get Contacts** from the Actions menu.

When you start adding enriched contacts to an account, the application displays a list of contacts available for download from the Data Cloud. You can choose to see these contacts grouped by job level or by location, and you can choose to add the contacts by level, by location, or both.

**Enriching Data in Real Time: Overview**

You can enrich the customer data in real time using the Oracle Social Data and Insight Cloud service, also known as, Data as a Service (DaaS). Before you can enrich data, you must first purchase a third-party Data as a Service (DaaS) subscription and your administrator must create a new user with the Data Service Client API AppID role. This user is used by the application to securely communicate with the Oracle Social Data and Insight REST APIs.

Before you start enriching the data, you must:

- Set up Data Cloud integration.
- Set up real-time enrichment preferences and administrator profile options.

After setting up the enrichment and integration preferences, you can enrich an account or account contact (B2B contact) from the Accounts or Contacts pages.
Enriching Accounts and Contacts: Procedure
You can use Oracle Data Cloud and Insight service to enrich an account or contact profile with the latest information available from outside sources, such as Dun & Bradstreet Corporation.

**Enriching an Account**
Follow the steps below to enrich an account:

1. From your Accounts list, select the account you want to enrich.
2. On the Overview page for the selected account, select Enrich Account from the Action menu.
3. On the Select Fields to Enrich dialog box, select the data cloud values you want to add to the account, and click Enrich.

You see a confirmation message stating that the enrichment was successful, and you return to the account Overview page, which reflects the enriched information for the account. The available social media handles, in the account, are added or updated.

**Enriching a Contact**
Follow the steps below to enrich your contact:

1. From your Contacts list, select the contact you want to enrich.
2. On the Overview page for the selected contact, select Enrich Contact from the Action menu.
3. On the Select Fields to Enrich dialog box, select the data cloud values you want to add to the contact, and click Enrich.

You see a confirmation message stating that the enrichment was successful, and you return to the contact Overview page, which reflects the enriched information for the contact. The social media handles, in the contact, are added or updated.

**Enriching Account Lists and Contact Lists: Procedure**
You can use Oracle Data Cloud and Insight service (Oracle Data Cloud) to enrich your account list and contact list with the latest information available from outside sources, such as Dun & Bradstreet Corporation.

**Enriching Your Account List**
Follow the steps below to enrich your account list:

1. From your Accounts list, select the accounts you want to enrich.
2. From the Action menu, select Enrich Selected Accounts.
3. On the Select Fields to Enrich dialog box, select the data cloud values you want to add to the accounts, and click Enrich.

You see an Enrichment Results page listing the selected accounts and the enrichment status of each.

If the enrichment was successful, you return to your Accounts list page and the additional information now appears for the selected accounts. The available social media handles, in the accounts, are added or updated.

**Enriching Your Contact List**
Follow the steps below to enrich your contact list:

1. From your Contacts list, select the contacts you want to enrich.
2. From the Action menu, select Enrich Selected Contacts.

3. On the Select Fields to Enrich dialog box, select the data cloud values you want to add to the contacts, and click Enrich.

You see an Enrichment Results page listing the selected contacts and the enrichment status of each.

If the enrichment was successful, you return to your Contacts list page and the additional information now appears for the selected contacts. The available social media handles, in the contacts, are added or updated.

Enriching Account and Account Contact Data in Real Time:
Procedure

This topic illustrates how you can enrich account and account contact data in real time using Oracle Social Data and Insight Cloud Service. Oracle Social Data and Insight Cloud Service includes authenticated D&B records of companies and contacts. You can use the service to authenticate and enrich account and contact data in your application.

Enrich Account Data in Real Time

You enrich account data from the Accounts page.

To enrich account data:

1. Navigate to the Accounts page.
2. Select the Enrich from Data Cloud option from the Actions menu. In the Create Account flow, the option is named Enrich Account.
3. Select the account (or multiselect the accounts) you want to enrich.

If you select multiple accounts for enrichment, the application automatically enriches the accounts and displays the results. The result includes information about the accounts enriched and the status of each account.

If you select one account for enrichment, the Select Fields to Enrich page is displayed. In the page, you can select which data values you would like to use in the enriched account record for each of the fields.

4. Select existing value or the Data Cloud value for each of the fields.
5. Optionally, click Hide Identical Values to hide the fields where the Sales data is same as the Data Cloud data.
6. Click Enrich.

Enrich Account Contact Data in Real Time

You enrich account contact data from the Contacts page.

To enrich account contact data:

1. Navigate to the Contacts page.
2. Select Enrich from Data Cloud option from the Actions menu. In the Create Contact flow, the option is named Enrich Contact.
3. Select the contact (or multiselect the contacts) you want to enrich.

If you select multiple account contacts for enrichment, the application automatically enriches the contacts and displays the results. The result includes information about the contacts enriched and the status of each contact.

If you select one contact for enrichment, the Select Fields to Enrich page is displayed. In the page, you can select which data values you would like to use in the enriched contact record for each of the fields.
You can enrich only those contacts who are associated with enriched accounts.

4. Select existing value or the Data Cloud value for each of the fields.

5. Optionally, click **Hide Identical Fields** to hide the fields where the Sales data is same as the Data Cloud data.

6. Click **Enrich**.

Adding Accounts from Data Cloud

You can search for accounts in Data Cloud within a sales application, while creating a new account. Use the filter criteria to search and add accounts. If you select an existing Sales account to be added from Data Cloud, then those accounts are enriched.

Add the selected (one or more) accounts and their contacts as new accounts. You can create a maximum of five real-time accounts. You can use the advanced search for adding the account search filter criteria that are searchable in data cloud, for example:

- County
- Created By
- Creation Date
- Current Fiscal Year’s Potential Revenue
- D&B Credit Rating
- Data Confidence
- HQ Branch Indicator
- Global Ultimate D-U-N-S Number
- Domestic Ultimate D-U-N-S Number

For more information about data cloud enrichment, see the Using Customer Data Management guide.

To add accounts from Data Cloud

1. Sign in as a sales representative.

2. Click **Navigator > Sales > Accounts**.
   The Accounts page appears.

3. From the Actions menu, click Add Accounts from Data Cloud.
   The Get Accounts from Data Cloud: Select Accounts page appears.

4. Click the Show filter icon.
   The Advanced Search pane appears.

5. Click the Data Cloud Accounts tab.

6. Add filters or attributes that are searchable in data cloud, such as Revenue, Industry Category.
   The accounts are created and you receive a message stating the results.

7. Click View Results on the Account Creation: Results page.
   A list of newly added, enriched, or failed to create or enrich accounts displays.

8. Click Done.
   The View Results page is closed and the Get Accounts from Data Cloud page displays.
9. Add contacts from Data Cloud to the newly created accounts.
10. Click Add to add more filter criteria by adding attributes to view DaaS searchable attributes.

   The Data Cloud Accounts filter is available on the Advanced Search pane.
11. Verify that the Data Cloud usage is tracked for successfully created accounts.

Related Topics

- Enriching Data Using Social Data and Insight Cloud Service

Using Smart Data for Account and Address: Overview

You can use "smart data" when creating create accounts, add or edit an account, add or edit a contact address. Smart data is ready to use in the application without any additional setup. Smart data for accounts is available on the Create Account page. Smart data for address is available on create or edit pages for accounts and contacts. The highlights for smart data are:

- Minimize the use of clicks and keystrokes during account entry in the account creation flow in Engagement Cloud.
- Maximize the data quality by retrieving current, accurate data from Dun and Bradstreet.
- Leverage integration with Oracle Social Data and Insight Cloud Service (DaaS for Sales). The service automatically suggests matching accounts and automatically fills 90 plus account fields into the appropriate fields.
- Use autosuggestion when searching and selecting verified addresses using Oracle Address Verification Cloud Service.
- Add or edit addresses across Engagement Cloud for accounts and contacts.

To use smart data for accounts your organization requires DaaS for Sales for accounts, and Oracle Address Verification Cloud Service license for address.

Using Smart Data for Accounts

Smart data lets you to search and select validated Dun and Bradstreet accounts using autosuggestion functionality. Smart data provides you with enriched, validated data without data entry issues.

Validated global accounts improve the completeness, accuracy, and integrity of data. For validated accounts, the account data gets automatically populated into the fields, allowing you to quickly create an account without typing in account details. Thus improving your efficiency and user experience when creating accounts. Additional benefits of smart data are:

- Search in real time to predict and fill more than 90 company fields with accurate and validated data.
- Specify country or address details using autosuggestion.
- Save time searching and filling in data.
- Avoid errors when filling in data.
When you create an account, enter the name of the account. Automatically, possible accounts appear. You simply select the appropriate account and the application automatically fills in the details for you.

Using Smart Data for Addresses

Smart data for addresses provides you with addresses and automatically enters complete data for you.

The benefits of smart data for account and contact addresses are:

- You type in a partial address and the application automatically suggests addresses for you.
- When you type more characters, the application automatically narrows the results.
- Select the address to automatically populate validated data.

Select appropriate options and all the details are populated with the relevant data.

Related Topics

- DaaS for Address Verification
- DaaS for Sales

Managing Business Plans
Account Business Plans: Overview

Sales representatives and sales managers perform account planning to achieve specific goals. Goals for business plans are represented through objectives.

Access to the business plans is determined by the team membership and resource reporting hierarchy. This means that managers have access to business plans of the sales representatives in their team. In an account business plan, salespeople collaborate to discuss the sales of a specific account and analyze the need of a plan. An account business plans focuses on a specific account, to increase the sales or revenue of that account. With a business plan you can:

- Analyze the strengths, weaknesses, opportunities, and threats of the business plan in the context of the account.
- Add business plan classes to define plans for partner, account, opportunities, and contacts.
- Collaborate with team members to discuss prospective plans.
- Enable or disable any of the embedded classes for account and partner business plans.

Make sure that your administrator has enabled the account business plan using Application Composer.

Adding Business Plans

You can add objectives to a business plan. The type of a business plan helps you to differentiate between business plans.

The following steps represent a flow for creating a partner business plan:

1. Sign in to the sales application as a sales manager.
2. Click the Business Plan icon on the home page.
   A list of business plans appears.
3. Click Create Business Plan.
4. Enter the name of the plan.
5. Select a partner with whom you want to collaborate from the Partner drop-down list.
6. Define the period for the objectives that you want to achieve, in the Period field.
   By default, the current year is displayed. You can change the period to year, quarter, or period.
7. Select a type from the options Regional and Global.
   The current user is the owner, by default.
8. Select a status for the plan. Initially, the status is Draft.
9. Click Save and Continue.
   You automatically navigate to the Edit Business Plan page.
10. Modify your business plans if required, and click Save and Continue.
11. Click the SWOT Analysis subtab to analyze the strength and weakness of your business plan.
12. Click the Activities subtab to add tasks to your plans.
13. Click Save and Close.

Adding Objectives to Business Plans

Objectives are the key aspect of a business plan. Salespeople use business plans to achieve objectives to meet the target goals.
To create objectives for a business plan:

1. Click **Create Objective** on the Edit Business Plan page. The Create Objective page appears.
2. Enter a name for the business plan.
3. Select a type from the Type drop-down list.

   **Note:** You can add a type to the list of options. The type of a business plan determines the unit of measure and the field is automatically populated on selection of a type.

4. Define the period in which you want to achieve your goals for the business plan.
5. Enter your target to achieve your objective in the defined period.
6. Click **Save and Close**. The objective is displayed on the Edit Business Plan page.
7. If you click **Save and Continue**, then the Edit Objective page appears. You can view the newly created objective and you can add notes, activities, and attachments to the objective.

### Splitting Objectives

You can split an objective to specify how to achieve the objective between partner and account. To split an objective:

1. Click **Split Objective** on the Edit Objective page. The Split Objective page appears.
2. Specify how you want to split your objective.
3. Click **Save and Close**. The split objective appears on the Edit Objective page.
4. Enter your plan to achieve your set target, in the specified period.
5. Select **Attainment** in the Show field. The Attainment column appears.
6. Enter the details for the targets you achieved.
7. Click **Save and Close**.

### Using the Business Plans Overview Tab: Explained

You view the list of business plan objectives on the Edit Business Plan: Summary page, or on a separate subtab named Objectives. If an objective is listed in the Objectives subtab, you can search for objectives by name. For every objective you must specify the following fields:

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Split</td>
<td>Enables you to define dimensions for objectives.</td>
</tr>
<tr>
<td>Name</td>
<td>Displays the name of the account.</td>
</tr>
<tr>
<td>Type</td>
<td>Specifies the account type. The options are amount and quantity.</td>
</tr>
</tbody>
</table>
### Maintaining Account, Contact, and Household Information

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unit of Measure</td>
<td>By default, the measure is determined by the type of account that you select.</td>
</tr>
<tr>
<td>Period</td>
<td>Defines the period to achieve the objective.</td>
</tr>
<tr>
<td>Target</td>
<td>Specify the amount or quantity to achieve the objective.</td>
</tr>
</tbody>
</table>

#### Using Business Plans for Oracle Social Network

You can use Oracle Social Network to view information from other shared business plans and contribute to social conversations. You can focus your attention on a specific account for sale and revenue for the account. To share your business plans, you must publish a business plan using the Social subtab on the Edit Business Plan page. You can drill-down to the View Details link and edit a business plan.

**Note:** Only internal users such as salespeople, channel account managers, channel sales managers, have access to Oracle Social Network.

#### Managing Assets

### Sales Assets: Overview

Assets are high-net-worth products owned by an organization. After the functionality is enabled by the administrator, you can create and manage assets.

You use assets in the following ways:

- Click **Sales > Assets** on the springboard to use a full set of create, edit, and manage assets capabilities
- Manage assets within the context of accounts
- Associate assets with activities, such as tasks and appointments
- Create an organization-level view of calendars associated with assets
- Associate assets with opportunities and leads
What assets records can I search using saved searches?

The Assets landing page provides two saved searches that allow you to view different records.
The following table lists and describes the supplied saved search for assets.

<table>
<thead>
<tr>
<th>Record Set Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>My Customers’ Active Assets</td>
<td>All active assets associated with your customers</td>
</tr>
<tr>
<td>All My Customers’ Assets</td>
<td>All assets, purchased in the last six months, associated with your customers (although the time frame can be modified by the administrator)</td>
</tr>
</tbody>
</table>

How can I view assets?

You can view asset information for your accounts.

You can view assets for your accounts in the following ways:

1. Sign in to a sales application as a sales manager.
2. Click **Sales > Assets** on the home page.
3. On the Assets landing page, view the summary details.
4. Click an asset record to view and edit the asset details.

If enabled by the administrator, you can also view asset information in activities, such as appointments, tasks, and call reports.

How can I create assets?

You can create asset information for your accounts.

To create assets:

1. Sign in to a sales application as a sales manager.
2. Click **Sales > Assets** on the home page.
3. In the Assets landing page, click **Create Asset**.
4. Enter the details, such as the account, product, status, quantity, and purchase price.
5. Click **Save and Close**.
1. Sign in to a sales application as a sales manager.
2. Click **Sales > Accounts** on the home page.
3. In the Accounts landing page, edit an account.
4. In the edit page, click the **Assets** tab.
5. Click **Create Asset** and enter the details.
6. Click **Save and Close**.

How can I edit assets?

You can edit asset information for your accounts.

To edit the assets related to your accounts:

1. Sign in to a sales application as a sales manager.
2. Click **Sales > Assets** on the home page.
3. In the Assets landing page, select an asset to edit.
4. In the Edit Asset page, you can edit the asset information, such as owner, as well as details like status, quantity, and purchase price.
5. Save your changes.

1. Sign in to a sales application as a sales manager.
2. Click **Sales > Accounts** on the home page.
3. In the Accounts landing page, edit an account.
4. In the edit page, click the **Assets** tab.
5. Select an asset to edit and edit the details.
6. Save your changes.

How can I delete assets?

You can delete asset information for your accounts from the Accounts landing page or the Assets landing page.

To delete assets from the Assets landing page:

1. Navigate to **Sales > Assets** on the springboard.
2. In the Assets landing page, select an asset.
3. In the Edit Asset page, select **Delete Asset** from the Actions menu.
4. Respond to the confirmation message.

To delete assets from the Accounts landing page:

1. Navigate to **Sales > Accounts** on the springboard.
2. In the Accounts landing page, edit an account.
3. In the Edit page, click the **Assets** tab.
4. Select an asset to delete.
5. In the Edit Asset page, select **Delete Asset** from the Actions menu.
6. Respond to the confirmation message.

Applying Mass Update to Assets

The mass update feature lets you select multiple asset records and update all of them to the same value for a field or a set of fields. Before you can use the mass update feature, your administrator must enable it.
The default attributes that are available for mass update on the UI are:

- Asset Owner
- Status
- Quantity
- Purchase Date

To apply mass updates to assets:

1. Navigate to the **Sales > Assets**.
   
   The Assets landing page appears.
2. Enter the search criteria for the assets that you want to update and click **Search**.
   
   The application returns a list of results based on your search criteria.
3. Select the assets that you want to update at the same time.
4. Click **Update** from the **Actions** menu.
   
   To select or deselect assets click a record in the list. Use the select all and deselect all links to select or deselect all assets.

   **Note:** By default, all the asset attribute fields on the Mass Update dialog box are read-only until you select to update them.

5. Select the records that you want to update such as competitor asset, asset tag, and click **Update**. Assign a value for each of the selected attributes.
   
   The number of records you can update at once is configurable by the administrator.
6. Click **Save and Close**.
7. Click **Submit**.

### Exporting Assets: Explained

You can export a list of assets from the application. When you export assets, the application generates a spreadsheet file that you can save locally.

To export assets, from the Assets landing page, click **Export List** in the Actions menu.

### Mass Updating Accounts and Contacts

#### Understanding Mass Update of Accounts and Contacts

The mass update feature enables salespeople to select records in bulk and update the values for fields of selected records at once. You can update fields for multiple accounts, contacts, or assets at once. For example, you can update the status or add comments for multiple accounts, contacts, or assets at the same time. You can update several fields on multiple accounts, or contacts using the **Update** action. Before you can use the mass update feature, your administrator must enable it.
The following account fields are available for update.

- Name
- Account
- Owner
- Job Title
- Phone
- Email

The list of fields that you can update for contacts are:

- First Name
- Last Name
- Middle Name
- Job Title
- Academic Title
- Annual Income
- Cleanliness
- Comments
- Created By
- Creation By Application
- Creation Date
- Last Updated By
- Last Updated Date
- Prefix(Salutation)
- Affinity
- Buying Role
- Certification Level
- Certification Reason
- Email
- Owner
- Account

### Applying Mass Update to Accounts and Contacts

You can update an attribute including company-defined attributes, on multiple accounts, and contacts at once using the mass update feature. For example, you might want to change a predefined field, such as Expiration Date, on multiple records. You can also use the mass update feature to update product information or primary contact information for accounts and contacts.

Before you can use the mass Update feature, your administrator must enable the update action using Application Composer. You can update several fields on multiple accounts, or contacts using the **Update** action. Predefined fields are also available for update.
Updating Accounts and Contacts in Bulk

Perform the following procedure to apply mass updates for accounts and contacts. For the purpose of example, account is used in the procedure.

To apply mass update to accounts and contacts:

1. Navigate to the Accounts landing page from Sales > Accounts.
2. Enter the search criteria for the accounts that you want to update, and click Search.
   
   The application returns a list of results based on your search criteria.
3. Select the accounts that you want to update at the same time.
4. Click Update from the Actions menu.

   To select or deselect accounts click a record in the list. Use the select all and deselect all links to select or deselect all accounts.

   ✅ Note: By default, all the account attribute fields on the Mass Update dialog box are read-only until you select to update them.
5. Select the attributes that you want to update and assign a value for each of the selected attributes.

   For account attribute lists, their default value is displayed. Text fields are blank by default.
6. Click Save and Close.

Deleting Accounts and Contacts

What happens when I delete an account?

When you delete an account, the entire record is removed from the sales application and cannot be restored.

In general, when you delete an account:

- The account party status becomes inactive in the database.
- The deleted account does not appear in the accounts list, account search, account list of values, account data quality match, segmentation, and recent items.
- The deleted account’s profile and children, such as attachments and notes, can no longer be viewed.
- The account’s contact relationships, if any, are deleted. The contact can still be viewed, but deleted contact relationships are not shown in the contact.
- Deleting an account does not delete account-related objects, such as opportunities, leads and tasks. You can still view related objects and the account name on these objects, but you can no longer access the deleted account’s details.
What happens when I delete a contact?

When you delete a contact the entire record is removed and cannot be restored.

In general, when you delete a contact:

- The entire person record of the contact is removed, including all profile data, customer usages, group memberships.
- Relationships with associated customers or sales accounts are deleted.
- Contact points or other child objects specific to the customer-contact relationship are not shown.
- A deleted contact is not shown or available in any other contact or customer lists. A deleted contact is not visible to all contact types (standalone, single, or multiple) including a customer-contact, a consumer or prospect, or in cases where the contact is both a customer contact and a consumer or prospect.
- Even if you have the functional privilege to delete a contact, you cannot delete contacts unless you have full or edit access to at least one of the accounts associated with the contact.

How can I view contracts?

You can view contracts associated to your account only if the privilege of viewing contracts is assigned to your role. You can download individual contracts in PDF format, if you have the required security. Click Preview Contract, to view the contract in a PDF document format.
Sales Campaigns: Overview

This topic provides an overview of sales campaigns. Sales representatives and sales managers can create sales campaigns for reaching out to contacts within their territories. Using sales campaigns, they invite contacts to an event or inform them about a product launch. Features of a sales campaign include:

- The ability to target contacts from multiple sources including the contact repository and previous campaigns.
- An easy-to-use guided process
- Access to email templates
- A response gathering and monitoring capability
- The option to personalize email for individual contacts
- The ability to schedule a campaign to launch on a specific date
- Automated follow-up for specific response types

Sales campaigns make it easy for salespeople to keep their contacts informed, announce product launches, and invite them to events. You can configure HTML email templates that salespeople can use to send modified emails using your sales application built-in email server. The application monitors responses and can create follow-up tasks or send emails to the sales campaign owners.

To create sales campaigns, start from the Campaigns work area, which you can access from the Navigator by selecting Sales Campaigns under the Sales section.

Creating a Sales Campaign

Video

Watch: This tutorial shows you how you can use sales application to easily create sales campaigns that send marketing e-mail correspondence to individual contacts of your customers. The content of this video is also covered in text topics.

Procedure

This topic describes how to create a sales campaign in your sales application.

Note: You should sign in as a sales representative (or higher classification) in order to create a sales campaign.

Creating a Sales Campaign

To create a Sales Campaign:

1. Sign in as the sales administrator and navigate to Sales > Sales Campaigns.
The Sales Campaign page appears. At the top of the page are competed campaigns, if available.

2. Click **Create Campaign**.
   The Create Sales Campaign: Select Contacts page appears.

3. Click **Add Contacts**.
   The Add: Contacts page appears.

4. Enter your search criteria and click **Search**.

5. In the search results list, click the check box next to each contact you want to add to the campaign.

6. Click **OK** to save the changes and return to the Create Sales Campaign: Select Contacts page.

7. Click the right-arrow icon to advance the page to the next step in the process, the design email step.
   The Create Sales Campaign: Design E-Mail page appears.

8. From the Actions list choose **Change Template** to use a different template.

9. Click **Insert Elements** to add response forms and show the Merge Fields list.

10. Select the **Personalized Message** standard field and click **Insert**. then **Done**.
    Before you create a personal message, you must insert the merge field into the body of the email where the personal message will appear. If the merge field for personalized message is not inserted into the template, the text doesn’t display anywhere in the email.

11. From the Action list select **Personalize Message**.

12. Click the pencil icon next to the contact who is to receive the personalized message

13. Enter the contents of your personalized message.

14. Enter your message and click **Ok**. Then click **Done**.

15. Click the right-arrow icon to move to the wrap-up stage.
   The Create Sales Campaign: Wrap Up page appears.

16. Enter the name of the sales campaign and a short description.

17. Select Immediate as the launch date for your sales campaign and click **Submit**.
    From your completed campaigns list, you can view the recently sent message, see how many contacts you targeted and check to see if you have received any responses to your campaign.

---

**Working with Sales Campaigns**

**Adding Contacts to Sales Campaigns**

You can select a specific set of contacts to include in a sales campaign, or you can decide to include all contacts from a previously created sales campaign.

> **Note:** The number of contacts to include in your sales campaign should not exceed 500.

From the **Contacts** subtab, you can search for contacts by **Record Set**, **Name** or **Account**. You can add additional search criteria fields by clicking the **Add** button. This action lets you further segment and target specific contacts to include search criteria such as City, Country, Creation Date, Buying Role, and so on to further refine your search.

By selecting the **Previous Campaigns** subtab, you can select the campaign you want from the **Campaign Name** list. You can then select and apply the contacts to your campaign.

Select contacts for your sales campaign from the **Contacts** subtab as follows:

1. Sign in as a sales representative or a sales manager.
2. Navigate to **Sales - Sales Campaigns** to go to the Sales Campaigns work area.
3. Click **Create Campaign**.
4. Click **Add Contacts** to go to the **Add: Contacts** screen.
5. Click **Contacts** subtab and enter search criteria for contacts by **Record Set, Name** or **Account**, and click **Search**.
6. Click **Add** if you need to further refine your search for specific contacts.

Note: Click **Create Contact** if you want to create a new contact to add to your sales campaign.

7. Select the contacts you want from the search list and click **Apply** and then **OK**.

### Inserting Response Forms to Sales Campaigns

You can add forms to campaign content so that recipients can respond to your campaign. Sales campaigns have the capability to track responses and convert them to leads. You can add customer response forms to an e-mail template when creating a sales campaign.

For example, during the **Design E-Mail** step of the sales campaign process, you decide to insert one of the following response forms to your campaign:

- Forward To Friend
- Request Call Back
- Requested More Information

Insert a response form to your sales campaign as follows:

1. Sign in as a sales representative or a sales manager.
2. Navigate to **Sales - Sales Campaigns** to go to the Sales Campaigns work area.
3. Click **Create Campaign**.
4. Click **Add Contacts** to add the contacts you want to target for your sales campaign.
5. Go to the **Design E-Mail** step and select the template you want to use.
6. Place your cursor in the area of the template where you want to insert a response form link.
7. Click **Insert Elements** and from the **Show** field, select **Response Forms**.
8. Select the response form you want and click **Insert**. Repeat this step if you want to include another response form, and click **Done** when finished.

### Adding Follow-up Tasks to Sales Campaigns

You can associate follow-up tasks with customer response forms on an email template when creating a sales campaign. For example, during the final **Wrap Up** step of the sales campaign process, you decide to associate one of the following tasks to the customer response forms you inserted from the Design E-Mail step:

- Create call back task
- Receive e-mail notification

Add a follow-up task for your customer response form as follows:

1. Sign in as a sales representative or a sales manager.
2. Click **Sales - Sales Campaigns** to go to the Sales Campaigns work area.
3. Click **Create Campaign**.
4. Click **Add Contacts** to add the contacts you want to target for your campaign.
5. Go to the **Design E-Mail** step and select a template to use.
6. Select the response form you want, and click **Insert**. Repeat this step if you want to include another response form, and click **Done** when finished.
7. From the **Wrap Up** step, go to the **My Follow-Up Actions, Customer Responses** area.
8. From the **Actions** list, select the follow-up action you want to associate with each of the customer response forms you previously inserted in your email template.

**Sales Campaign Content: Explained**

You can personalize your sales campaign by adding components such as images, merge fields and response forms.

To create the content of your sales campaign, you can add any combination of the following:

- Images
- Merge fields
- Response forms
- Standard and other URLs
- Conditional content

**Images**

Add graphic images to your email. You can provide a link to an image already on a server, or select a local file and upload it to the server. Specify the size and placement of the image. You can add a URL of a publicly hosted image using the `img src` tag.

**Merge Fields**

Personalize your email message body by adding placeholders from a list of merge fields, such as the recipient’s first name. Merge fields are standard sets of attributes pertaining to an individual contact. You can insert them into your email content. When you launch the campaign, merge fields are dynamically populated directly from the database. With sales campaigns you can also compose a personalized text message for each recipient.

**Response Forms**

Insert response forms as active links in your email campaign content. When a contact clicks one of the links, a specific response is automatically generated. All such responses are gathered and monitored, to track contacts’ actions. Available response forms for sales campaigns are:

- Forward to Friend
- Request Call Back
- Request More Information

**Standard URLs**

You can add any of the following types of URL:

- Standard URLs are predefined and commonly used across the enterprise.
- A URL can be created when you define your email content.

By default, all standard URLs are tracked automatically. You can optionally enable tracking for other URLs, or disable tracking for standard URLs. With tracking enabled, every time a contact clicks a link in a campaign email, the click is recorded as a specific response, together with details pertaining to the URL.
Conditional Content

Conditional content is inserted or omitted based on the results of a rule. There are two elements that you can use to generate conditional content within an email:

- If-Then-Else cases are used to determine if a block of text or HTML is removed from an outgoing email, by verifying if a merge field value is defined. The merge field is defined if it is not an empty string or, for numeric merge fields, if it is not a value of 0 (zero). If the merge field is defined, the block of text or HTML remains in the outgoing email. If the merge field is not defined, the block of text or HTML is removed from the outgoing email.

- Named Blocks are used to decide whether or not to insert a block of text or HTML into an outgoing email, by comparing one string to another. If the two strings are identical, the block is inserted.

Using Conditional Content in Sales Campaign Templates: Explained

Conditional content provides the ability to present relevant information to individual email recipients without having to create multiple messages. There are two ways to generate conditional content within a sales campaign template:

- Block statement personalization
- If-Then-Else personalization

Conditional content and merge fields are available in both HTML and Text format emails.

Block Statement Personalization

Blocks determine whether to insert a block of text or HTML into an outgoing email by comparing one string to another:

- If the two strings are identical, the block is inserted.
- If the two strings are not identical, the block is not inserted.

> Note: The string comparison is case sensitive.

The following table lists components of the block personalization element.

<table>
<thead>
<tr>
<th>Personalization Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$(DefineBlock &quot;MatchString&quot;)</td>
<td>Starts a block of text or HTML that is inserted in place of an Insert Block component when MatchString is identical to the MatchString of the Insert Block component.</td>
</tr>
<tr>
<td>$(EndBlock)</td>
<td>Ends a block of text or HTML that was started with the Define Block component.</td>
</tr>
<tr>
<td>$(InsertBlock &quot;MatchString&quot;)</td>
<td>A block of text or HTML is inserted at the location of this component when MatchString is identical to the MatchString of a Define Block component.</td>
</tr>
</tbody>
</table>

The following is an example of a block personalization element:

```
You live in $(InsertBlock "${Account Country}").
$(DefineBlock "USA") <B>the United States.</B>
$(EndPoint)
$(DefineBlock "India") <B>India</B>
$(EndPoint)
```
In this example, if USA is entered in the Country field of the Account record, the following sentence appears:

You live in the United States.

If a given recipient has no associated value for a block variable listed in the `InsertBlock MatchString` component, then nothing is inserted into the message for that block.

**Inserting a Block Statement**

To insert a block statement, do the following:

1. Display the email template in the HTML editor.
2. Place the cursor in the location where you want to insert the block.
3. Create the Insert Block statement as follows:
   - In the editor toolbar, select **Insert Block** from the rule conditions drop-down list.
   - In the next drop-down list, select the record the field comes from: Contact, Account, or Campaign.
   - In the next drop-down list, select the field in the record.
   - Click **Insert**.
4. Create a Define Block component as follows:
   - In the drop-down list immediately within the email tag, select **Create Block**.
   - A `$(DefineBlock "")` and `$(EndBlock)` statement appear in the text.
   - Type a field value within the quotation marks of the `$(DefineBlock "")` statement. This is the value that drives the content displayed in the block.
   - Type the text that you want to insert into the email between the `$(DefineBlock "")` and `$(EndBlock)` tags.
5. Repeat Step 4 until you have added all the **Define Block** components that you need.

**If-Then-Else Personalization**

If-Then-Else personalization provides the ability to insert or remove text within your email content, based on whether a Merge field value is defined. The merge field is defined if it contains a value or, for numeric merge fields, if the value is not 0 (zero).

- If the merge field is defined, the text remains in the outgoing email.
- If the merge field is not defined, the text is removed from the outgoing email.

The following table lists components of the If-Then-Else personalization element.

<table>
<thead>
<tr>
<th>Personalization Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>$(if {Record.FieldName})</code></td>
<td>The If component is used to start an If-Then-Else personalization element. It determines whether the merge field named [FieldName] has a value. If there is a value for [FieldName], the text between this If-Then-Else component and the next If-Then-Else component is not removed from the email.</td>
</tr>
<tr>
<td><code>$(elseif {Record.FieldName})</code></td>
<td>Ends a block of text or HTML that was started with the Define Block component.</td>
</tr>
<tr>
<td><code>$(else)</code></td>
<td>The Else component is used after a $(if) or $(elseif) component. If the preceding $(if) or $(elseif) component removes the preceding block of text or HTML from the email, the $(else) component’s block of text or HTML is included in the email. If the preceding $(if) or $(elseif) component does not remove it’s block of text or HTML, the $(else) component’s block of text or HTML is not included in the email.</td>
</tr>
</tbody>
</table>
The following is an example of an If-Then-Else personalization element:

$(if ${Contact.First Name})
Dear ${Contact.First Name}${Contact.Last Name},
$(else)
Dear Mr. or Ms. ${Contact.Last Name},
$(endif)

- If the Contact.First Name field is defined, the email begins with “Dear First Name Last Name”.
- If the Contact.First Name field is not defined, the email begins with “Dear Mr. or Ms. Last Name”.

You can use If-Then-Else statements similarly to block statements, by including operators such as Equal to, Starts with, or Contains. You can select these operators from a drop-down list when you generate If or If-Else statements. Unlike blocks, this permits you to insert conditional content where the variable is true or not true.

For example, to modify the email with a condition for accounts in the state of California, you use the following statement:

$(if ${Account.Bill to State} == "CA") Join us all month long for special events and workshops held in each of our California locations.
$(else) Join us all month long for weekly online workshops and special offers at www.mycompany.com/events.
$(endif)

You can also nest If-Then-Else statements, placing one within another.

**Note:** The components of personalization elements must be placed in the correct locations in the text. Any incorrect placement causes an error.

### Inserting an If-Then-Else Personalization Statement

To insert an If-Then-Else statement, do the following:

1. Display the email template in the HTML editor.
2. Place the cursor in the location where you want the If-Then-Else statement.
3. Create the If or ElseIf statement as follows:
   - In the editor Toolbar, from the drop-down list, select either If or ElseIf.
   - In the next drop-down list, select the record the field comes from: Contact, Account, or Campaign.
   - In the next drop-down list, select the field in the record.
   - In the next drop-down list, select the operator.
   - In the next text box, enter the value that the field is compared with.
   - Click Insert.
4. Following the If or ElseIf statement, enter the text that appears if the condition in the statement is satisfied.
5. At the end of the entire If-Then-Else statement, enter $(endif).

### Related Topics
- How Standard URLs and Marketing Content Fit Together
Adding Personalized Text in a Sales Campaign: Example

You are creating a sales campaign inviting contacts to an event that your company will host next month. You already have a template that provides most of the information.

In addition to standard merge fields that will automatically populate contact data, you want to add a more personal touch, for a selected few contacts, to the otherwise generic email content.

Adding Personalized Text

1. Create a campaign, enter the details, select all the contacts for the campaign (not just the ones to whom you will send a personalized message) and, optionally, choose a template.
2. When you edit the email content, add the personalized text merge field where you want the personalized text to appear.
3. When you enter advanced options, locate the contact for whom you want to create a personal text in the list of contacts. Click the edit icon in the Personalize column to open a new HTML editor window where you can enter a message for the selected contact. You can apply styles just as in the common area of the email. You can preview and edit the personal message until you have what you want. You can repeat this step to create individual personal messages for as many contacts as you choose.

Follow-Up Actions: How They Work

When you create a sales campaign, you may want to be notified automatically when a targeted contact responds in a specific way. You can associate follow-up actions with specific responses, so that the follow-up action is triggered automatically when a contact responds to your campaign email.

Response Form

You can include response forms in the content of your campaign. These appear to recipients as hyperlinks that they can click within the email. Every click is recorded, and used to track usage statistics. In addition, each response can also trigger an associated action to be performed automatically.

Follow-up Action

Follow-up actions are predefined actions that can be triggered by contacts’ responses. The purpose of these actions is to inform you, the creator of the campaign, when a particular contact clicks a specific response. You can choose to receive this information in an email notification that will appear in your email, or by the creation of a task that will appear in your worklist. In either case, the information you receive includes campaign details, contact details, the specific response that the contact clicked, and the date and time of that click.

FAQs for Managing Sales Campaigns
What is the recommended limit of contacts to include in a sales campaign?

The number of contacts to include in your sales campaign should not exceed 500. Oracle recommends to create a new sales campaigns if you want to add more contacts beyond the recommended specification.

What campaign records do the different record sets permit you to search?

The different record sets provided in the Saved Searches window restrict your saved searches to different sets of sales campaigns.

The following table lists and describes the record sets for sales campaigns. Not all record sets are available to all users. For example, the record set involving subordinates is available only to managers.

---

**Tip:** To improve saved search performance, restrict your saved searches to smaller record sets. For example, rather than searching all the records you can see, search all the records you and your subordinates own. Or restrict your searches to a smaller geographical area. For example, search all the sales campaigns in one state instead of the whole country.

<table>
<thead>
<tr>
<th>Record Set Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>I own</td>
<td>Sales campaigns that you created.</td>
</tr>
<tr>
<td>My subordinates own</td>
<td>Sales campaigns owned by your subordinates.</td>
</tr>
<tr>
<td>All records I can see</td>
<td>Sales campaigns that you can view based on your sales team membership, your position in the organization, and security permissions.</td>
</tr>
</tbody>
</table>

---

What campaign records do the different record sets permit you to search?

The different record sets provided in the Saved Searches window restrict your saved searches to different sets of sales campaigns.

The following table lists and describes the record sets for sales campaigns. Not all record sets are available to all users. For example, the record set involving subordinates is available only to managers.

---

**Tip:** To improve saved search performance, restrict your saved searches to smaller record sets. For example, rather than searching all the records you can see, search all the records you and your subordinates own. Or restrict your searches to a smaller geographical area. For example, search all the sales campaigns in one state instead of the whole country.
### Record Set Name | Description
--- | ---
I own | Sales campaigns that you created.
My subordinates own | Sales campaigns owned by your subordinates.
All records I can see | Sales campaigns that you can view based on your sales team membership, your position in the organization, and security permissions.

### How can I add optional text to the Forward to Friend response form?

Using the Design E-Mail step of the Sales Campaigns process, insert the **Forward to Friend** link from the **Insert Elements > Response Forms** list. Next, show the **Merge Fields** list, and insert the **Forwarder Message** standard merge field in the message content: ${Standard.ForwarderMessage}. The standard merge field is replaced with any optional text you might enter when you forward the e-mail campaign to your friend using the **Forward to Friend** link.

### What sales campaigns display when I select the My Draft Campaigns and the My Completed Campaigns lists?

When you select the **My Draft Campaigns** list in the Sales Campaigns work area, the application displays a list of all of the campaigns you own that are pending activation. Selecting the **My Completed Campaigns** list displays all sales campaigns you own that have been completed within the last three months.

### Understanding Marketing Content

#### Treatments: Explained

You use treatments to represent the combination of a marketing message for targeted audience members and delivery options for third-party suppliers. This topic provides a brief overview of the treatment components. A treatment defines the channel-specific marketing message for targeted audience members. For example, depending on the channel you select, the treatment can include options that control how marketing messages are sent to third-party suppliers. You can change the content and attach marketing collateral to personalize a treatment for a specific segment.

Treatments can have the following components:

- Products and promotions
- Distribution options
- Associated lists
- Confirmation e-mails
- Content and attachments
Products and Promotions
When you create treatment content, you can do the following:

- Associate products and product groups with treatments.
- Use the available collateral for the products and product groups.
- Associate time-limited promotions and coupon codes to support the tracking of offers given to customers.

Distribution Options
Select the supplier and the supplier’s distribution profile if you use a supplier to fulfill your marketing campaign. The distribution profile provides instructions for creating and delivering campaign information to the supplier when the campaign is launched.

Associated Lists
In addition to your external recipients, you can associate a predefined list with your campaign. A predefined list is a static list of internal employees who receive the same campaign information as your external recipients. Sending your campaign content to a predefined list is a useful way to verify the quality of service that the supplier is providing to your contacts.

A subscription list associated with a treatment is the list of contacts that’s updated when e-mail recipients select whether they want to subscribe or unsubscribe. You can associate a subscription list with multiple treatments. You can use a treatment-specific subscription list to have opt-in and opt-out responses associated with a particular list.

Confirmation E-Mails
If you are required to confirm or cancel a subscription, then you must have three treatments. To illustrate this requirement, consider the following example of three treatments that are referred to as Treatment One, Treatment Two, and Treatment Three.

Treatment One offers recipients the options to request a subscription or cancel a subscription. Those who respond receive a second e-mail in which they can finalize their request. Although Treatment One is the first treatment to be sent, it is the last that you create because it refers to the other two treatments. The following table shows the required attributes and values for Treatment One.

<table>
<thead>
<tr>
<th>Treatment Step</th>
<th>Attribute</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Treatment Details</td>
<td>Channel</td>
<td>E-mail</td>
</tr>
<tr>
<td>Channel Details, Confirmation E-Mails</td>
<td>Confirm-in Treatment</td>
<td>Click the <strong>Subscribe confirmation request</strong> link included in the e-mail content. For this example, select Treatment Two.</td>
</tr>
<tr>
<td>Channel Details, Confirmation E-Mails</td>
<td>Confirm-out Treatment</td>
<td>Click the <strong>Unsubscribe confirmation request</strong> link included in the e-mail content. For this example, select Treatment Three.</td>
</tr>
<tr>
<td>Content</td>
<td>Response Forms</td>
<td>Click <strong>Subscribe confirmation request</strong> or click <strong>Unsubscribe confirmation request</strong></td>
</tr>
</tbody>
</table>


Treatment Two provides the subscribe confirmation request to recipients who click the **Subscribe confirmation request** link included in the e-mail content of Treatment One. Recipients who respond to this treatment are added to the subscription list associated with this treatment. The following table shows the required attributes and values for Treatment Two.

<table>
<thead>
<tr>
<th>Treatment Step</th>
<th>Attribute</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Treatment Details</td>
<td>Channel</td>
<td>E-mail confirmation in</td>
</tr>
<tr>
<td>Channel Details, Associated Lists</td>
<td>Subscription List</td>
<td>Select a list</td>
</tr>
<tr>
<td>Content</td>
<td>Response Forms</td>
<td>Subscribe to list</td>
</tr>
</tbody>
</table>

Treatment Three provides the unsubscribe confirmation request to recipients who click the **Unsubscribe confirmation request** link included in the e-mail content of Treatment One. Recipients who respond to this treatment are removed from the subscription list associated with this treatment. The following table shows the required attributes and values for Treatment Three.

<table>
<thead>
<tr>
<th>Treatment Step</th>
<th>Attribute</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Treatment Details</td>
<td>Channel</td>
<td>E-mail confirmation out</td>
</tr>
<tr>
<td>Channel Details, Associated Lists</td>
<td>Subscription List</td>
<td>Select a list</td>
</tr>
<tr>
<td>Content</td>
<td>Response Forms</td>
<td>Unsubscribe from list</td>
</tr>
</tbody>
</table>

**Content and Attachments**

To create your content, you can select a treatment template, or you can start with a blank page. You can either upload content from your desktop or switch the HTML editor to source mode and paste the HTML source code.

In the body of the e-mail, you can include text, merge fields, graphic links and response forms. If you have both plain text and HTML versions of the treatment, the MIME standard ensures that the appropriate version is delivered to each recipient's e-mail client. You can attach a file, a URL, or a text block to the treatment. You can also select product specific content.

**Content, Treatments, and Contact Lists for a Global Campaign: Points to Consider**

When creating campaigns that target multiple geographic regions, languages and currencies, typical considerations include what products to market, what languages to include, and how the campaigns will be fulfilled. This topic discusses the following points:

- Product eligibility
- Contact Lists
- Treatments
- Campaigns
Determining Product Eligibility
You must select products that apply to each geographic area that you target with your global campaign.

Creating Contact Lists
You can create lists of contacts that are filtered by language or by geography. Name your lists so that you can identify them by language when you add your contacts to your sales campaign.

Creating Treatments
If you have multiple language-specific contacts, then you must create a corresponding treatment for each language. Name your treatments so that you can identify them by language when you add them to your sales campaigns. When creating your marketing message and choosing supporting product collateral, consider the following:

- Marketing message text
- Text, images, and colors included in graphics
- Date and time formats
- Currency and local taxes
- Content of any collateral attached to the treatment
- Content of any web pages linked to the treatment

You must also verify that your third-party fulfillment supplier can manage your language requirements.

Creating Campaigns
For campaigns, you can create separate treatment template for each language. For example, for Latin America, you could create a Spanish campaign applicable to multiple countries and a Brazilian Portuguese version for Brazil.

Marketing Source Codes: Explained
A marketing source code is a unique identifier that represents a sales campaign or marketing activity and is used to track marketing effectiveness.

Source Codes
Marketing source codes are automatically generated for every sales campaign and marketing activity. To view a listing of source codes and associated campaign components, navigate to the Review Marketing Source Codes task from Setup and Maintenance. Note that a source code can be listed more than once in this page to support querying on specific promotions and coupons.

Associating Source Codes to Responses and Leads
Source codes associated with responses and leads provide a reference to sales campaign activities for tracking campaign effectiveness.

You can provide a source code when creating, editing, or importing a response. A response generated as a result of an e-mail campaign trackable URL or an e-mail bounce inherits the source code derived from the originating e-mail sales campaign.

A source code can be associated with leads when designing a sales campaign, when manually creating or editing a lead, or when importing a lead. A lead created from a converted response will inherit the source code from the response.
FAQs for Understanding Marketing Content

What happens to existing campaigns if I update the campaign template?

Existing campaigns that were created from the template are unaffected. Your changes will only affect campaigns created after the template is updated. Campaign templates provide models to use as a basis when planning and designing sales campaigns. When you use a template to create a sales campaign, the template values are copied to the new campaign and the template's purpose then ends for that campaign.

What's the difference between a predefined list and a subscription list?

A predefined list is a static list of contacts.

A subscription list is another type of static list. When associated with a specific treatment that has subscription response forms included in the treatment content, it will reflect the responses of campaign recipients who choose to subscribe.

Marketing Campaigns

Campaign Management and Reporting: Overview

Marketing data such as campaigns and campaign members created and updated in Oracle Marketing Cloud can now be stored in your sales application. Campaign related data is maintained and synchronized between Oracle Marketing Cloud and your sales application thus enabling improved campaign management and reporting.

Salespeople can view meaningful information about marketing campaigns and campaign members from the Campaigns user interface. This UI provides visibility into the campaign effectiveness to support the sales processes. For example, salespeople can view the campaigns and campaign members associated with a given lead and contact to enable them gain key insights for closing a sale.

The total number responding to a campaign represents the total count of campaign members who have responded to a marketing campaign. Campaign members include either leads or contacts that were sent or responded to a marketing campaign and have a status of Responded or Sent. Note that the response is only counted once even when a campaign member has responded multiple times to the same campaign.

Salespeople can use the campaign summary data to view associated leads, contacts, opportunities, and revenue amounts. The following subject areas enable the creation of reports on the Marketing Cloud and your sales application data.

- Campaign Members
- Campaign Opportunities

For example, sales and marketing operations can run campaign related reports and perform analysis on marketing attribution and evaluate a campaign's return on investment (ROI). The Profile subtab on the View Campaign shows some details about the campaign such as name, type and current status of the campaign. It also shows the owner, and the dates when the
campaign started and ended as well as a brief description and costs of the campaign. Your administrator can use Application Composer to expose or hide such details or change the layout of the fields as they appear in the Profile subtab.

In addition, your administrator can also display a campaigns subtab on the Leads and Contacts user interface pages from where you can view data about the marketing campaigns that include the associated leads and contacts.

The Campaign Analytics subtab on the View Campaign page shows the campaign member dashboard. Your administrator can use Application Composer to expose a Campaign ROI dashboard from a side tab on the Campaign List page.

Related Topics
- Enabling the Campaigns Subtab in Leads
- Enabling the Campaigns Subtab in Contacts
- Enabling the Campaign Analytics Tab in Campaigns List Page

Campaign Management Reports: Overview

You can view predefined campaign related reports and charts from the Campaign Analytics subtab from the View Campaign page.

You can create your own specific Campaign reports and charts using the Campaign and Campaign Member subject areas to suit your business needs.

The following reports are available through the Campaign Analytics subtab from the View Campaign page:

<table>
<thead>
<tr>
<th>Report</th>
<th>Access this report to...</th>
</tr>
</thead>
</table>
| Campaign Members      | View Campaign Members associated with the campaign.  
                        | A campaign member is an individual targeted in a campaign.  
                        | Displays how many leads, contacts, opportunities, won opportunities, responses the campaign resulted in.  
                        | Filter report data by lead or contact name and response date range. |
| Campaign Summary      | View Campaign Overview information, including summary of count of associated leads, contacts, and opportunities.  
                        | View the campaign pipeline view from campaign responses to won opportunities.  
                        | Determine which campaigns have resulted in what number of leads, contacts, opportunities, and total revenue won  
                        | Drill down on each tile or chart to view further detailed reports. |
| Related Opportunities | View all the opportunities related to a campaign. Related opportunities show the opportunities converted from leads associated with the campaign. |

Note: A lead can be converted to multiple opportunities, and multiple opportunities can be associated with a lead.

FAQs for Marketing Campaigns
How can I view the amount of responses for a campaign?

From the Campaigns List page, you can drill down into each campaign record to view campaign members that have responded to a given campaign, and view campaign member details. In addition, you can view campaign details including campaign name, start and end dates, status, and other standard or custom attributes.

The total number responding to a campaign represents the total count of campaign members with a status of **Responded**. Note that the response is only counted once even when a campaign member has responded multiple times to the same campaign.

How many campaign members are associated with a campaign?

From the Campaigns List page, you can drill down into each campaign record to view campaign members that have responded to a given campaign. You can also access the Campaign Members report that shows the amount of members in a campaign from the **Campaign Analytics** subtab on the **View Campaign** summary page. You can filter the report data by lead or contact name and response date range.

Your administrator can filter what user-defined or predefined campaign related reports to display to campaign users. For example, the default Campaign Analytics subtab search filter is **Record Set = All Members**. This search returns all campaign members with a status of **Responded and Sent**.
8 Managing Leads

Lead Management: Overview

Lead management features help to align marketing and sales objectives from lead generation to lead execution. This ultimately contributes to increasing revenues. Lead information is generated and captured from:

- A company’s existing contacts
- Sales campaigns

All leads then undergo the qualification and assessment process and are qualified either manually by a salesperson or automatically based on predefined rules. Finally, qualified leads are converted into opportunities.

Lead Processing

Lead Processing: Overview

Lead data is generated from a variety of sources and goes through further enrichment based on updates and follow-up activities. As a result, lead quality must be assessed periodically so that leads are distributed to the right salesperson to ensure timely lead follow up and closure.

This section contains information about how to import lead data from an external data source into your sales application using the Import Management feature.

File Import: How It Works

The Define File Import group of tasks relies on integration with different architecture components, such as interface tables and application base tables. This topic provides an overview of these components to help you understand the import process and the different import activity statuses.

The following figure provides an overview of the major application components used when you import data from a file. These components include:

- Import object
- Import mapping
- Import activity
- File repository
- Application Composer
- Interface tables
- Base tables
You select the import object during setup. The import mapping is used in the import mapping step. The import file you upload is stored in a file repository. Any additional attributes you create in Application Composer are stored in a separate extensions repository and available for import and in the import mapping.

Import Objects, Import Mapping, and Import Activity

The import objects you select when you create an import activity are provided by Oracle. They are managed using the Manage File Import Objects task.

>Note: Avoid concurrent submission of File Import jobs for the same import object. Concurrent submission of multiple import jobs with same content results in creation of duplicate object records.

When you create an import activity, you must specify a mapping of the fields in your file to the attributes of the import object. You can create the mapping while creating an import activity or separately using the Manage File Import Mappings task. The mapping is stored and managed as a separate object.
File Repository
The text or XML data file you upload for import is stored in a file repository so that it is available for import processing when you schedule an import activity. Any attachments you upload are stored in the same repository.

Application Composer Extensions
When you create additional attributes for import using Application Composer, your extensions are stored in a separate repository and are available for import and export.

Interface Tables
The import activity populates the application interface tables with your data.

Base Tables
The import activity loads your data into the base tables to complete the import.

Related Topics
- File Import Activity Statuses: Explained
- Importing Data from a File: Procedure

Importing Leads Using File Import: Explained
This topic explains how to prepare and import lead data from an external data source into your sales application using the File Import feature. You enter your lead information using the Lead Qualification work area or you can import data to create or update existing sales leads.

Consider the following questions when importing your data:

- How does your legacy system or source system represent the sales lead compared to how Oracle Engagement Cloud represents the same data?
- Do you have to configure values in Oracle Engagement Cloud application to map to your data values?
- Do you have to configure your Oracle Engagement Cloud object model to capture additional attributes that are critical to the way you do business?
- What import features are available for importing your business object?
- How do you verify your imported data?

Comparing Business Object Structures
You must understand how your sales lead data corresponds with the data in Oracle Cloud Applications so that you can map your legacy data to the data that Oracle Cloud Applications requires. First, you must understand how Oracle Cloud Applications represents the structure of the data for a sales lead.

The sales lead structure is hierarchical. At the top level is the lead summary, which must exist before you can import lower level components such as team members and activities. This hierarchical structure supports one-to-many relationships.
between the components that make up the lead. For example, a lead can have many sales team members and activities as shown in the following diagram.

The lead summary contains basic information about the lead such as the account or prospect details, status, and deal size. For each lead, you can add contacts, assign sales team members, and associate products. As you pursue the lead, you can:

- Track activities and assign due dates
- Attach documents relevant to the lead
- Post notes for the lead

**Import Objects for the Lead**

To facilitate importing leads, Oracle Engagement Cloud incorporates the structure of the sales lead into import objects. The following table lists the import objects for the lead.

<table>
<thead>
<tr>
<th>Import Object</th>
<th>Structure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lead</td>
<td>Contacts</td>
</tr>
<tr>
<td></td>
<td>Sales Team</td>
</tr>
<tr>
<td></td>
<td>Products</td>
</tr>
<tr>
<td></td>
<td>Attachments</td>
</tr>
<tr>
<td>Note</td>
<td>Notes</td>
</tr>
<tr>
<td></td>
<td>Attachments</td>
</tr>
<tr>
<td>Activities</td>
<td>Activities</td>
</tr>
<tr>
<td></td>
<td>Notes</td>
</tr>
<tr>
<td></td>
<td>Attachments</td>
</tr>
</tbody>
</table>
Comparing Business Object Data
Each import object is a collection of attributes that helps to map your data to Oracle Cloud Applications data values and to support one-to-many relationships between the structural components that make up the sales lead.

You must understand the attribute details of the import objects so that you can prepare your import data. You can use reference guide files that contain:

- Attribute descriptions
- Values that populate attributes by default when you do not provide values
- Validation information for each attribute

The validation information includes the navigation path to the task where you can define values in Oracle Cloud Applications. For example, you have values in your data that correlate to a choice list. The validation information for that attribute provides the task name in the Setup and Maintenance work area where you can define your values. For additional information, including a list of reference guide file names and locations that you need to complete this task, see the following table.

<table>
<thead>
<tr>
<th>Import Object</th>
<th>Related Import Object Topic</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lead</td>
<td>Lead Import Object and Attributes: How They Work Together</td>
</tr>
<tr>
<td>Note</td>
<td>Note Import Object and Attributes: How They Work Together</td>
</tr>
</tbody>
</table>

You can explore related topics by entering the following keywords in the Help application search: importing leads

Configurable Attributes
If you want to configure the object to import your legacy or source data, then you must use the Application Composer to:

- Design your object model extensions
- Generate the required artifacts to register your extensions
- Make your extensions available for importing

The corresponding import object is updated with the configurable attributes, which you can then map to your source file data. You can use the same source file to import both configurable attributes and the standard import object attributes.

Importing Sales Leads Using File Import
For the lead business object, you must use the File Import feature. You prepare XML or text source data files in a form that is suitable for file-based import. The file-based import process:

- Reads the data in your source file
- Populates the interface tables based on your mapping
- Imports the data into the application destination table

The Define File Import Setup and Maintenance task list includes the tasks that are required to:

- Configure the import objects
- Create source file mappings
- Schedule the import activities

You submit file-based import activities for each import object. When you’re creating a marketing budget, you first import the Budget object, followed by subsequent import activities for each of the other import objects. The exception is Attachments,
which are imported by including the file names in your source file for the marketing budget object and selecting the files when defining the import activity.

You must be assigned the Corporate Marketing Manager, Marketing Analyst, Marketing Manager, Marketing Operations Manager, Marketing VP, Sales Lead Qualifier, or Sales Representative job role to access and submit the import activities for sales leads.

Verifying Your Imported Data
Oracle Engagement Cloud provides File-Based Import activity reports, which you can use to verify imported data. Users with access to the associated business objects can also view the imported sales lead.

Related Topics
- Getting Started with File-Based Import: Documentation Overview
- Lead Import Objects: How They Work Together
- Extending Your Applications: How It Works

Lead Follow Up

How Lead Components Fit Together

A sales lead cycle ends when a lead is converted to an opportunity or when a lead is retired. A lead is retired if no possibility exists for converting the lead to an opportunity. The lead life cycle includes an automated process that captures leads and then prioritizes them for sales engagement through a scoring and ranking process. Leads are distributed to appropriate sales resources for further lead qualification, follow-up, and conversion.

Leads Life Cycle
Leads are automatically monitored for sales representative acceptance. Unaccepted or rejected leads are reassigned as appropriate. The quality of the lead is continuously reviewed and adjusted by the lead owner at different stages of the lead life cycle. The lead owner can be a marketing resource or a sales resource, depending at what stage the lead is at in its life cycle. The lead life cycle is captured in the following sections:

- Lead Generation
- Lead Qualification
- Lead Distribution
- Lead Assessment
- Lead Conversion

Lead Generation
Leads are generated and captured from many different sources such as:

- Campaign responses
- Third-party lead sources
- Sales prediction application through the creation of new leads
Flexible lead import, customer and contact creation, and deduplication ensure that sales lead generation efforts are
optimized. For example, the lead import process checks whether leads represent new or existing customers. For new
customers, data must be created for the lead. If the lead is an existing customer, then part of the lead import process checks
to ensure customer and lead information isn’t duplicated.

Lead Qualification
Marketing departments help with the lead qualification process to ensure that only qualified leads are handed over to sales.
Leads are typically ranked as Hot, Warm, or Cool. Leads are further qualified by the use of company-specific standard
questions to score a lead. Lead scores are numeric values typically ranging from 1 to 100, in which a high score represents
high quality.

It isn’t good practice to let stale leads build up. Standardized criteria for lead qualification ensure that quality leads reach the
sales representative and help maximize the conversion rate from leads to opportunities. For example, your organization has
criteria and processes for ensuring that leads are either developed or retired within 30 days. When the lead age is greater
than 30 days and the rank is Warm, Marketing reassigns the leads for follow-up by an internal telemarketing group. If the
leads cannot be qualified or further developed to revenue opportunities, then the rejected leads can be reassigned or can be
retired manually.

Lead Distribution
As the qualification of leads progresses into real potential prospects, assignment manager uses expression-based rules to
associate one or more internal sales representatives with each lead. If the lead is associated with either a sales prospect or
a sales account, then assignment manager uses territory definitions to associate (typically one) internal territory with each
lead. The sales representative newly assigned to the lead can be related to the lead record directly through the lead team or
indirectly through a territory associated with the lead. The sales representatives can view and update those leads assigned to
them in the lead work area and can claim ownership of the lead by accepting the lead.

Other assigned resources can view and update the lead, but they cannot make themselves the owners. If a sales prospect
changes to a sales account by adding an address, assignment manager is automatically called during the next automated
assignment cycle. Depending on the assignment logic, the lead can be reassigned to a different territory or sales resource.
If the assigned sales representative takes no action on a lead for several days, then the lead can be manually reassigned to
another sales representative.

Lead Assessment
Sales representatives must evaluate the quality of the information that they have received for the lead. They determine
whether the details are sufficient to reach out to the customer and assess whether a lead is worth pursuing with the help of
preconfigured assessment templates. Assessment templates can qualify the lead by:

• Reviewing the content shared with the customer during a campaign
• Framing the lead in the context of the campaign
• Ensuring the salesperson understands the information that has already been sent to the customer

You use the lead assessment feature to assess leads. Predefined questions help determine the likelihood of the lead being
accepted by Sales. For example, you’re a sales representative and you ask the customer a series of questions created by
Marketing and Sales to assess the quality of the lead. You record the answer of each question and the lead assessment tool
automatically factors the answer into the assessment score of the lead. At the end of the call, you note that the assessment
lead score is high, so you request that the lead is assigned to the direct sales team. If the lead score was low, then you might
want to retire the lead. If the lead needs qualifying, then you can decide to leave it in your list of leads for follow-up. Finally, if
the lead is good, but the potential revenue opportunity is less than a predetermined monetary amount, for example, twenty-
five thousand dollars, then you can convert the lead to an opportunity to pursue as part of the sales cycle.
Lead Conversion

After establishing that the lead has potential, the sales representative can convert the lead to an opportunity. You can schedule meetings and presentations with your lead contact to move the opportunity along the sales pipeline. To track the progress of the lead, you can capture contact notes and associate them with the contact and opportunity. As the lead progresses through its life cycle, decisions to retire the lead are based on the following:

- You cannot verify the customer and lead details.
- The customer isn’t interested in pursuing the lead any further.

Differences Between Response, Lead, and Opportunity: Explained

The following table describes the main differences between a response, a lead, and an opportunity.

<table>
<thead>
<tr>
<th>Response</th>
<th>Lead</th>
<th>Opportunity</th>
</tr>
</thead>
</table>
| A response is an interaction initiated by the customer in response to a marketing stimulus. Every outbound sales activity is a sales stimulus. | A lead is an inquiry, referral, or other information, obtained through a sales campaigns, or other means that identifies:  
  - Potential contact or prospect  
  - Specific purchase interest  

You can create a lead if the specific purchase interest is not known when the lead is created. However, to qualify a lead you must record a primary purchase interest. | An opportunity is a pending sale of a product or service that can be forecasted and tracked using summary data such as:  
  - Potential revenue  
  - Sales stage  
  - Win probability  
  - Expected close date |

Responses are created from interest recorded in response to sales activities. Responses include:  
- Providing answers to phone survey questions  
- Subscribing to a list  
- Replying to an email response form request  

As interest for the product or service matures, responses are elevated as leads. | Leads are mostly created by automated lead capture or lead import processes which periodically create qualified responses as sales leads.  

Leads are sometimes created from the response data of a contact or prospect who has expressed a need or interest in a product or service offered by the business. | Opportunities are created by sales administrators when they have identified a qualified lead with a potential revenue opportunity. Leads are converted to opportunities when significant sales investment is foreseen to close the deal.  

A salesperson can create opportunities from scratch, without previously having a response or lead created.  

Responses are not included as part of the sales forecast. | Leads are not included as part of the sales forecast. | Inclusion of opportunities in the sales forecast is at the discretion of the sales administrator. However, not all opportunities are included and the decision to include them may depend on your company’s requirements. |
Lead Actions: Explained

Use lead actions to manage leads. This topic provides a brief description of the actions that you perform on a lead. Lead actions are generally grouped into the following categories:

- Standard create, edit, delete, and update functions such as performing a mass update
- Ranking, scoring, and qualifying actions to assist in prioritizing leads
- Accepting, rejecting, reassigning, and retiring actions to ensure leads are in the right queue for pursuing
- Converting leads to opportunities to continue sales pursuits and include in sales forecasting

The ability to perform each action depends on:

- Privileges assigned to your role
- Access level as a lead sales team member
- Current status of the lead

Lead Actions

The following table shows the actions that you can perform to manage leads:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mass Update</td>
<td>Performs a mass update of specific attributes and user-defined attributes from the Leads Overview work area when selecting multiple records.</td>
</tr>
<tr>
<td>Rank</td>
<td>Submits the Request Sales Lead Assignments process to automatically assign a lead rank based on predefined rules specified in the Assignment Rule for Ranking Leads profile option. A rank represents the priority of the lead, such as Hot, Medium, and Cool.</td>
</tr>
<tr>
<td>Score</td>
<td>Submits the Request Sales Lead Assignments process to automatically assign a lead score based on predefined rules specified in the Assignment Rule for Scoring Leads profile option. Lead assignment score is different from qualification and assessment scores. A lead score can be used as a source for predefined rules that automatically assign lead rank, qualification status, territories, and resources.</td>
</tr>
<tr>
<td>Qualify</td>
<td>Updates the lead status to Qualified, bypassing the automated sales lead classification process.</td>
</tr>
<tr>
<td>Reassign</td>
<td>Provides choices for when the sales lead assignment process evaluates the lead to reassign sales team members and territories to the lead:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Automatic assignment</strong> Lead is selected for reassignment and is reassigned when the Request Sales Lead Assignments process next runs using the Reassign process selection criteria.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Immediate automatic assignment</strong> Immediately runs the Request Sales Lead Assignments process, reevaluating, and reassigning per the process.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Manual assignment</strong> You can select an owner to assign to the lead from a list of eligible resources.</td>
</tr>
</tbody>
</table>
### Lead Statuses: Explained

The status of a lead is primarily determined by a user performing an action on a lead, or upon successful completion of the lead qualification activity. This topic describes the different lead statuses. Once leads have been assigned to lead qualifiers or related sales roles, lead follow-up activities begin. As specific actions are performed on a lead, the status of the lead changes accordingly.

#### Lead Status

The following table describes the statuses of leads:

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unqualified</td>
<td>A lead with a status of unqualified signifies that the lead requires additional information and qualification activities by the lead team. Unqualified is the default status assigned to all newly created leads.</td>
</tr>
<tr>
<td>Qualified</td>
<td>A qualified lead signifies that the lead is ready for sales attention. The status can be updated to qualified by either the user selecting the Qualify action or upon successful completion of the qualification processing activity. Leads can have a status of qualified based on many factors including the status of the budget and the time frame of the project.</td>
</tr>
<tr>
<td>Converted</td>
<td>When a lead is converted to an opportunity, then the status is set to Converted.</td>
</tr>
</tbody>
</table>
The status of a lead is updated to Retired when a user selects the Retire action. A lead is retired when:

- There is no likelihood of the lead being converted to an opportunity
- A lead is no longer followed up by Sales
- A lead is not evaluated by Marketing over a certain period of time

A retired lead can't be converted to an opportunity. Marketing users can review retired leads and then delete them as required.

Converting Leads

A lead’s life cycle ends either when a lead is converted to a sales opportunity, or when the lead is retired. Conversion to an opportunity stage allows the sales representative to pursue the account in the sales cycle. After establishing that the lead has potential, the sales representative converts the lead to an opportunity. Contact is established and meetings and presentations are scheduled to move the opportunity along the sales pipeline.

To convert a lead to an opportunity depends on the privileges assigned to your role, your access level as a lead sales team member, and the current status of the lead. You can convert a lead to an opportunity from the Actions menu by selecting Convert. This action creates an opportunity based on lead information. When a lead is converted to an opportunity, the lead status is set to Converted.

Converting Leads to Opportunities

You convert a lead to an opportunity when the lead is ready for further processing along the sales cycle. Once the conversion is successfully completed, you can review the newly created opportunity using the opportunities UI. During your review, you might want to retain only a select few lead product lines to pursue as opportunity revenue line items. Since the conversion process automatically creates revenue lines from all lead lines, you can remove unwanted revenue lines from the opportunities UI. You can, at a later stage, create another opportunity from the removed lead revenue lines by converting the lead to an opportunity again. You can then decide to keep only those revenue lines that you want on the newly created opportunity.

When you convert a lead to an opportunity, the following rules may apply depending on the setup criteria for your company:

- The person converting the lead becomes the primary sales team member for the opportunity.
- The customer reference on the original lead is maintained for the opportunity.
- The associated lead team members are copied with the same primary team member.
- The newly created opportunity is assigned to the appropriate sales territories.

You can view opportunities associated with leads in the leads UI. If you do not see the converted lead in your list of opportunities, this means that the opportunity is assigned to a different territory.

Creating Leads with New Contact and Account: Procedure

You can enter leads for new sales prospects without associating an existing contact or account with the lead. As part of the lead management ready to use functionality, this is achieved by typing the contact name and account name directly onto the lead.
Creating Leads with New Contact and New Account

to create a lead for a new sales prospect without associating an existing contact and account:

1. Sign in as a salesperson and navigate to the Leads area.
2. Click Create Lead.
3. From the Create Lead page, enter the name of your contact in the Primary Contact field.
   As you enter the name, note that any existing matching contacts are automatically suggested which you can choose to ignore, as applicable.
4. Enter the name of the account in the Account field.
5. Enter other lead details as required, and when finished, click Save and Close.

When you convert the lead, the Primary Contact and Account on the converted lead will show links to the newly created contact and account.

Converting Leads with New Contact and Account: Procedure

You can convert leads for new sales prospects with a new contact and a new account. When a sales prospect lead is converted, a new contact and account are created along with a new opportunity.

Converting Leads with New Contact and New Account

to convert a lead for a new sales prospect with a new contact and a new account:

1. Sign in as a salesperson and navigate to the Leads area.
2. Select the sales prospect lead that you want to convert.
3. From the Edit Lead page, enter other lead details as required and when finished, click Save.
4. From the Actions menu, select Convert.
5. From the Convert dialog, click Submit.

A new contact and a new account are created during the lead to opportunity conversion. The newly created contact and account are now associated with both the opportunity created during conversion and the converted lead. The Primary Contact and Account fields on the converted lead contain links to the newly created contact and account. Prior to the conversion, they are both listed as a value in their respective drop down lists.

Applying Mass Update to Leads

You can update attributes, including user-defined attributes, on multiple leads at once using the Mass Update feature. This topic explains how to use the Mass Update feature to apply changes to multiple fields on multiple leads at once. For example, you might want to change a user-defined field, such as Expiration Date, on multiple leads. You can query leads using the Expiration Date field, and then select which leads you want to update all at once. You can also use the Mass Update feature to update product information or primary contact information for leads.

Before you can use mass update, your administrator must enable the update action using Application Composer and, optionally, set a profile option that controls how many lead records you can update at once.

You can update several fields on multiple leads using the Update action. You can update any of the following fields:

- Account
- Budget Amount
- Budget Status
• Campaign  
• Currency  
• Customer Need  
• Deal Size  
• Decision Maker Identified  
• Description  
• Primary Contact  
• Primary Product  
• Rank  
• Sales Channel  
• Source  
• Time Frame  

User-defined fields, if created, are available for update as well.

**Applying Mass Update to Leads**

To apply a mass update to leads, perform the following steps:

1. From the *Leads* landing page, enter the search criteria for the leads that you want to update, and click *Search*.
2. Based on the leads returned from your search criteria, select the leads that you want to update at the same time.
3. From the *Actions* menu, click *Update*.
   
   You can select or deselect leads by a single click of the lead record in the list. Use the select all and deselect all links to select or deselect all leads.

   
   **Note:** By default, all the lead attribute fields on the Mass Update dialog box are read-only until you select to update them.

4. Select the attributes that you want to update and assign a value for each of the selected attributes.
   
   For lead attribute lists, their default value is displayed. Text fields are blank by default.

5. Click *Save and Close*.

**Related Topics**

- Enabling Mass Update of Records

**Sales Users Access to Leads: Explained**

This topic explains how the security reference implementation provided by Oracle determines who can access what lead information in your sales organization. Qualified leads are assigned to a sales team based on sales territories. Unqualified leads are assigned to individual lead qualifiers either manually or based on rules defined in the assignment manager application. Whether or not you can access a particular lead depends on your membership in the resource and territory hierarchies.

You can access a lead if the following conditions apply:

- You are the lead owner.
• The lead owner or sales team member is your direct or indirect report in the resource hierarchy.
• You are a member of the lead sales team.

Resources in the management hierarchy of a newly added lead sales team member have the same level of access to the sales leads as the team member.
• You are the owner or are a member of the territory assigned to the lead.
• You are the owner or member of an ancestor territory of the territory assigned to the lead.

The following figure illustrates some of the different ways you can gain access to a lead:
• Named agents in the diagram (A, B, and C) can access the lead.
• Unnamed agents (highlighted in yellow) cannot access the lead.
• Sales managers can access the lead because a salesperson in their management chain has access.
The following figure shows who in a sales hierarchy can access a sales lead. Access using accounts is not shown.

- Agent A can access the lead because agent A created it. When you create a lead, you are the initial owner.
- Agent B can access the lead because agent B is on the sales team.
- Agent C can access the lead because agent C is the owner of the NW territory.
- Sales managers who are higher up in the management chain can also see the lead because access is provided through the resource hierarchy. The manager of agent C can access the lead information, but colleagues of agent C do not have access to the lead.
Special Access

Not all access is affected by the management hierarchy and membership in sales teams or territories. For example, special access includes:

- Administrators: Administrators get access to leads and other objects. This access is based on their privileges, regardless of where the administrators are in the management hierarchy. Administrators do not have to be on the sales team or members of territories.

- Deal Registration: Salespeople assigned to a deal registration retain access even if they are moved to another deal registration.

Lead Ownership and Sales Team Resources: Explained

A market is typically organized into territories that include customers and prospects. Marketing is closely aligned with sales, and marketing activities are launched to generate leads and maintain the strength of the sales pipeline. This topic explains lead ownership and sales team resources.

When the lead doesn't have any owner, the sales representative can accept the lead which makes him or her the lead owner. All resources who are given access to leads get full access. Full access level allows the user to update the sales lead team by adding or removing individual resources. Hence, territory resources, sales team members and lead owner and resources in their hierarchy, all get full access. Territory team members inherit the access level of the territory. All members of sales territories assigned to the lead have full access to the lead. Ancestor territory owners of all sales territories assigned to the lead also have full access to the lead. Resources who access leads have different roles as follows:

- Operations
  Support an automated process to capture leads, prioritize leads for sales engagement, and distribute the leads to appropriate sales or territory team resources.

- Marketing and lead qualifiers
  Monitor leads, reassign leads, and continually review and adjust the lead quality.

- Sales and territory teams
  Enable lead qualification, perform follow-up lead activities, and convert leads to opportunities.

This topic includes the following sections:

- Lead, Sales, and Territory Resources
- Assignment of Leads to Marketing and Sales Resources
- Sales Resource Role

Lead, Sales, and Territory Resources

Sales resources are organized into flexible teams and are associated with the sales territories. These sales territories are then assigned to customers, leads, and opportunities to carry out the sales process. The lead follow-up team can include a lead team made up of individual sales resources who are predominantly active during the lead qualification stage. All sales resources who are assigned to the territory team can view and follow up the lead.
Assignment of Leads to Marketing and Sales Resources

Qualified leads are assigned to a sales team based on sales territories. Unqualified leads are assigned to individual lead qualifiers either manually or based on rules defined in the assignment manager engine. Users can be assigned to a lead in one of the following ways:

- Ownership through lead creation
- Territory-based lead assignment
- Rule-based sales team member assignment
- Manual selection of resources

Sales Resource Role

The sales resource performs the following activities:

- Review quality leads that are augmented with sales collateral, marketing content, customer contact interactions, and references.
- Qualify and assess the lead quality further with the help of user-defined or company-defined assessment templates.
- Use the resource drop-down list to manually select a resource to add to the team.
  
  Include a description to indicate what role the resource has on the sales team. Many sales team members can access each lead, and each team member is identified as either an internal (sales force), or an external (channel partner sales force) resource. Each sales team member can be associated with a specific resource role to indicate what capacity the member has on the lead.
- Add additional contacts and products to the lead as the lead moves further down the sales cycle.

Sales Lead Team Examples

A sales lead team comprises assigned territories and individual team members. This topic provides examples that illustrate some of the features available for the sales lead team:

- Automate assignment of individual resources to sales lead team
- Add ad hoc members to sales lead team
- Update access rights based on the resource
- Change the lead owner

Automate Assignment of Individual Resources to Sales Lead Team

The sales lead team for your company wants to add a support person to the lead. Typically, support people are not part of any sales territory. You can use the Manage Sales Lead Assignment Rules task to set up a rule set for the category, Sales Lead Resource Rule Category. For example, you can assign support team members as individual resources based on rules which match the lead product with specific support team members.
Add Ad Hoc Members to Sales Lead Team
Generally, sales team resources are automatically assigned to leads based on configured assignment rules. The following scenarios provide examples of when you may want to manually add additional team members to assist with the lead.

- The lead owner, who has full access to your company lead, wants to add one of his company’s contractual experts to his team to help pursue the lead. The lead owner manually accesses the resource drop-down list and selects the ad hoc resource that he wants to add to his team.
- When pursuing a lead for an insurance policy, the customer contact requests a unique and complex combination of policy components that require an expert in the company to review. The lead owner adds the expert resource to the lead with full access. Now the expert resource can update the lead with valid combinations of products and services, and, if required, add more team members to the team.
- A salesperson is pursuing a lead that requires the export of products outside the country. He wants to ensure there are no legal issues with exporting the products. The salesperson adds a member of their company’s legal counsel to the lead to review the details before contacting the customer again.

Update Access Rights Based on the Resource
When a resource is added to the sales lead team through rule-based assignment, a profile option determines the member’s default access level. Resources in the management hierarchy of a newly added team member have the same level of access to the sales leads as the team member.

All members of the sales territories assigned to the lead have full access to the lead. Owners of ancestor territories of all sales territories assigned to the lead also have full access to the lead.

Change the Lead Owner
Only the lead owner, or the resources in the management hierarchy of the lead owner, can change the ownership of the lead.

Lead Qualification
Lead Qualification: Explained
The lead qualification process can either be performed by internal marketing or internal sales groups. This topic provides a brief overview of what constitutes a qualified lead. Qualifying leads is an important first step in bringing the sales lead to a conclusion. At the end of the lead qualification process, you can classify the lead as a qualified lead that is ready for conversion to an opportunity. Or you can retire the lead if the purchase interest for the lead cannot be validated. What constitutes a qualified lead varies from company to company.

Basic Lead Qualification
In some companies, basic lead qualification data is gathered by lead qualifiers and contains data such as:

- Customer need
- Urgency or time frame for the project
- Budget considerations such as available amount and status

The scheduled process that determines lead qualification status also takes into consideration basic lead data.
Additional Lead Qualification

In other companies, the lead qualifier or salesperson uses a lead qualification questionnaire as part of the qualification process. Based on the answers received, he or she can decide to manually set the lead to a Qualified status using the lead actions menu. Your application administrator assigns the questionnaire to your Lead Qualification Template profile. The answers entered are assessed using a weighted scoring model with instant feedback available as a scoring status bar in the UI.

Related Topics
- Defining a Sales Lead Qualification Template: Example

Performing a Lead Qualification: Procedure

Lead qualification helps in the lead follow-up process, in which the sales representative continues to assess the lead quality and lead conversion potential by using the preconfigured qualification templates.

Lead qualification is part of the lead follow-up activity where you further nurture the lead in order to qualify it. Your administrator must set the Advanced Lead Qualification Enabled profile option after the qualification templates are created. This action specifies the qualification template to display in the Edit Lead UI to assist with evaluating the lead.

You can conduct a lead qualification, view completed lead qualifications, and view the responses to the questions posed in the qualification template. Qualification templates enable you to analyze the lead and suggest the appropriate next steps based on the overall assessment score and feedback for the lead.

Performing a Lead Qualification

Use the following procedure to perform a new lead qualification.

1. From the Navigator, click Leads.
2. In the list of leads, click on a lead to edit it. The Edit Lead page appears.
3. Click the Qualification tab to open the default qualification template.
4. Fill out and complete the lead qualification template.

If there are multiple qualification templates associated with the lead, then you can choose to select a different qualification by clicking Replace Qualification.

Related Topics
- Creating Assessment Templates: Procedure
- Assessment Template Score Range: How It's Calculated
- Assessment Template Components: How They Fit Together

Performing Multiple Lead Qualifications: Explained

When you create a lead, you can perform qualification on the lead leveraging the many templates provided by your sales organization. This means you can evaluate various aspects of the lead which can subsequently help you sell more by converting the leads in less time.
Choosing the Qualification Template

After you create the lead, go to the Qualifications tab and view the recommended qualification that is created for you by your organization. You proceed to fill out and complete the qualification template. If there are multiple templates associated with the lead, select one by clicking Replace Qualification. Any responses for the current qualification will be reset and can’t be restored. You can choose to cancel the operation and use the current qualification template, or you can choose to continue.

If you continue, the qualification UI is refreshed to display the questions from the new template that you selected. You can then start providing responses to the questions. You can track the updates on the current qualification from the Qualification status fields on the page. Statuses toggle between: Not Started, In Progress, and Completed. You can also include other status values such as the number of questions you have answered, last updated date, and name of the template. You can also track the total score by summing up the weighted answers and viewing a graphical circular format of the score.

Performing Multiple Lead Qualifications Using the Same Template

From time to time, you might want to requalify your sales lead information and perform multiple qualifications for leads using the same qualification template. To enables you to create multiple qualifications for your sales leads, your administrator must set the profile option Enable Multiple Assessments Per Qualification Template to Yes at the site level.

You can add a questionnaire template by clicking Add Qualification and then selecting the template you want from the available templates for your sales lead. When you add another qualification for your lead using the same qualification template, the application automatically generates a qualification name using the qualification template name plus a counter suffix. For example, if you have an existing qualification for a lead named Lead Qualification V1, then if you add another qualification using the same template, the new qualification name is displayed as Lead Qualification V2. You can edit this name to suit your own requirements.

When all questions are answered, the status of the qualification is set to Complete and continues to be editable. You can view all ongoing or historical qualifications, scores, statuses, and qualification template names. You can use the Delete and Submit features only if the buttons are enabled by your administrator using Page Composer. You can delete a qualification that is no longer required or if it was created by mistake as long as it has not been submitted. The Submit button, if, enabled, becomes available only when you have entered responses for all questions. Submit is not available on the single lead qualification page. You cannot edit the lead qualification once the status is set to Submitted but you can continue to view it.

Performing Multiple Lead Qualification Using the Same Qualification Template

Before you begin, ensure that your administrator has set the Enable Multiple Assessments Per Qualification Template (MOW_MULTIPLE_QUALIFICATIONS_ENABLED) profile option to Yes. You must also have Full or Edit access on a lead to perform multiple qualifications and update existing qualifications for leads using the same qualification template. With View Only access, you can view qualifications but not update them.

Use the following procedure to perform multiple lead qualifications using the same qualification template.

1. From the Navigator, click Leads.
2. In the list of leads, select a lead to edit it. The Edit Lead page appears.
3. Click the Qualification tab to open the Edit Qualification page.
   - If existing qualifications are available for the selected lead, they are listed here.
4. Click Add Qualification. The Add Qualification dialog appears.
5. From the Template drop-down list, select the qualification template previously chosen for the selected lead qualification.
6. Click Save and Continue.
Select the appropriate responses to all the questions.

Click Submit and then click Yes from the confirmation dialog box.

The qualification status is changed to Submitted.

After you submit the lead qualification, you cannot revise it.

Qualifying Leads: Examples

This topic explains the lead qualification process and provides examples of the different methods used for qualifying leads.

Lead Qualification Process

Lead quality is assessed as soon as a lead is generated and is mainly based on:

- The characteristics of the customer contact on the lead
- The type of response which caused the lead to be generated
- The type of sales campaign that the lead may be associated with

Leads are enriched further, typically by means of prequalification telemarketing activities performed by internal marketing, internal sales groups, or external third-parties. Qualification data is added to the lead such as:

- Customer need
- Urgency or time frame for the project
- Budget considerations such as available amount and status

At the end of this process, the lead is either:

- Classified as a qualified lead which is ready for conversion to a sale
- Retired if purchase interest for the lead can’t be validated

The following scenarios illustrate some of the lead qualification processes.

Rule-Based Lead Qualification

The rule-based lead qualification process requires that the value of the Lead Status attribute be set to Qualified if qualification rules evaluate to a positive answer. For example, consider the rule:

IF budget status is approved AND time frame is 3 months
AND decision maker has been identified
AND response type is attended event
THEN rule is passed
ELSE rule is failed.

If this rule evaluates to TRUE, the value of Lead Status is set to Qualified.

Internal Marketing Qualification

Internal lead qualifiers or inside salespeople conduct phone conversations to gather qualification data about leads. They can use qualification templates to define consistent and specific qualification criteria for similar leads. The qualification questions are tailored to a specific product, industry, and source of the lead.
Before updating the lead status to qualified, the lead must have a valid primary product associated with it. Users can select multiple leads and select **Qualify** from the **Actions** list. Leads meeting the requirements for lead qualification are processed.

As the qualification data is gathered using the leads management user interface, the lead qualifier or salesperson can decide to manually set the lead to Qualified status. In some companies, the lead qualification data gathered by lead qualifiers is considered in the scheduled automated lead process. For example, the assignment manager engine can calculate lead score or lead rank, as well as assign sales team territories. For such companies, a simple rule to move leads to a Qualified status when the lead score reaches a specific threshold is sufficient.

A lead can be qualified when the basic attributes of the lead indicate interest in the purchase of a product. For example, basic attributes might include:

- Contact attended a product event
- Budget is approved
- Purchase time frame is less than a year

The **Additional Qualification** tab displays the qualification template with questions where you can enter the answers on the same page. Most of the data required to qualify the lead is available from the Basic Qualification area of the Lead details page. Supporting data is included in the contextual area for easy reference.

**Internal Sales Group Qualification**

Leads are generated and captured from many different sources. The sales prediction system generates and captures leads. Leads are created when customers are created. Leads are also generated from leads that already exist. After salespeople accept those leads generated by the sales prediction system, they can evaluate the quality of the information received for the lead. They determine if the details are sufficient to reach out to the customer and assess whether a lead is worth pursuing with the help of predefined assessment templates. If they can establish that the lead has potential and can be marked as qualified, they can then convert the lead to an opportunity. Contact is established and meetings and presentations are scheduled to move the opportunity along the sales pipeline.

**External Third-Party Qualification**

External third-party qualification involves using input from a third-party source to qualify leads. For example, your company has obtained a list of contacts that purchased a car in the last 90 days. You have hired a telemarketing company to call each contact to determine if there is interest in your company’s auto security products. The third-party telemarketer provides weekly files of potential contacts who are interested in your products. Using the file-based data import feature and qualification rules configured using the assignment manager engine, the interactions resulting from the telemarketer’s activities are imported as leads. The marketing operations manager schedules the rule-based qualification process to occur as soon as the enriched lead data is imported to the lead management application. If the rules evaluation is successful, the result sets the lead status as Qualified.

**Related Topics**

- Lead Assessments: Explained
- Lead Ranking: Explained

**FAQs for Managing Leads**
What leads are displayed when I select My Open Leads?

Selecting the **My Open Leads** list in the Leads work area displays a list of all of the qualified and unqualified leads where you are listed as the lead owner and that were created within the last 90 days, or another number of days specified by the administrator in a system profile. You are automatically the lead owner if you create the lead or you can be designated as the owner by an application administrator.

How can I check for duplicate leads?

As a sales representative you want to know if your leads for new contacts or accounts have any duplicates in the application. You can manually check for leads duplicates from the edit leads page. Select the lead that you want to check and from the **Actions** menu, select **Duplicate Check**. Duplicate check can only be run on new (non-existing) contacts and accounts.

A message is displayed if no duplicates are found for new contacts or accounts. If potential duplicates exist, the Resolve Duplicates page is displayed for the contact or account where you can select the appropriate contact or account to resolve any duplicates.

Why did the deal size change?

The deal size is automatically determined by the products entered for the lead. When you add or remove products for a lead the deal size is recalculated. You can override the calculated amount after all products are entered. For example, if the lead is eligible for a discount, you can manually change the total of the deal size to apply the discount. However, the application overrides the deal size total if you add or remove a product from the lead after having manually adjusted the deal size. In this case, you have to reapply the manual change.

What happens if I manually change a lead rank that was automatically assigned?

Lead rank suggests a priority to help you select leads for follow up. When the lead is created, a lead rank is first calculated by the assignment manager engine based on ranking rules. You can select a different lead rank from the list in the UI. When the lead is further processed, a different rank may be assigned based on enriched lead data, or the rules may cause the lead to revert to its original rank.

How can I add lead contacts to my sales campaign?

From the Leads overview area, select the lead you want to be part of your sales campaign. From the Lead details page, click the **Contacts** tab. Select the contacts that you want to add to your sales campaign. From the **Actions** menu, select **Add to Sales Campaigns** to view and select a campaign from your saved campaigns. Your selected contacts are notified either when you launch your sales campaign or at the next scheduled mailing if you set up your sales campaign to repeat.
What's the difference between lead qualification and lead assessment?

Lead qualification determines whether a lead has a budget and project timeline defined, and indicates if someone with purchasing authority is identified. Company-specific standard questions and the associated scoring mechanism help to capture the additional data critical to qualifying leads. A lead is typically considered qualified when the need and purchase interest are confirmed.

Lead assessment helps in the lead follow-up process, where the salesperson continues to assess the lead quality and lead conversion potential through preconfigured assessment templates. From the Assessment tab, the salesperson can conduct a new assessment, view completed assessments, and view the responses to the questions. Assessment templates provide the mechanism for the salesperson to analyze the lead and suggest appropriate next steps based on the overall assessment score and feedback for the lead.

Related Topics

- Lead Assessments: Explained
- Assessment Template Score Range: How It’s Calculated

What are assessment templates?

You can use assessments to evaluate the health of a business object, such as an opportunity or a lead. Administrators set up assessment templates that consist of weighted questions and possible responses that get scored. After selecting the appropriate assessment type, you enter responses for all the questions in an assessment, and achieve a score once the assessment is submitted. This score is used to evaluate the health of the business object. For example, the score could help determine whether an opportunity is viable enough to offer the potential customer a discount.

Related Topics

- Assessments: Overview

Why was a customer reference displayed for my lead?

A customer reference is based on the customer industry and associated lead product or product group related to the specific lead. For example, a customer reference displays for your lead if a customer has purchased a similar product or service. You can leverage the reference details for effective lead follow-up.

The leads UI is designed to ensure that you are productive and can readily access related lead information with as few clicks as possible. Supporting data related to each lead is included in the contextual area for easy reference. It includes references to all open leads and open opportunities for the lead customer, as well as supporting collateral. This information is useful to the lead sales team to facilitate an effective lead follow-up.
What happens if I convert a lead to an opportunity?

You convert a lead to an opportunity when the lead is qualified and is ready for further processing along the sales cycle. Once the conversion is successfully completed, you can review the newly created opportunity using the opportunities UI. During your review, you might want to retain only a select few lead product lines to pursue as revenue on the opportunity. Since the conversion process automatically creates product lines (representing revenue) from all lead lines, you can remove unwanted product lines from the opportunities UI.

You can view opportunities associated with leads in the leads UI. When you convert a lead to an opportunity, the following rules may apply depending on the setup criteria for your company:

- The person converting the lead becomes the primary sales team member for the opportunity.
- The customer reference on the original lead is maintained for the opportunity.
- The associated lead team members are copied with the same primary team member.
- The newly created opportunity is assigned to the appropriate sales territories.

How can I copy notes, attachments, and activities during Lead to Opportunity conversion?

You can copy notes, attachments, and activities from a lead record to an opportunity record during the lead to opportunity conversion process. Your administrator must set the Reference Copy Lead to Opportunity Map profile option value to the Direct Lead to Opportunity Mapping profile option.

Related Topics

- Enable a User-Defined Copy Lead To Opportunity Map Value

Can I create more than one opportunity from a single lead?

Yes, you can convert the same lead into another opportunity and then delete unwanted product lines. For example, during your review of an opportunity, you decide you want to retain only a select few of the lead product lines to pursue as opportunity revenue. Since the conversion process automatically creates the product lines from all lead lines, you can remove unwanted product lines from the opportunity details page. You can, at a later stage, create another opportunity from the removed lead product lines by converting the lead to an opportunity again. You can then decide to keep only those product lines that you want on the newly created opportunity.

Why can't I see converted leads in my list of opportunities?

If you don't see the converted lead in your list of opportunities, this means that the opportunity is assigned to a different territory.
Who can view the record sets for leads for saved searches?

The different record sets provided in the Saved Searches window restrict your saved searches to different sets of leads. The following table lists and describes the record sets for leads. Not all record sets are available to all users. For example, the record sets involving subordinates are available only to managers.

**Tip:** To improve saved search performance, restrict your saved searches to smaller record sets. For example, rather than searching all the records you can see, search all the records in your territory hierarchy. Or restrict your searches to a smaller geographical area. For example, search all the leads in one state instead of the whole country.

<table>
<thead>
<tr>
<th>Record Set Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>I own</td>
<td>Leads you own, including those leads you created or where ownership is assigned to you.</td>
</tr>
<tr>
<td>I am on the team</td>
<td>Leads where you are on the lead team. You are on the lead team if you are the lead owner or were added as a member by another team member.</td>
</tr>
<tr>
<td>My territory</td>
<td>Leads in your sales territories.</td>
</tr>
<tr>
<td>My subordinates own</td>
<td>Leads where you or your subordinates are on the lead team.</td>
</tr>
<tr>
<td>My territory hierarchy</td>
<td>Leads in your sales territories and all of their subordinate territories in the sales territory hierarchy.</td>
</tr>
<tr>
<td>All records I can see</td>
<td>Leads that you can view based on your lead team membership, sales territory assignments, your position in the organization, and security permissions.</td>
</tr>
</tbody>
</table>

Can I perform a mass update for leads of different business units?

You can't perform a mass update of modified values for leads that apply to different business units. A dialog box is displayed if the selected leads belong to different business units which do not share the same reference data sets. You must remove the set-enabled attribute for the offending leads and perform the mass update only for leads with business units containing the same reference data sets. For more information on reference data sets, see the topic Business Units and Reference Data Sets: How they Work Together. Also, consult the online help, using keywords "reference data".
9 Understanding Responses

Response Management: Overview

Whenever prospects or contacts respond to an offer through a channel, such as inbound email, Web, or call center, their responses are captured in detail using response management functionality. You can review response details and convert qualified responses to sales leads.

You can determine which responses to pursue as leads or which ones you can convert to opportunities. Campaign channels can be different from response channels. Recipients of an internet campaign can respond through a call center. Recipients of a direct mail offer may respond by going to a Web offer URL. Responses are generated because of sales and marketing activities. Responses gathered from external call centers and suppliers are imported in the application.

Websites can capture response details, while phone calls or direct mail responses must be recorded manually. When these responses are recorded, you can import them. Inbound email replies aren't automatically captured as responses. You must configure your email response product to support inbound email processing. Each response type has several parameters that store details about a given response. You can modify an automatically captured response if you have permission. Responses are tracked for an offer and for a campaign.

Response Management Summary

Responses are captured either through file-based data import, or they're automatically captured by recording the various clicks when opening emails associated with the sales campaign. You can review imported and autogenerated responses and convert qualified responses to leads and opportunities.

Response Management Features

You can create responses provided by prospects and contacts, and you can convert responses to leads and opportunities. You can record campaign responses to:

- Calculate campaign response rates
- Target promotional material to those prospects and contacts who are more receptive to offers
- Build a profile of prospects and contacts who responded to run targeted campaigns
- Extract and source key data from the responses to generate quality leads
Differences Between Response, Lead, and Opportunity: Explained

The following table describes the main differences between a response, a lead, and an opportunity.

<table>
<thead>
<tr>
<th>Response</th>
<th>Lead</th>
<th>Opportunity</th>
</tr>
</thead>
<tbody>
<tr>
<td>A response is an interaction initiated by the customer in response to a marketing stimulus. Every outbound sales activity is a sales stimulus.</td>
<td>A lead is an inquiry, referral, or other information, obtained through a sales campaigns, or other means that identifies: • Potential contact or prospect • Specific purchase interest You can create a lead if the specific purchase interest is not known when the lead is created. However, to qualify a lead you must record a primary purchase interest.</td>
<td>An opportunity is a pending sale of a product or service that can be forecasted and tracked using summary data such as: • Potential revenue • Sales stage • Win probability • Expected close date</td>
</tr>
<tr>
<td>Responses are created from interest recorded in response to sales activities. Responses include: • Providing answers to phone survey questions • Subscribing to a list • Replying to an email response form request</td>
<td>Leads are mostly created by automated lead capture or lead import processes which periodically create qualified responses as sales leads. Leads are sometimes created from the response data of a contact or prospect who has expressed a need or interest in a product or service offered by the business.</td>
<td>Opportunities are created by sales administrators when they have identified a qualified lead with a potential revenue opportunity. Leads are converted to opportunities when significant sales investment is foreseen to close the deal. A salesperson can create opportunities from scratch, without previously having a response or lead created.</td>
</tr>
<tr>
<td>Responses are not included as part of the sales forecast.</td>
<td>Leads are not included as part of the sales forecast.</td>
<td>Inclusion of opportunities in the sales forecast is at the discretion of the sales administrator. However, not all opportunities are included and the decision to include them may depend on your company’s requirements.</td>
</tr>
</tbody>
</table>

What's the difference between a response and an interaction?

A response signifies a recorded reaction of a prospect or contact to a sales or marketing activity. An interaction is a record of communication between your company and the prospect or contact or customer.
The following table outlines the key points about responses and interactions:

<table>
<thead>
<tr>
<th>Responses</th>
<th>Interactions</th>
</tr>
</thead>
<tbody>
<tr>
<td>A response can be converted into a sales lead for further qualification or sales opportunity to be pursued and included in sales forecasting.</td>
<td>An interaction is recorded when a communication occurs with customer contacts by means of any communication channel such as e-mail, phone, direct mail, or web.</td>
</tr>
<tr>
<td>Responses received by phone, e-mail, or web are saved and positive responses can be converted to sales leads and opportunities.</td>
<td>An interaction is typically created for each outbound and inbound communication. An outbound communication is initiated by a company employee such as a salesperson by a phone call, or marketing manager by means of an e-mail campaign. An inbound communication is initiated by a prospect or contact by means of web activity or through a call center.</td>
</tr>
<tr>
<td>Responses are typically captured by automated processes or are imported in the application.</td>
<td>Interactions for a particular customer or contact can be viewed in Customer Center.</td>
</tr>
<tr>
<td>A response captures information specific to the sales or marketing activity such as source codes and specific destination URLs.</td>
<td>The channel details on a marketing treatment include the option to create interactions when a response is created.</td>
</tr>
</tbody>
</table>

**What happens when I convert a response to a lead?**

A lead is created and becomes available for follow up from the Leads work area. As the user who converted the response to the lead, you are listed as the lead owner.
10 Managing Opportunities

Opportunities: Overview

Opportunities allow organizations to support the full sales process, from leads, to opportunities, to sales, to follow-up analytics. Within opportunities, sales organizations can capture a wide variety of information related to an opportunity, such as customer (account) and the products to be sold. They can use the supplied sales methods and sales stages to step the opportunity to its eventual conclusion.

In addition, account intelligence, sales actions, and historical sales analysis further enable salespeople to increase their win rates by offering data-driven pipeline management and recommendations for the next best sales action. For example, setting win probability variance thresholds and providing multiple recommendations per opportunity enables sales representatives to optimize their sales opportunities.

The following table lists opportunity features.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Support the sales life cycle</td>
<td>Create, manage, and close opportunities, supporting the entire sales life cycle. By integrating with leads, you can convert leads to opportunities. Post-sale, take advantage of supplied business intelligence reports related to sales.</td>
</tr>
<tr>
<td>Maintain opportunity information</td>
<td>Following are just some of the data that sales teams can capture for an opportunity:</td>
</tr>
<tr>
<td></td>
<td>• Accounts: You can associate an account (for example, a customer or prospect) with the opportunity.</td>
</tr>
<tr>
<td></td>
<td>• Opportunity owner: The person who creates an opportunity is automatically assigned ownership. You can change owner if needed.</td>
</tr>
<tr>
<td></td>
<td>• Contacts: You can associate contacts with an opportunity. In addition, you can specify a contact’s role, affinity, and influence level on an opportunity. A single contact can be marked as primary.</td>
</tr>
<tr>
<td></td>
<td>• Currency: The application supports multiple currencies at both the opportunity header and revenue-line levels.</td>
</tr>
<tr>
<td></td>
<td>• Budget: A Budgeted indicator lets you display whether the opportunity revenue amount has been budgeted by the customer, as well as the date that the budget was made available.</td>
</tr>
<tr>
<td></td>
<td>• Competitors and partners: You can associate partners and competitors with opportunities, both at the opportunity and revenue line levels.</td>
</tr>
<tr>
<td></td>
<td>• Marketing data: The Source field allows the association of sales campaigns with an opportunity.</td>
</tr>
<tr>
<td></td>
<td>• Mass update opportunities: Allow sales personnel to update several opportunity attributes at once on multiple opportunities.</td>
</tr>
<tr>
<td>Employ sales methodology</td>
<td>Your company can employ its own sales methodology by using the supplied sales methods and stages. For each sales stage, administrators can create action items (process steps), task templates, recommended documents, assessment templates, and required fields for use in opportunities. In addition, administrators can specify a different default win probability percentage for each sales stage.</td>
</tr>
<tr>
<td>Use Sales Coach for guided selling</td>
<td>Sales Coach, part of sales methods, guides salespeople through each step of the sales cycle with an organization’s own sales methodology and best practices. The action items (process steps), task templates, recommended documents, assessment templates, and mandatory fields set up by your</td>
</tr>
<tr>
<td>Feature</td>
<td>Details</td>
</tr>
<tr>
<td>---------</td>
<td>---------</td>
</tr>
<tr>
<td>Leverage the product revenue model</td>
<td>Opportunities support a product revenue model that features revenue-based forecasting, products and product groups, recurring revenue, and revenue data captured at the line level, such as win probability, close date, include in forecast, and status.</td>
</tr>
<tr>
<td>Support recommended actions</td>
<td>Prompts salespeople to respond to the next best set of recommended actions for customer engagement, drive pipeline and determine how often to reach out to customers post sales. The following lists some of the benefits of the next best sales action feature:</td>
</tr>
<tr>
<td></td>
<td>• Support multiple recommendations per opportunity.</td>
</tr>
<tr>
<td></td>
<td>• Enables smarter sales experiences and optimizes the selling process.</td>
</tr>
<tr>
<td></td>
<td>• Provides a percentage win probability in comparison to other opportunities from your sales organization or a prediction about the close date of the opportunity. For example, based on historical data, the likelihood to close an opportunity is less than 40%.</td>
</tr>
<tr>
<td></td>
<td>• Supports user feedback per opportunity.</td>
</tr>
<tr>
<td></td>
<td>• Enables administrative and supervisory controls. For example, manage the win probability variance thresholds for opportunities and define user actions to suit the organization’s requirements. As salespeople update the opportunity information, win likelihood and recommended actions are regenerated.</td>
</tr>
<tr>
<td>Assign sales team</td>
<td>Opportunities align with territories and the assignment engine for rule-based or territory-based autoassignment of salespeople to opportunities. In the team pages, you also can manually add sales team members to an opportunity.</td>
</tr>
<tr>
<td>Allocate sales credit</td>
<td>By allocating sales credit to salespeople on product lines, you can capture the amount of credit salespeople receive for the sale. You can track direct, channel, and overlay resources and their contributions using revenue and nonrevenue credit splits.</td>
</tr>
<tr>
<td>Use forecast territories on product lines</td>
<td>By integrating with forecasting, you can use forecast criteria to automatically include product-line revenue in the forecast. You can leave the default forecast territory on the product lines or assign another forecast territory. The forecast is refreshed in real-time from revenue when an opportunity is created or updated.</td>
</tr>
<tr>
<td>Assess opportunities and their products, contacts, and competitors</td>
<td>You can use assessments to evaluate the health of an opportunity or an opportunity product, contact, or competitor. After setup by the administrator, assessments are available to salespeople in the Assessments tab.</td>
</tr>
<tr>
<td>View business intelligence reports</td>
<td>Several supplied business intelligence reports give you views into sales metrics, from lists of opportunities and accounts, to pipeline data, sales team performance, and other revenue metrics.</td>
</tr>
</tbody>
</table>

**Related Topics**

- Opportunity Products and Revenue: Overview
- Sales Credits: Overview
- Sales Methods, Sales Stages, and Sales Coach: Overview
- Sales Prediction: Overview
Working with Opportunities

What opportunities are displayed for My Open Opportunities and Open opportunities where I am on the team?

Selecting the **My Open Opportunities** list in the Opportunities work area landing page displays a list of all of the open opportunities expected to close within the current calendar or fiscal period where you are listed as the opportunity owner. You are automatically the opportunity owner if you created the opportunity. You also can be assigned as the owner by someone else.

Selecting the **Open opportunities where I am on the team** list displays a list of all of the open opportunities expected to close within the current calendar or fiscal period where you are on the opportunity team. You are on the opportunity team if you created the opportunity or you can be assigned to the team either by an automatic assignment process or by another team member.

What do the opportunity saved searches mean?

In the opportunities landing page, several different saved searches retrieve specific sets of records.

The following table lists and describes the record sets for opportunities. Not all record sets are available to all users. For example, the record sets involving subordinates are available only to managers.

<table>
<thead>
<tr>
<th>Record Set Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>I own</td>
<td>Opportunities you own include those opportunities you created or where ownership is assigned to you.</td>
</tr>
<tr>
<td>I am on the team</td>
<td>Opportunities where you are on the opportunity team. You are on the opportunity team if you are the opportunity owner or if you were added as a member.</td>
</tr>
<tr>
<td>My territory</td>
<td>Opportunities in your sales territories.</td>
</tr>
<tr>
<td>My subordinates own</td>
<td>Opportunities owned by you and your subordinates.</td>
</tr>
<tr>
<td>My subordinates are on the team</td>
<td>Opportunities where you or your subordinates are on the opportunity team.</td>
</tr>
<tr>
<td>My territory hierarchy</td>
<td>Opportunities in your sales territories and all of their subordinate territories in the sales territory hierarchy.</td>
</tr>
<tr>
<td>All records I can see</td>
<td>Opportunities that you can view based on any of the following:</td>
</tr>
<tr>
<td></td>
<td>• Your opportunity team membership</td>
</tr>
<tr>
<td></td>
<td>• Sales territory assignments on opportunity, customer, or partner accounts</td>
</tr>
<tr>
<td></td>
<td>• Your position in the organization</td>
</tr>
<tr>
<td></td>
<td>• Security permissions</td>
</tr>
</tbody>
</table>
Can I sort opportunity searches by the last update date?

Yes, you can sort the records returned from your opportunity search by last updated date in descending order. Request your administrator to change the Opportunity List Sort profile option from N to Y. You can then quickly review and action recently updated opportunities.

Why did some fields change when I changed the sales stage?

When you move an opportunity from one sales stage to the next, the opportunity-level win probability increases to reflect the progress of the opportunity. The win probabilities of all product lines that are in sync with the opportunity-level win probability also change to match the opportunity-level probability.

During setup, the administrator can specify the default win probability for each sales stage.

Which fields or data is initially set on an opportunity?

Several fields are initially set to default values when you create an opportunity, as described in this topic.

Following are the fields initially set to default values when you create an opportunity:

- Sales Channel: Set to Direct
- Currency: Determined by the settings in user preferences
- Win Probability: Set to percentage determined by sales method or profile option
- Close Date: Set to 90 days from creation date
- Status: Set to Open
- Sales Method: Set to default sales method
- Sales Stage: Set to first sales stage in default sales method
- Owner: Set to user creating opportunity
- Revenue: Set to zero
- Worst Case: Set to zero
- Best Case: Set to zero
- Opportunity Number: Unique, application-generated number
- Created By: Set to user creating opportunity
- Creation Date: Set to current date
- Include in Forecast: Based on forecast settings

What information is required to create an opportunity?

Opportunity Name is the only field required to be filled out when creating an opportunity. Note, however, that the name and sales account combination must be unique. In other words, you cannot have two opportunities with exactly the same name and associated to the same sales account.
What happens if I change win probability?

If you change win probability at the opportunity level, the application updates the win probability of all opportunity product lines that are in sync. In addition, if you update win probability at the product level, the product lines included in the forecast may change, depending on whether the line matches forecast criteria or not.

How is the expected close date of an opportunity initially set?

When defining a sales method, administrators can insert the average close window of the sales method, in days. The value is then used to set the default close date of opportunities using that sales method.

What's a billing account on an opportunity?

A billing account on an opportunity is the customer's financial account to be used for the transaction.

How can I copy an opportunity?

While viewing the opportunity details, select Copy Opportunity from the Actions menu and enter a new, unique name for the opportunity.

What is copied when I copy an opportunity?

The application copies the following attributes when you copy an opportunity:

- Opportunity header attributes, including standard and user-defined fields
- Contacts
- Products:
  - Revenue information, such as quantity, unit price, revenue amount
  - Schedule information and the underlying scheduled transactions
  - Sales credits, including recipients, amounts, and percentages
  - User-defined attributes of revenue
- Sales team, including partner resources
- Source
- Partners
- References
- Competitors
- Leads
- User-defined child objects of the opportunity
The following are not copied:

- Notes
- Tasks
- Appointments
- Assessments
- Attachments
- Deal registrations

What happens to forecasted revenue when an opportunity is changed?

The current forecast is automatically updated to reflect the changes. Past forecasts remain unchanged. Scheduled processes synchronize changes to territories and update active forecasts.

Related Topics

- Forecast Synchronization: Explained

How do I delete an opportunity?

To delete an opportunity, open it for editing and click Delete Opportunity from the Actions menu.

After you delete an opportunity, it is no longer available in the application.

Applying Mass Update to Opportunities

You can update fields on multiple opportunities at once. For example, you can update the status or add comments for multiple opportunities at once.

You can modify several fields for each update. The following predefined fields are available for mass update:

- Account
- Budgeted
- Close Date
- Comments
- Currency
- Date Budget Available
- Estimated Deal Duration
- Include in Forecast
- Level of Risk
- Owner
- Primary Competitor
• Primary Contact
• Sales Stage
• Status
• Win Probability
• Win/Loss Reason

The following predefined fields cannot have a blank value:

• Currency
• Close Date
• Sales Stage
• Include in Forecast

Mass Updating Opportunities

Use the following procedure to update multiple opportunities at once.

1. In the Opportunities overview (also called the landing page or list page), enter the search criteria for the opportunities that you want to update, and click Search. The application returns a list of results based on your search criteria.

2. From the Actions menu, click Update.

3. Click the opportunities you want to update.

4. After you have made your selections, click Update. The Update Opportunities page appears. The page title indicates how many opportunities you are updating.

5. In the Field column, select a field that you want to update. After you make your selection, the application activates the Value column for data entry or selection.

6. In the Value column, assign a value for the selected field.

7. Click Submit to commit the changes.

8. Click Done in the confirmation page to return to the overview page.

Recommended Actions for Opportunities

Recommended Actions for Opportunities: Overview

Opportunities allow organizations to support the full sales process, from leads, to opportunities, to sales, to follow-up analytics. Within opportunities, sales organizations use the supplied sales methods and sales stages to step the opportunity to its eventual conclusion. Account intelligence, sales actions, and historical sales analysis further enables salespeople to increase their win rates by offering data-driven pipeline management and recommendations for the next best sales recommended actions. For example, setting win probability variance thresholds and providing multiple recommendations per opportunity help sales representatives optimize their sales opportunities.

Using the recommended actions feature enables sales representatives to know which opportunities to focus on, which ones are at risk to close, and specifically, what is the next best recommended action to take to close opportunities.
Your administrator must enable the Enable Adaptive Intelligence profile option (ZCA_ENABLE_ADAPTIVE_INTELLIGENCE) and extend the opportunity detail page to display the Recommended Actions section and related steps in the Opportunity UI. The following table lists some of the ways recommended actions can help close deals:

<table>
<thead>
<tr>
<th>Feature</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Smarter sales experiences and optimizes the selling process</td>
<td>Enable salespeople to identify best opportunities to pursue based on:</td>
</tr>
<tr>
<td></td>
<td>• Current and past deal assessments</td>
</tr>
<tr>
<td></td>
<td>• Opportunities needing most attention</td>
</tr>
<tr>
<td></td>
<td>• Sales volatility</td>
</tr>
<tr>
<td>Multiple recommendations per opportunity</td>
<td>Prompt salespeople to respond to the next best set of actions for customer engagement, for driving the sales pipeline, and for determining how often to reach out to customers post-sales. For example, provide the relevant data to:</td>
</tr>
<tr>
<td></td>
<td>• Perform competitive analysis through competitive data alert messages.</td>
</tr>
<tr>
<td></td>
<td>• Initiate a follow-up call with the customer.</td>
</tr>
<tr>
<td></td>
<td>• Focus on the top five deals, to reduce sales volatility.</td>
</tr>
<tr>
<td></td>
<td>• Determine the likelihood of closing an opportunity.</td>
</tr>
<tr>
<td></td>
<td>• Provide a percentage win probability in comparison to other opportunities from your sales organization or a prediction about the close date of the opportunity. For example, based on historical data, the likelihood to close an opportunity is less than 40%.</td>
</tr>
<tr>
<td>User feedback per opportunity</td>
<td>Enable salespeople to provide feedback such as to how helpful, or not, are the recommended next best actions provided for the opportunity. Salespeople can select the recommended action they completed or signify whether or not the suggested action was helpful.</td>
</tr>
<tr>
<td>Administrative controls</td>
<td>Enable sales administrators to manage the win probability variance thresholds for opportunities. As salespeople update the opportunity information, the application regenerates win likelihood probability and recommended actions.</td>
</tr>
</tbody>
</table>

**Recommended Actions for Opportunities: Explained**

Recommended actions in opportunities are prompts provided to salespeople with suggestions about how to reduce the risk of opportunities being lost. The prompts, which leverage adaptive intelligence data, guide salespeople by suggesting which actions can improve the likelihood of winning and closing deals. Salespeople can regenerate the win likelihood and recommended actions by providing feedback and updating information for the opportunity.

**Recommended Actions**

Using adaptive intelligence, system learning, and other data science capabilities, optimized recommended actions and predicted win likelihood data is presented to you for Opportunities. Recommended actions provide insights into the possible issues in the opportunity, and suggest recommended actions to improve your chances of winning the opportunity. You engage with those opportunities requiring most attention and move them to the next sales stage. For example, suppose the role marked as the primary contact on an opportunity correlates with a low win rate in the past. The reason might be that this contact isn't the decision maker in the customer organization. Therefore, the adaptive intelligent algorithm recommends that you check that the primary contact is the decision maker.
Other examples of recommended actions include the following:

- Schedule an appointment
- Focus on the top five deals to reduce sales volatility
- Perform competitive analysis
- Other opportunity-specific recommended actions prompted to move a deal to the next sales stage and closer to win

Feedback on Recommended Actions

When you select a recommended action for a specific opportunity, a dialog box appears which provides additional information about the recommended action along with a link to any additional recommended actions to take for the selected opportunity. After reading the explanation or after you perform the action, you can signify whether or not the suggestion was helpful. You can also indicate whether the recommended actions were helpful in moving the opportunity to the next stage.

You provide feedback by clicking either **Good Suggestion** or **Not Helpful**. As soon as you provide your feedback, the recommendation isn’t visible anymore.

Creating a Task from Recommended Actions

You can create a task for each recommended action by clicking the **Task** icon from the contextual Recommendations dialog box. You can also create a task from the edit opportunity's recommended region page by clicking **Create Task** to create a related task for yourself.

FAQs for Recommended Actions for Opportunities

What's the difference between win probability and predicted win probability?

Win probability represents the likelihood (in percent form) of winning the opportunity. You manually set the win probability at the opportunity level for the sales stage. If you don’t want your sales stages to control opportunity win probability, make sure that no value exists in the win probability field.

The predicted win probability displays the automated predicted win probability based on adaptive intelligence (AI), system learning, and other data science capabilities. It provides a percentage of the predicted win probability in comparison to other opportunities from your sales organization or a prediction about the close date of the opportunity. For example, the adaptive intelligent models might suggest a win probability for an opportunity that’s significantly different to the salesperson’s estimation. In that case, your sales application displays a warning icon on the Opportunities page.

You can hover over a warning indicator icon next to the **Win Probability (%)** field which is displayed only when the differences between the win probability percentage value and the predicted win probability percentage value is greater than the defined threshold. The text is read only and displays both win and AI predicted probability values as well as the Opportunity name.

Related Topics

- Setting the Opportunity Win Probability Risk Threshold Profile Option
Adding Team Members to Opportunities

Video

Watch: This tutorial shows you how to add team members to an opportunity. The content of this video is also covered in text topics.

Procedure

You must have Full or Edit access control privileges to add or remove team members to or from an opportunity. From the opportunity team page, you can add team members to the opportunity team. You can also view assigned territories and the associated territory team members on the opportunity team by selecting Territories from the Show list of values. With View Only access, you can view team members but not update them.

Adding a Team Member to an Opportunity

As owner of the opportunity you are listed on the opportunity team page as the owner with Full access.

Use the following procedure to add a member to an opportunity.

1. Sign in to the application as a user with access to opportunities, such as a salesperson or sales manager.
2. Navigate to Sales > Opportunities.
   The opportunity landing page displays your opportunities.
3. Find an opportunity and edit it. Or, create an opportunity and save and edit it.
4. From the Edit Opportunity page, click the Team icon to open the Team page.
5. Click Add Team Members.
6. Search for the team member you want to add to your opportunity team.
7. Select the team member you want from the Search Results, then click OK.
8. Select the access level control for the team member’s privileges from the Access list of values.
9. Select the function for the team member from the Function list of values.
10. Click Save to add the team member to the opportunity team.

You can change the primary owner of the opportunity by selecting Owner from the team page.

Note: You can remove a team member from the opportunity team by clicking the delete icon denoted by X next to the team member. However, you cannot remove the owner from the opportunity team.

Related Topics

• Account Team Member Access Levels: Explained

Using Sales Coach
Video

Watch: This tutorial shows you how you can use Sales Coach to view action items, get recommended documents, and access assessments while editing an opportunity. The content of this video is also covered in text topics.

Overview

Sales Coach is a mechanism to present best practice sales methodology to help salespeople improve their sales effectiveness. A teaching tool, Sales Coach can help less experienced salespeople with aspects of an opportunity when and where they need help. Administrators set up Sales Coach by associating action items and recommended documents with a sales stage. Salespeople can then view these items as they work their opportunities. Since the teaching components or job aids are associated with a specific sales stage, each sales stage potentially can have multiple action items and recommended documents associated with it.

Following are the areas that administrators can define for each sales stage:

- Action items (process steps)
- Recommended documents

Action Items

Action items are steps you should follow during a sales stage. For example, in Discovery, your company may recommend that you interview the potential customer, develop a product list, and schedule a presentation.

Recommended Documents

Recommended documents are helpful documents and resources, such as customer letter templates, relevant websites, and training materials.

Related Topics

- Sales Methods, Sales Stages, and Sales Coach: Overview

Access to Opportunities

How Sales Users Gain Access to Opportunities: Explained

This topic explains how the security reference implementation provided by Oracle determines who can access what opportunity information in your sales organization.

Whether or not you can access a particular opportunity depends on your membership in the resource and territory hierarchies. You can access an opportunity if:

- You create the opportunity.
- You are on the opportunity sales team.
- The opportunity owner or sales team member is your direct or indirect report in the resource hierarchy.
• You are the owner or are a member of the territory assigned to the opportunity.
• You are the owner or member of an ancestor territory of the territory assigned to the opportunity.
• You are assigned to a territory for the account associated with the opportunity.
• You are assigned to a territory that is an ancestor of the territory for the account associated with the opportunity.

Salespeople can see all opportunities related to their accounts. However, access differs between territory members and opportunity members:

• An opportunity owner gets full access to the opportunity, which includes the ability to edit as well as add and remove team members.
• Owners and members of territories or of ancestor territories assigned to the account of the opportunity get read-only access to the opportunity and are not added to the opportunity sales team.
• Owners and members of territories assigned to the opportunity product lines are added as a distinct list of territories to the opportunity sales team. Owners and members of these territories get full access to the opportunity. Depending on a profile option, either only the owner or all the members of the territory are added as resources to the opportunity sales team. Regardless of the access level for these members as a resource on the opportunity team, they always have full access.

Owners and members of ancestor territories of the territory assigned to the opportunity do not get added to the opportunity sales team but they always get full access.

The following figure illustrates some of the different ways you can gain access to an opportunity:

• Named agents in the diagram (A, B, and C) can access the opportunity.
• Unnamed agents (highlighted in yellow) cannot access the opportunity.
• Sales managers can access the opportunity because a salesperson in their management chain has access.
This figure shows who in a sales hierarchy can access an opportunity.

- Agent A can access the opportunity because she created it. When you create an opportunity, you are the initial owner.
- Agent B can access the opportunity because he is on the sales team.
- Agent C can access the opportunity because he is the owner of the NW territory.
- Sales managers who are higher up in the management chain can also see the opportunity because access is provided through the resource hierarchy. Agent C’s manager can access the opportunity information, but agent C’s colleagues cannot.
- Sales administrators can access the opportunity.

**Note:** Access using accounts is not shown in this figure.

### Special Access

Some access is not affected by the management hierarchy and membership in sales teams or territories. This special access includes:

- **Administrators:** Users assigned the Sales Administrator job role get full access to opportunities and other objects. This access is based on their privileges, regardless of where the administrators are in the management hierarchy. Administrators do not have to be on the sales team or members of territories.

- **Deal Protection:** Salespeople assigned to an opportunity retain the sales credit on an opportunity even if they are moved to another opportunity.

### Why can't I edit some fields for an opportunity?

Salespeople can see all opportunities related to their accounts. However, depending on how your opportunity access profile has been set up, your access may be different between territory members and opportunity members. If you are listed as the owner of the opportunity, you have full access to the opportunity, which includes the ability to edit as well as add and remove team members. If you are a territory or ancestor territory member assigned to the account of the opportunity, you can edit some fields in the opportunity record, but you can't make changes to the team or change the record ownership.

For example, the following fields in the edit opportunity page are not editable for territory or ancestor territory members:

- Name
- Account
- Primary Contact
- Owner
- Status
- Currency
- Sales method
- Sales Stage
- Primary Source

### Why can't I see the Partners tab and Primary Partner field when I edit an opportunity?

You need specific user roles to see partner functionality in opportunities. Contact your administrator for more details.

**Note:** If administrators removed some fields from the opportunity page layout, then you won’t see the Partners tab, the Primary Partner field, and the partner column on the revenue line in opportunities even if you have the correct user roles.
Managing Sales Competitors

Introduction to Sales Competitors

Associate competitors with opportunities so that you can get insight into your competition on a deal. After you (or an administrator) enter information on the competition into the application, you have access to important data that can help you work the deal, including:

- Details about the competitor, such as: stock symbol, website, industry, and geography
- Threat level, such as: high, medium, or low
- Experts who have knowledge about the competitor
- Collateral about the competitor, such as data sheets and the like
- Opportunities where the competitor is associated
- Revenue at stake, which is potential revenue that could be lost
- Notes about the competitor

Associating Competitors with Opportunities

When you’re ready to enter competitor information on a deal, link competitors at the opportunity-level or at the product-line level. Once linked, the competitor and opportunity are associated in the competitor’s profile screens (available in sales but outside of the opportunities UI). The revenue amount entered on an opportunity drives the revenue-at-stake metric, also available in the competitor profile screens. See the related topics for more information.

⚠️ Note: Depending on how the application is configured, you may be required to enter a competitor when you close an opportunity.

Viewing Competitor Information Outside Opportunities: Procedure

Sales administrators can store a variety of details about sales competitor companies. As a salesperson, you can associate competitors with opportunities. You can also use competitor details when you want specific information about a competitor during a sales deal.

Use the following procedure to view competitor information.

1. Sign in as a sales user, such as a salesperson or sales manager.
2. Click the Competitors icon in the navigator.
   
   The list of competitors displays.
3. Select a competitor in the list.
   
   The Edit Competitor page appears.
4. View the details of the competitor.
   
   The following table shows the competitor profile information.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Organization Name</td>
<td>Name of the competitor.</td>
</tr>
<tr>
<td>Name Suffix</td>
<td>Value appended to the name of the Organization Name for the competitor.</td>
</tr>
<tr>
<td>Chief Executive Name</td>
<td>Name of the competitor company’s chief executive officer or highest-level employee.</td>
</tr>
<tr>
<td>Line of Business</td>
<td>Line of business of the competitor company’s products.</td>
</tr>
<tr>
<td>D-U-N-S Number</td>
<td>Dun &amp; Bradstreet Corporation unique nine-digit identification number for the competitor company.</td>
</tr>
<tr>
<td>Organization Size</td>
<td>Size of the competitor company.</td>
</tr>
<tr>
<td>Year Established</td>
<td>Year the competitor company was first started.</td>
</tr>
<tr>
<td>Threat Level</td>
<td>Perceived threat level of the competitor in closing deals, such as low, medium, and high.</td>
</tr>
<tr>
<td>Year Incorporated</td>
<td>Year the competitor company was first incorporated.</td>
</tr>
<tr>
<td>Stock Symbol</td>
<td>Stock symbol for the competitor company in the financial markets.</td>
</tr>
<tr>
<td>Fiscal Year End Month</td>
<td>Month that the competitor company closes its fiscal year.</td>
</tr>
<tr>
<td>Dun &amp; Bradstreet Corporation Credit Rating</td>
<td>Credit rating of the competitor company with Dun &amp; Bradstreet Corporation.</td>
</tr>
<tr>
<td>Privately Owned</td>
<td>Indicates the competitor company is privately owned.</td>
</tr>
<tr>
<td>Minority Owned</td>
<td>Indicates that the competitor company is minority owned.</td>
</tr>
<tr>
<td>Small Business</td>
<td>Indicates that the competitor company is a small business.</td>
</tr>
<tr>
<td>Status</td>
<td>Status of the competitor record, either active or inactive.</td>
</tr>
</tbody>
</table>

The following table shows the information available in the details tabs of the Edit Competitor page.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SWOT Analysis</td>
<td>Strength, weakness, opportunity, and threat (SWOT) value for a competitor. This analysis helps you understand, plan, and craft an effective competitive strategy when facing a competitive threat on a deal.</td>
</tr>
<tr>
<td>Product groups</td>
<td>Product groups the competitor company is associated with. You can associate product groups using the Competitive Presence node in the desktop UI customer pages.</td>
</tr>
</tbody>
</table>
## Item | Description
--- | ---
Opportunities | View historical and current opportunities associated with the competitor.

Attachments | Attachments are files, free-form text, or URLs that can give you information that helps you position products or solutions against specific competitors.

Internal Experts | Internal experts are people in your company who are experts on the competitor.

Geographies | Geographies where the competitor company is present.

Industries | Industries where the competitor competes with your company.

You can also view revenue at stake for the competitor. The Revenue at Stake area in the Edit Competitor page shows the revenue that potentially could be lost to the competitor. The data comes from product or product group revenue on the opportunities where the customer is present.

Additionally, you can view notes associated with the competitor, if entered by the administrator. Notes are stored in the contextual area of the Edit Competitor page.

### Associating Competitors with Opportunities: Procedures

You can associate competitor companies with opportunities in order to capture the competitive information for a deal. You can associate competitors at the opportunity level and additionally at the product-line level.

#### Associating a Competitor at the Opportunity Level

Use the following procedure to associate a competitor at the opportunity level.

1. Sign in as a sales user, such as a salesperson or sales manager.
2. Navigate to Sales > Opportunities. The list of opportunities displays.
3. Click the name of an opportunity to edit it. The Edit Opportunity page appears.
4. Depending on how the application is configured, you can access and modify competitors on the opportunity using the following methods:
   - Use the Competitors subtab: If the Competitors subtab is enabled, click the Competitors subtab and make your changes in the Competitors page.
   - Use the Primary Competitor or Competitors field: If they are enabled, these fields appear in the edit page.
5. In the competitor association pages, you can:
   - Search for and select a competitor to add to the opportunity.
   - Remove competitors from the opportunity.
6. Save your changes.

**Note:** In order to associate multiple competitors with an opportunity, more than one competitor must be set up in the application. Competitors are set up by the administrator.
Associating a Competitor at the Product-Line Level
Use the following procedure to associate a competitor at the product-line level on an opportunity.

Prerequisites:

- More than one competitor must be set up in the application. Competitors are set up by the administrator.
- The administrator must have enabled the Competitor field in the Products table using Application Composer.
- In order for a competitor to be selectable in the Competitor list of values in the Products table, it must first have been associated with the opportunity at the opportunity level. Competitors won’t show up in the list of values in the Products table unless they were first added to the opportunity at the header level.

1. Sign in as a sales user, such as a salesperson or sales manager.
2. Navigate to Sales > Opportunities. The list of opportunities displays.
3. Click the name of an opportunity to edit it.
4. In the Primary Competitor list, click Search.
5. Search for and select a competitor.
6. Click OK.
7. Save your changes.
8. Add a product line to the table.
9. In the Competitor list of values, select a competitor.
10. Save your changes.
11. Repeat this procedure to add additional competitors.

FAQs for Managing Sales Competitors

How can I view a list of opportunities that I have lost to a competitor?
You can view the list of opportunities from the details of the competitor record. The list is a consolidated view of past and current opportunities where the competitor is at play. It provides you useful insight to plan appropriate sales strategies.

How can I see the win/loss reason distribution between competitors?
You can use the competitor analysis graphs to see the distribution of either won or lost reasons for closed opportunities. You can get insight into the reasons behind your organization’s win-loss trends. You can further analyze the reasons for losing or winning against specific competitors. As a sales manager, you can use this analysis to improve your overall deal success rates and revenues. For more information, refer to the Creating and Administering Analytics guide.

How can I see win/loss trends against selected competitors?
The Win Loss Trends report displays the opportunity revenue won by your organization against competitors. The report shows the number of wins and losses, and closed-won opportunity revenue by quarter and by competitor. The report can also show overall opportunity won revenue and number of wins and losses regardless of whether there was a competitor on the opportunity.
How can I get more information about a competitor?

To better understand a competitor, speak to someone who has faced a similar situation before or someone who knows the competitor well. Access a list of your colleagues from the Internal Experts tab. The list contains experts who have prior experience with the selected competitor.

What's SWOT?

SWOT stands for: Strengths, Weaknesses, Opportunities, and Threats. The SWOT attribute in the Competitors feature of your sales application gives organizations a way to examine the strengths, weaknesses, opportunities, and threats of a competitor. SWOT analysis can provide insight into how a competitor's resources are mapped against the environment in which it is pitted against the deploying organization. As part of the competitor profile, SWOT provides a mechanism to plan, strategize and compete against your competition.

Assigning Opportunities

How are territories assigned to opportunities?

You can't explicitly add territories to an opportunity. Rather, the assignment engine automatically assigns territories to opportunity product lines by matching the dimensional attributes of product lines to territory dimensions, such as Customer Size or Industry.

When the assignment engine assigns territories to opportunity product lines, the territory owner is also copied to the opportunity team.

Profile options set by the administrator determine the following:

- Whether, when a territory is assigned to an opportunity product line, all territory team members are also copied to the opportunity team, in addition to the territory owner.
- Whether the assign opportunity action is available from within an opportunity for salespeople to run assignment.
- Whether the application runs assignment when salespeople save an opportunity.

Note: With partner integration, partner territories (territories whose sales channel dimension is equal to Partner) are not assigned to product lines. Partner organizations can only be associated with an opportunity manually, or they can be automatically associated through an approved lead registration.

Related Topics

- Opportunity Assignment: Overview
- Sales Account Assignment Object: Explained
How do I assign team members automatically to an opportunity?

While editing an opportunity, from the Actions menu, select Save and Run Assignment.

You must have Full access to the opportunity to see the Save and Run Assignment action.

💡 **Tip:** You can view assigned territories and the associated territory team members on the opportunity team in the opportunity Team pages.

Why can't I assign an opportunity?

You must have Full permission on an opportunity to see the Save and Run Assignment action.

Note that a profile option determines whether the assignment action is available in opportunities.

What's lock assignment?

Lock assignment prevents a salesperson from being automatically removed from an opportunity through the assignment engine. Only users with Full access on the opportunity can check or deselect the Lock Assignment check box for sales team members.

What's deal protection?

With the deal protection feature, all salespeople are automatically protected from being removed from a product line for which they are receiving sales credit, or from the opportunity team, when territory realignment happens. Deal protection applies to sales resources that get automatically assigned to product lines as credit recipients or to the opportunity team using territory-based assignment.

A profile option set by the administrator specifies the default number of days for which salespeople are protected. An opportunity team member with Full access level can override the dates for which the protection is active.

Closing Opportunities

Closing an Opportunity: Explained

You can close opportunities as needed, for example, when they are won, lost, or no longer active.

When closing an opportunity, you may be required to enter a win/loss reason and a competitor, if enabled during setup.

There are two ways to close an opportunity:

- Use the edit opportunity UI: See the topic, Closing an Opportunity Using Edit Opportunity UI, for more information.
• Use the update feature: See the topic, Closing Multiple Opportunities, for more information.

Closing an Opportunity Using the Edit Opportunity UI

You can use the Edit Opportunity page to close an opportunity by setting its status to one of the closed status categories and entering any required information.

Closing an Opportunity Using the Edit Opportunity Page

Use the following procedure to close an opportunity from the Edit Opportunity page.

1. Sign in as a salesperson and navigate to Sales > Opportunities.

   The opportunity landing page displays the list of your opportunities.

2. Find an opportunity and edit it.

3. From the Status field, select a status that belongs to a Closed status category. For example, select Won.

   The Close Date field changes to the current date.

   The Win/Loss Reason field becomes active.

   Note: The Win/Loss Reason and Competitor fields may or may not be required to be filled out, depending upon how the administrator has configured the closing behavior.

4. Select a Win/Loss Reason, if required.

5. Select a Competitor.

The following figure shows an example of the fields involved in closing an opportunity in the Edit Opportunity page.

6. Click Save or Save and Close.

   Tip: You can find closed opportunities by searching for them using the search utility.
Closing Multiple Opportunities

You can select several opportunities in the opportunity list and close them at once.

You must have Full or Edit access to the opportunities to update them.

Closing Multiple Opportunities at Once

Use the following procedure to close multiple opportunities at once.

> **Note:** If Competitor is a required field in the close opportunity flow, the opportunities you update must already have competitors associated with them before you attempt to update them.

1. Sign in as a salesperson and navigate to Sales > Opportunities.
2. In the Opportunities overview (also called the landing page or list page), enter the search criteria for the opportunities that you want to close, and click Search.

   The application returns a list of results based on your search criteria.
3. From the Actions menu, click Update.
4. Select the opportunities you want to close.

   To select multiple opportunities, hold the Ctrl key down as you select them. You can click the Select All link if you want to close all the opportunities up to a maximum of 25. Click Deselect All to undo your selection.
5. After you have made your selections, click the Update button.

   The Update Opportunities page appears. The page title indicates how many opportunities you are updating.
6. From the Field drop-down list, select Status.

   After you make your selection, the application activates the corresponding Value column for data entry or selection.
7. Select one of the values that belongs to a Closed status category. For example, select Won.
8. Enter a Win/Loss Reason, if enabled as required by your administrator.
9. If you want to enter a date to close your selected opportunities, enter Close Date in the Field drop-down list. Then enter a date to close the opportunities from the corresponding Value field.
10. Click Add if you want to add more fields to update for your closed opportunities.
11. Click Submit to commit the changes.

   A page appears, confirming that the changes were successfully applied.
12. Click Close in the confirmation page to return to the overview page.

**Related Topics**

- Synchronization of Opportunity and Product Line Attributes: Explained
Using Opportunity Search Close Period and Close Date Range Fields: Explained

The opportunity search fields Close Period and Close Date Range can be used together or separately.

Use the Close Period field to set the calendar period for the opportunity close date. Predefined values are Current Quarter, Previous Quarter, Next Quarter, Previous and Current Quarter, Current and Next Quarter. When you set a value in this field, the Close Date Range field automatically changes to the dates for the calendar period.

To use the Close Date Range separately, enter your own Close Date Range values instead. When you do, the application clears the Close Period list so that it displays nothing.

Examples of Field Actions

Following is an example of the Close Date Range and Close Date fields working together:

- The CRM calendar is defined as:
  - Q1 2014 - January 1 to March 31
  - Q2 2014 - April 1 to June 30

- In January 2014, you select Current Quarter in the Close Period field.
  - The application sets the default Close Date range as 01/31/2013 to 3/31/2013.

Following is an example of using the Close Date field by itself:

- You want to review opportunities for a five-month range: March 1 through July 31, 2014.
- In the Close Date fields, you select 03/1/2014 to 7/31/2014.
- The application clears the Close Period field and retrieves opportunities whose close date falls within the date range.

Performing Assessments

Performing an Opportunity Assessment: Procedure

Opportunity assessments let you evaluate the health of an opportunity. Assessments contain a series of questions and responses. After you answer the assessment questions and submit the assessment, the application returns a rating score and feedback that can help you better pursue the opportunity and increase the chance of winning the deal.

For example, you complete an assessment intended to determine whether an opportunity is healthy enough to offer the customer a 15 percent discount. Based on the assessment score, you and your manager determine whether the opportunity qualifies for the discount. Giving a discount increases the chance of winning the deal.

Assessments Available for Sales Stages

Assessments are enabled for a specific opportunity sales stage within the sales method being used on the opportunity. Assessments available in one sales stage may not be available in another sales stage.
Performing a New Assessment

Use the following procedure to perform a new opportunity assessment.

**Note:** You must have Full or Edit access on an opportunity to perform new assessments and update existing assessments. With View Only access, you can view assessments but not update them.

1. From the Navigator, click **Opportunities**.
2. In the list of opportunities, select an opportunity to edit it. The Edit Opportunity page appears.
3. Click the **Assessments** tab to open the Assessments page. Note the following behavior:
   - If only one assessment is available, it displays in the Assessments page, ready for entry.
   - If multiple assessments are available, the most recently created (by the administrator) assessment displays. You can use the Show list of values to select other assessments.
   - You can add assessments, provided more are available, by clicking Add Assessment and then selecting the assessment. The Add Assessment button displays only if multiple assessments are available.

After you submit an assessment, you cannot revise it.

Updating an In-Progress Assessment

Use the following procedure to update an assessment that’s in progress.

1. From the Navigator, click **Opportunities**.
2. In the list of opportunities, select an opportunity to edit it. The Edit Opportunity page appears.
3. Click the **Assessments** tab to open the Assessments page.
4. To retrieve the assessment you have in progress, click the **Show** list of values and select the assessment from the list. Note that the assessment that was worked on last is the one that will appear by default in the Assessment tab.

Deleting Assessments

Your administrator may have enabled the Delete Assessment button in the Assessments page. The delete action lets you delete an existing assessment. After you delete an assessment, it’s available to rerun using the Add Assessment button. Note that you must have Full or Edit access on the opportunity to delete an assessment.

Performing Multiple Opportunity Assessments Using the Same Template

From time to time, you might want to reassess your opportunity information and perform several assessments for opportunities using the same assessment template. To perform multiple assessments per template, your administrator must set the profile option Enable Multiple Assessments Per Assessment Template to Yes at the site level.

You can add assessments, provided more are available, by clicking Add Assessment and then selecting the assessment template. When you add another assessment for your opportunity using the same assessment template, the application automatically generates an assessment name using the assessment template name plus a counter suffix. If you have an existing assessment for an opportunity named Discount Eligibility V1, then if you add another opportunity assessment using the same template, the new assessment name is displayed as Discount Eligibility V2. You can edit this name to suit your own requirements.

When all questions are answered, the status of the assessment is set to Complete and continues to be editable. You can view all ongoing or historical assessments, scores, statuses, and template names. You can use the Delete and Submit
features only if the buttons are enabled by your administrator using Page Composer. You can delete an assessment that is no longer required or if it was created by mistake as long as it has not been submitted. The Submit button becomes available only when you have entered responses for all questions. You cannot edit the assessment once the status is set to Submitted but you can continue to view it.

Performing Multiple Assessments Using the Same Assessment Template

Before you begin, ensure that your administrator has set the Enable Multiple Assessments Per Assessment Template (MOW_MULTIPLE_ASSESSMENTS_ENABLED) profile option to Yes. You must also have Full or Edit access on an opportunity to perform multiple assessments and update existing assessments using the same assessment template. With View Only access, you can view assessments but not update them.

Use the following procedure to perform multiple opportunity assessments using the same assessment template.

1. From the Navigator, click Opportunities.
2. In the list of opportunities, select an opportunity to edit it. The Edit Opportunity page appears.
3. Click the Assessments tab to open the Edit Opportunity Assessments page.
   If existing assessments are available for the selected opportunity, they are listed here.
4. Click Add Assessment. The Add Assessment dialog appears
5. From the Template drop-down list, select the assessment template previously chosen for the selected opportunity assessment.
6. Click Save and Continue.
7. Select the appropriate responses to all the questions.
8. Click Submit and then click Yes from the confirmation dialog box.

   The assessment status is changed to Submitted.
After you submit an assessment, you cannot revise it.
Managing Opportunity Products and Revenue

Opportunity Products and Revenue: Overview

Salespeople typically add product groups or products to opportunities to record potential sales revenue while working the deal. After an opportunity is won and closed, the revenue from the products sold becomes actual revenue, for reporting purposes. Companies use opportunity revenue information for several reasons, such as analyzing sales pipelines and win/loss trends, monitoring the performance of salespeople, and generating revenue forecasts.

The following are typical tasks that a salesperson performs with opportunity products and revenue:

- Add products and product groups that the customer is interested in.
- Set product line revenue attributes, such as revenue amount, price, and quantity.
- Set other product line attributes, such as inclusion in the forecast, expected close date, win probability, and competitors.
- Enter and maintain recurring revenue schedules, such as those for subscription services or training plans.
- Allocate and manage sales credit amounts that opportunity team members receive.
- Run assignment in order to assign salespeople to the product lines.

Working with Opportunity Products

Managing Opportunity Products and Revenue: Procedures

You can add products or product groups to opportunities and then update the product lines, including revenue attributes, as needed.

Adding Products or Product Groups

Use the following procedure to add a product or product group to an opportunity.

1. Sign in to the application as a user with access to opportunities, such as a salesperson or sales manager.
2. Navigate to Sales > Opportunities.
   The opportunity landing page displays your opportunities.
3. Find an opportunity and edit it. Or, create an opportunity and save and edit it.
4. In the Products region, click Add to add a row to the table.
5. In the Type field, select Group if you are adding a product group. Select Product if you are adding a single product.

   Note: Depending on your implementation, you may have the option to browse the sales catalog. The catalog contains the same product groups and products as those accessible from the table.

6. Select the Name list, and then select the product group or product.
If the product group or product if it is not in the recently used items list, access the search page by clicking the **Search** link in the **Name** list.

7. In the Search page, the product groups or products you have access to may be automatically filtered to show only the products in your sales territories. To search all products in the database without the territory filtering, deselect the **Filter by Territory** option.

8. Select the product group or product and click **OK** to return to the Products table, where you can set other attributes of the product line, such as quantity, price, and so forth.

9. Save your work.

The following table explains the product line attributes.

<table>
<thead>
<tr>
<th>Product Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Select either product group or product.</td>
</tr>
<tr>
<td>Name</td>
<td>Use to select a product or product group. If individual products are not implemented, then only product groups are available.</td>
</tr>
<tr>
<td>Quantity</td>
<td>Enter values in whole numbers. The application multiplies this field by Estimated Price to calculate the revenue amount.</td>
</tr>
<tr>
<td>Estimated Price</td>
<td>Enter estimated price per item. The application multiplies this field by Quantity to calculate the revenue amount.</td>
</tr>
<tr>
<td>Amount</td>
<td>Amount used in forecasting and for reporting. The application calculated this field from price multiplied by quantity, but you can override the value.</td>
</tr>
<tr>
<td>Currency</td>
<td>The initial value is based on the opportunity-level currency. If multiple currencies are implemented, you can pick a different currency.</td>
</tr>
<tr>
<td>Sales Credit</td>
<td>Use sales credits to specify who gets revenue and overlay sales credit for the sale.</td>
</tr>
</tbody>
</table>

Depending upon how your application is configured, you may have the following additional product line attributes available.

<table>
<thead>
<tr>
<th>Product Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Close Date</td>
<td>Indicates the expected close date of the product line. The initial value is the opportunity-level close date, but each line can have its own close date.</td>
</tr>
<tr>
<td>Forecast</td>
<td>Displays a check mark if the product line matches the established forecast criteria.</td>
</tr>
<tr>
<td>UOM (Unit of Measure)</td>
<td>The initial value is based on the product or product group selected.</td>
</tr>
<tr>
<td>Status</td>
<td>Use to set the product line status, such as Open or Won.</td>
</tr>
<tr>
<td>Win Probability</td>
<td>The initial value is the opportunity-level win probability, but can be overridden.</td>
</tr>
<tr>
<td>Best Case</td>
<td>The initial value is the revenue amount for the item or group (providing Revenue is greater than Best Case).</td>
</tr>
</tbody>
</table>
Product Field | Description
--- | ---
Worst Case | Use to set a worst case revenue amount.
Include in Forecast | The application sets the initial value to *When matches forecast*, if forecasting criteria have been enabled. Can be overridden to **Yes** (meaning always include in forecast) or **No** (meaning never include in forecast), if forecasting criteria override has been enabled.
Territories | Displays the territories assigned to the product lines. You can drill down into the field to view all of the associated territories.
Competitor | You can set a competitor at product-line level. The choice list is limited to those associated at the opportunity level. Depending upon your implementation, you may be required to enter a competitor when setting an opportunity or product line to closed.
Win/Loss Reason | When a product line or the opportunity is closed, this field indicates why the product line was won or lost.
Actual Close Date | This is a read-only field set by the application automatically when you set a product line to a closed status.

For procedures on managing recurring opportunity products or product groups that are part of a subscription business model, see the topic, *Working with Recurring Opportunity Products: Procedures*.

Removing Product Lines
You can remove any products you do not need from the Products table in opportunities using the following procedure.

1. Sign in to the application as a user with access to opportunities, such as a salesperson or sales manager.
2. Navigate to **Sales > Opportunities**.
3. Find an opportunity and edit it. Or, create an opportunity and save and edit it.
4. In the Products region, click the X icon located at the end of the applicable table row to remove a product line from your opportunity.
5. Save your work.

Managing Recurring Products

Recurring Opportunity Products: Overview

Recurring schedules in opportunities let sales representatives enter and track opportunity products or product groups that are part of a subscription business model.

The subscription business model applies to the sale of goods, software, or services where the customer is required to pay a subscription price for access to the goods, software, or services, with additional usage or pay-as-you-go charges in some cases. Some examples are:

- Data and phone services
- Credit collection or payment processing services
- Software, platform, or data-as-a-service costs
• Magazine subscriptions
• Product life cycle costs
• Engineering and infrastructure services

The subscription model can encompass both business-to-business (B2B) and business-to-consumer (B2C) customers. For example, a telecommunications company may sell mobile phone services to individuals, and multiple phone lines to a business for their employees. The supplier of these services typically charges the customer a periodic rate applicable to the plan that they subscribed to.

After a sales representative defines a schedule for a subscription product or service, the application automatically creates the recurring transactions from the frequency and the number of transactions specified in the schedule. There are several time frequencies to choose from, such as weekly, monthly, quarterly, yearly, and so on. The multiple frequencies make it easy to set up a recurring schedule, like a monthly subscription for three years, or a biweekly annual subscription. Sales representatives can review the automatically-created schedule and quickly add a one-time registration or installation fee, and adjust the amount or date of any transaction.

Subscription changes are easy to manage. If there is a change in the terms or price of the subscription, sales representatives can quickly define a new schedule to replace the previous one. If the original subscription is extended, say, for another year, sales representatives can easily extend the existing schedule on the product for the period that you want.

Product amounts from recurring schedules are summed into the corresponding quarterly or yearly periods, and are readily available in pipeline reports and forecast rollups for sales representatives and sales managers.

Video

Watch: This tutorial shows you how to manage recurring revenue on opportunities. The content of this video is also covered in text topics.

Procedure

You use recurring transactions to enter and track opportunity products or product groups that are part of a subscription business model. Use the procedures in this topic to create and maintain recurring revenue schedules in opportunities.

Note: Recurring opportunities functionality is available only if your administrator has enabled it.

Creating a Recurring Revenue Schedule

Use the following procedure to create a recurring revenue schedule for a product or product group in the opportunities UI.

1. Sign in as a sales user, such as a sales representative or sales manager.
2. Navigate to Sales > Opportunities.

   The opportunity landing page displays your opportunities.

3. Edit an opportunity by clicking on the name in the list. Or, create an opportunity and save and edit it.
4. In the Products table, click the Add button and enter the details about the product or product group.
5. In the Schedule column, click the add icon (plus sign). The Set Schedule page appears.

   Enter data into the fields, using the guidance in the following table.
Field | Guidance
---|---
Frequency | Select a frequency that the revenue should be generated for. Note that:
  - Bi-Weekly is twice a month (every two weeks)
  - Bi-Monthly is every other month
Start Date | The default date is opportunity close date.
  - You can update the field to any other value (equal to or later than current date).
End By | Enter the number of transactions or a calendar end date.

**Note:** The number of transactions to include in your recurring revenue schedule for a product or product group should not exceed 500.

Quantity | Enter quantity of the product or product group being sold, as a whole number.
Amount | Enter the amount of the product or product group being sold.

6. Click **Next**. The Manage Schedule page appears. Note the following behavior:
  - The appropriate number of transactions are created based on frequency, start date, and number of transactions or end date.
  - The close date on each transaction is set to a value derived from the combination of frequency, start date, and end date.
  - Quantity and amount are repeated for each transaction.
  - Other values (like status, win probability percent, product, currency, and so on) are cascaded from the parent revenue line.
  - Transactions are ordered by ascending close date by default.
  - Total quantity and amount are displayed for the schedule. Total amount shows the applicable currency symbol of the product currency.

7. Review the transactions in the schedule and adjust as needed.

You can add a schedule transaction row by clicking the **Add** button and entering the required information.

8. Click **OK** to save the schedule. The application returns to the edit opportunity page.

9. Click **Save** or **Save and Close** to save the changes.

**Managing Scheduled Transactions**

All other of the other actions you can perform with an existing recurring schedule are done in the Manage Schedule page, available by editing the schedule.

You can:

- Edit the existing transactions in the schedule.
- Extend the schedule by entering new dates.
- Replace the schedule altogether.
- Delete the schedule.
Use the following procedure.

1. Sign in as a sales end user, such as a sales representative or sales manager.
2. Navigate to Sales > Opportunities.

   The opportunity landing page displays your opportunities.
3. Edit an opportunity by clicking on the name in the list.
4. In the Products table, click the edit icon in the Schedule column. The Manage Schedule page appears.
5. In the Manage Schedule page, perform, as needed, the actions in the following table.

<table>
<thead>
<tr>
<th>Action</th>
<th>Details</th>
</tr>
</thead>
</table>
| Edit schedule       | - To add a row to the transactions table, click the Add button and enter the required information.  
| transactions         | - To remove a row in the transactions table, click the X in the row.     |
| Replace a schedule  | - Click the Replace Schedule button.                                    |
|                      | - The Replace Schedule page behaves as if you are creating a new schedule. |
|                      | - Enter the new schedule details and save. The new schedule replaces the old schedule. |
| Extend a schedule    | - Click the Extend Schedule button to retrieve the Extend Schedule page. |
|                      | - Edit the schedule details as needed.                                  |
|                      | - Note the following behavior:                                          |
|                      |   • If the previous schedule had the number of occurrences stored, then that value is set as the default. |
|                      |   • The recurring quantity and recurring amount are set by default, based on previous values. If you update these to any other values, the resulting transactions are generated based on the updated values. |
|                      |   • If the start date of the new schedule is prior to the end of current schedule then the process will replace all existing transactions with a close date later than the new schedule’s start date. |
| Delete a schedule    | - Click the Delete Schedule button.                                      |
|                      | - Respond with Yes to the warning message.                               |
|                      | - All underlying scheduled transactions are deleted, and the schedule parameters on the parent line are removed. |
|                      | - The product line is converted to a standard revenue line and the quantity and amount field are set to blank. |

6. Click Save or Save and Close in the edit opportunity page to commit the changes made in the recurring schedules page.

Managing Sales Credits

Sales Credits: Overview

Companies use sales credits to report on salesperson performance and quota attainment, to aid in compensation calculation, and to facilitate forecasting by territories. Sales credit recipients and revenue amounts roll up the resource hierarchy for pipeline reporting and quota attainment.
You assign sales credits to sales resources (salespeople or other sales users) while editing product lines in opportunities. When a product line is first added to an opportunity, the application sets the user who added it as the sole sales credit recipient, receiving 100 percent of the sales credit.

There are two types of sales credit in opportunities:

- **Revenue sales credit**: Typically allocated to salespeople working the deal.
- **Overlay sales credit**: Typically allocated to other resources helping out with the deal, such as a product or market specialist. Overlay sales credit is also known as nonrevenue sales credit.

### Revenue Sales Credit

When assigning revenue sales credits, keep in mind:

- Only internal resources are eligible as revenue credit recipients.
- Revenue sales credits must add up to 100 percent.
- The Forecast Territory can be set to any territory assigned to the product line with Revenue or Revenue and Nonrevenue Forecast Participation.

### Overlay Sales Credit

When assigning overlay sales credits, keep in mind:

- Both internal and external (for example, partner) resources are eligible as nonrevenue credit recipients.
- Nonrevenue sales credits do not need to add up to 100 percent.
- If the selected Allocation Style is Proportional to Revenue, the sales credit amounts adjust automatically and proportionally when the product line amount changes.
- If the selected Allocation Style is Ad Hoc Amounts the sales credit amounts do not change with product line amount changes.
- The Forecast Territory can be set to any territory assigned to the product line with Revenue or Revenue and Nonrevenue Forecast Participation.

> **Note:** Territories with a Forecast Participation of Nonforecast are not eligible to be set as the forecast territory on either revenue or nonrevenue sales credits.

### Configuring Default Assignment

You can configure the revenue territory assignment defaulting logic to meet your specific business needs for reporting and forecasting the product amounts on an opportunity. See the article, Configuring Credit Recipients and Forecast Territories Assignment (Doc. ID 2089301.1), available on My Oracle Support (support.oracle.com).

### Manual Territory Assignment by Administrators

In the sales credits screens, sales administrators can manually assign a sales representative’s territory to a product line when the territory has not been assigned automatically. Manual assignment allows sales personnel to forecast an opportunity immediately while the territory setup is being reviewed and updated.

**Related Topics**

- Sales Credit Recipient and Forecast Territory Defaulting Logic: Explained
- Deal Protection on Opportunities: Explained
Allocating Sales Credits: Procedures

Your company can use sales credits to report on salesperson performance and quota attainment, to aid in compensation calculation, and to facilitate forecasting by territories. Sales credit recipients and revenue amounts roll up the resource hierarchy for pipeline reporting and quota attainment.

When a product line is first added to an opportunity, the application sets the user who added it as the sole revenue sales credit recipient (receiving 100 percent of the sales credit). For each product line, you can assign a portion or all of the sales credit from the product revenue to individual salespeople.

Note: You must have Full access to an opportunity to be able to assign sales credits.

Allocating Revenue Sales Credit

You typically allocate revenue sales credit to salespeople working the deal.

Use the following procedure:

1. Sign in as a salesperson or sales manager and navigate to Sales > Opportunities.
   The opportunity landing page displays the list of your opportunities.
2. Find an opportunity and edit it. Or, create, save, and edit an opportunity and then add a product line to it.
3. In the Edit Opportunity page Products table, click the edit icon in the Sales Credit column for the line you’re editing.
   The Edit Sales Credit window appears.
4. Click the Add Revenue Credit button to add another row to the sales credits table.
5. Select the drop-down list in the Name column for the new row. Select a name from the recently used list, or click Search to search for the salesperson.
   a. If searching, in the Select: Owner page, enter the search criteria for the user you want to allocate sales credit.
   b. In the search results, select the user and click OK.
6. In the table, enter the percent of sales credit for the user or an amount. With revenue sales credit, the total of all percentages entered must add up to 100 percent.
7. Optionally, in the Forecast Territory column, pick a territory to forecast the revenue in. The Forecast Territory can be set to any territory assigned to the product line with Revenue or Revenue and Nonrevenue Forecast Participation. The forecast territory is set automatically when the assignment process runs, so you can skip this step if you want to.
8. When you’re finished setting the sales credit, click OK.
9. In the Edit Opportunity page, save your changes.

Allocating Overlay Sales Credit

You typically allocate overlay sales credit, or nonrevenue credit, to other resources helping out with the deal, such as a product or market specialist.

Use the following procedure:

1. Sign in as a salesperson and navigate to Sales > Opportunities.
   The opportunity landing page displays the list of your opportunities.
2. Find an opportunity and edit it. Or, create, save, and edit an opportunity and then add a product line to it.
3. In the Edit Opportunity page Products table, click the edit icon in the Sales Credit column for the line you’re editing.
   The Edit Sales Credit window appears.
4. Decide which type of overlay credit you want to enter and then select that type from the Allocation Style list of values:
   o **Proportional to Revenue**: With this type, the sales credit amounts adjust automatically and proportionally when the revenue item amount changes.
   o **Ad Hoc Amounts**: With this type, the sales credit amounts do not change with revenue item amount changes.

5. Click the **Add Overlay Credit** button to add another row to the sales credits table.

6. Select the drop-down list in the **Name** column for the new row. Select a name from the recently used list, or click **Search** to search for the salesperson.
   a. If searching, in the Select: Owner page, enter the search criteria for the user you want to allocate sales credit.
   b. In the search results, select the user and click **OK**.

7. In the Edit Sales Credit window, in the **Sales Credit** column of the table, enter the percent of sales credit for the user. With overlay sales credit, the total of all percentages do not need to add up to 100 percent.

8. Optionally, in the Forecast Territory column, pick a territory to forecast the revenue in. The Forecast Territory can be set to any territory assigned to the product line with Revenue or Revenue and Nonrevenue Forecast Participation. The forecast territory is set automatically when the assignment process runs, so you can skip this step if you want to.

9. When you're finished setting the sales credit, click **OK**.

10. In the Edit Opportunity page, save your changes.

**Related Topics**

- What’s deal protection?

**How can I lock in a sales credit recipient?**

When assigning sales credits, you can lock the sales credit recipients of a revenue line by setting the corresponding Lock Credit Owner check box on the line. This setting prevents the recipient from automatic replacement when assignment is run. Generally, you don’t need to lock resources who are members of a forecast territory on the sales credit. However, you should consider locking ad hoc resources or non-territory-based recipients, such as partner resources, to prevent automatic assignment from removing them as credit recipients.

**Related Topics**

- Sales Credit Recipient and Forecast Territory Defaulting Logic: Explained

**Understanding Product Attribute Synchronization**

**Product Line Synchronization with Win Probability: Example**

When you change the win probability percentage on an opportunity, the application automatically resynchronizes any product lines whose win probability percentages were previously in sync with the opportunity win probability.
Scenario
The following example illustrates the behavior:

- Opportunity win probability is 50%.
- Product line 1 win probability is 50%.
- Product line 2 win probability is 50%.
- Product line 3 win probability is 40%.

You change the opportunity win probability to 60%. The application automatically changes the win probability for product lines 1 and 2 to 60% as well, because they were previously in sync with the opportunity-level win probability.

The win probability for product line 3 doesn't change, because it was not previously in sync with the opportunity-level win probability.

Related Topics
- What happens if I change win probability?

Synchronization of Opportunity and Product Line Attributes: Explained
Opportunities and their product lines share common attributes, for example, status or win probability percentage. For several attributes, under certain conditions, the application automatically synchronizes them so that they are the same. In addition, the application updates certain opportunity and product line attributes based on the values of other attributes.

The attributes that the application synchronizes or updates automatically are:

- Win probability
- Close date
- Include in forecast setting
- Status
- Win/loss reason
- Competitor

Note: An attribute is said to be synchronized if its opportunity and product line values are the same, and if the product line is in the same status category as its opportunity. If a product line and its opportunity both have undefined values, they are considered to have the same value.

Opportunity and Product Line Attribute Synchronization
The application synchronizes certain product line attributes based on the opportunity-level attribute, under certain conditions.

Synchronization occurs for the following attributes:

- Win probability
- Close date
- Include in forecast setting
- Status (not status category)
Consider the following example of close date synchronization:

- An opportunity with an Open status category has a close date of July 14, 2018.
- Product lines 1, 2, and 3 have the same close date and they are in the same status category.
- Product line 4 has a different close date, but the same status category.
- The close date of the opportunity is changed to August 14, 2018. The application automatically sets the close dates of product lines 1, 2, and 3 to the same close date as that of the opportunity. The close date of product line 4 remains unchanged, because it has close date that was not already synchronized with that of the opportunity.

Opportunity Status Updates
The following scenarios explain what happens when the opportunity status is updated:

- Opportunity status is updated to a Won status:
  - The application updates the opportunity win probability to 100 percent. It also updates all synchronized product lines’ win probability to 100 percent.
- Opportunity status is updated to a Lost or No Sale status:
  - The application updates the opportunity close date to the current date. It does not update the close date on synchronized product lines.
- Opportunity status is updated from an Open status to a Closed status:
  - The application enables the opportunity win/loss reason attribute.
  - If an opportunity primary competitor has been defined, the application updates the product line competitor to the opportunity primary competitor for all opportunity product lines, if they are not already defined. This action applies only to the close opportunity and mass update opportunities flows.
- Opportunity status is updated from a Closed status to an Open status:
  - The application disables the opportunity win/loss reason attribute.
  - The application sets the opportunity win/loss reason attribute to "undefined". It does not update the win/loss reason on synchronized product lines.

Product Line Status Updates
The following scenarios explain what happens when the product line status is updated:

- Product line status is updated to a Won status: The application sets the product line win probability to 100 percent.
- Product line status is updated to a Lost or No Sale status: The application sets the product line close date to the current date.
- Product line status is updated to a Closed status: The application enables the product line win/loss reason attribute.
- Product line status is updated to an Open status:
  - The application disables the product line win/loss reason attribute.
  - The application updates the product line win/loss reason attribute to "undefined".

Opportunity Win/Loss Reason Updates
When an opportunity is in an Open status, the opportunity win/loss reason attribute is disabled. Win/loss reason is activated when the opportunity is set to a Closed status. When the opportunity win/loss reason is updated, the application updates all opportunity product lines where the win/loss reason attribute is synchronized.
Opportunity and Product Line Competitor Updates

If a primary competitor has been defined at the opportunity level, when the opportunity status changes from an Open status to a Closed status, the application updates the product line competitor to the primary competitor for all lines that don’t already have a competitor.

**Tip:** If a product line without a competitor is set to closed and the opportunity is saved, the application displays a dialog box that allows you to copy the opportunity primary competitor to the product lines without competitors.

This action applies only to edit opportunity and close opportunity flows, not to the mass update flow.

**Related Topics**

- Setting Opportunity Revenue Forecast Criteria
12 Using Actionable Infolets

Overview of Actionable Infolets

Actionable infolets are transactional infolets that can co-exist on the same page as Business Intelligence (BI) infolets and provide a quick overview of pending tasks for salespeople, all available in a single place. Actionable infolets let salespeople quickly act from the infolet itself, without having to navigate to different detail views.

The following actionable infolets are available by default:

- My Tasks
- My Appointments
- My Leads
- My Opportunities

You can also view a graphical representation of the My Leads and My Opportunities infolets. The summary charts display lead and opportunity data based on the selected filters.

The predefined actionable infolets lets you quickly navigate to relevant areas where you can perform quick actions on individual records. You can improve your sales performance tasks by prioritizing and using filters. Filtering reduces the number of searches required to view any outstanding items that might require attention.

You can personalize your actionable infolets, refresh data, create and edit data as required. Built in configuration features help you effectively plan your day thus saving valuable time. For example, you can choose to select or hide predefined filters that you want to make available on the actionable infolets.

Related Topics

- Modify Actionable Infolets

Get Started with Actionable Infolets

Video

Watch: This video tutorial shows you how to use actionable infolets. The content of this video is also covered in text topics.

Procedure

Use predefined, actionable infolets to view important sales information at a glance. Use the infolets to quickly navigate to target areas and take immediate action. Improve your sales performance by prioritizing and using infolet filters. The infolets support do-not-contact functionality when displaying emails and phone numbers.
Take advantage of the following sales-oriented infolets:

- **My Tasks**
  Quickly work on your tasks and take action with minimum additional navigation.

- **My Appointments**
  Directly review, add, update, and add notes to your appointments. You can also access your calendar to create appointments.

- **My Opportunities**
  View, update, and add a note for your individual opportunities. You can drill down to edit an opportunity record as well as create opportunities.

- **My Leads**
  View newly assigned leads, accept or reject individual lead records without having to drill down to the leads landing page. You can also create a lead and drill down to edit individual leads.

### Infolet Filters and Actions

With a few clicks, navigate to the relevant areas in your sales process where you can perform quick actions at the record and infolet levels. For example, you can select a record to drill down and view or modify the details of the selected record. You can easily complete or defer tasks without having to drill down to view the record, or you can accept or reject new leads at the click of a button.

Here are the filters and actions available from the predefined actionable infolets:

<table>
<thead>
<tr>
<th>Actionable Infolet</th>
<th>Select one of these filters...</th>
<th>Take one of these record quick actions...</th>
<th>Take one of these infolet actions...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>My Tasks</strong></td>
<td>• Today’s Task (default)</td>
<td>• Mark as Complete</td>
<td>• Refresh</td>
</tr>
<tr>
<td></td>
<td>• Overdue Tasks</td>
<td>• Defer by 1 Day</td>
<td>• Create Task</td>
</tr>
<tr>
<td></td>
<td>• Tomorrow’s Task</td>
<td>• Defer by 2 Days</td>
<td>• Configure</td>
</tr>
<tr>
<td></td>
<td>• Beyond Tomorrow’s Tasks</td>
<td>• Defer by 1 Week</td>
<td>• Edit Title and Views</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Create Note</td>
<td>• Hide</td>
</tr>
<tr>
<td><strong>My Appointments</strong></td>
<td>• Today’s Appointments (default)</td>
<td>• Create Note</td>
<td>• Refresh</td>
</tr>
<tr>
<td></td>
<td>• Tomorrow’s Appointment</td>
<td>• Create Call Report</td>
<td>• My Calendar</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Configure</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Edit Title and Views</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Hide</td>
</tr>
<tr>
<td><strong>My Opportunities</strong></td>
<td>• Closing in Next 7 Days (default)</td>
<td>• Create Note</td>
<td>• Refresh</td>
</tr>
<tr>
<td></td>
<td>• Closing This Month</td>
<td></td>
<td>• Create Opportunity</td>
</tr>
<tr>
<td></td>
<td>• Closing This Quarter</td>
<td></td>
<td>• Configure</td>
</tr>
<tr>
<td></td>
<td>• Closing Next Quarter</td>
<td></td>
<td>• Edit Title and Views</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Hide</td>
</tr>
<tr>
<td><strong>My Leads</strong></td>
<td>• Unaccepted Leads (default)</td>
<td>• Accept</td>
<td>• Refresh</td>
</tr>
<tr>
<td></td>
<td>• My Open Leads</td>
<td>• Reject</td>
<td>• Create Lead</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Configure</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Edit Title and Views</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Hide</td>
</tr>
</tbody>
</table>
Sales-Oriented Actions

Using the actionable infolet actions menu, you can create tasks, appointments, notes and call reports as well as leads and opportunities. Here are more details about the create actions available from the predefined actionable infolets:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
<th>For More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Task</td>
<td>Create an appointment as follows:</td>
<td>For more information about creating an appointment, see the chapter Managing</td>
</tr>
<tr>
<td></td>
<td>1. Click the Actions icon on the top right corner of the My Tasks actionable</td>
<td>Activities and Calendar in the Using Sales guide.</td>
</tr>
<tr>
<td></td>
<td>infolet, and select Create Task.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2. From the Subject field, enter a short description that helps identify the</td>
<td></td>
</tr>
<tr>
<td></td>
<td>details of the task.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3. Select a due date for the task and enter other information about the task</td>
<td></td>
</tr>
<tr>
<td></td>
<td>as required.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4. Select Save and Close to return to the My Tasks actionable infolet.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>5. Ensure you select the correct filter.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>You can refresh your data by clicking the Actions icon on the top right</td>
<td></td>
</tr>
<tr>
<td></td>
<td>corner of the My Tasks actionable infolet, and select Refresh.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Create Appointment</th>
<th>You can add a new appointment to your calendar or to the team calendar, if one is enabled. Create an appointment as follows:</th>
<th>For more information about creating an appointment, see the chapter Managing Activities and Calendar in the Using Sales guide.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1. Click the Actions icon on the top right corner of the My Appointments actionable infolet, and select My Calendar.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2. Click Create Appointment.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3. From the Subject field, enter a short description that helps identify the details of the appointment.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4. Select an appointment type, such as a making a call or chatting with someone.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>5. Select the dates and times for your appointment.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6. Associate accounts, leads, and opportunities with the appointment, if required.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>7. Select Save and Close to go back to the My Calendar screen.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>8. Click Close to return to the My Appointments actionable infolet.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>You can refresh your data by clicking the Actions icon on the top right corner of the My Appointments actionable infolet, and select Refresh.</td>
<td></td>
</tr>
<tr>
<td>Action</td>
<td>Description</td>
<td>For More Information</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Create Note</td>
<td>You can create notes from the My Appointments, My Tasks, and My Opportunities infolets for any additional information that you want to record. From the ellipsis icon (quick actions), click Create Note. Select the note type you want and enter your note.</td>
<td>For more information about creating a note, see the chapter Managing Activities and Calendar in the Using Sales guide.</td>
</tr>
<tr>
<td>Create Call Report</td>
<td>Appointments are calendar events, for example, a meeting with another person or a scheduled phone call. You can create a call report from the My Appointments actionable infolets to record a brief summary of your call or meeting. From the ellipsis icon (Quick actions), click Create Call Report. From the Subject field, enter a short description that helps identify the details of the appointment. Select the dates and times for your appointment and any other details you want to provide.</td>
<td>For more information about creating a call report, see the chapter Managing Activities and Calendar in the Using Sales guide.</td>
</tr>
<tr>
<td>Create Opportunity</td>
<td>You can create an opportunity from the My Opportunities actionable infolet. Click the Actions icon on the top right corner and select Create Opportunity.</td>
<td>For more information about creating leads, see the chapter Managing Opportunities in the Using Sales guide.</td>
</tr>
<tr>
<td>Create Lead</td>
<td>You can create a lead from the My Leads actionable infolet. Click the Actions icon on the top right corner and select Create Lead.</td>
<td>For more information about creating leads, see the chapter Managing Leads in the Using Sales guide.</td>
</tr>
</tbody>
</table>

**Related Topics**

- Modify Actionable Infolets

**Personalize Actionable Infolets**

You can personalize actionable infolets from the Actions menu. For example, you can edit infolet titles and views, move, hide, or show specific infolets and refresh the data displayed. If enabled by the administrator, you can personalize the layout, record count, filters, and actions at the record level for each of your infolets.

The following information explains how to:

- Configure actionable infolets
- Edit infolet titles and views
- Move infolets
- Hide or show specific infolets on an infolet page
Configure Layout of Actionable Infolets

Once enabled, the Configure menu item from the Actions menu becomes available so that you can personalize the actionable infolets to suit your requirements. For example, you might want to change the layout and size of columns, as well as the locations of the fields being displayed. You might want to use your own saved searches as view filters or hide some of the quick actions that might not be relevant to you.

Here’s how to modify the layout of an actionable infolet:

1. Navigate to the actionable infolet that you want to modify.
2. From the actionable infolet that you want to modify, for example, My Opportunities, select **Configure** from the **Actions** menu.

   The My Opportunities actionable infolet screen is displayed with the predefined fields selected.
3. From the **Layout** tab, select the attributes that you want to edit from the respective drop-down lists.
4. Set and adjust the two column table widths in percentage terms by sliding your mouse along the Column Width ruler.
5. Make the changes that you want to the attribute and select another attribute to edit, if required.
6. In the **Drill Down Field**, select the item that you want to use for drilling down to the detail page of an opportunity.

   **Tip:** If Dynamic Choice List fields are added to the Actionable Infolet, then the drill down is automatically enabled.

This table shows the field names and associated attribute names that you can select for drill down for each of the actionable infolets:

<table>
<thead>
<tr>
<th>Actionable Infolet</th>
<th>Field</th>
<th>Attribute</th>
</tr>
</thead>
<tbody>
<tr>
<td>My Opportunities</td>
<td>Account</td>
<td>AccountName</td>
</tr>
<tr>
<td></td>
<td>Primary Contact</td>
<td>ContactName</td>
</tr>
<tr>
<td>My Leads</td>
<td>Owner</td>
<td>OwnerPartyName</td>
</tr>
<tr>
<td></td>
<td>Asset</td>
<td>AssetProduct</td>
</tr>
<tr>
<td>My Appointments</td>
<td>Account</td>
<td>AccountName</td>
</tr>
<tr>
<td></td>
<td>Primary Contact</td>
<td>PrimaryContactName</td>
</tr>
<tr>
<td>My Tasks</td>
<td>Account</td>
<td>AccountName</td>
</tr>
<tr>
<td></td>
<td>Primary Contact</td>
<td>PrimaryContactName</td>
</tr>
</tbody>
</table>

7. Click **Save and Close** when you have finished making the changes.

Configure Record Counts for Actionable Infolets

You can also change the predefined number of records to display on the infolet. By default, 10 records display. You can change the default to 10, 20, 25, or 30, as required.
Here's how to modify record counts for an actionable infolet:

1. From the actionable infolet that you want to modify, for example, My Opportunities, select Configure from the Actions menu.

   The My Opportunities actionable infolet screen is displayed.

2. From the Record Count tab, select the number of records that you want to display on the infolet from the drop-down list.

3. Click Save and Close.

Modifying Filters

Filtering reduces the number of searches required to view any outstanding items that might require attention. For example, you can choose to select or hide predefined filters that you want to make available on the actionable infolets.

You can show or hide filters, rearrange filters, and add custom filters. You can multiselect and double-click filters in the Available list to move them to the Selected list. However, you must select at least one filter for the actionable infolet filter list.

Here are the selected attributes that you can modify and represents the order as they appear on the UI.

<table>
<thead>
<tr>
<th>Actionable Infolet</th>
<th>Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td>My Tasks</td>
<td>• Today’s Tasks</td>
</tr>
<tr>
<td></td>
<td>• Tomorrow’s Tasks</td>
</tr>
<tr>
<td></td>
<td>• Overdue Tasks</td>
</tr>
<tr>
<td></td>
<td>• Beyond Tomorrow's Tasks</td>
</tr>
<tr>
<td>My Appointments</td>
<td>• Today’s Appointments</td>
</tr>
<tr>
<td></td>
<td>• Tomorrow’s Appointments</td>
</tr>
<tr>
<td>My Opportunities</td>
<td>• Closing in Next 7 Days</td>
</tr>
<tr>
<td></td>
<td>• Closing This Month</td>
</tr>
<tr>
<td></td>
<td>• Closing This Quarter</td>
</tr>
<tr>
<td></td>
<td>• Closing Next Quarter</td>
</tr>
<tr>
<td>My Leads</td>
<td>• Unaccepted Leads</td>
</tr>
<tr>
<td></td>
<td>• My Open Leads</td>
</tr>
</tbody>
</table>

Here's how to modify the filters of an actionable infolet:

1. Navigate to the actionable infolet that you want to modify.

2. From the actionable infolet that you want to modify, for example, My Opportunities, select Configure from the Actions menu.

   The My Opportunities actionable infolet screen is displayed with the predefined fields selected.

3. From the Filters tab, select the filters that you want to modify

4. Click Save and Close when you have finished making the changes.

Modifying Quick Actions

You can navigate to the relevant areas in your sales process where you can perform quick actions at the record level. For example, you can easily complete or defer tasks without having to drill down to view the record, or you can accept or reject new leads at the click of a button.
You can show or hide actions, rearrange actions, and add custom quick actions. For example, you can multiselect and double-click actions in the Selected list to move them to the Available list if you want to hide a quick action. However, you must select at least one action for the actionable infolet quick actions list.

Here are the selected quick actions that you can modify and represents the order as they appear on the UI.

<table>
<thead>
<tr>
<th>Actionable Infolet</th>
<th>Quick Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>My Tasks</td>
<td>• Mark as Complete</td>
</tr>
<tr>
<td></td>
<td>• Defer by 1 Day</td>
</tr>
<tr>
<td></td>
<td>• Defer by 2 Days</td>
</tr>
<tr>
<td></td>
<td>• Defer by 1 Week</td>
</tr>
<tr>
<td></td>
<td>• Create Note</td>
</tr>
<tr>
<td>My Appointments</td>
<td>• Create Note</td>
</tr>
<tr>
<td></td>
<td>• Create Call Report</td>
</tr>
<tr>
<td>My Opportunities</td>
<td>• Create Note</td>
</tr>
<tr>
<td>My Leads</td>
<td>• Accept</td>
</tr>
<tr>
<td></td>
<td>• Reject</td>
</tr>
</tbody>
</table>

Here’s how to modify the quick actions of an actionable infolet:

1. Navigate to the actionable infolet that you want to modify and make sure that the infolet displays in expanded view.
2. From the actionable infolet that you want to modify, for example, My Opportunities, select Configure from the Actions menu.
   The My Opportunities actionable infolet screen is displayed with the predefined fields selected.
3. From the Quick Actions tab, select the actions that you want to modify.
4. Click Save and Close when you have finished making the changes.

Edit Actionable Infolet Titles and Views
Here’s how to edit titles and views for actionable infolets:

1. Click the Actions icon on the top right corner of the actionable infolet, and select Edit Title and Views.
2. Edit the infolet title, and enable or disable the infolet views.
   The Enable option is automatically set to Yes. You cannot disable a view of an infolet.
3. Click Save and Close.

Move Actionable Infolets
To change the position of an actionable infolet within an Infolet page, click and drag the infolet, and drop it at the required position.

Hide or Show Actionable Infolets
To hide an actionable infolet from an infolet page, click the infolet repository icon, and deselect the actionable infolet from the list of infolets. Alternatively, click the Actions icon on the top right corner of the actionable infolet, and select Hide. To show a hidden infolet on an infolet page, click the infolet repository icon, and select the infolet from the list of infolets.
Related Topics

- Modify Actionable Infolets

FAQS for Using Actionable Infolets

How can I display actionable infolets?

Actionable infolets are mini-portals or infolets, that summarize key sales data and let you take immediate action on the tasks presented. The actionable infolets contain key metrics modified for sales roles in your organization. You can access the infolets from the page control area of your home page. Sales actionable infolets are part of other predefined sales infolets that are available from the Sales Infolets page.

To display the actionable infolets on the Sales Infolets page, click the infolet repository (gears) icon. Then select the check box next to the actionable infolets you want to display.

How can I increase the size of an actionable infolet?

The My Opportunities and the My Leads actionable infolets can be expanded to a larger view by clicking the expanded view icon located at the bottom right corner of the infolet.
# Managing Forecasts

## Sales Forecasting Features: Overview

Forecasting future sales is a method of providing predictions of future revenue for specific time periods. Management uses sales forecast data to set production schedules and volumes, to determine resource requirements, and to report financial guidance to investors.

The following table lists forecasting features:

<table>
<thead>
<tr>
<th>Feature</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Submit forecasts</td>
<td>Salespeople can view, manage, and submit their forecasts in the office and using the mobile application. Specifically, salespeople can:</td>
</tr>
<tr>
<td></td>
<td>• Review their forecasted product items and submit the forecast.</td>
</tr>
<tr>
<td></td>
<td>• View their unforecasted pipeline.</td>
</tr>
<tr>
<td></td>
<td>• Use embedded analytics to improve forecast accuracy.</td>
</tr>
<tr>
<td>View automatically generated forecasts</td>
<td>The forecast for a period is automatically generated from eligible opportunity product items scheduled to close within the period. Forecasts are refreshed from the pipeline revenue in real time. Opportunities and forecast items continue to synchronize until the salesperson submits forecast items for final approval.</td>
</tr>
<tr>
<td></td>
<td>The sales administrator sets the criteria that determine whether a product item is eligible to be automatically included in a forecast. The administrator also provides the option for salespeople to override the established criteria and manually include or exclude a product item from the forecast.</td>
</tr>
<tr>
<td></td>
<td>Forecasting reflects any edits made to an opportunity, or any adjustments made at the deal level in real time.</td>
</tr>
<tr>
<td>Forecast by territory</td>
<td>You forecast sales by territory. The forecasts roll up following the territory hierarchy. Changes to the active territory hierarchy are periodically synchronized with the forecast hierarchy up until a freeze date. After the territory freeze date, salespeople can make changes to their forecasts.</td>
</tr>
<tr>
<td>Compare forecasts</td>
<td>You can view current, future, and past forecasts. The current forecast is open for editing at certain times and then frozen. Sales managers can view the latest forecasting data and compare it to key metrics such as pipeline and won revenue.</td>
</tr>
<tr>
<td>Adjust forecasts</td>
<td>Sales managers can review and adjust their forecasts wherever they are.</td>
</tr>
<tr>
<td>Manage subordinates’ forecasts</td>
<td>Sales managers can quickly see which salespeople have submitted their forecasts, what has changed since the previous forecast, and the opportunities that comprise the forecast. Sales managers can also drill into their subordinates’ forecasts to view a forecast the same way that the salesperson sees it. This provides sales managers with the opportunity for more effective coaching and greater forecast accuracy.</td>
</tr>
<tr>
<td></td>
<td>Sales managers can add, remove, or adjust individual lines in a salesperson’s forecast, segment the totals by time period, and override forecast totals for each salesperson. Any adjustments are clearly identified throughout the forecast hierarchy, allowing management to quickly view the changes made by sales managers on their team.</td>
</tr>
</tbody>
</table>
### Adding Opportunity Items to Your Forecast

**Video**

Watch: This video tutorial shows you how to add opportunity line items to your sales forecast. The content of this video is also covered in text topics.

**Procedure**

To add forecast items to a forecast, navigate to Forecasts and click **Review**. Search for opportunity items on the Unforecasted Pipeline tab and add them to the forecast. For any forecast item with a warning icon, you must change any attributes that don’t meet the forecast criteria. When all attributes fall within the forecast criteria, the product item becomes part of your forecast.

You can also use a forecast override if the administrator enabled it for your territory. You can set the Forecast Option to **Always** to override the lack of matching forecast criteria. An icon warns you when a revenue item doesn’t match the forecast criteria and requires the forecast override.

If you are unable to edit the forecast item you are adding, then the item is added with the unadjusted forecast amount set to zero. However, the item now has a positive adjustment amount to match the original revenue item revenue amount. For example, if the revenue amount is 3,000, then the unadjusted forecast is 0, the forecast adjustment is 3,000, and the adjusted forecast is 3,000. You can further refine the adjusted forecast item amount, or remove the forecast item if you no longer want the item included in the forecast.

**About Forecasting by Territory, Product, or Unit**

You can forecast sales by territory and amount, by product and amount, or by product and quantity of units. A forecast covers a specified time period, such as quarter or month. A territory owner submits the current forecast to the owner of the parent territory, who is likely the owner’s manager.

The application generates the forecast by capturing information from opportunity lines as follows:

- Opportunity items are placed in time periods according to the planned or actual close date.
- Only opportunities that meet the forecast criteria are included in a forecast.
- Opportunities assigned to a territory are added to the forecast for that territory.
Forecasting Amounts by Territory
The territory owner forecasts the amount of sales for the territory by time period. The sum of the amounts for all included opportunity items is the forecast amount.

Salespeople and sales managers can then, for their territory:

- Manually add opportunity items to their forecasts or remove them.
- Change the amounts for individual forecast items.
- Make adjustments by changing the total forecast amount for individual time periods for a subordinate’s territory forecast.
- Make adjustments to the amounts for a subordinate’s forecast items.

Use the Edit Forecast page Territories tab and Forecast Items tab.

Forecasting Amounts by Product
Within the territory, the territory owner forecasts the amount of sales for each product by time period. The forecast amount for each product is the sum of the amounts from opportunity items for that product.

Salespeople and sales managers can then, for their territory:

- Manually add opportunity items to their forecasts or remove them.
- Change the amounts for individual forecast items.
- Make adjustments to the individual product amounts by time period.
- Make adjustments to the amounts for a subordinate’s forecast items.
- Make adjustments to the product amounts for a subordinate’s territory forecast.

Use the Edit Forecast page Products tab and Forecast Items tab.

Forecasting Unit Quantities by Product
Within the territory, the territory owner forecasts the quantities of each product by time period. The forecast quantity for each product is the sum of the quantities from opportunity items for that product.

Salespeople and sales managers can then, for their territory:

- Manually add opportunity items to their forecasts or remove them.
- Change the quantities for individual forecast items.
- Make adjustments to the individual product quantities by time period.
- Make adjustments to the quantities for a subordinate’s forecast items.

Use the Edit Forecast page Products tab and Forecast Items tab. In the Products tab, select to show Quantity or All Totals.

Managing Your Forecast
Video

Watch: This video tutorial shows you how to manage the forecast for your team. The content of this video is also covered in text topics.

Procedure

Sales managers review and adjust the forecasts of their sales teams. You can add or remove items from your or a subordinate’s forecast. When you make adjustments, you can adjust quantities and amounts directly for an opportunity item. You can also make adjustments for a territory and add amounts that do not come from existing opportunities.

Reviewing Your Forecast

To review your forecast:

1. During an open forecast time period, navigate to Sales Forecasts.
2. Review the graph to compare your group’s forecast with won revenue and the pipeline.
3. The second chart shows your group’s percentage of quota attained. Roll over the target quota amount to review quota and won revenue amounts.
4. Click the breadcrumbs to switch to your next forecast for review and back to your current forecast.
5. Click Review to see the details of your forecast.
6. Click Edit to make your changes.

Any subordinate forecasts that weren’t submitted by their owners will now be submitted for them.

Editing the Forecast

The Territories tab shows your team’s forecasts, won revenues, open pipelines and quotas. To edit your forecast:

1. Roll over the icons in the first column to see which territory owners submitted their forecasts.
2. Hover over the Forecast Change arrow to see what’s changed since you last submitted your forecast.
3. Click the Products tab.
4. Click Show and choose All Totals.
5. You can view and change the totals for current, best case, and worst case forecasts as well as the quantity for each product.

Adjusting Opportunity Items in the Forecast

You can adjust the forecast for accuracy in two ways. Edit the totals by product or adjust the opportunities that sum to the totals. To adjust your forecast:

1. Click the Forecast Items tab.
2. In the Show list, select one subordinate’s territory.
3. Select the opportunity item you want to change, and enter new values for quantity or forecast, or both.
4. Click the icon to remove an opportunity item.
5. Click Add Forecast Items to find an add a missing opportunity item.
6. Click Save.

The opportunity items you edited show the new values, and the forecast totals are recalculated.
7. Hover over a blue dot next to one of your changed opportunity items. You see the adjustment you made, as well as the un-adjusted forecast submitted to you by the salesperson. The salesperson can’t see any of the changes you made.

Adjusting and Submitting the Forecast
You can adjust the forecast by product and submit the forecast to your manager. To complete your forecast:

1. Click the **Products** tab. You can see the changes you made to the opportunities reflected in the respective product totals.
2. Deselect **Exclude All Rows with All Zero Values**. You can now see and adjust all products.
3. Make your changes to quantities and forecast amounts to any products, including those with zero values.
4. **Save** your forecast.
5. **Submit** your forecast to your manager.

You can make no further changes after submitting your forecast.

Sales Forecast Adjustments: Explained
Changes you make to the original forecast up or down are adjustments. If your forecast is by product, then you can adjust quantities as well as the amounts for individual forecast items.

Depending on your configuration, you can adjust the following:

- The amounts for individual forecast items
- The total amounts for each territory owned by your subordinates and by time
- The total amounts by product and also by time period for your territory
- The quantities for individual forecast items
- The total quantities by product and also by time period for your territory

Removing Adjustments
To remove all of your adjustments, go to the Actions menu and select Remove My Adjustments.

Copied Forecasts
If you copy the prior forecast, then your copy takes the total forecast numbers from the previous forecast, including adjustments, and pastes them into your current forecast. These numbers overwrite any calculated totals from rolled up opportunity or adjustment data.

Adjusted Best Case and Worst Case Forecasts
The adjusted best case forecast is the sum of:

- The best case for all forecasted items
- Item-level adjustments for the best case
• Any summary level adjustment to best case

The adjusted worst case forecast is the sum of:

• The worst case values for all forecasted items
• Item-level adjustments for worst case
• Any summary level adjustment to worst case

Forecast Adjustment Notes

If enabled, you can add a note to each forecast item you adjust and add one consolidated note for all summary adjustments. Each note includes who created the note and when you created it. You can edit the notes that you created. Managers and senior management can view notes within their territory hierarchy. You can create notes for the following:

• Forecast Items
  A sales manager can add a note to each item included in subordinates’ forecasts provided the item is not in won status. Use the Note column in the Items tab to add, edit, or delete an adjustment note for an item. A VP sees item adjustment notes added by subordinates. When the VP drills down into the manager territory forecast, he can add notes to items.

• Territory Summary
  This is a single consolidate note for all the territory summary adjustments that the user can make in the territories tab. A VP sees summary adjustment notes added by subordinates in the territory row of the Territories tab. When the VP drills down into the manager territory forecast, he sees the summary adjustment note added by the subordinate in the Territories tab.

• Product Summary
  This is a single consolidate note for the product summary adjustment you create in the products tab. A VP sees summary adjustment notes added by subordinates in the territory row of the Territories tab. When the VP drills down into the manager territory forecast, he sees the summary adjustment note added by the subordinate in the Products tab.

Copying the Prior Forecast: Explained

Use the Copy Prior Forecast action to ignore the rolled up opportunity data and copy the numbers from the previously submitted forecast to the current forecast. Your copy takes the total forecast numbers, including adjustments, and pastes them to your current forecast. These numbers overwrite any calculated totals from rolled up opportunity or adjustment data.

Forecasting Actions and Consequences: Explained

Salespeople modify their active forecasts during the submission window and submit them to their managers. Managers then adjust their forecasts and submit them to their managers.

The user actions described in the following table are available during the submission window, before a user submits his forecast. The only exception is the withdraw action, which is available after the user submits his forecast and before his manager also submits or adjusts her forecast.
The following table lists user roles, the actions they can perform, and the results:

<table>
<thead>
<tr>
<th>Role</th>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sales Representative</td>
<td>Make changes to opportunities</td>
<td>The forecast is updated to reflect changes.</td>
</tr>
<tr>
<td></td>
<td>Add or remove forecast items</td>
<td></td>
</tr>
<tr>
<td>Sales Representative</td>
<td>Submit his forecast</td>
<td>The forecast is frozen. The salesperson can’t make changes.</td>
</tr>
<tr>
<td>Sales Representative</td>
<td>Withdraw his forecast</td>
<td>The sales representative can again make changes to the forecast and resubmit. Forecast numbers now update from the pipeline.</td>
</tr>
<tr>
<td>Sales Manager</td>
<td>All actions of the sales representative also apply to the sales manager</td>
<td>All results of the sales representative also apply to the sales manager.</td>
</tr>
<tr>
<td>Sales Manager</td>
<td>Adjust numbers for forecast items</td>
<td>If previously unsubmitted, all subordinates’ forecasts are submitted and frozen when the manager edits his forecast. The subordinate’s forecast is frozen and can’t be changed by the subordinate. All direct and indirect subordinates can’t make changes unless the manager removes her adjustments and rejects each subordinate’s forecast. Forecast numbers no longer update from the pipeline. The adjustment becomes the current forecast and ignores the rollup values from current forecast items.</td>
</tr>
<tr>
<td></td>
<td>Adjust totals, including copy previous forecast totals to the current forecast</td>
<td></td>
</tr>
<tr>
<td>Sales Manager</td>
<td>Edit a subordinate’s unsubmitted or rejected forecast</td>
<td>The sales manager acts as the subordinate; therefore, all edits and adjustments can be seen by the subordinate. The sales manager can adjust the forecast only if the subordinate can adjust his own forecast.</td>
</tr>
<tr>
<td>Sales Manager</td>
<td>Submit a subordinate’s unsubmitted forecast</td>
<td>The subordinate’s forecast is frozen and can’t be changed by the subordinate. All direct and indirect subordinates can’t make changes unless the manager removes her adjustments and rejects each subordinate’s forecast. Forecast numbers no longer update from the pipeline.</td>
</tr>
<tr>
<td>Sales Manager</td>
<td>Remove adjustments</td>
<td>Adjustments are removed. Opportunity changes are ignored for as long as the subordinate’s forecast remains submitted.</td>
</tr>
<tr>
<td>Sales Manager</td>
<td>Reject a subordinate’s forecast</td>
<td>The application will clear all adjustments made by the manager to the subordinate’s forecast.</td>
</tr>
</tbody>
</table>
### Forecasting: Available Metrics

Metrics provide calculated measures based on historical or current transactional data. Salespeople can refer to metrics when making forecasting decisions. Your administrator enables one or more metrics. Disabling a metric hides the metric from the user interface and speeds up the execution time for certain background processes.

The following table shows the available metrics and how they are calculated:

<table>
<thead>
<tr>
<th>Metric</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Best Case Forecast</td>
<td>The best case forecast metric is the sum of all best case revenue values for all forecast items in the forecast period. You can enter the best case revenue amount when you change the product line details in an opportunity.</td>
</tr>
<tr>
<td>Closed Revenue</td>
<td>The closed revenue metric is actual revenue for the target territory that was closed during the forecast period.</td>
</tr>
<tr>
<td>Estimated Adjustment</td>
<td>The estimated adjustment metric is the sum of the difference between estimated revenue and revenue for all transactions in the forecast period. Sales Predictor uses statistical analysis to provide the estimated revenue amounts based on historical sales for the product.</td>
</tr>
<tr>
<td>Expected Forecast</td>
<td>The expected forecast metric is the sum of all weighted revenue values for all forecast items in the forecast period. Weighted revenue is the revenue amount multiplied by the probability of the deal closing.</td>
</tr>
<tr>
<td>Likelihood to Buy Product</td>
<td>The likelihood to buy product metric reflects the percentage of confidence that a deal will close with the specified revenue on the specified close date. Sales prediction uses statistical analysis to provide the likelihood to buy product based on historical sales for the product.</td>
</tr>
<tr>
<td>Pipeline</td>
<td>The pipeline metric is the total revenue amount of all product lines where the Status category is Open, the primary territory is the target territory, and the close date lies in the forecast period. Unforecasted pipeline is the total revenue amount of all product lines without a corresponding forecast item, where the status category is Open, the primary territory is the target territory, and the close date lies in the forecast period.</td>
</tr>
<tr>
<td>Metric</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Quota</td>
<td>The quota metric is the revenue target associated with the expected performance of a salesperson’s territory for a given forecast period.</td>
</tr>
<tr>
<td>Worst Case Forecast</td>
<td>The worst case forecast metric is the sum of all worst case revenue values for all forecast items in the forecast period. You can enter the worst case revenue amount when you change the product details in an opportunity.</td>
</tr>
</tbody>
</table>

**FAQs for Managing Forecasts**

**How can I remove forecast items from a forecast?**

You can click the item in the Forecast Items tab to open the opportunity and make changes. For any product item with a warning icon, you must change any attributes so that the product item doesn’t meet the forecast criteria or so that the forecast item no longer closes within the forecasting period.

A sales manager can drop the item by selecting Remove from the Action menu for the item in the Forecast Items tab. To see your deleted items, choose Dropped Forecast Items from the Show list. You can then add any dropped items back to your forecast by clicking the Add icon for the item.

You can also use a forecast override if the administrator enabled it for your territory. You can set the Forecast Option to Never to override the matching forecast criteria. An icon warns you when a product item matches the forecast criteria and requires the forecast override.

If you are unable to either change the forecast criteria for the item or use the override, the item disappears from your forecast items list, but the unadjusted forecast amounts remain the same. However, the item now has negative adjustment amounts to match the unadjusted forecast amounts. For example, if the unadjusted forecast amount is 3,000, then the forecast adjustment is negative 3,000 and the adjusted forecast is 0. With the removed forecast item selected, you can add it back in if you want to include the item back in the forecast.

**When does my forecast appear in my currency?**

Your forecast appears in your preferred currency. You can select a different currency from the Currency list. Your selected currency also applies to your view of subordinate forecasts. However, the currency selection does not apply to any BI graphs or reports that were added to the forecasting screens.

**When do I submit my forecast?**

You can make changes to your forecast and submit it during the submission window. You can submit your child territory forecasts on behalf of your subordinates and then make adjustments to your forecast before submitting.
What happens if I submit my forecast?

You can’t make adjustments or update your forecast after you submit it. Your manager can make adjustments to your forecast only after your submission. If your manager rejects your forecast, you can make further changes to the rejected forecast and then resubmit it.

What happens if I select Forecast not visible to territory owner?

The territory is hidden in the Forecasting Overview page, but is available on the Edit Forecast page. The owner of the parent territory can submit the forecast for the child territory. If the child territory owner also owns the parent territory, then the territory owner can edit forecast items, add and remove forecast items as adjustments, and adjust the territory forecast.
Chapter 14
Using Sales

14 Using Sales Prediction

Sales Prediction: Overview

Sales prediction features enable organizations to capture and leverage predictive sales intelligence. Predictive models analyze sales data to evaluate buying patterns. After the evaluation of model results, lead generation can be scheduled to disseminate lead recommendations to users. Each lead recommendation includes win likelihood, average expected revenue, and sales cycle duration.

Summary of Features

This table lists sales prediction features.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Predictive Analytical Reports</td>
<td>These reports provide sales analysts with a summary of the prediction model results. Additionally, reports on the dashboard provide overviews of model performance and leads adoption.</td>
</tr>
<tr>
<td>Predictive Model Learning</td>
<td>Model learning uncovers hidden customer buying patterns. Salespeople can replicate sales success using historical insight generated through model training.</td>
</tr>
<tr>
<td>Rule-based Recommendations</td>
<td>When new products are launched or during initial deployment, historical data is sparse. In such cases, the sales analyst can create customer-, industry-, or product-specific rules to drive the recommendation of new products.</td>
</tr>
<tr>
<td>Higher Lead Adoption Rate</td>
<td>By using a combination of data mining, segmentation, prediction and business rules, sales prediction functionality ensures that the recommendations have a higher likelihood of being converted to a win.</td>
</tr>
<tr>
<td>Analyze Recommendation Performance</td>
<td>Built-in analytical reports verify whether the recommendations are being accepted by the sales organization. If adoption is low, then the predictive models can be fine-tuned by selecting different attributes for model learning or editing the rules. Simulation can then be performed to assess the impact of these new changes before publishing new recommendations.</td>
</tr>
<tr>
<td>Usage across your sales application service</td>
<td>The recommendations generated can be viewed when using other sales application capabilities such as managing customers and contacts. When reviewing customer details, recommended products display next to the customer with the rationale for the recommendation. Territory managers can use sales prediction metrics to set sales targets by territory and assign them to salespeople. Metrics ranking also determines whether leads can be qualified during the lead qualification process.</td>
</tr>
</tbody>
</table>
Understanding Buying Patterns of Your Customer: Overview

You can view predictive product recommendations based on customer assets and historical buying trends. Click the Customer Asset Analysis tab in the Recommendations work area to analyze information about customers and provide intelligent product recommendations. Access the many reports to analyze customer buying trends across many attributes, such as currently owned products, industry, company size, and geography. To identify customer buying trends, click the Buying Patterns tab. From here you can analyze how the different attributes can affect different product purchases. You can then use attributes identified by the buying pattern reports to build the criteria for creating prediction rules.

Sales Prediction Rules: Explained

This topic explains the types of rules used in sales prediction. Use rules to identify target customer segments for target products. The results provide salespeople with quality leads with the best products to sell to specific accounts.

Sales prediction features enable you to create two types of rules:

- Prediction rules
- Eligibility rules

Prediction Rules

Products with little or no past sales history, products that must be promoted due to lack of demand, and products that must align with marketing initiatives are some of the situations where a company might create prediction rules. Many companies have product experts who have deep market and industry insight about the best customers they should target for their products. They use the information provided by the data mining model to validate their knowledge and to extract correlation patterns. Then they write their own prediction rules to control product recommendations and predictions. For example, you can create a prediction rule to recommend a new mobile product called Mobile Talk that has no historical data, to customers of a specific age group.

Eligibility Rules

You can create an eligibility rule to define conditions that a customer must meet to be eligible for a product recommendation. Eligibility rules apply to both prediction rules and models. You can have rules which prevent the sale of certain products to certain customers. Management of eligibility rules can ensure the model derived recommendations don't inadvertently violate these rules. For example, you can have an eligibility rule that ensures that you do not recommend the Mobile Talk mobile to customers in Asia because it will not work there. Achieving sales objectives through prediction rules and compliance with sales policies by eligibility rules help determine which products to select for recommendations. Eligibility rules always win over prediction models and rules.

Related Topics

- What happens if a prediction rule conflicts with another prediction rule
Reviewing and Modifying Prediction Rules: Explained

Use rules to identify target customer segments for target products. The results provide salespeople with quality leads with the best products to sell to specific accounts. You can view and create rules from the Manage Rules tab in the Recommendations work area. You can identify target products or product groups to apply to the rule. The attributes of the targeted customer are listed as identified by the sales predictor analysis.

To review or modify an existing rule, do the following:

1. Sign in as a sales user, such as a sales administrator or sales analyst.
2. Navigate to Sales > Recommendations.
   The Customer Asset Analysis page displays.
3. Click Manage Rules from the graphic panel to display the Manage Rules page.
4. Double-click one of the existing rules and the Edit Recommendation page for the rule is displayed.
5. Review or modify the rule criteria, such as the Rule Name, and specify the Rule Folder. You also select or modify the existing products and customers you want to target.
6. Click Save and Close if you make any changes. Otherwise, click Cancel.

Selecting Products for Recommendations: Points to Consider

You may have numerous products in your sales catalog, but 20% of the products usually generate 80% of the revenue. You can train models and write prediction rules or eligibility rules only for those products that are selected for recommendations. Also, you can only generate leads for products selected for recommendation.

Product Selection with Sales Focus

Product selections should be based on your business objectives. For example, if you want to increase sales for poorly performing products or to achieve inventory reduction goals, your product selections can be used to generate leads to achieve those objectives. Once you select a set of products for recommendation, you can create prediction rules to meet sales objectives, particularly for new products or in cases where historical sales data is insufficient to generate useful correlation statistics.

You can change the products or product groups selected as the business needs and market conditions change. A product that is currently in high demand may have no buyers within 12 months and so you have the flexibility to update the products in the set of recommendable products.

Product Hierarchy Levels

Sales prediction capabilities allow you to manage the set of products available for recommendation at any level in the product hierarchy and predict recommendations at that level.
The following figure shows an example of a product hierarchy.

For example, if you want to select a product called Vision HDTV LED television, you can either select the specific product, or select product groups higher in the product hierarchy, such as Television or Home Audio/Video. You can decide the level at which you want to generate recommendations and enforce that decision for sales prediction.

Product Eligibility Rules
Additionally, you can create eligibility rules which prevent the sale of certain products within customer segments.

FAQs for Using Sales Prediction

Can I derive product recommendations based on Assets and Asset related attributes?
Yes, sales representatives can view customer product buying patterns by existing assets. Your sales analyst can add a new Asset as a target from the Target Customers section of the Create Recommendation rule page.

How can I associate one or more existing customer asset attributes with a specific condition?
Your sales analyst can add a customer asset as a target from the Target Customers section of the Create Recommendation rule page. They can associate one or more existing customer asset attributes with conditions and customer attribute values. For example, you might want a rule that captures an asset purchase date or an asset install date with a condition of days expiring less than or equal to 90 days or days expiring less than or equal to 180 days.
Where can I view my asset rule results?

You can view the rule results for your accounts in the Recommendations infolet of the Account Summary page.

Where can I view my leads generated for my account based on Assets?

You can view the leads generated for your accounts matching your asset rule from the White Space Analysis report.

White Space Analysis

About the White Space Analysis Report

The white space analysis report identifies suggested recommendations for accounts that you have access to in a business-to-business (B2B) setting. By using this report, you can focus on selling products or product groups that have the highest potential for generating revenue. If the tab is enabled by the administrator, you can view the white space analysis report from a tab in the Accounts pages.

Report Data

The white space analysis report data is derived from rule-based recommendations and leads of the statuses, qualified or unqualified, generated within the last 90 days for the accounts in your territory. The 90 days is a configurable profile option and 90 days is the preset setting.

Report View

The report lists all recommendations and leads by the highest revenue potential and displays accounts listed in descending order of revenue. If more than six accounts with recommendation and lead potential are found, the report displays only the top six accounts sorted by revenue in descending order.

If no recommendation or lead is found for an account, then a message is displayed to inform you that no recommendations and leads are found. If at least one account and product is found with an asset, opportunity, lead or recommendation, then the report is generated.
The following figure shows an example of the white space analysis report.

![White Space Analysis](image)

**Note:** You cannot select more than a total of six accounts, or six products, or six product groups for inclusion in the white space analysis report.

### White Space Analysis Report Actions

Access the white space analysis to review ongoing leads, opportunities and recommendations, and take actions to move them along the sales pipeline. You can also evaluate what actions to take on the recommended products to increase the sales pipeline potential and sell more products to your accounts.

### Accounts

Depending on your specific requirements, you can focus on deals with the highest value. You can select up to six accounts within your territory and focus on the account with the highest potential.

### Product and Product Groups

If you want to analyze specific product or product group, then you can also select up to a maximum of six products or six product groups that are within and outside your territory.
Leads and Opportunities

You can navigate to a specific lead or opportunity from the white space analysis report by clicking an icon to take you to the appropriate UI. From the appropriate UI, you can perform specific actions on the lead or opportunity. Click Save and Close, or Cancel, to return to the white space analysis report.

Recommended Actions

You can take actions on the recommended products to increase the sales pipeline potential and sell more products to your customers. You can click a cell with a recommendation on the white space analysis report and take actions on the specific recommendation to meet your sales targets. You can perform one of three possible actions depending on the configuration setup:

- Convert to Lead
- Convert to Opportunity
- Reject recommendation and specify a reason for rejection from preset values or user-defined values.

The following figure shows an example of the Recommendation screen with the Actions menu items displayed.

Displaying Latest White Space Analysis Data

Lead, opportunity, and asset information is always up to date when the white space report is accessed. Recommendations can be out of synchronization with the white space analysis report based on when the lead generation job was last run by the sales analyst. The Recommendations Last Updated time stamp, displayed at the bottom of the report, indicates the time the recommendations were last generated. This helps ensure that the set of recommendation available for accounts is always up to date.

In case a lead generation job might have completed since you last accessed the report, click Reset to update the white space analysis report and view the top six accounts by revenue. If applicable, the latest changes to the set of accounts and products are displayed. Any prior changes you might have to the report such as adding accounts or products will be lost and the updated report will not reflect such changes. Note also that the time the report is reset is not indicated.

How can I access the white space analysis report?

You access the white space analysis report from a tab in the Accounts pages. The report contains recommendations and leads based on sales predictions rules, so that you can take immediate actions based on the data in the report.
The white space analysis tab is not available by default and must be enabled by the administrator. The first time you access the white space analysis report, you see either a maximum of six accounts and six products in a grid format, or a message that indicates there are no leads or recommendations to display. If you close the initial report without taking any actions, then after you sign out of the application, the same set of accounts and products or product groups are displayed the next time you sign in.

**Using the White Space Analysis Report for Cross Sell or Up Sell**

**Video**

**Watch:** This tutorial shows how to use the white space analysis report to focus on selling products or product groups to accounts that have the highest revenue potential. The content of this video is also covered in text topics.

**Procedure**

This topic describes how to use the white space analysis report.

To use the White Space Analysis report:

1. Sign in as the sales administrator and navigate to **Sales > Accounts**.
2. Click the White Space Analysis report.
   - The tab isn’t enabled in the shipped product, which means that your administrator must explicitly enable it in Page Composer. It is also best to have some recommendations and leads created based on sales prediction rules to populate the report with data. A message is displayed if no data is available to display.
3. Click any area of the report to view examples of the type of analysis contained in the report.
   - For example, different areas of the report contain view based recommendations, leads, and opportunities for the accounts within your territories that you can view. You can also see what assets and recommendations have been rejected.
4. Click any one of the recommendations.
5. Click **Actions** to display the options.
   - You can take some actions on a specific recommendation. To meet your upcoming sales targets you might want to convert a recommendation to a lead, or to an opportunity, and then submit it. If you decide that a recommendation isn’t for you, select Reject where you are prompted to add a reason for rejecting the recommendation.
6. Click a **Lead** icon on the report.
   - In the Edit Lead area, you can edit the details of the lead, or you can take some actions on the specific lead. For example, to meet your upcoming sales targets, you might want to convert a lead to an opportunity.
7. Click any opportunity.
   - You can take some actions on a specific opportunity. You could copy or delete this opportunity or add some additional products.
8. Click an **Assets** icon.
   - You can view what assets exist for the accounts in your territories. For example, maybe an account has purchased a set of software manuals recently, so you can check back when an updated version becomes available.
9. Hover over the **Rejected** icon.
You can tell which recommended product was rejected by a specific account. The White Space Analysis report lets you see at a glance which products are showing up as having no revenue potential. With this information, you can focus on selling products or product groups to those accounts that have the highest sales potential.

FAQs for Using White Space Analysis

What data can I view from the white space analysis report?

You can view the white space analysis report for the accounts that you have access to.

The white space analysis report displays the following objects, in order of priority, for the accounts and products within and outside your territories:

- Assets
- Opportunities
- Leads
- Rule-based recommendations
- Rejected recommendations
- White space

If there are multiple leads and opportunities for the same account and products, then the last-updated lead and opportunity can be viewed.

>Note: If a recommendation has been rejected, then the corresponding cell in the report is disabled and color coded visually, and no further action can be taken on the recommendation.

Leads with a status of Retired, and opportunities with a status of Lost and No Sale are not displayed on the report.

What happens when I click a recommendation from the white space analysis report?

Depending on your configuration, when you click on a recommendation from the white space analysis report, you can take actions on the specific recommendation. For example, in order to meet your sales targets, your administrator might configure recommendation actions to allow you do one of the following:

- Convert a recommendation to a lead
- Convert a recommendation to an opportunity
- Reject a recommendation and specify the reason

Can I reject recommendations that are no longer relevant?

Yes. All recommendations may not be suitable for your accounts. For example, customers may have bought a competing product in the last few weeks and that information is typically not available in your data. You can reject recommendations
displayed in the white space analysis report to allow you focus on the products that you are more likely to sell to your customer.

How is the deal size calculated for a white space analysis report?

Sales representatives are interested in the deal size for recommendations, leads, and opportunities, so that they can focus on the deals with the highest value.

The deal size for a recommendation is computed as the estimated revenue of the recommendation multiplied by the win percentage of the recommendation. The deal size for a lead or an opportunity is computed as the amount for the specific product represented by the column of the report in the product details. Total potential is the sum of revenue values for recommendations, leads, and opportunities, for an account across the six products or product groups displayed in the report.

Note that the deal size is always displayed in the corporate currency.
15 Using Territories

Using Territories: Overview

Territories provide the rules for automatically assigning salespeople and other resources to accounts, contacts, households, partners, leads, and opportunity items.

Salesperson

As a salesperson viewing an account, partner, lead, or opportunity, you can see the assigned territories when you view the sales team information. You also forecast your sales by territory. Sales quotas can be assigned to you by territory.

Sales Managers

As a sales manager, you can modify the territories in the hierarchies below your assigned territories. Your sales administrator must create the top territory first. If you see no Parent field and no existing territories, then the top territory doesn’t exist. Following are some examples of changes you can make to territories:

- Add a new child territory.
- Change the owner of an existing territory.
- Add team members to a territory.
- Remove an existing territory.
- Add specific accounts, contacts, and households to the coverage of a territory.
- Exclude specific accounts, contacts, and households from the coverage of a territory.
- Define or change the definition of a territory coverage.

You can change an active territory directly without using a territory proposal. You can:

- View a list of territories.
- Look at the details for a territory.
- Use the Summary tab to change attributes of the territory.
- Use the Dimensions tab to modify the boundaries of the territory.
- Use the Inclusions tab to add specific accounts, contacts, and households to the territory.
- Use the Exclusions tab to exclude specific accounts, contacts, and households from the territory.
- Use the Team Members tab to change team members or the territory owner.
- Use the Child Territories tab to navigate the territory hierarchy and to add a new child territory.

See the Implementing Sales guide for additional information about modifying territories.
Using Territory Management

Video

Watch: This tutorial introduces you to the UI to create and change active territories. The content of this video is also covered in text topics.

Worked Example

This worked example describes each tab in the Territories work area and the typical tasks a sales manager performs.

It covers exploring the following tabs in the work area:

- Summary tab
- Dimensions tab
- Team Members tab
- Child Territories tab

Viewing the Summary and Dimension Tabs

1. On the home page, click Territories. A list of your team’s territories appears.
2. Click the Ireland territory name. The Summary tab displays commonly used territory attributes. You can use Application Composer to add other attributes to this tab.
3. Click the Actions menu. From this menu you can delete this territory including all of its children. You can also delete this territory coverage or add coverage if it has none.
4. Click the Dimensions tab. The Dimensions tab displays the defined boundaries of the territory. You can add or change the values that define the territory coverage.
5. Click Edit. The coverage dimensions include a set of attributes and their corresponding values. An account that matches these attributes will be assigned to this territory.
6. Select the Industry dimension.
7. To add an industry to the coverage, select it in the Available region and use the arrow to move it to the Selected region.
8. Select the Geography dimension.
9. Click Edit.
10. Choose to add the values you select to the existing values for geography and click OK.
11. Enter values separated by commas, or a range of values. Enter a range of postal codes, 85001-85030.
12. Click Cancel until you return to the Edit Coverage Dimensions page.
13. Click the list arrow next to the Edit button and note the Remove All selection will remove all coverage for this territory.
   You can add individual customers to this territory in the Inclusions tab.
Viewing the Team Members Tab

1. Click the Team Members tab. This tab displays the territory team members. I can add or remove team members and change the territory owner.
2. The Owner column contains a check mark to indicate Paddy Joyce is the owner of this territory. Click his name. The Resource Details dialog shows information about Paddy Joyce. You can send an e-mail to Paddy by clicking the e-mail address on this dialog or in the Team Members page.
3. In the Function field for Paddy, change his function to Sales Representative. This is the function Paddy has in this territory team.

Viewing the Territory Hierarchy

1. Click the Summary tab.
2. Click the name of the parent territory. The Edit Territory page opens for the parent territory.
3. Click the Child Territories tab. The tab lists all child territories of the open territory.
4. Click the Ireland territory.
5. Click the Child Territories tab.
6. Click Create Territory. Notice that the parent territory is Ireland.
7. Click Cancel. When you click Save, or Save and Close, your changes immediately become the active definition for this territory.

Changing Territories

Creating a Territory Proposal

You can update active territories directly, or use a territory proposal as a sandbox where you make your proposed changes to your territory hierarchy before activating the changes.

Tip: Use proposals for territory realignments or changes to be activated at a future date.

1. Navigate to Territories.
2. In the Active Territories page, click the Manage Proposals button.
3. In the Current Territory Proposals region, click Create.

The Create Territory Proposal window appears.

4. Enter a name for the proposal.
5. You can enter an Activation Date or accept the default which is immediate activation.
6. Click Save and View.

Your territory proposal opens and displays your current territory hierarchy. You can start making your changes.
Adding Child Territories to Your Territory Hierarchy

You can add child territories to your own territory or to another territory in your hierarchy.

Changing Active Territories

Use the following steps to add or change a territory that becomes immediately active. If you see no territories and no parent territory field, then your sales administrator must first create the top territory for the hierarchy.

1. Select from your territories list the territory that will be the parent to your new territory.
2. Go to the Hierarchy tab.
3. Click **Create Territory**.
4. Enter the territory name.
5. Select the owner for the territory.
6. If Territory Precedence is enabled, you can select a territory function. Assignment compares all territories with the same function and gives precedence to the territories with included accounts.
7. Click **Save and Continue**.
8. Go to the Dimensions tab.
9. To change dimension definitions, click **Edit**.
10. Select a dimension and move the values you want to the Selected column.
11. Optionally, click **Edit** and enter several members or ranges of members separated by commas and click **OK**.
12. Click **OK**.
13. To add an account, select the Inclusions tab.
14. Click **Add Customers** and select **Accounts**.
15. Use the Exclusions tab to select customers to be excluded from the territory. (Use Application Composer to enable the Exclusions tab.)
16. Use the Team Members tab to add members to the territory team.
17. When you complete making all changes, click **Save and Close**.

Your new territory is now active.

Using Territory Proposals

Use the following steps to add territories using a territory proposal you created.

1. In Manage Territory Proposals page, select the name of your proposal.
   The territory proposal opens for editing.
2. Select the parent territory.
3. From the Actions menu, select **Create Child**.
4. Enter the territory name.
5. Select the owner for the territory.
6. If Territory Precedence is enabled, you can select a territory function. Assignment compares all territories with the same function and gives precedence to the territories with included accounts.
7. Click **Save and Close**.
   The new territory is added to the proposal.
8. Click **Edit Coverage**.
   The coverage for the child territory is the same as the parent's coverage.
9. Select the members for each dimension that you want to change.
10. Click **Save and Close**.

How can I move a territory in the hierarchy?
When you edit a territory you can change the parent territory on the Summary tab. Click the X to delete the current parent and use the choice list or search to select a new parent territory.

**Changing Territory Coverage**
A new child territory has the same coverage as the parent. Change dimension selections and included or excluded accounts, contacts, and households to refine the coverage. Your changes are not active until you activate the proposal.

1. In Manage Territory Proposals page, select the name of your proposal.
   The proposal opens for viewing.
2. In the Territories table, select the territory you want to change.
3. If the territory is not already added to the proposal, then click **Add to Proposal**.
4. Click **Edit Coverage**.
   The Edit Coverage window appears.
5. For every dimension you want to change:
   a. Select the dimension from the **Dimensions** list. (For the Address dimension, enter values in the correct address column.)
   b. Add or remove dimension members from the Selected Dimension Members box.
   c. Optionally, click **Add Members in Bulk** and enter several members or ranges of members separated by commas and click **OK**.
   d. Click **Save and Close**.
6. In the Included Customers region, select and add specific accounts, contacts, and households to include in the territory.
7. In the Excluded Customers region, select and add specific accounts, contacts, and households to exclude from the territory.
8. Click **Done**.

**Activating a Territory Proposal**
When you finish making changes to your territories, use this procedure to activate your territory proposal and start using the new territories for assignment.

1. Navigate to **Territories**.
2. In the Active Territories page, click the **Manage Proposals** button.
3. If the proposal you want to activate doesn’t appear in the Current Territory Proposals table, select **All Proposals** from the **Proposals** list.
4. Select the proposal and click **Activate**.
   You can see the activation process status in the Details region of your proposal.
5. Click **Done** to return to Manage Proposals.
6. Click **Done** to return to the Overview page. Your territory changes now appear in the list of active territories.
Territories Defined by Dimensions: Explained

Dimensions define territory boundaries. For example, you use the geography dimension to define territories by assigning specified countries, states, and postal codes. You define territory dimensions to assign customers, partners, leads, and opportunity items to the correct territories.

A territory captures business objects, such as customers, that fall within the defined boundaries of the territory.

The following figure shows a geography example. The sales team assigned to this territory is responsible for all customers in Spain. In this example, the Spain Territory is assigned Customer A, but not Customer B.

Customers and Partners

You can define a territory either for partners or for customers, but not for both. You select either Customer Centric or Partner Centric for the coverage model. When creating a territory, you can include individual customers or partners by selecting them for the territory coverage. You can use the following dimensions to assign customers or partners to a territory:

- Geography or Address, but not both
- Account type
  The account type designates the customer designated as named or not named. This dimension is only available for customer-centric territories.
- Customer size
- Industry
- Organization type

Your administrator can also use classification categories to define up to three additional dimensions. The definitions are based on classifications to assign customers or partners.

Leads and Opportunities

A territory is assigned to leads and opportunities using the attributes of the customer or partner on the transaction and attributes of the transaction itself, shown in the following list.

You can use the additional dimensions to assign leads and opportunity items:

- Business unit
• Product
  Groups of products form a hierarchy in the sales catalog.

• Sales channel
  The available sales channels are Direct, Indirect, and Partner.

For example, your company is launching a new product line in all countries. One sales manager with a small sales team will specialize in selling only the new product line. The following figure shows the sales manager’s territory defined only by the new product line and by geography set to Any.

One of the salespeople reporting to this manager sells the new product line in Canada. The following figure shows the salesperson’s territory and an opportunity item assigned to the territory:

Tip: You can use the Line of Business attribute to assign leads or opportunities to a territory, although it’s not a dimension.

Related Topics
• Territory Coverage: Explained
Overview of Using Quotes

Create quotes and orders from an opportunity as part of a deal or directly from an account using the automated opportunity-to-quote-to-order process. The quotes and orders feature lets you:

- Create professional proposal documents.
- Share quotes and collaborate with customers to close the deal.
- View quote summary information and drill down into quotes to view details.
- Create valid product configurations in the integrated quoting application.
- Perform automated pricing calculations.
- Specify pricing and discounts.
- Streamline approval processes.

Creating Quotes in Sales

While working on an opportunity or account, you can create, update, duplicate, and version quotes. You can add and remove products and change pricing. When you are satisfied with a quote, you can save it and then mark that quote as active. When you create, edit, or version a quote, you navigate to the integrating quoting service, Oracle Configure, Price and Quote (CPQ) Cloud. The application carries the opportunity ID and account ID into CPQ, and when you save the quote, CPQ creates the new quote. When you return to the sales application, the newly created quote reflects there, associated with the opportunity or account it relates to.

Accessing Quotes

In the sales work area, you access quotes by:

- Searching for quotes using the global search
- Navigating to the Quotes and Orders landing page with the Sales work area
- Viewing and updating quotes from within an opportunity or an account

For the quotes you have access to, the details include quote number, quote amount, status, and proposal document.

Synchronizing Opportunity Products and Status

You can automatically synchronize opportunity products and associated revenue with quote lines. Marking a quote as active enables the synchronization of the quote lines with the opportunity revenue lines that were the source of that quote. When you update an opportunity, the first three rows with the information is saved.

For more information on using Oracle CPQ see the Oracle CPQ Help Center, linked in this topic.

Related Topics

- Oracle CPQ Cloud Help Center
Get Started with Quotes

Video

Watch: This video tutorial shows you how to use quotes with your sales applications. The content of this video is also covered in text topics.

Overview

Using the Oracle Engagement Cloud quotes and orders feature, you can create quotes from an opportunity as part of a deal cycle or directly from an account. You can view basic quote information such as quote number, quote amount, status, and proposal document for all quotes to which you have access and then drill down into the quote to view details.

Get quick access to the quotes you need using the global search. Search on External Quote Number, Order Total, Status, Expiration Date, Opportunity Name, Opportunity Number and Account Name.

In addition to listing all quotes as well as quotes that you own, you can create your own personal list. For example, you want quick access to a listing of quotes for which an order has been submitted or quotes with amounts greater than $1 million.

You can modify the quote details for an opportunity or account by drilling down on the quote links from the Quotes and Orders landing page. This action takes you to the Oracle Configure, Price and Quote (CPQ) Cloud service screen, where you can modify the quote details. For example, you can update the quantity of servers that a customer wants to purchased, and the sales figures are immediately updated. Click Update Opportunity to sync your changes back to your sales application and when done, return to your sales application.

When you drill down on an opportunity and click the Quotes and Orders tab, then from the resulting page, you can edit the quote, create a new version, or duplicate the quote. You can also create a new quote or navigate to the quote record.

Create and Update a Quote for an Opportunity

Create, view, and share quotes from opportunities using the seamless integration with the quoting application. You can also manage quotes in a standalone list from the Quotes and Orders user interface.

With quotes, you can:

- Create professional proposal documents including current product and pricing information within an existing opportunity.
- Create multiple quotes and orders for an opportunity, including multiple versions for the same quote.

Note: Only one quote or sales order version can be active for an opportunity.

After creating or updating a quote or sales order in the quoting application, Oracle Configure, Price, and Quote (Oracle CPQ Cloud), the associated opportunity needs to be updated in your sales application with the changes that have been made.
to the quote or sales order, if it is active for the opportunity. Updates include additions, deletions, and updates to product (revenue) lines on the opportunity.

Note:

Updates such as issuing the quote to a customer and submitting it as a sales order are performed only within Oracle CPQ Cloud application.

Creating a Quote from an Opportunity

When you create a quote from an opportunity in your sales application, Oracle CPQ Cloud automatically starts. The application carries the opportunity ID and account ID into CPQ, and when you save the quote, CPQ creates the new quote. When you return to the sales application, the newly created quote reflects there, associated with the opportunity or account it relates to.

Here’s how to create a quote from an opportunity:

1. From the springboard or Navigator, click Sales > Quotes and Orders.
2. From the Quotes and Orders landing page, edit an opportunity.
3. From the Edit Opportunity page, click the Quotes and Orders tab.
4. Click Create Quote and the application automatically signs you into CPQ.
5. In CPQ, start creating the quote by clicking Add Line Item.
6. Enter the remaining quote information.
7. See the Online Help for CPQ Cloud for information about adding line items for your quote.
8. When done, click the Update Opportunity tab to sync your changes back to your sales application.
9. Click Return to Engagement Cloud.

Updating Opportunity Products and Status

You can automatically synchronize opportunity products and associated revenue with quote lines. If you are satisfied with a quote, save it, and then mark that quote as active. Setting a quote as active enables the synchronization of the quote line items with the opportunity revenue lines. When you update an opportunity, the first three rows that contain the revenue information is saved.

Here’s how to update a quote from an opportunity:

1. From the springboard or Navigator, click Sales > Quotes and Orders.
2. From the Quotes and Orders List page, click the Opportunity link for which you want to update a quote.
3. From the Edit Opportunity page, click the Quotes and Orders tab.
4. Locate the quote you want and click Edit from the Actions menu. You’re are signed into CPQ.
5. In CPQ, update the quote.
6. Click the Update Opportunity tab to sync your changes back to your sales application.
7. Click Return to Engagement Cloud.

For more information on using Oracle CPQ see the Oracle CPQ Help Center, linked in this topic.

Related Topics

- Overview of Using Quotes
Create and Update a Quote for an Account

While working on an account you can create, update, duplicate, and version associated quotes to reflect the product and pricing configuration.

Here’s how to create a quote from an account:

1. From the springboard or Navigator, click Sales > Accounts > Quotes and Orders.
2. From the Quotes and Orders landing page, edit an account.
3. From the Edit Accounts page, click the Quotes and Orders tab.
4. Click Create Quote and the application automatically signs you into CPQ.
5. In Oracle Configure, Price and Quote (CPQ Cloud), click Add Line Item and start creating the quote.
6. Enter the remaining quote information.

See the Help Center for CPQ Cloud for information about adding line items for your quote.

7. When done, click the Update Account tab to synchronize your changes back to your sales application.
8. Click Return to Engagement Cloud.

Related Topics

• Overview of Using Quotes

• Oracle CPQ Cloud Help Center
17 Allocating Quotas

Overview of Using Quotes

Create quotes and orders from an opportunity as part of a deal or directly from an account using the automated opportunity-to-quote-to-order process. The quotes and orders feature lets you:

- Create professional proposal documents.
- Share quotes and collaborate with customers to close the deal.
- View quote summary information and drill down into quotes to view details.
- Create valid product configurations in the integrated quoting application.
- Perform automated pricing calculations.
- Specify pricing and discounts.
- Streamline approval processes.

Creating Quotes in Sales

While working on an opportunity or account, you can create, update, duplicate, and version quotes. You can add and remove products and change pricing. When you are satisfied with a quote, you can save it and then mark that quote as active. When you create, edit, or version a quote, you navigate to the integrating quoting service, Oracle Configure, Price and Quote (CPQ) Cloud. The application carries the opportunity ID and account ID into CPQ, and when you save the quote, CPQ creates the new quote. When you return to the sales application, the newly created quote reflects there, associated with the opportunity or account it relates to.

Accessing Quotes

In the sales work area, you access quotes by:

- Searching for quotes using the global search
- Navigating to the Quotes and Orders landing page with the Sales work area
- Viewing and updating quotes from within an opportunity or an account

For the quotes you have access to, the details include quote number, quote amount, status, and proposal document.

Synchronizing Opportunity Products and Status

You can automatically synchronize opportunity products and associated revenue with quote lines. Marking a quote as active enables the synchronization of the quote lines with the opportunity revenue lines that were the source of that quote. When you update an opportunity, the first three rows with the information is saved.

For more information on using Oracle CPQ see the Oracle CPQ Help Center, linked in this topic.

Related Topics

- Get Started with Quotes
Sales Quota Management: Overview

Sales Quota Management provides a comprehensive solution for managing sales quotas to maximize quota attainment and improve overall sales performance. Effective top-down planning with bottom-up assessments ensures that quotas relate to corporate goals. After the sales plan is deployed for the year, sales executives can then monitor and track sales performance by comparing forecasts with actuals and with quotas.

Summary of Features

The key features of Quota Management include the following:

- Assign territory quotas to territories and resource quotas to people.
- Create sales goals such as number of sales calls.
- Review quotas assigned to you by your senior manager and allocate quotas to your salespeople.
- Compare quota to revenue, pipeline, forecast, and other metrics using business intelligence.
- Use formulas to calculate territory quotas using measurements of historical data and future potential.
- Add adjustments to your quota to cushion against attainment risk.
- Track current quota achievement compared with quota targets.
- Manage seasonal variations in sales by distributing the revenue quota among several calendar periods using seasonality guidance.
- Send notification to Incentive Compensation with new and changed individual quota assignments for all sales goals.
- Use a round trip export, update, import of quotas to add bulk quotas from spreadsheets.

Quota Allocation, Publishing, and Revision: Explained

When sales managers complete assigning quotas to their directs, they publish the quotas to the owners and resources of their child territories. Child territory owners can then view their quotas for the territories they own. And in turn they assign and publish quotas to the owners and resources of their child territories. Publishing your quotas also sends notifications containing resource quota information to an incentive compensation analyst. The territory owner and the manager of the sales manager who published the quota receive notifications that the quotas are published.

Quota Allocation

You can allocate quotas in the Manage Sales Quotas page. Sales administrators can enter and edit territory and owner quotas for any territory quotas that aren't published. Sales managers can enter and edit child quotas that aren't published. For territory quotas that aren’t published, you can also:

- Enter or edit a quota for each period
- Apply seasonality factors
Select a parent territory and click Details to use the Edit Sales Quotas page to enter or edit quotas. You can enter annual quotas, period quotas, and apply seasonality to any quotas not published.

Quota Publishing

When you finish allocating your quota, you publish the quotas to make them available to your directs. After publishing, you can’t make changes to the quotas.

You can select one or more territories to publish. If you click Publish Child Territories, then the selected territories and their children are published. A sales administrator can publish a hierarchy of territories from the Actions menu. When you publish a territory, you publish the following, and the data becomes available for Business Intelligence:

- Territory quota
- Resource quotas for all sales goals for the selected territory
- Quotas assigned to finer time periods

If you did not apply seasonality to quotas, then the publishing process applies the seasonality factor that was defined in the sales quota plan for the territory. If there are no seasonality factor groups defined, then seasonality factors are not applied and there is no granular time period quota. Excluded territories can’t be published. Publishing fails if the selected territory or any territory resource has no quota.

Tip: Save time entering period quotas. Seasonality gets applied automatically on publish if you haven’t manually entered period quotas.

Copying Territory Quotas to Resource Quotas

By setting two profile options, the administrator enables the automatic copying of quotas during publishing. Publishing does the following:

- Copies the territory owner’s annual quota for the sales revenue goal to the owner’s resource quota.
- If the owner’s annual resource quota is zero, then publishing copies the territory period quotas to resource period quotas. It overwrites any existing resource period quotas.

Quota Revision

Before you can revise published quotas, you must change the quota status to Pending Revision. The Revise action changes the status for your selected territory and its children. You can then revise territory quotas, and add, revise, or end date resource quotas. When you complete your revisions you can again publish the quotas and send notifications. The territory quotas change to Published status and resource quotas change to Submitted status.

When you revise quotas, the revised values are not available in Business Intelligence until you republish the revised quotas.

Related Topics

- Enabling Quota Copy: Explained

FAQs for Allocating Quotas
What's an adjustment?

An adjustment is the amount that territory owners, or sales managers who have child territories, add to the territory quota assigned to the territory they own. The territory owner can then allocate the adjusted territory quota to child territories.

What's a variance?

The variance is the difference between the adjusted quota amount for the parent territory and the rolled up total amount from the child territory quotas. The variance can be spread, meaning it gets added to the child territories.
Chapter 18  Using Analytics

Sales Analytics Pages: Overview

Oracle provides a broad set of analytics and analytic pages to give you quick access to key insights and metrics for all aspects of your sales organization.

The following table shows the various options for using analytics for sales organizations.

<table>
<thead>
<tr>
<th>Sales Analytics</th>
<th>What’s Available</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prebuilt or Build-Your-Own Analytics</td>
<td>Your application comes with over 150 prebuilt analytics. There are role-based analytics as well as analytics for the organization in general. Administrators create and edit analytics, as well as add them to the user interfaces. If you want to build your own, there is an easy drag-and-drop editor for creating analytics.</td>
</tr>
<tr>
<td>Sales Infolet Page / Sales Pages</td>
<td>You get to the Sales Pages by navigating from the Home page using the white navigation dots. The Sales Infolet page comes enabled, and prebuilt with infolets specific to many of the roles in your organization. The five Sales Pages are enabled and configured by your administrator.</td>
</tr>
<tr>
<td>Analytics Tabs</td>
<td>Many of your work areas such as Opportunities, Contacts, Accounts, and the Analytics page, provide additional Analytics tabs with detail in context to the information you are viewing. These tabs appear along the side of the page. Typically, administrators and some manager roles add analytics tabs to work areas for users.</td>
</tr>
<tr>
<td>Analytics Page</td>
<td>From the Home page click Sales and then click Analytics. Users search and make analytics favorites which persist on this page as long as they remain favorites. This page also shows analytics recently viewed by the signed-in user.</td>
</tr>
</tbody>
</table>

Related Topics
- Complete listing of available Engagement Cloud prebuilt analytics in downloadable format

Using Sales Analytics Pages

Oracle Sales provides many options for getting key analytic data for sales users.

Sales Analytics Pages

With Oracle Sales analytics you have analytics interfaces right at your fingertips. You can make favorite analytics on your Analytics page, and your administrator can add analytics to your Sales Pages.
Interfaces where you view analytics:

- **The Sales Pages**: These pages are linked from the white navigation dots on the Home page. The Sales Infolet page comes enabled and prebuilt with analytics specific to many of the sales roles. The Sales Pages are enabled and configured by your administrator.

- **The Analytics Page**: You personalize this page by adding favorite analytics. It also shows recently viewed analytics.

*Note*: Depending on your implementation and software version, some page icons, menu links, and navigator options may not be available.

### Exploring the Sales Infolet Pages

From the Home page you navigate to your Sales Pages using the navigation dots. These pages contain analyses that are available on mobile, tablet, or laptop. Clicking an infolet drills down to more detail on an analysis. Your administrator can change the content that you see on these pages. The Sales Infolet page comes prebuilt with analytics ready-to-use. Your administrator adds up to five additional configured Sales Pages with navigation dots to each of them.

This figure shows the Home page with the infolet navigation dots and the Sales and Analytics icons which link to sales and analytics work areas.
Exploring the Analytics Page

From the Home page you get to your Analytics page by clicking **Sales** and then **Analytics**. You configure which analytics you see on this page by searching for analytics, and marking them as your favorites. Favorites remain on your Analytics page to view at any time.

This figure shows the Analytics page with the Search for analytics option and the favorites marked with the gold star.
Oracle Sales Cloud for Office 365: Overview

Use Oracle Sales Cloud for Office 365 to maximize productivity by accessing your sales application data, such as emails and appointments, from within Office 365.

The following table describes the key features.

<table>
<thead>
<tr>
<th>Features</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access your sales application information within Office 365.</td>
<td>View records, top connections, and activities associated with a contact.</td>
</tr>
<tr>
<td>Share Office 365 emails with your sales application.</td>
<td>Save your Office 365 emails in your sales application as activities and associate them with accounts, leads, or opportunities.</td>
</tr>
<tr>
<td>View the top contact connections in the side panel.</td>
<td>Leverage your organization’s resources that interact the most with a contact to gain better insight into the contact.</td>
</tr>
<tr>
<td>Create and follow up with contacts and activities in the side panel.</td>
<td>Create and edit contacts from the side panel. You can also view activities’ history and create activities such as appointments, tasks, and calls.</td>
</tr>
<tr>
<td>Synchronize data between your sales application and Office 365.</td>
<td>Synchronize contacts, appointments, and tasks between your sales application and Office 365 to have a continuously updated and accurate 360-degree view.</td>
</tr>
</tbody>
</table>

Signing in and Signing out

To use the side panel, sign in using your cloud service credentials.

Ensure that your browser’s compatibility view setting is disabled before you load the side panel. Also, be sure to add Office 365 to the list of trusted sites (https://*.office365.com).

The first time you sign in to the side panel, you must authorize the link between your sales application user and your Office 365 account. Subsequently, no other sales application user can access the side panel using the same Office 365 account.

Note: If you enter a set of your cloud service credentials that is associated with a different Office 365 account, you must clear the browser cache before signing in again.

Email Productivity Applications
Video

Watch: This video tutorial shows you how to access Oracle Engagement Cloud data from your email client, such as Outlook, IBM Notes, Office 365 and Gmail. The content of this video is also covered in text topics.

Worked Example

You can install configurations that integrate your sales application with Office 365, Gmail, IBM Notes, or Outlook. These configurations help you increase productivity by managing your contacts, appointments, and relevant emails to correspond with records in your cloud service.

The steps cover the following:

- Using the Office 365 add-in
- Sharing contacts with your cloud service, using Gmail as an example
- Associating a calendar appointment with your cloud service, using Outlook as an example
- Capturing relevant email activity within your cloud service, using IBM Notes as an example

Using the Office 365 Add-in

You can use the Office 365 add-in to access and modify your records in your cloud service.

1. Access your cloud service contacts and related records in Office 365:
   - Click Top Connections to know the ranked internal resources who have had most interactions with the contact in the past.
   - Click Activities to see the most recent activity details.
   - Click Create Contact to add an unknown contact to your cloud service.
   - Click Settings and choose what information you want to synchronize with your cloud service.

Sharing Contacts

You can share contacts between your cloud service and your email client, for example, Gmail.

1. Click the contact who has sent an email.
2. Enter the new contact information about the Oracle Sales Cloud for Gmail panel.
3. Search for and select the account you want to associate your contact with.
4. Click Save.
5. Sign in to your cloud service to verify that your contact is shared.
6. In the Accounts work area, search for and click the account that you associated your contact with.
7. On the Edit Account page, find the new contact that you just added on Gmail.

Associating a Calendar Appointment

You can associate calendar appointments with your cloud service from your email client, for example, Outlook.

1. Click Home on Oracle Sales Cloud for Outlook.
2. Click New Items, and then click Appointments.
3. On the Appointments page, select the account, and opportunity or contact.
4. Enter the appointment information, such as subject, location, and time.
5. Click Save.
Capturing Email Activity
You can share email activity with your cloud service from your email client, for example, IBM Notes.

1. Open the email that you want to share.
2. Click **Share with your cloud service** to save emails as activities on your cloud service.
3. Link emails with corresponding accounts, opportunities, leads, or contacts.
   
   If you are using Outlook or IBM Notes, you must synchronize your records manually with your cloud service.

Oracle Sales Cloud for Office 365 Side Panel: Explained

You can integrate your sales application and Office 365 and access your cloud service data, such as contacts and appointments, through the side panel. You can also manage synchronization settings for contacts and activities using the side panel.

The side panel appears when you open an email and displays relevant information about all the known and unknown contacts associated with the email.

The side panel has three main regions:

- **Related Records**
- **Top Connections**
- **Activities**

You can use each of these regions to work with your sales application.

**Related Records**
You can view the accounts, open opportunities, and open leads associated with the contact in the Related Records tab. You can associate an email as an activity with any of the accounts, opportunities, and leads. Resources on the email are automatically added to the activity.

> **Note:** If the contact you are viewing is not the primary contact of a lead, the lead is not displayed as a related record.

**Top Connections**
You can view a list of resources from your company who have interacted most with the contact. These top connections are listed in the order of resources with most interactions to the least. Interactions are a sum of emails, appointments, and calls with the contact. You can view interactions from the current month back to the first email, appointment, or call logged against the contact. You can also select a specific month or year to view activity history for that point in time.

**Activities**
You can view the history of a contact’s activities in the Activities tab. You can also create, edit, and delete activities such as appointments and tasks using the side panel.
The activities created, edited, or deleted in the side panel are automatically updated in your sales application. However, if you import an activity to your sales application and synchronize it with Office 365, the activity exists in Office 365 even after you delete in your sales application. You must delete the activity in Office 365 as well.

**Note:** You are redirected to the login page after every four hours. If you click **Save** on the create form after your session times out, the details entered will not be saved. You must sign in again to create the activity.

### Creating Contacts from the Office 365 Side Panel: Procedure

You can add contacts to your sales application from your Office 365 account and maintain a consolidated list to work more effectively. You can identify which of your contacts from an email exists in the sales application and those that should be added through the side panel.

#### Adding Contacts to The Sales Application

You must have an email on Office 365 open to add a contact to your sales application. If your contact already exists in your sales application, the side panel displays the name of the contact. If the contact does not exist in your sales application, the side panel displays the person icon and email ID. You can view the email IDs of resources only if they have sent the email.

To add a contact to Oracle Sales Cloud from Office 365:

1. Open an email in Office 365.
   
   The following message appears on the side panel: The contact does not exist in your sales application.
2. Click **Create Contact**.
3. Enter relevant information to create your contact.

   **Note:** The email is automatically populated with the email ID that the opened email displays. You cannot edit the email ID.

4. Click **Save**.

The full name of the contact you just added now appears in the side panel indicating that the contact is added to your sales application.

To edit or open the contact in your sales application, click the ellipsis icon on the home page and select the option you want.

### Leveraging Top Connections to Gain Contact Insight: Example

You can view a list of salespeople from your company on the Top Connections tab who have interacted most with a contact in various ways such as through appointments, calls, and emails. This example demonstrates how sales representatives can use top connections to familiarize themselves with contacts before approaching them.
Scenario

Robin Marlow is a sales representative in PennyPack Systems. He spends a significant amount of time working on Outlook. Recently, he took over Service Sales in the North America region and is introduced to several new accounts that he is not familiar with.

Robin receives an email from Smith Wilson of First Software.

- He looks through the top connections to see if anyone from his company has worked with Smith in the past and decides that Daniel Grayson is the ideal resource to contact.
- He views Smith’s upcoming activities through the side panel and finds that Smith has an appointment scheduled with Daniel.
- He creates a task to call Daniel later in the day to learn more about Smith and the appointment scheduled for next week.

Robin’s call with Daniel gives him details about Smith’s interests and activities and Robin is now better informed about the contact before he interacts with him.

Sharing your Office 365 Emails and Appointments with Your Cloud Service Server: Example

You can share emails and appointments that you send or receive from your Office 365 account with your sales application.

You can share emails and appointments related to a specific account, opportunity, or lead with your team in your sales application thereby providing them with any relevant information or history related to the customer. Sharing emails and appointments associates the email or appointment as an activity with the relevant account, opportunity, or lead. You can also search for other accounts, opportunities, and leads that you have access to. Related known contacts or resources are added to the activity in your sales application.

This topic provides an example that illustrates how to share an email and appointment in your sales application.

Sharing Email

You are a sales representative handling the North America region for laptop sales. You are in conversation with a customer on their requirement for your new range of laptops.

You have just received an email reply from the customer with some questions on pricing. You would like to associate this email with an existing opportunity in your sales application so that you can share it with your manager and other salespeople on your team.

Open the email to view the side panel. Click Share Email on the Related Records tab. On the Share Email page, search for and select the relevant opportunity, and click Save. You have now saved your email in your sales application as a task for the selected opportunity, making it available for your team to review. When salespeople open the opportunity, they can now view this email as an activity associated with the opportunity.
Sharing Appointments

To further discuss the customer’s requirement, you decide to include them in an existing appointment that you have with your manager.

Open the appointment to view the side panel. Click **Share Appointment** on the Related Records tab. On the Share Appointment page, you search for and select the customer, and click **Save**. You have now saved your appointment in your sales application and shared the activity with the customer.

Creating Activities in the Side Panel: Worked Example

This example demonstrates how to create activities, such as appointments and tasks, in the Office 365 side panel. The following table summarizes the key decision for this scenario.

<table>
<thead>
<tr>
<th>Decisions to Consider</th>
<th>In this Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Should I create my sales application activity in Office 365?</td>
<td>Yes, use the Office 365 side panel to create an appointment that is automatically synchronized with your sales application.</td>
</tr>
</tbody>
</table>

Creating an Appointment

To create an appointment:

1. Open an email from the contact you want to schedule an appointment with.
2. Click the Activities tab on the Office 365 side panel.
3. Click **Create** and select **Appointment**.
4. On the Create Appointment page, enter all the details. Invite contacts and resources for the appointment.
5. Select attachments that you want to include in the appointment.
   The attachment size for the file types .jpg, .png, .m4a, .mp3, .gif, .pict, .aac, .wav, and .tiff must not exceed 2 MB whereas the attachment size for the file types .ppt, .doc, .xls, .mov, .mp4, and .avi must not exceed 25 MB. The attachment size for any other file type must not exceed 10 MB.
6. Click **Submit**.
   The appointment you just created now appears on the Activities tab in the side panel and your sales application. When you change the owner of the activity and save your updates, then the application does not remove your login information from invited resources. The new owner must sign in to the application to remove you as the original owner from invited resources.
Sales Application and Office 365 Records: How They Are Synchronized

You can synchronize contacts, appointments, and tasks between your sales application and Office 365 through Scheduled Processes.

Settings That Affect Synchronization

You can use the following synchronization settings, on the Manage Office 365 task page, to synchronize data between your sales application and Office 365. The Manage Office 365 task is available in the Sales offering and Integrations task.

- Enable Contact Synchronization
- Enable Appointment Synchronization
- Enable Task Synchronization
- Sync Private Appointments
- Sync Private Tasks

You can select predefined saved searches from the side panel or create your own saved search in the sales application. When you select a saved search, the corresponding records matching the saved search are synchronized with Office 365 when the next synchronization runs.

The following table lists the predefined saved searches options for contacts and activities such as appointments and tasks.

<table>
<thead>
<tr>
<th>Saved Search</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Contacts</td>
<td>All contacts in your sales application.</td>
</tr>
<tr>
<td>My Business Contacts</td>
<td>All contacts belonging to all the accounts you own.</td>
</tr>
<tr>
<td>My Contacts</td>
<td>All contacts, of the type account, that you are an owner of.</td>
</tr>
<tr>
<td>My Favorite Contacts</td>
<td>All your favorite contacts.</td>
</tr>
<tr>
<td>My Open Activities</td>
<td>All appointments that are open and you are a resource for in your sales application.</td>
</tr>
</tbody>
</table>

You can synchronize your Office 365 contacts and tasks with your sales application only if you have the Shared with Oracle category enabled. You must manually select the Shared with Oracle category from the Office 365 ribbon to synchronize contacts and tasks with Oracle Engagement Cloud.

**Note:** When you synchronize Oracle Engagement Cloud records with Office 365, the Shared with Oracle category is automatically added to each record in Office 365.
How Records Are Synchronized

When you create, update, or delete records using the side panel, information is updated simultaneously in your sales application and Office 365. However, if you modify records in either your sales application or Office 365, then the changes reflect in the other application only after synchronization.

Note: Contacts deleted in your sales application are instantly deleted in Office 365 whereas contacts deleted in Office 365 are deleted in your sales application only after synchronization. However, if synchronized contacts were originally imported into your sales application or created after data merge, then deleting the contact in your sales application does not delete the contact in Office 365. You must manually delete such contacts in Office 365.

Related Topics

- Configuring Saved Search for Office 365: Explained

FAQs for Using Office 365

What happens when I share an Office 365 email with your cloud service?

The shared email is associated as a task with the relevant account, opportunity, or lead. Related known contacts or resources are added to the task on your sales application.

How can I share an email that I am composing?

You can share Office 365 emails with the sales application through the side panel.

1. Compose an email and enter recipients.
2. Open the Office 365 add-in.
3. Click Share Email and select the contacts, leads, or accounts you want to share the email with.
4. Click Save.

The email is shared as a task after you send the email.

You can similarly share appointments that you compose in Office 365.

Can I share my Office 365 email attachments with my sales application?

Yes. Click Share email in the Related Records tab. From the list of contacts, accounts, and attachments associated with the email, select the attachments you want to share, and click Save. Attachments must not exceed 25 MB.
Why doesn't the category of my email show the sales application after I share it?

The category is added to your email after Outlook updates the inbox. To categorize instantly, click **Send / Receive** on the Office 365 ribbon. Click **Update Folder** and select the email.

Why can't I open the sales application records from the Office 365 side panel?

You cannot open the records because the profile option FND_CLASSIC_INTERFACE is enabled. Disable this profile option to view your sales application records from the Office 365 side panel.

Why aren't my sales application user preferences visible in the Office 365 side panel?

Any change that you make to user preferences in your sales application is reflected in the side panel only after you sign out of the add-in, restart Outlook, and sign in again.
Overview of Oracle Sales Cloud for IBM Notes

The Oracle Sales Cloud for IBM Notes application helps maximize sales productivity by providing your sales application capabilities directly within IBM Notes, thereby allowing sales professionals access to essential your cloud service data.

Summary of Features

The key features of Oracle Sales Cloud for IBM Notes are:

- Sales capabilities within IBM Notes: Using Oracle Sales Cloud for IBM Notes, all emails, calendar events, and tasks can be linked to the respective contact, customer, lead, or opportunity within your sales application. Sales professionals can access customer and sales information within IBM Notes.

- Single-click sharing between IBM Notes and your sales application: When sending a meeting invite or an email, or when setting up a task, a single click captures the action and updates of your sales application in the background.

- Synchronization of data between your sales application and IBM Notes: Two-way data synchronization allows sales professionals to have a continuously updated and accurate 360-degree view of your sales application data changes.

- Synchronization Control Panel: Oracle Sales Cloud for IBM Notes provides synchronization filtering capabilities, enabling sales professionals to synchronize only the most critical data from your sales application.

- Offline access: The transition between online and offline modes of operation allows sales professionals in the field to use the full functionality of the product in an offline mode, and then synchronize the sales data in the next synchronization cycle.

> Note: You cannot create user-defined configurations for Oracle Sales Cloud for IBM Notes as it is not supported.

Configuration of IBM Databases: Points to Consider

The Oracle Sales Cloud for IBM Notes configuration is deployed on top of the email database, which in most cases is located on the IBM Domino Server or on the Personal Address Book database, which is located on the client. These databases are both created and updated using IBM’s user-specific templates.
The following figure shows the IBM Notes and email database considerations to install Oracle Sales Cloud for IBM Notes.

As a part of your cloud service configuration process, the installer modifies some of the existing original design elements in the Personal Address Book and IBM Notes email databases. To protect those changes in the design elements from unexpected external updates, the **Prohibit design refresh or replace to modify** check box is selected for such modified elements. Therefore, the user-defined elements won’t be updated with any design refresh or be replaced, after the user-defined template is released. As a result, the IBM Notes email database’s design elements may become incompatible and cause errors.
Applying a New User-Defined Template on Top of the IBM Notes Email Database

To avoid errors, you must follow these steps. If you have user-defined configurations installed, and to apply a new user-defined template on top of the email database, then do the following:

1. Perform full synchronization with your cloud service server to synchronize all your local unsaved data.
2. Remove your sales application user-defined configuration from IBM Notes.
3. Deploy your own template on the IBM Notes email database.
4. Install the user-defined configuration again.

Oracle recommends that you test how your user-defined configurations work with your cloud service configurations using a test deployment, before rolling out your user-defined template.
21 Using Gmail

Overview of Oracle Sales Cloud for Gmail

Oracle Sales Cloud for Gmail helps increase sales productivity by providing your sales application capabilities within Gmail. Sales professionals can easily access the cloud service data such as contacts, appointments, and emails from their Gmail accounts.

Summary of Features

The key features of Oracle Sales Cloud for Gmail are:

- Synchronize contacts and appointments from your sales application with Gmail and have a consolidated view in Gmail.
- Selectively choose which emails, contacts, and appointments in Gmail are tracked in your sales application.
- Link your sales application Accounts, Contacts, Leads, Opportunities, and Resources with emails, contacts and appointments in Gmail.
- Administrative filters to determine which contacts and appointments synchronize to Gmail to limit the cloud service data in users’ Gmail accounts.

Note: Oracle Sales Cloud for Gmail does not support the concept of a joint email inbox.

Installing and Configuring Oracle Sales Cloud for Gmail: Explained

You can integrate your sales application with your Gmail account and access your contacts, appointments, and emails from your Gmail account. This topic explains how to install and sign in to the Oracle Sales Cloud for Gmail extension, how to upgrade to new versions, and how to uninstall.

To install the Oracle Sales Cloud for Gmail extension:

1. View the MOS note at https://support.oracle.com/epmos/faces/DocumentDisplay?id=2188228.1 for details on where to find the Gmail Extension on the Chrome Web Store.
2. Click Add to Chrome.
3. On the confirmation dialog box, click Add.

The Chrome extension for your sales application is now added to your Chrome browser.

The Oracle Sales Cloud for Gmail extension appears as a side panel on your Gmail when you open an appointment or an email.

Note: If you installed the extension after signing in to your Gmail, you must refresh the page for the Oracle Sales Cloud for Gmail side panel to appear.
To uninstall the Oracle Sales Cloud for Gmail extension:

1. Navigate to Chrome Settings.
2. Click **Extensions**.
3. Find the Oracle Sales Cloud for Gmail extension and click the **Remove from Chrome** icon.

**Signing in to Oracle Sales Cloud for Gmail**

Once you sign in to Gmail, you must open an appointment or an email for the Oracle Sales Cloud for Gmail side panel to appear.

To configure and sign in to Oracle Sales Cloud for Gmail:

1. Click the **Settings** icon on the side panel.
2. On your sales application connection page, enter the host name.

To obtain the host name, sign in and navigate to Accounts, and copy the server portion of the URL, for example, https://slc11kez.us.oracle.com. The following figure shows the sample URL with the portion you should copy highlighted.

![Sample URL](https://slc11kez.us.oracle.com)

3. Sign in using the salesperson user name and password that you use to sign in to your sales application.

**Upgrading to New Versions**

Oracle Sales Cloud for Gmail detects when a new version of the extension is available and automatically upgrades you to the latest version. If your Chrome browser is open, the upgrade happens only when you restart the browser.

**Creating Contacts from the Oracle Sales Cloud for Gmail Side Panel: Procedure**

You can maintain a consolidated list of your contacts within Gmail to work more effectively. You can add contacts to your sales application from your Gmail account.
Oracle Sales Cloud for Gmail identifies which of your contacts from an email or appointment exist in your sales application and highlights those that have to be added. The Gmail configuration also highlights Google contacts that do not exist on your cloud service server when you open a specific contact.

Adding Contacts to Your Sales Application
You must have an email, an appointment or the new or existing contact on Google Contacts open to add a contact to your sales application.

If your contact already exists in your sales application, the side panel displays the initials of the contact. For contacts that do not exist in your sales application, the side panel displays the person icon.

To add a contact to your sales application from Gmail:

1. Click the person icon for the contact on the side panel of Oracle Sales Cloud for Gmail.
   A message appears on the top of the Oracle Sales Cloud for Gmail panel notifying that the contact does not match an existing contact in your sales application.
2. Click the link on the message to add your contact.
   The Create page appears.
3. Enter the fields to create your contact, as defined in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Name</td>
<td>Enter the name of the contact.</td>
</tr>
<tr>
<td>Last Name</td>
<td></td>
</tr>
<tr>
<td>Job Title</td>
<td>Optionally, enter the job title of the contact.</td>
</tr>
<tr>
<td>Account</td>
<td>Optionally, search for and select the account that the contact belongs to.</td>
</tr>
<tr>
<td>Email</td>
<td>The email is automatically populated with the email ID that the opened email displays. You cannot edit the email ID.</td>
</tr>
<tr>
<td>Address</td>
<td>Enter the complete address of the contact.</td>
</tr>
<tr>
<td>Favorite</td>
<td>To save this contact as a favorite, highlight the star.</td>
</tr>
</tbody>
</table>

4. Click Save.

Your contact is now added to your sales application. Close the email and open it again. The contact you just added now appears as initials in the side panel indicating that the contact is now added to your sales application.
Creating Contacts Using Oracle Sales Cloud for Gmail: Examples

You can create contacts on your sales application using Oracle Sales Cloud for Gmail in several ways. The following examples illustrate these options.

Creating Contacts from E-Mail

You just received an e-mail on Gmail from your customer Devon Smith from Seven Corporation. You open the e-mail and the Oracle Sales Cloud for Gmail side panel appears. The side panel shows that your contact Devon Smith is not added as a contact on your sales application.

You would like to add Devon Smith to your sales application. You click the person icon and create your contact.

Creating Contacts from Appointments

You want to set up a meeting with Anne Balmer, a new contact that you are interacting with from Seven Corporation. You navigate to Google Calendar and create a new appointment. When you add Anne Balmer as a guest to the appointment, the Oracle Sales Cloud for Gmail side panel appears with the person icon to indicate that your contact is not added on your sales application. You click the person icon and create your contact on your sales application.

Creating Contacts from Google Contacts

You are viewing your list of contacts on Google contacts to verify if you have already added your customer Fen Lee as a contact on Google. You do not see the contact, and you want to create the contact and also add it to your sales application. You click **New Contact** on Google Contacts and enter the name of the contact, Fen Lee. The Oracle Sales Cloud for Gmail side panel appears and shows that your contact is not added as a contact on your sales application.

You click the person icon and create the contact Fen Lee on your sales application.

*Note:* If you add a note to the contact on Google Contacts, the note is not synchronized with your cloud service server.

Sharing Your Email with Sales Application Users: Example

You can share e-mail that you receive or send from your Gmail account with your sales application. You can share e-mail related to a specific account, opportunity, or lead with your team on your sales application thereby providing them with any relevant information or history related to the customer. Sharing e-mail not only associates your e-mail as an activity with
the relevant account, opportunity or lead, but also adds related known contacts or resources to the Activity on your sales application.

This topic provides an example that illustrates how to share an e-mail as an activity of type task under opportunities on your sales application.

Sharing Email with Your Sales Application

You are a sales representative handling the North America region for laptop sales. You are in conversation with a customer on their requirement for your new range of laptops. You have just received an e-mail reply from the customer with some questions on pricing. You would like to associate this e-mail with an existing opportunity on your sales application so that you can share it with your manager and other salespeople on your team.

You click the E-mail icon on the side panel of Oracle Sales Cloud for Gmail.

On the Share E-Mail page, you search for and select the relevant opportunity and click Save. You have now saved your e-mail on your sales application as an activity task for the selected opportunity, making it available for your team to review. When salespeople open the opportunity, they can now view this e-mail as an activity associated with the opportunity.

Note: If the e-mail that you are sharing contains attachments, all attachments that are 10 MB or less are associated with the corresponding task in your sales application.

Synchronization Settings: Explained

You can synchronize your contacts and appointments between your sales application and Gmail. This topic explains how you can set up the synchronization on your Oracle Sales Cloud for Gmail.

Synchronization of contacts and appointments between Gmail and your sales application is triggered automatically according to the defined synchronization frequency. All Google contacts and appointments are not automatically saved in your cloud service server. You must choose contacts and appointments that you want saved in your sales application in the Oracle Sales Cloud for Gmail side panel.

Synchronization Settings

You can use two settings to select saved searches and determine what you want to synchronize between your sales application and Gmail:

- Contact Synchronization
- Activity Synchronization

You can select the setting you want from the drop-down list of the Oracle Sales Cloud for Gmail side panel. You can select a saved search option to set up synchronization between your sales application and Gmail.

Note: After contacts and appointments are synchronized between your sales application and Gmail, any updates to the contacts and activities either on your cloud service server or on Gmail are synchronized during the next synchronization depending on the frequency that your administrator has defined.
Saved Search

You can use the predefined saved searches that are available in the drop-down list on Oracle Sales Cloud for Gmail or create your own saved search for your sales application. By default, the saved search for contact is set to **My Favorite Contacts** and for appointment it is set to **All Open Activities**.

Apart from the predefined saved searches, if you want to define your saved search, you can create it on your sales application. The following table lists the predefined saved search options for contact and activity, along with descriptions.

<table>
<thead>
<tr>
<th>Saved Search</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Contacts</td>
<td>All contacts in your sales application.</td>
</tr>
<tr>
<td>My Business Contacts</td>
<td>All contacts belonging to all the accounts you own.</td>
</tr>
<tr>
<td>My Contacts</td>
<td>All contacts, of the type account, that you are an owner of.</td>
</tr>
<tr>
<td>My Favorite Contacts</td>
<td>All your favorite contacts.</td>
</tr>
<tr>
<td>My Open Activities</td>
<td>All appointments that are open and you are a resource for in your sales application.</td>
</tr>
</tbody>
</table>

When you select a saved search, the corresponding records matching the saved search are synchronized with Gmail when the next synchronization runs. If you then select another saved search, a new set of records are synchronized with Gmail. However, the old set of records synchronized with Gmail earlier continue to remain on Gmail. You must manually delete these records on Gmail. If you update a record from the old set of records on Gmail, your changes will be synchronized with your sales application. However, if you update a record from the old set of records in your sales application, your changes are not synchronized with Gmail.

**Related Topics**
- Scheduling Gmail Synchronization Job: Procedure
- Managing Contact Saved Search Lists: Explained

Sales Application and Gmail Synchronization: Explained

You can synchronize your contacts and appointments between your sales application and Gmail. This topic explains how synchronization works when you create, update, or delete records in your sales application in Gmail.

**New Records**

Contacts and appointments that you create in your sales application are added to Gmail during synchronization, based on the saved search criteria that you have defined. However, contacts and appointments that you create in Gmail are not synchronized with your cloud service server. You can synchronize contacts and appointments with your sales application only through the Oracle Sales Cloud for Gmail side panel.
**Note:** If you mark a new contact as favorite in your sales application, the contact does not appear as favorite in Gmail.

### Updated Records

Contacts and appointments that are already shared with your sales application can be updated directly in Gmail or in the side panel.

- **Updates in the side panel:** If you update your record in the side panel, the record is updated in your sales application as soon as you save your record.
- **Updates in Gmail:** If you update the record in Gmail, the record in your sales application is updated during the next synchronization. Any updates to records in your sales application are updated in Gmail during the next synchronization.

### Deleted Records

You can delete records only in your sales application. If you delete a shared contact or appointment in Gmail, the record is shared with Gmail again from your sales application during the next synchronization.

### Simultaneous Updates to Records

If contacts or appointments are updated simultaneously in your sales application and Gmail, the updates in your cloud service server are retained and synchronized with Gmail. Between synchronization cycles, even if a record is updated first in your sales application and then in Gmail, the updates made in your sales application are retained and synchronized with Gmail.

For example, your synchronization duration is set to run once every hour starting at 12.00 a.m. During the synchronization cycle between 2.00 p.m. and 3.00 p.m., a salesperson updates the mobile number of a contact in your sales application at 2.10 p.m. You update the mobile number of the same contact on Gmail at 2.45 p.m. When synchronization runs at 3.00 p.m., your changes on the contact will be lost and the mobile number update on your sales application will be brought down to Gmail although you made your change later in the synchronization cycle.

**Related Topics**

- Scheduling Gmail Synchronization Job: Procedure
Using Mobile Applications

Using Mobile Applications: Overview

Oracle Applications Cloud offers the following mobile applications that integrate with Oracle Sales Cloud: Oracle CX Cloud Mobile and Oracle Sales Cloud Mobile. This chapter outlines the capabilities of these applications, provides installation information, and answers general use questions.

Oracle CX Cloud Mobile

Oracle CX Cloud Mobile: Overview

The Oracle CX Cloud Mobile (CX Cloud Mobile) application enables field sales representatives, channel account managers, and partner representatives to manage their day effectively and develop customer relationships using a smartphone. With a task-based user interface and built-in analytics, the CX Cloud Mobile application guides daily sales activities and enables the following activities for sales representatives:

- Manage Sales Activities
  - View your calendar and configure color coding to quickly distinguish between customer meetings, demos, and other sales activities.
  - View and update opportunities.
  - Create follow up tasks, to help you manage your opportunities.
  - View and update call reports, to help you prepare for future meetings and log meeting attendees, objectives, and minutes.
  - Review quote proposal documents and email them to customers. Share proposals with relevant team members and get feedback before finalizing the proposal.
  - View leads in your vicinity using the map.

- Use Offline
  - View and edit Oracle Engagement Cloud data in areas with no network connection.
  - Sync automatically when a connection is re-established.

- Configure the Application
  - Configure your application using a drag-and-drop interface designer.
  - Add, remove, and reorder standard or custom fields.
Create layouts based on sales roles.

- **Navigate Using Voice**
  - Find any sales record with a simple command from anywhere in the application. For example, say, "Open Account Pinnacle Technologies"

- **View Customer Service Requests**
  - View, create, and edit service requests
  - Access related information such as team, message, and attachments
  - View service request interactions and milestone history

- **Manage Partner Relationships**
  - Submit and approve deal registrations
  - Manage partners and partner contacts

## Installing

**What are the supported platforms for Oracle CX Cloud Mobile?**


### Installing the iPhone Application: Procedure

This procedure shows you how to install the Oracle CX Cloud Mobile application on your iPhone.

1. Open the App Store, search for Oracle CX Cloud Mobile application, and then tap **Install**.
2. Open the application. If you have received an application URL from your administrator, you can tap on the URL link to open the application. Alternatively, you can scan the QR code to launch the application.
3. Accept the Legal Terms.
4. If you have opened the application using the application URL or the QR code, the host name, port number, and SSL details will be populated automatically.
   - If you opened the application after downloading it from the App Store, you must enter the host name your administrator has provided (or refer to the Finding Your Company’s Host URL: Worked Example topic).
5. Enter your Engagement Cloud application user name and password. You can tap **Save Password** to save this password.
6. Tap **Sign In**.

### Installing the Android Application: Procedure

This procedure shows you how to install the Oracle CX Cloud Mobile application on your Android device.

1. Open the Google Play Store on your Android device.
2. Search for the Oracle CX Cloud Mobile application and tap **Install**.
3. Open the application. If you have got the application URL from your administrator, you can tap on the URL link to open the application. Alternatively, you can scan the QR code to launch the application.
4. Accept the Legal Terms.
5. If you have launched the application using the application URL, or the QR code, the host name will be populated automatically.
If you have opened the application after downloading it from the Google Play Store you must enter the host name provided by your administrator (or refer to the Finding Your Company's Host URL: Worked Example topic). Tap **Settings** to enter the host name.

6. Enter your Engagement Cloud application user name and password. You can tap **Save Password** to save this password.

Setting Up Calendar and Contact Synchronization on Your iPhone: Worked Example

This example shows you how to set up the synchronization of Oracle Engagement Cloud calendar and contacts with the native calendar and contacts on your iPhone.

**Note:** You can synchronize your Oracle Engagement Cloud favorite contacts using the contact synchronization. However, the calendar synchronization does not synchronize invitees.

Install the Calendar Synchronization Profile

1. Sign in to Oracle CX Cloud Mobile (CX Cloud Mobile) using your user name and password.
2. Tap the menu icon to access the shuttle menu.
3. Tap **Settings** and tap **Setup Calendar Sync**.
4. The Safari browser opens automatically with the Oracle Engagement Cloud sign in page displayed. Sign in using your CX Cloud Mobile name and password and install the synchronization profile onto your phone. Installing the profile adds a new calendar to your iPhone that you can view beside your other calendars.
5. Enter the password for the CalDav server. This is the same password that you use to sign in to Oracle Engagement Cloud.
6. Tap **Next**.
7. When you have finished tap **Done**.

Install the Contacts Synchronization Profile

1. Sign into CX Cloud Mobile using your user name and password.
2. Tap the menu icon to access the shuttle menu.
3. Tap **Settings** and tap **Setup Contact Sync**.
4. Repeat steps 5 to 7 above.

General Use

**How can I navigate within Oracle CX Cloud Mobile?**

On both the iPhone and Android mobile devices, tap the menu icon to show the list of features. Then tap the feature to retrieve a list of items; for example, tap Opportunities to retrieve a list of your open opportunities. To view the item details, tap any item in the list view. In the list view, swipe right on an item to access frequent tasks.

To e-mail, call, text, or locate a contact quickly, tap their initials to display a contact wheel, and then tap the relevant icon. Your smartphone’s native e-mail, phone, or text application opens, or - if you have tapped the pin icon - a map opens within Oracle CX Cloud Mobile.

Tap the more icon anywhere within the application to view actions for an item, such as logging a call, creating a task, or sending an e-mail that you’re running late.
How can I remove a contact from an opportunity, account, or lead?
From the opportunity, account, or lead detail page, tap the Contacts tab and swipe right on the contact you want to remove. Tap the more icon and tap Remove.

How can I add an objective when I am creating a call report?
There are two different kinds of objectives that you can add when creating a call report: A predefined objective and a user-defined objective.

To create a predefined objective:
1. Tap the plus icon in the Objectives section
2. Select the predefined objective
3. Tap Add

To create a user-defined objective:
1. Tap the plus icon in the Objectives section
2. Type the name of the objective at the top of the page
3. Tap Add

How can I view an interaction that I have logged?
Open the navigator menu and tap Call Reports. Tap the list of options at the top of the page and select My Call Reports. Alternatively, you can view the Leads, Contacts, or Accounts details pages and tap the Activities tab.

Why can't I view more records on the map?
You can only view the first 25 records prioritized by your current location. If there are more records, you will see a message saying there are more records in the vicinity. Tap the message and you will see the next 25 records (as well as the ones you can already view). If there are more records to display, then tap the message again and you will see another 25 records on top of the records you can already view (totaling the first 75 records in your vicinity).

How can I change my primary contact in an opportunity, account, or lead?
Tap the edit icon on the opportunity, account, or lead, and tap the cross icon that appears next to the primary contact name. Select a new primary contact from the contact list and tap Save.

Voice Commands: Explained
You can use the following voice commands in Oracle CX Cloud Mobile to navigate around the application.

> **Note:** Voice commands are available in English only at this time.

<table>
<thead>
<tr>
<th>To do this</th>
<th>Say this</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open a page</td>
<td>Open &lt;page name&gt;</td>
<td><em>Open Calendar</em></td>
</tr>
<tr>
<td>Take me to &lt;page name&gt;</td>
<td><em>Take me to Deal Registrations</em></td>
<td></td>
</tr>
<tr>
<td>Pull up &lt;page name&gt;</td>
<td><em>Pull up Opportunities</em></td>
<td></td>
</tr>
<tr>
<td>Go to &lt;page name&gt;</td>
<td><em>Go to Tasks</em></td>
<td></td>
</tr>
<tr>
<td>Show &lt;page name&gt;</td>
<td><em>Show Contacts</em></td>
<td></td>
</tr>
</tbody>
</table>

<p>| Open a list | Open/open my&lt;list name&gt; | <em>Open my Account list</em> |</p>
<table>
<thead>
<tr>
<th>To do this</th>
<th>Say this</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Take me to/my take me to the &lt;list name&gt;</td>
<td><em>Take me to the Contact list</em></td>
<td></td>
</tr>
<tr>
<td>Pull up/pull up my/pull up the &lt;list name&gt;</td>
<td><em>Pull up Lead list</em></td>
<td></td>
</tr>
<tr>
<td>Go to/go to my/go to the &lt;list name&gt;</td>
<td><em>Go to my Opportunity list</em></td>
<td></td>
</tr>
<tr>
<td>Show/show my/show the &lt;list name&gt;</td>
<td><em>Show the Deal Registration list</em></td>
<td></td>
</tr>
</tbody>
</table>

**Open a record**

<table>
<thead>
<tr>
<th>To do this</th>
<th>Say this</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open &lt;record type&gt; &lt;record name&gt;</td>
<td><em>Open Deal Registration 'Elite Server'</em></td>
<td></td>
</tr>
<tr>
<td>Take me to &lt;record type&gt; &lt;record name&gt;</td>
<td><em>Take me to Call Report 'Key Account Call'</em></td>
<td></td>
</tr>
<tr>
<td>Pull up &lt;record type&gt; &lt;record name&gt;</td>
<td><em>Pull up task 'Executive Demo Prep'</em></td>
<td></td>
</tr>
<tr>
<td>Go to &lt;record type&gt; &lt;record name&gt;</td>
<td><em>Go to Accounts 'Pinnacle Technologies'</em></td>
<td></td>
</tr>
</tbody>
</table>

**Search for a record**

<table>
<thead>
<tr>
<th>To do this</th>
<th>Say this</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search for &lt;record type&gt;&lt;record name&gt;</td>
<td><em>Search for task 'Email Quote'</em></td>
<td></td>
</tr>
<tr>
<td>Find &lt;record type&gt; &lt;record name&gt;</td>
<td>Find contact ‘Cole Mitchell’*</td>
<td></td>
</tr>
<tr>
<td>Look for &lt;record type&gt; &lt;record name&gt;</td>
<td>Look for opportunity 'Data Center Upgrade'*</td>
<td></td>
</tr>
</tbody>
</table>

**Open an embedded application**

<table>
<thead>
<tr>
<th>To do this</th>
<th>Say this</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search for &lt;application name&gt;</td>
<td><em>Search for 'Incentive Compensation'</em></td>
<td></td>
</tr>
<tr>
<td>Go to &lt;application name&gt; &lt;application name&gt;</td>
<td><em>Go to ‘Social’ application</em></td>
<td></td>
</tr>
</tbody>
</table>

**Open the settings page**

<table>
<thead>
<tr>
<th>To do this</th>
<th>Say this</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open/Take me to/Pull up/Go to the Settings page</td>
<td><em>Take me to the Settings page</em></td>
<td></td>
</tr>
</tbody>
</table>

**Open the home page**

<table>
<thead>
<tr>
<th>To do this</th>
<th>Say this</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open/Take me to/Pull up/Go to the home page</td>
<td><em>Pull up the home page</em></td>
<td></td>
</tr>
</tbody>
</table>

There are also specific sentences that you can say to open your task list and calendar, and to turn off the voice feature.

<table>
<thead>
<tr>
<th>To do this</th>
<th>Say this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open the task list</td>
<td><em>What’s on my task list?</em></td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td><em>What should I do next?</em></td>
</tr>
</tbody>
</table>

| Open the calendar         | *What’s on my calendar?*                        |
|                           | or                                              |
|                           | *What’s next on my calendar?*                   |
|                           | or                                              |
|                           | *What’s coming up next?*                        |

| Turn off voice commands   | *Close voice*                                   |
Working Offline

Can I use CX Cloud Mobile when there is no network available?
Yes, you can view, create, and edit records in the application even when you don’t have access to a cellular (mobile) or Wi-Fi network. When the network connection is lost, a banner is displayed to indicate that you are working offline. When the network connection is restored, the application will automatically sync the updates you have made on your phone to Oracle Engagement Cloud. Alternatively, you can manually sync the records by tapping Pending Sync in the main menu.

Why can’t I view updates to my data?
When the application is in offline mode, you cannot view any updates that were made to the sales data since the application changed to offline mode, because of the absence of a network connection. You can view data updates when you access the record again after regaining access to a network connection.

Can I create new records offline?
Yes, you can create, edit, and delete records throughout the application in the offline mode and then sync them once the network connection is restored. You will see a banner telling you that you are in the offline mode when the application detects the network connection is lost.

Data Availability and Capacity in Offline Mode: Explained
Oracle CX Cloud Mobile (CX Cloud Mobile) enables you to access your sales data offline by storing up to 500 MB of data on your smartphone.

Here are some details about the data that is available in the offline mode and how to specify how much data you want to store on your phone when you’re in the offline mode.

Data Availability
All of the data that you view in the application when you are online will be available when you are offline. Also, all of the sales objects that your administrator has specified for offline use, such as opportunities and contacts, are available in the offline mode. The data can be synchronized when the application detects a network connection and switches to the online mode, or alternatively you can sync the records manually.

Note: Any features that require access to online data, or a network connection, are not available offline. These include reports, analytics, maps, voice navigation, and Oracle Social Network.

Data Capacity
Up to 50 MB of offline data can be downloaded to your device by default. This is usually sufficient for typical usage, however if you find that this isn’t enough then you can increase the storage in increments of 100 MB, up to a maximum of 500 MB. To change the storage amount, open the main menu in the application, tap Settings and then select the storage limit in Offline Storage Limit.

Your administrator can specify how long the downloaded data is stored. After this time the data will be erased and more recent data is downloaded when you next use the application online.
Feature Availability in Offline Mode: Explained

You can view, create, and edit records in the application even when you don’t have access to a cellular (mobile) or Wi-Fi network. However, any features in the application that require access to up-to-date data are not available offline, for example, reports and analytics.

Also, any features that need to interact with online data, or interact with other applications, are not available offline. These include maps, voice navigation, and Oracle Social Network.

How can I synchronize my offline data?

Depending on the settings that your administrator has specified, your data either synchronizes automatically when the device detects a network connection and goes online, or you can synchronize your data manually.

What happens if there is an issue with data synchronization?

You can find a list of records that have had synchronization issues in the shuttle menu item called Pending Sync. You can sync the records manually once the issues have been resolved.

Note: If Oracle CX Cloud Mobile detects a data conflict, then the changes made in CX Cloud Mobile override any changes made in the Oracle Engagement Cloud application.

How can I stop the offline banner notification from appearing?

Tap Settings on the main menu and in the Offline Mode section set the Offline Notification toggle to off.

Sales Cloud Mobile

Oracle Sales Cloud Mobile: Overview

Use the Oracle Sales Cloud Mobile application to do the following tasks:

- Track and update sales information on your smartphone or tablet
- Keep up to date with sales activities in your enterprise while on the move

Tasks That You Can Do

The key features of Oracle Sales Cloud Mobile include the following:

- Application Home Page: From the application home page, you can access critical information when you’re in the field.
- Sales Account Management: You can access reference information, as well as current events about the customer while on the road.
- Opportunity Management: From the mobile opportunity management page, you can access current and critical information about your opportunities and share opportunity updates with your sales team.
- Lead Management: With access to open leads while on the road, you can act upon leads and reduce the sales cycle time.
- Calendar and Tasks: With these features, you can manage appointments and tasks on the road.
• Contacts: You can call or e-mail contacts from the Actions menu. The application displays a list of your key contacts by default, and you can search for all other contacts. E-mail Contact and Call Contact features are disabled for contacts who don’t want to be phoned or e-mailed
• Sales Analytics: You can access business intelligence reports from the home page. Analytics also are embedded contextually for each account that you view. The contextual reports include data on sales account revenue trends, sales account win/loss trends, and sales account win/loss reasons.
• Alerts: You receive alerts when new leads are assigned or opportunities of interest become available.

Prerequisites
Before implementing Sales Cloud Mobile, you must:

• You must set up Oracle Engagement Cloud before you can use Sales Mobile.
• Determine if your mobile device meets Sales Mobile system requirements. See the System Requirements for Oracle Applications Cloud here: http://www.oracle.com/us/products/system-requirements/overview/index.html

Installing

What are the supported platforms for Oracle Sales Cloud Mobile?
See the System Requirements for Oracle Applications Cloud at: http://www.oracle.com/us/products/system-requirements/overview/index.html

Installing the Oracle Sales Cloud Mobile iPhone Application: Procedure
This procedure shows you how to install Oracle Sales Cloud Mobile on your iPhone.

1. Use your iPhone to sign in to iTunes and access the App Store.
2. Search for Oracle Sales Cloud Mobile and then tap Install.
3. Enter the host URL that your administrator has provided.
4. Enter your user name and password.
5. Sign in to the Oracle Sales Cloud Mobile application.

Related Topics
• Finding Your Company’s Host URL for Oracle Sales Cloud Mobile: Worked Example

Installing the Oracle Sales Cloud Mobile Android Application: Worked Example
This example shows you how to install the Oracle Sales Cloud Mobile application on an Android device.

1. Use your Android device to sign in to Google Play, then browse the Apps.
2. Search for Oracle Sales Cloud Mobile and then tap Install.
3. Enter the host details that your administrator provided.
4. Open the Oracle Sales Cloud Mobile application, and enter your user name and password.
5. Sign in to the Oracle Sales Cloud Mobile application.

Related Topics
• Finding Your Company’s Host URL for Oracle Sales Cloud Mobile: Worked Example
Installing the Oracle Sales Cloud Mobile BlackBerry Application: Worked Example
This topic shows you how to install the Oracle Sales Cloud Mobile application on a BlackBerry device.

1. Check that the BlackBerry’s Wi-Fi is switched on.
2. Obtain the host URL from your administrator, then enter the host URL in the BlackBerry browser.
3. Enter the authentication credentials to sign in.
4. Click Start Download to start the download and installation.

Related Topics
• Finding Your Company’s Host URL for Oracle Sales Cloud Mobile: Worked Example

How can I update the Oracle Sales Cloud Mobile application on my BlackBerry device?
Enter the following URL in the BlackBerry browser: http(s)://host:port/sales/faces/MobileInstallerMain (replace the word "host" with the location of the latest version of Oracle Engagement Cloud). Enter the authentication credentials to sign in, and click Start Download to start the download and installation of the latest version of Oracle Sales Cloud Mobile. Your existing Oracle Sales Cloud Mobile installation will be overwritten.

Note that Oracle Sales Cloud Mobile application is not available on BlackBerry App World.

Configuring Off-line Access for Oracle Sales Cloud Mobile: Worked Example
If your administrator requires that all data stored on devices, you must first configure off-line access. By default, all data is encrypted and secured.

iOS users must perform the following tasks:

1. Swipe to open the side navigation panel
2. Tap Configure Offline Mode.
3. Install the profile when prompted.

Android users must perform the following tasks:

1. Open the Settings app on your Android device.
2. Tap Security.
3. Tap Encryption. Note: Your device may have a different label such as Encrypt Tablet or Encrypt Device.

General Use

How can I navigate within the Oracle Sales Cloud Mobile client?
On both the Apple iPhone and Blackberry mobile devices, tap any icon on the home page to show a list of items. For example, tap Opportunities to retrieve a list of your open opportunities. To view details, tap any item in the list view. Scroll upward in list view to access a search box. To access contextual actions, tap and hold any list item to reveal available contextual actions.

On the Apple iPhone, tap the Title bar to return to the application springboard. Select Action to reveal a contextual action sheet. Select Action again to close the action sheet.

On the Blackberry, both Short and Full menus are enabled. You can also use the Back button to return to the previous screen.
Why can't I access Oracle Sales Cloud Mobile?
You must have the Sales Representative duty role to access Oracle Sales Cloud Mobile. The delivered application has this role granted in the Sales Representative, Sales Manager, and Sales VP job roles.

How can I remove contacts, assignees, and resources from appointments, tasks, and interactions?
Navigate to the appointment, task, or interaction, and tap Edit to turn on the edit mode. Tap and hold on the contact, assignee, or resource you want to remove for two or three seconds. Then tap Remove, and tap Done to save your update.

Note that the owner of the appointment, task, or interaction can't be removed.

How can I manage my activities in Oracle Sales Cloud Mobile?
While viewing an opportunity, lead, customer or contact, open Activities. By default, your current activities are shown. This list includes the activity subject, due date and an icon that denotes the type of activity.

When is data quality checked in Oracle Sales Cloud Mobile?
If your company has licensed and set up Oracle Engagement Cloud Data Quality features, when you enter a new contact address, upon clicking Done, you are presented with a list of similar addresses. You can choose the closest match, merge the new information with the existing contact, or save the new contact you just entered.

How can I change my Primary Contact in an opportunity, account, or lead in Oracle Sales Cloud Mobile?
While viewing the contact list in the opportunity, account or lead, tap the Action list and choose Change Primary Contact. Tap and hold the contact name that you want, then choose Make Primary.

Why is the contact's account information missing?
When you open the Create or Edit Appointment page, and then create a contact record from the contact search results page, the related account information won't be transferred to the new record. You will need to select the account associated with the contact record, even if you have already associated an account with the original appointment.

How can I remove a contact from an opportunity, account, or lead?
While viewing the contact list in the opportunity, account or lead, tap the Action list and choose Remove Contact Association. Tap and hold the desired contact name, then choose Remove Contact.

How can I create customers and prospects in Sales Cloud Mobile?
When you create an account, you can create customers at the same time. Enter a name, and designate the customer as either a prospect or a customer. No additional information (such as an address) is required. The account list displays both prospects and customers.

How can I work with reports and graphs in Sales Cloud Mobile?
You can swipe to navigate between reports, or tap to view a list of available reports. When you’re viewing a report, you can tap and hold a slice of graph to see the aggregate values, for example, on a bar of a bar graph, to see values for the bar. You can also double tap to drill down into the area of the graph or see the report view, or pinch and zoom to zoom in or out of a graph.

Why can't I convert a lead to an opportunity?
You can convert a lead to an opportunity only when the prospect or customer associated to the lead is a sales account.
How can I create a search criterion that can be saved for use in the Oracle Sales Cloud Mobile application?

You can create saved search criteria for Apple and Android devices. Use either Oracle Page Composer or the Oracle Engagement Cloud web interface to create the saved search. Select **Run Automatically** to ensure that the search can be executed in the Oracle Sales Cloud Mobile application. Tap the search name in Oracle Sales Cloud Mobile to execute the saved search.

How can I view saved search criteria?

Tap the magnifying glass icon in the list view to view a list of available saved searches. Execute the search by tapping an individual saved search. Tap the search box to see additional fields where you can make changes to the search criteria.

Why can't I access the Around Me feature from Oracle Sales Cloud Mobile?

The Around Me feature isn't available for BlackBerry devices. It's available only for devices that use the iOS and Android operating systems.

Why can't I view the Around Me results on a map?

Android devices display the Around Me results in a list view, but not on a map.

Can I delete the custom fields I have created for the Around Me feature?

Yes. If you created custom fields for the Around Me feature for earlier releases, then you don’t have to maintain the fields with geocodes because the application no longer uses them.

### Working Offline

**Why can't I view updates to my data on Oracle Sales Cloud Mobile?**

When the application is in offline mode, due to the absence of a network connection, you cannot view any updates that were made to the sales data since the application changed to offline mode. You can view data updates when you access the record again after regaining access to a network connection.

**Why can't I create, edit, or delete any data in the Oracle Sales Cloud Mobile application?**

Verify that you have network coverage. Data cannot be created, edited or deleted in offline mode.

**What data is available in the Oracle Sales Cloud Mobile offline mode?**

Oracle Sales Cloud Mobile saves up to 50 MB of recently viewed data on the mobile device. After 50 MB is reached, the application removes the oldest entries to make room for newer data. Data stored includes:

- A list of opportunities
- Specific opportunity details
- A list of contacts
- Customer details

When you are using the offline mode, you can view saved data. You can also save specific account records and their related objects for offline use by tapping the **action** menu when viewing the record, and saving the customer detail.

When the application can connect to a network and you can get back online, data is not automatically synchronized with the data updates that other people have made when you were offline. To view updated data, you must access the records again in online mode.
Note that custom objects are not available in offline mode.

Integration with Oracle Social Networks

Can I use Oracle Social Network within Oracle Sales Cloud Mobile?
Yes, you can call the Oracle Social Network application for the customer, opportunity, or contact that you’re viewing. Navigate to the detail view of the customer, opportunity, or contact, tap the Actions menu, then start the Oracle Social Network application by tapping Conversations.

How can I use Sales Cloud Mobile to collaborate through Oracle Social Networking?
You can manually share and view information about opportunities, leads, and contacts in two ways. When you create an object, upon saving, you can share the object, or, while viewing an object’s details, you can tap Conversations in the Action sheet to see recent conversations.

You can also share information automatically. Automatic sharing means that a social object is created automatically in Oracle Social Network when an object - such as an opportunity, lead, or contact - is created in Oracle Sales Cloud Mobile. For more information about sharing information automatically, see the Oracle Sales Cloud Social Network Administration: Overview help topic.

What types of attachments can I include in Oracle Sales Cloud Mobile?
You can create image (for example, GIF or JPG) and audio files as attachments. You can view, but not save or create, PDF and Microsoft Office documents including Word, PowerPoint, and Excel attachments.

How can I view attachments offline in Oracle Sales Cloud Mobile?
To view an attachment offline, you must explicitly download it to your mobile device. In the attachment list view, tap the Actions menu to go into edit mode. Then, select one or more attachments to save locally and tap Done. When you tap Done, the attachment is saved locally for offline access.

How can I share attachments with my Oracle Social Network contacts from Oracle Sales Cloud Mobile?
In the attachment list view, tap on the action Post on OSN, then select one or more attachments, and tap Done.
23 Using Social Networking

Social Networking: Overview

Oracle Social Network is a secure, private social network that integrates with your sales application and connects you with all your colleagues. With Oracle Social Network, you and your teams have the tools to collaborate, capitalize on collective experience, and make informed business decisions.

You can use Oracle Social Network for:

• Discussing projects, plans, and issues in public forums, membership groups, or one-on-one.
• Reviewing and publishing files.
• Following the daily activities of the people you choose.

The real power of Oracle Social Network is how it integrates with common sales objects. For example, you can bring an opportunity into a Conversation where you can discuss it, plan around it, and share it. You can take the opportunity from possibility to realization without losing any of the casual and formal information that flows from all of this activity.

Note: You can create custom reports for Lightbox. For more information see the Creating and Administering Analytics guide.

Adding Oracle Social Network: Overview

After the administrator has enabled Oracle Social Network in your environment, you can add Oracle Social Network to your sales application.

Objects Enabled for Oracle Social Network

You can share object records to Oracle Social Network as Social Objects.

To share object records:

1. Click the Social tab from within the specific opportunity to open Oracle Social Network.
2. Click the Social link on a specific object record.
3. Click Share if the opportunity hasn’t already been shared.
4. Click Join to join the opportunity.

Sharing Information Using Oracle Social Network

Oracle Social Network helps you collaborate with colleagues who can share their knowledge or information about a particular business object. Sharing knowledge and collaborating helps you to be prepared with the latest data. Using Oracle Social Network conversations, you can associate collaborative discussions with a particular Oracle Applications Cloud object. You
can include participants in the conversation even if they don’t have access to Oracle Applications Cloud. You can also join an object, add members to the wall, post messages, and share the object if the object hasn’t been shared.

Objects you can tie conversations to include:

- Accounts
- Activities
- Contacts
- Households
- Leads
- Opportunities
- Partner accounts

The following example shows how to use Oracle Social Network to share information. The example is common to all object types, though the specifics might vary slightly by object. For example, suppose you are a sales representative who needs more information about the way regulations work in a particular territory, so you want to seek additional information from colleagues with knowledge of that territory. To share information:

1. Click the **Social** tab from within the specific object to open Oracle Social Network.
2. Click **Share** if the object hasn’t already been shared, or **Join** to join the object. You can also add members to the wall and post messages to the wall associated with the object.
3. Click **Create New Conversation**, from the More Options menu, to create a new conversation about the object.
4. Add your knowledgeable colleagues to the conversation.
5. Post your questions to the conversation, and mark them for follow-up to let your colleagues know you’re waiting for their responses.
6. When your colleagues respond (perhaps with Word documents or other useful files), you can annotate these files with additional questions and comments if necessary. Mark the additional questions for follow-up to alert your colleagues that you have updated them.
7. Continue the collaboration in the conversation as long as you require further details. If you want additional information, you can add more colleagues.

If you see the **Social** link in an Oracle Engagement Cloud object, that’s your cue that social networking features are available for that particular object.

**Note:** Oracle Social Network integration is only available with Oracle Cloud deployments.

### Collaborating to Drive Sales Activity

If you are a sales manager, you can encourage collaboration among your team and any other people at your company who can provide information. To do this:

1. Review your team’s conversations, and identify any issues that they might need help with.
2. Add colleagues, both in your group and in other areas, who have knowledge about these issues.
3. If necessary, add documents to the conversation to update your newly added colleagues about the issue.

You can facilitate collaboration when you notice that one of your team’s sales accounts hasn’t had any activity for two months. You can collaborate with the customer about a new product that fits their requirement. To facilitate collaboration:

1. Start a private conversation with a member of the product team to discuss the product and how well it meets the customer’s needs.
2. Schedule a meeting between you, the product team member, and the salesperson.
3. You and the other participants can post files, such as a slide deck, to the conversation for review prior to the meeting.

4. Participants can annotate the files with additional or updated information both before and after the meeting.

>Note: Oracle Social Network is currently available in Cloud implementations only.
Managing Service Requests

Service Request Management: Overview

The service request management feature enables sales and service professionals to manage and deliver a streamlined service in response to service requests. Delivering consistent answers to customer questions help ensure that service requests are resolved efficiently and effectively.

Service request management lets salespeople:

- Create service requests
- Enter summary information into service requests
- Add products and product groups to service requests
- Organize service requests into queues
- Compose and send messages from service requests
- Add contacts to service requests
- Add team members to service requests
- Automatically or manually assign service requests to other users
- Create activities for service requests
- Share service request information using a social network
- Associate and view items in the knowledge base
- Integrate with the partners application to capture and resolve issues reported by your partner accounts

See the Oracle Engagement Cloud Using Service in Engagement Cloud guide for more information about sales user tasks for service requests.

Related Topics
- Managing Service Requests: Overview

Service Request User Tasks: Overview

You can create and manage service requests once your sales administrator enables the service request offering. To create a service request (SR), select the Service Requests menu from the Navigator page, and on the Service Requests list page, click Create Service Request.

You can perform the following high-level user tasks for service request management:

- Capture service requests
  You can capture new service requests through user data entry, APIs, or file import.
- Organize and assign service requests
  You can organize and assign service requests to queues either manually or using the Assignment Manager feature. You can also assign service requests to team members through the Assign To field in the service requests UI.
• Manage the lifecycle of a service request

A service request typically moves through the statuses: New, Waiting, In Progress, Resolved, and Closed. You can modify the statuses per your requirements if you have sufficient privileges.

See the Oracle Engagement Cloud Using Service in Engagement Cloud guide for more information about sales user tasks for service requests.

See the Oracle Engagement Cloud Implementing Service in Engagement Cloud guide for more information about service requests setup tasks.

Related Topics

• Oracle Engagement Cloud - Using Service guide

• Oracle Engagement Cloud - Implementing Service guide

• Managing Service Requests: Overview
25  Using Sales Lightbox

Sales Lightbox: Overview

With the Sales Lightbox content library, you can store, access, and share files, such as slide decks, web-based content, and .pdfs. The following is a high-level summary of the content library features:

- Upload and access stored content: Upload content from your computer to the library for later access and sharing. Supported file types include .pptx, .html (in the form of microsite .zip files), and .pdf. The image file types .jpg and .png are supported as separate file types as well.
- Find content: Browse and search for library content. Search includes file name, owner, and keywords.
- Share content: Share content with other users, with sales accounts, and with sales opportunities. Joint ownership also is supported.
- Create new presentations on the fly: For .pptx files only, assemble new slide decks using slides from the library.
- Add to cart: For .pptx files only, add slides to your cart.

The topic, Available Lightbox Actions for Different Content Types, has full details of the available actions for each file type.

Library Views

When you open the library, you see the following views:

- **My Content**: Displays all content that you own. This includes content that you have uploaded and all the content that was shared with you by other users. Documents can be shared with or without joint ownership.
- **Shared Content**: Displays all content that you own, and all the content that is shared with you by other users.

If you are an administrator, you also see the **All Content** view: This view displays all content uploaded by all users, including all content that belongs to the administrator. For more administrator information, see the Implementing Sales guide.

For more information about user tasks in the content library, see the online help and the Using Sales guide.

Available Lightbox Actions for Different Content Types

In the Sales Lightbox content library, different file types carry different available actions. For example, slides presentations can be added to the cart, but microsite and .pdf files cannot.

Lightbox Actions for Different File Types

The following table lists actions that you can perform with different Lightbox file types.

<table>
<thead>
<tr>
<th>Action</th>
<th>PowerPoints</th>
<th>PDFs</th>
<th>Microsites</th>
<th>Images</th>
</tr>
</thead>
<tbody>
<tr>
<td>Upload</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
The following table lists the actions with different Lightbox file types and the information that you must consider while performing them.

<table>
<thead>
<tr>
<th>Action</th>
<th>PowerPoints</th>
<th>PDFs</th>
<th>Microsites</th>
<th>Images</th>
</tr>
</thead>
<tbody>
<tr>
<td>Download</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Update</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Open</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>New Pages</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Share</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Add to cart</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Delete</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Search</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>View properties</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

The following table lists the actions with different Lightbox file types and the information that you must consider while performing them.

<table>
<thead>
<tr>
<th>Action</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Upload</td>
<td>• Slides must be .pptx files.</td>
</tr>
<tr>
<td></td>
<td>• Microsites must be .zip files. See the topics, Using Microsites in the Lightbox Content Library and Creating and Uploading a Microsite .Zip File: Procedure: Procedure, for more information.</td>
</tr>
<tr>
<td></td>
<td>• Image files must be .jpg or .png format.</td>
</tr>
<tr>
<td>Share</td>
<td>Sharing is possible with other users, accounts, and opportunities, including joint ownership.</td>
</tr>
<tr>
<td>Delete</td>
<td>The file owner can delete files that she owns. Administrators can delete any content.</td>
</tr>
<tr>
<td>Search</td>
<td>• Slides: Can use file name, owner, or keyword in the document.</td>
</tr>
<tr>
<td></td>
<td>• PDFs: Can use file name, owner, or keyword in the document.</td>
</tr>
<tr>
<td></td>
<td>• Microsites: Can use file name or owner. If keyword search is enabled within the microsite, can search by keyword. If keyword search is not enabled, then the main .html file is scrubbed of HTML tags and stored as searchable content.</td>
</tr>
<tr>
<td></td>
<td>• Image files: Can use file name and owner.</td>
</tr>
<tr>
<td>View properties</td>
<td>• Slides: Can view file name, owner, number of slides, date and time uploaded, current version number, number of downloads, number of views, number of shares.</td>
</tr>
<tr>
<td></td>
<td>• PDFs: Can view file name, owner, date and time uploaded, views, number of downloads, number of shares.</td>
</tr>
<tr>
<td></td>
<td>• Microsites: Can view file name, owner, number of pages, date and time uploaded, current version number, number of downloads, number of views, number of shares.</td>
</tr>
</tbody>
</table>
About Bursting and Assembling Content

The terms burst and assemble have specific definitions in the context of the Lightbox content library.

- **Burst**: Users burst content when they open a file in Lightbox. The act of "bursting" refers to the application displaying the individual pages of a file as it’s opened. During this process, after splitting a file into individual pages, the application analyzes the pages, saves them, and creates records for them in the database.

- **Assemble**: Users assemble content when they save individual pages to a cart and download them. Assembling means content with pages from one or more different files (of the same content type) is saved to the cart, potentially rearranged, and then downloaded. During assembly, in the background, the application compiles the files into a single file set.

For more information about using the content library, see the online help and the Using Sales guide.

Creating Content

Creating Lightbox Content: Overview

To be able to upload presentations to the Sales Lightbox content library, you first create them and then save them to your hard drive. Lightbox supports the following file types:

- **Microsoft PowerPoint**: The presentation library supports the Open XML file format (.pptx 2007). If you install the Microsoft Office Compatibility Pack, and save a presentation in the Open XML format (.pptx 2007), then those presentations are fully compatible with Sales Lightbox.

- **PDF**: You can upload .pdf files and share them with other users. However, you cannot open .pdf files in Lightbox or add them to the cart.

- **Microsites**: These are collections of html and supporting files, saved in a .zip compressed file type. For more information about this content type, see the topics, Using Microsites in the Lightbox Content Library and Creating and Uploading a Microsite .Zip File: Procedure.

- **Image files**: The image file types .jpg and .png are supported for upload and sharing as distinct pieces of content.

The topic, Available Lightbox Actions for Different Content Types, has full details of the available user actions for each file type.

Using Microsites in the Lightbox Content Library

You can use the Sales Lightbox content library to store and share microsite content. The content library supports multiple-page and single-page microsite content. You construct your microsite content in .zip file format. The .zip file contains the required .html and supporting files, such as images and cascading style sheets.

For a procedure about creating and uploading the microsite files, see the topic, Creating and Uploading a Microsite .Zip File: Procedure.
About the .Zip File

You create the microsite file structure on your hard drive and then you use a .zip compression utility to compress the files for upload. Only .zip compression format is allowed. The microsite’s main landing page can have its own domain name or subdomain name. Your .zip file structure determines whether Lightbox considers the microsite a single-page microsite or a multiple-page microsite.

- **Single-page microsite:** The .zip file contains no embedded .zip files and contains one .html (or .htm) file in the directory structure. The page also contains additional supporting image files, cascading style sheet (.css) files, or JavaScript (.js) files in a separate folder.
- **Multiple-page microsite:** The .zip file contains embedded .zip files that contain one .html (or .htm) file in the directory structure. The page also contains additional supporting image files, cascading style sheet (.css) files, or JavaScript (.js) files in a separate folder.

This topic contains examples of the supported folder construction for microsite .zip files.

The following rules apply to the .html files:

- For a single-page microsite, the .zip file must contain only one .html (or .htm) file at the top location in the folder. For multiple-page microsites, the embedded .zip files serve as independent microsite pages. That is, each embedded .zip file must contain all of the elements that a single-page microsite contains, including the .html file.
- The .html file must be named identically to the .zip file. For example, `visionservers.zip` must contain a file named `visionservers.html` (or .htm) at the top location in the folder.
- If a properly-named, full-sized thumbnail image is provided in the .zip file, the application uses it as the thumbnail. See the rules on image files following this text for more information.

The following rules apply to the image files:

- Supported image file types are .png and .jpg.
- To designate a thumbnail image in the microsite, include the image file at the same location as the .html file, and append `-full` to the file name. For example, in the `visionservers.zip` file, include an image file named `visionservers-full.jpg`.
- If no image is designated as the thumbnail, then Lightbox displays its default thumbnail image.

You can enable keyword search for microsites by including a text file with the keywords. See the section on enabling keyword search for microsites later in this topic.

Naming and Structuring Microsite Files

For microsites to be accepted for upload into the content library, you must follow some rules for naming and structuring the files. Each page must contain a folder of the same name, and that folder must contain an .html file of the same name. Thus, `visionservers.zip` must contain a folder, `visionservers`. In that folder there must be a file, `visionservers.html`. It can contain any number of other files and folders, but it must at least contain that file.

For a single-page microsite, you supply the .zip file that contains an .html file named the same as the .zip file. Optionally, you also supply a thumbnail image, a text file for keyword search, and supporting files, such as a cascading style sheet and JavaScript files.
The following figure shows an example of a well-constructed single-page microsite folder structure called `visionservers`.

```
/visionservers.zip
 /visionservers/
    visionservers.html
    visionservers-full.jpg
    visionservers-Searchdata.txt
 /css
 /fonts
 /img
 /js
```

For multiple-page microsites, you construct the .zip file as multiple .zip files within a parent .zip file.

The following figure shows an example of a well-constructed multiple-page microsite folder structure called `visionservers`.

```
visionservers.zip
 /visionservers1.zip
    /visionservers1/
       visionservers1.html
       visionservers1-full.jpg
       visionservers1-Searchdata.txt
    /css
    /fonts
    /img
    /js
 /visionservers2.zip
    /visionservers2/
       visionservers2.html
       visionservers2-full.jpg
       visionservers2-Searchdata.txt
    /css
    /fonts
    /img
    /js
 /visionservers3.zip
    /visionservers3/
       visionservers3.html
       visionservers3-Searchdata.txt
    /css
    /fonts
    /img
    /js
```
Enabling Keyword Search for Microsites

You can add the ability for users to search for microsite files by keywords. Add a text file with the keywords to the microsite .zip file and name the file appropriately. If keyword search is not enabled, then the main .html file is scrubbed of HTML tags and stored as searchable content. Use the following guidance when creating the text file:

- Use a text editor application, such as Microsoft Notepad, to create the text file.
- Name the text file with the same name as the .zip and .html files and append it with -Searchdata (note the file name is case-sensitive). For example, name it visionservers-Searchdata.txt.
- Include the text (.txt) file in the same location as its corresponding .html file.
- Enter the keywords with only spaces between them.
- Do not use punctuation marks, such as commas or periods, in the text file.

Creating and Uploading a Microsite .Zip File: Procedure

After you have created your files and file structure for the microsite, you then must create a .zip file containing the folders and files in the correct structure.

Creating and Uploading Microsite Files

The following procedure shows the high-level steps to create and upload microsite .zip files to the content library. For more details about how to structure the folders for the .zip file, see the topic, Using Microsites in the Lightbox Content Library.

1. Create and store the .html and supporting files in a location on your computer. When creating the folder structure, you can use the examples in the topic, Using Microsites in the Lightbox Content Library.
2. Use a file compression application to add the files to a .zip file.
3. Sign in to the applications and navigate to Sales > Lightbox.
   The Lightbox page appears, showing content that is available to you.
4. In the My Content view, click Upload.
   The Upload Content dialog window appears.
5. Browse for the .zip file on your computer.
6. Click Open.
7. Click Upload in the Upload Content dialog window.
   A confirmation message lets you know of a successful upload.

Uploading Content

Using the Cart: Explained

The cart enables you to assemble content and download them. You can view the details of the content while they are in the cart. Select the content and remove it using the drop-down button on the content, or clear the cart and remove all the content.
You can add only one type of content at a time to the cart. If you try to add different types of content to the cart, you receive an error stating that the content type is different. For example, if you have uploaded a .pptx presentation and then try to add a PDF file, an error message appears. Clear out the cart and then add your other item type. To add content to a cart:

1. Click **Sales > Lightbox**.
   
The Lightbox overview page appears.
2. Click the **plus symbol** on the content on the Lightbox overview page to add the content to the cart.
3. Click **Cart** to view the content.

   The Lightbox: Cart page appears.
4. Click the **drop-down button** on the content to remove or move the content.
5. Click **Clear Cart** to remove all the content from the cart.

### Uploading Lightbox Content: Explained

In the Sales Lightbox content library, you can upload content that you want to view later or share with other users.

For a procedure detailing how to upload content, see the topic, **Uploading Lightbox Content: Procedure**.

When you upload content, the application performs in the following way:

- If the content uploads successfully, then a thumbnail image appears on the My Content view after you refresh your view. After an initial upload, a placeholder thumbnail appears and postupload processing continues. You can continue to work during this time.
- An error message appears if uploaded file is not a supported file type.
- After the initial file upload, postupload processing extracts thumbnails, performs a virus check on the uploaded file, and so on. A confirmation message appears if the content has successfully uploaded. When the upload is complete, refresh your view to see the content thumbnail image and to access the content.
- If postupload processing fails, and if a preferred notification method has been configured for you, then you receive a message explaining that an error occurred. If this error occurs, contact your administrator. Any content that fails the postupload process is removed from the My Content view.
- If you sign out during an upload, then postupload processing continues.

> **Note:** The maximum file size of a content that can be uploaded is 100 MB.

### Uploading Lightbox Content: Procedure

In the Sales Lightbox content library, you can upload content that you want to share with other users. You also can share content with a potential sales opportunity or with an account.

#### Uploading Content

Use the following procedure to upload new content.

1. Navigate to **Sales > Lightbox**.
   
The Lightbox page appears, showing content that is available to you. Each item is represented by a thumbnail image. The image has icons on it that allow access to actions and information.
2. In the My Content view, click **Upload**.

The Upload Content dialog window appears.

3. Click **Browse**. Browse for and select the content you want to upload from a location on your computer.

4. Click **Open** or double-click the file.

5. Click **Upload** in the Upload Content dialog window.

6. A confirmation message lets you know of a successful upload.

7. After the upload is complete, refresh your view to see the new thumbnail images for the content, and to access the content.

### Updating Content

#### Updating Lightbox Content: Explained

In the Sales Lightbox content library, you can replace or overwrite existing content that you own. For example, you might have already shared content with other users, but you want to replace the original content with a version containing newer data.

For a procedure detailing how to update an existing content, see the topic, Updating Lightbox Content: Procedure.

When you update content, the application performs in the following way:

- During post-upload processing, the placeholder thumbnail images change, but the file name remains the same for the newer content. You can continue to work during this time.

- If you are updating content while another user wants to use the content, for example, to add the content to the cart or to share the content, the other user can do so safely, and the current version of the content is used.

- When you are updating content, any search results for that content display the previous version of the content.

- If you attempt to update content while another user is already updating or deleting the content as a joint owner, then you will receive a message that an update is in progress, and to try again later.

- While the update is in progress, the content properties panel is available and a dynamic circle image is overlaid on the thumbnail, providing visual feedback that a new upload is processing.

- While the update is in progress, other users can open the previous version of the content.

- If you decide to update content with content that has a different name than the original content, then the name of the original content is kept, and only the content slides are updated.

After you update content, the application performs in the following way:

- If the content is successfully updated, then the content displays as the first document in the list.

- If the content fails to update, then the existing version remains in place and you receive an e-mail notification confirming that the update failed.

- The cover thumbnail image for the new content is determined by the previously selected cover thumbnail image. For example, if slide number 5 was the previous cover thumbnail, then slide number 5 is also selected for the new content. If the slides are re-ordered, then a different cover thumbnail is displayed.

- If the number of slides in content is reduced, then the thumbnail for the first slide is the cover thumbnail. For example, if slide number 20 was selected as the cover thumbnail for the previous content, but the new content only contains 10 slides, then the thumbnail for the first slide is the cover thumbnail for the content.
• When the content is fully updated, the Version and Uploaded properties are updated accordingly.
• The contents remain shared and the ownership remains shared with other users.
• Each time you update a specific content, the content is listed at the start of the content list in the My Content view.

Updating Lightbox Content: Procedure

In the Sales Lightbox content library, you can replace or overwrite existing content that you own. For example, you might have already shared content with other users, but you want to replace the original content with a version containing newer data.

Updating Content

Use the following procedure to update content.

1. Navigate to Sales > Lightbox.
   The Lightbox page appears, showing content that is available to you. Each item is represented by a thumbnail image. The image has icons on it that allow access to actions and information.
2. In the My Content view, locate the content you want to replace and update.
3. From the Actions menu, click Update.
   The Upload new version of Content dialog window appears.
4. Click Browse. Browse for and select the updated content from a location on your computer.
5. Click Open or double-click the file.
6. Click Upload.
   A confirmation message lets you know of a successful upload.
7. After the update is complete, refresh your view to see the new thumbnail images for the content, and to access the content.

Searching for Content

Searching for Lightbox Content: Explained

In the sales Lightbox content library, you can search for content by file name, owner, or keyword. The search finds content that you own or that is shared with you by other users. As soon as a file is uploaded and processed, it is available in the search results.

To learn how to search Lightbox content, see the topic, Searching for Lightbox Content: Procedure.

When searching, remember:

• Searches are not case-sensitive. For example, searching for America returns the same results as searching for aMERICA.
• The search returns partial word matches. For example, if you search for mas, the application finds files containing the words Masterson, Master, and Mask.
• You can use the percent sign (%) as a wildcard at the beginning of a string. For example, if you perform a search for tore, the application returns all content containing core, sore, and so on.
• You can search for file names that contain special and accented characters such as ampersands.
• The order of keywords within the search string is irrelevant. All keywords must match, to match the search string text in file names and content. The Boolean AND operator is implicit. That is, you do not enter the Boolean AND operator in your search string. The application automatically inserts it between each keyword (or between keywords and phrases) in the search string.
• From the search results, you can perform the allowed activities with the content. See the topic, Available Lightbox Actions for Different Content Types, for more information about the allowed actions.

Searching for Lightbox Content: Procedure

In the sales Lightbox content library, you can search for content by file name, owner, or keyword. The search finds content that you own or that is shared with you by other users. As soon as a file is uploaded and processed, it is available in the search results.

For more information about the Lightbox search actions and tips, see the topic, Searching for Lightbox Content: Explained.

Searching for Content

Use the following procedure to search for content containing a specific word or text.

1. Navigate to Sales > Lightbox.
   The Lightbox page appears, showing content available to you.
2. In My Content or Shared Content views, click the magnifying glass icon.
3. Enter the text that you want to find in the search field, and press Enter or click the search icon.
4. Use the Actions menu to download the content or add it to your cart (if applicable). To open the content (if allowed), click the content name.

See the topic, Available Lightbox Actions for Different Content Types, for more information about the allowed actions.

Search results remain available until you perform a new search in your current session.

Downloading and Opening Content

Downloading Lightbox Content: Procedure

Using the Sales Lightbox content library, you can download content that is shared with you. You also can download .pptx slides that you added to your cart.

You can download content from the following locations in Sales Lightbox:

- The Shared Content view
- The My Content view
- The cart

Note: Only .pptx slides can be added to the cart; therefore, this is the only content type you can download from the cart.
Downloading Content from the Lightbox Page

Use the following procedure to download content from the Lightbox page. To filter the view of the content, you use the Shared Content and My Content view filters.

1. Navigate to Sales > Lightbox.

   The Lightbox page appears, showing content that is available to you. Each item is represented by a thumbnail image. The image has icons on it that allow access to actions and information.

2. In the My Content or Shared Content views, click the Actions menu on a content item and select Download.

3. Do one of the following:
   - In the open file window, click Save to save the content to your computer's local drive.
   - In the open file window, click Open to open the content and then save the content to your computer's local drive.

After the content is saved and the download is complete, the download properties for each slide are updated.

Downloading Slides from the Cart

This procedure applies only to .pptx slides. Other content types cannot be added to or downloaded from the cart. Use the following procedure to assemble all slides in your cart into a single slide deck and download them to your computer's local drive.

重要：Slides must first be added to the cart in order for you to be able to download them from the cart. See the topic, Managing Your Cart: Explained, for more information.

1. Navigate to Sales > Lightbox.

   The Lightbox page appears, showing content that is available to you. Each item is represented by a thumbnail image. The image has icons on it that allow access to actions and information.

2. Click Cart to open the cart.

3. Click the Download button.

4. Do one of the following:
   - In the open file window, click Save to save the content to your computer's local drive.
   - In the open file window, click Open to open the content in Microsoft PowerPoint and then save the content to your computer's local drive.

After you save the content, the download property for each slide is updated. The slides remain in the cart until you remove them.

Opening Lightbox Content: Procedure

In the Sales Lightbox content library, you can open your own content and content that has been shared with you. Opening content lets you:

- View the thumbnail images of PowerPoint slides (if available) in a dialog box.
- View thumbnail images of multiple-page microsites (if images have been provided) in a dialog box.
- Set a particular slide as the content’s cover thumbnail image (for slide presentations and microsites).
• Add individual slides from slide presentations to your cart.
• View content properties, such as the number of times the content was downloaded or shared.

\(\textbf{Note:}\) Note that you cannot open .pdf files from the library. When you click on the link for a .pdf file, you see a single thumbnail representing the entire document, instead of individual thumbnail images of each page.

Opening Content

Use the following procedure to open content.

1. Navigate to Sales > Lightbox.
   
The Lightbox page appears, showing content that is available to you.
2. In the My Content or Shared Content views, find the content you want to open.
   
   You can also locate content by performing a search. Files are listed in the chronological order in which they were uploaded.
3. To open content, do one of the following:
   
   ◦ Click the Actions menu and select Open.
   ◦ Click the file name link under each thumbnail.
   ◦ From search results, click the content name.

Managing Your Cart: Explained

You can use the cart in the Sales Lightbox content library to add and assemble Microsoft PowerPoint (.pptx) slides that are available to you. Other content types, including .pdfs, microsites, and image files, cannot be added to the cart.

The following are the tasks for the Lightbox cart:

• Adding a presentation to the cart
• Adding a slide to the cart
• Removing slides from the cart
• Emptying the cart
• Downloading slides from the cart
• Arranging the slide order in the cart

\(\textbf{Tip:}\) The current number of slides you have in your cart is always indicated on the Cart button. And the number of slides in a presentation is shown next to the Add to Cart action.

Adding All Slides in a Presentation to the Cart

To add all the slides of a presentation to the cart, do the following:

1. Navigate to Sales > Lightbox.
   
The Lightbox page appears, showing content that is available to you. Each item is represented by a thumbnail image. The image has icons on it that allow access to actions and information.
2. In the My Content or Shared Content views, locate the presentation you want to add to the cart.
3. Do one of the following:
   - Click the **plus sign (+)** icon located at the top center of the thumbnail to add the presentation to the cart.
   - Click the **Actions** menu and select **Add to Cart**.

   A confirmation message notifies you of a successful addition to the cart.

### Adding a Single Slide to the Cart

To add a single slide to the cart, do the following:

1. Navigate to **Sales > Lightbox**.

   The Lightbox page appears, showing content that is available to you. Each item is represented by a thumbnail image. The image has icons on it that allow access to actions and information.

2. In the **My Content** or **Shared Content** views, open the presentation that contains the slide you want to add to the cart. Open the presentation by clicking the **Actions** icon and then clicking **Open**.

3. To add a single slide of the presentation to the cart, do one of the following:
   - Click the **plus sign (+)** icon located at the top center of the slide that you want to add to the cart.
   - Click the **Actions** menu and select **Add to Cart**.

   A confirmation message notifies you of a successful addition to the cart.

4. Click **Done** to return to the **My Content** or **Shared Content** views.

   ✷ **Note:** If a slide in your cart has its corresponding presentation deleted, then the slide remains in the cart, but the slide properties are unavailable.

### Removing Slides from the Cart

To remove a slide from the cart, do the following:

1. Navigate to **Sales > Lightbox**.

   The Lightbox page appears, showing content that is available to you. Each item is represented by a thumbnail image. The image has icons on it that allow access to actions and information.

2. Click **Cart** and find the slide you want to remove.

3. Do one of the following:
   - Click the **minus sign (-)** icon located at the top center of the slide that you want to remove from the cart.
   - Click the **Actions** menu and select **Remove**.

4. Click **Yes** on the confirmation message.

5. Click **Done** to return to the **My Content** or **Shared Content** views.

### Emptying the Cart

To empty the cart:

1. Navigate to **Sales > Lightbox**.

   The Lightbox page appears, showing content that is available to you. Each item is represented by a thumbnail image. The image has icons on it that allow access to actions and information.

2. Click **Cart** to view your cart.
3. Click **Clear Cart**.

**Downloading from the Cart**

To download all slides from the cart into a single presentation and save them to your computer’s local drive, do the following:

1. Navigate to **Sales > Lightbox**.
   
   The Lightbox page appears, showing content that is available to you. Each item is represented by a thumbnail image. The image has icons on it that allow access to actions and information.

2. Click **Cart** to open the cart.

3. Click **Download**.

4. Do one of the following:
   
   - In the open file window, click **Save** to save the presentation to your computer’s local drive.
   - In the open file window, click **Open** to open the presentation in Microsoft PowerPoint and then save the presentation to your computer’s local drive.

   After you save the presentation, the application updates the properties information for the slide. The slides remain in the cart until you remove them.

5. Click **Done** to return to the **My Content** or **Shared Content** views.

**Arranging the Slide Order in the Cart**

To change the order in which slides appear in the cart, do the following:

1. Navigate to **Sales > Lightbox**.
   
   The Lightbox page appears, showing content that is available to you. Each item is represented by a thumbnail image. The image has icons on it that allow access to actions and information.

2. Click **Cart** to open the cart.

3. In the cart, find the slide you want to move.

4. Do one of the following:
   
   - Move the slides to where you want them.
   - Click the **Actions** menu and select **Move Left** or **Move Right**.
   - Click the left or right arrow located at the top center of the thumbnail.

5. Click **Done** to return to the **My Content** or **Shared Content** views.

**Sharing Content**

**Sharing Lightbox Content: Overview**

In the Sales Lightbox content library, you can share content with:

- Opportunities
- Accounts
- Users
You can also select a user to be the joint owner of a content item along with you.

**Sharing Content with Opportunities and Accounts**

You can share your content with accounts and opportunities. When you share content with an opportunity or an account, you are essentially attaching a copy of the content to the opportunity or account you select. Note the following:

- You can only share content with an account or an opportunity if you have access to Sales accounts or opportunities applications.
- If you make any changes to the content after you share it with an opportunity, the shared document is not affected.

**Sharing Content with Other Users**

You can share content with another user without granting joint ownership. The following table indicates which actions the other user can perform after the content is shared. All content that is shared without joint ownership is available in the user’s Shared Content view.

<table>
<thead>
<tr>
<th>Actions</th>
<th>User Permission?</th>
</tr>
</thead>
<tbody>
<tr>
<td>View content</td>
<td>Yes</td>
</tr>
<tr>
<td>Download content</td>
<td>Yes</td>
</tr>
<tr>
<td>Share content without joint ownership</td>
<td>Yes</td>
</tr>
<tr>
<td>Update content</td>
<td>No</td>
</tr>
<tr>
<td>Share content with joint ownership</td>
<td>No</td>
</tr>
<tr>
<td>Delete content</td>
<td>No</td>
</tr>
</tbody>
</table>

**Sharing Content with a User as the Joint Owner**

If you own a content item, you can share it with a user and grant joint ownership to that user. The following table indicates which actions the other user can perform when the content is shared with joint ownership. All content that is shared with joint ownership is available in the user’s My Content view.

<table>
<thead>
<tr>
<th>Actions</th>
<th>User Permission?</th>
</tr>
</thead>
<tbody>
<tr>
<td>View content</td>
<td>Yes</td>
</tr>
<tr>
<td>Download content</td>
<td>Yes</td>
</tr>
<tr>
<td>Update content</td>
<td>Yes</td>
</tr>
<tr>
<td>Share content with ownership</td>
<td>Yes</td>
</tr>
<tr>
<td>Share content without ownership</td>
<td>Yes</td>
</tr>
<tr>
<td>Delete content</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Sharing Lightbox Content with an Opportunity: Procedure

In the Sales Lightbox content library, you can attach a copy of a content to an opportunity. If you make any changes to the content after you share it with an opportunity, the shared document is not affected. You can only share content with an opportunity if you have permission to access the opportunities application.

Sharing Content with an Opportunity

Use the following procedure to share content with an opportunity.

1. Navigate to **Sales > Lightbox**.
   
   The Lightbox page appears, showing content that is available to you.

2. In the **My Content** or **Shared Content** views, click the **Actions** menu and select **Share Content with Opportunity**.
   
   The search and select page for opportunities appears.

3. Search for and select the opportunity.

4. Click **OK**.
   
   A confirmation message lets you know that the content was successfully shared.

Sharing Lightbox Content with a User: Procedure

In the Sales Lightbox content library, you can share your content with others using sales applications. After you share content with another user, the content appears in the user’s Shared Content view. If you make any changes to the content after you share it with a user, these changes are visible to all users with whom the document has been shared. You can only share content with a user who has access to Sales Lightbox, and if the content owner has granted you joint ownership.

Sharing a Presentation with a User

Use the following procedure to share content with a user.

1. Navigate to **Sales > Lightbox**.
   
   The Lightbox page appears, showing content that is available to you.

2. In the **My Content** or **Shared Content** views, click the **Actions** menu and select **Share Content with User**.
   
   The search and select page for users appears.

3. Search for and select the user.

4. Click **OK**.
   
   A confirmation message lets you know the content was successfully shared.
Sharing Lightbox Content as Joint Owner: Procedure

In the Sales Lightbox content library, you can share your content with other sales application users and make them joint owners of the content. If you make any changes to the content after you share it with a user, these changes are visible to all owners with whom the document has been shared. When you share a document with a user with joint ownership, that user is allowed to update and delete that document. You can only share a content with a user as joint owner if the user has access to Sales Lightbox, and if the content owner has also granted you joint ownership.

Sharing Content with a User as Joint Owner

Use the following procedure to share content with a user as joint owner.

1. Navigate to Sales > Lightbox.
   The Lightbox page appears, showing content that is available to you.
2. In the My Content or Shared Content views, click the Actions menu and select Share Content with User as Joint Owner.
   The search and select page for users appears.
3. Search for and select the user.
4. Click OK.
   A confirmation message lets you know the content was successfully shared.

Sharing Lightbox Content with an Account: Procedure

In the Sales Lightbox content library, you can attach a copy of a content item to an account. If you make any changes to the content after you share it with an account, the shared document is not affected. You can only share content with an account if you have permission to access the sales accounts application.

Sharing Content with an Account

Use the following procedure to share content with an account.

1. Navigate to Sales > Lightbox.
   The Lightbox page appears, showing content that is available to you.
2. In the My Content or Shared Content views, click the Actions menu and select Share Content with Customer.
   The search and select page for accounts opens.
3. Search for and select the account.
4. Click OK.
   A confirmation message lets you know that the content was successfully shared.

Working with Thumbnail Images
Setting a Slide as a Cover Thumbnail: Explained

When using .pptx slide decks as content in the Oracle Sales Lightbox content library, you can set one slide in the slide presentation as the cover thumbnail image. These images help users identify the contents of items in the library.

For a procedure detailing how to set a cover thumbnail image, see the topic, Setting a Slide as a Cover Thumbnail: Procedure.

Before you set a slide as a cover thumbnail image, consider the following:

- If you do not set a cover thumbnail, then a default cover thumbnail is assigned. The default cover thumbnail is either the last slide used as a cover thumbnail or the first slide in the presentation.
- If you explicitly set a cover thumbnail for a presentation once, then the cover thumbnail remains the same unless you explicitly change it again.
- If you are the owner of the document and set the cover thumbnail, then the cover you set becomes the cover thumbnail for you and for all other users with whom this document is shared, who have not explicitly set their own cover thumbnail.
- If you own a document jointly with other users, and you and a second user have changed the cover thumbnail from the default cover, then all other document owners who have not set a new cover will see the most recently set thumbnail as the new cover.

Setting a Slide as a Cover Thumbnail: Procedure

When using .pptx slide decks as content in the Oracle Sales Lightbox content library, you can set one slide in the slide presentation as the cover thumbnail image. These images help users identify the contents of items in the library.

Choosing a Slide as a Cover Thumbnail

Use the following procedure to set a slide that you want to display as the cover thumbnail image for a presentation.

1. Navigate to Sales > Lightbox.

   The Lightbox page appears, showing presentations that are available to you.

2. In the My Content view, open the presentation.

3. Click the star icon on the target slide to set the slide as the cover thumbnail.

   When a slide is set as the cover thumbnail, the star icon on it changes to a filled gray star.

Deleting Content

Deleting Lightbox Content: Explained

In the Sales Lightbox content library, you can delete content that you own. When you delete content, it’s no longer available to you or to others.

For a procedure detailing how to delete content, see the topic, Deleting Lightbox Content: Procedure.
If, before deleting a content item, you shared the content item with other users who are currently working with the content you deleted, one of the following scenarios might occur:

- If you are browsing through content library that includes deleted content, the deleted content is not available when the page is refreshed.
- If you are browsing through content that has been deleted since you started browsing, when you scroll to the next set of content, a warning message indicates that the content has been deleted. You are then returned to the view prior to opening the content, for example, the Shared Content view.
- If you are browsing through a content that has been deleted since you started browsing, and if you click Show Content Properties or another menu option, then a warning message indicates that the content has been deleted. You are then returned to the view that was active prior to opening the file, for example, the Shared Content view.
- In the case of slide decks, if you have already added slides from a deleted content to the cart, the thumbnail images of the slides remain visible and available for you to view and to download from the cart until they are manually removed from the cart, or until the cart is cleared. However, the slide properties are unavailable for the deleted slides.
- If you try to directly download a deleted content from the Actions menu or from one of the views, a warning message indicates that the content has been deleted and the content is not downloaded.
- If a deleted content item is displayed in search results and you attempt to select or open that content, then a warning message indicates that the content has been deleted. You cannot interact further with the search result item.

> **Note:** If you are a sales administrator or a setup user, you can delete any content from the All Content view. This view is available only to sales administrators and setup users.

### Deleting Lightbox Content: Procedure

In the Sales Lightbox content library, you can delete content that you own. When you delete content, it’s no longer available to you or to others.

#### Deleting Content

Use the following procedure to delete content.

1. Navigate to Sales > Lightbox.
   
   The Lightbox page appears, showing contents that are available to you.

2. In the My Content view, locate the content you want to delete.

3. Click the Actions menu and select Delete from the menu.

4. Click Yes to confirm the deletion.

> **Note:** If you are a sales administrator or a setup user, you can delete any content from the All Content view. This view is available only to sales administrators and setup users.
Glossary

adjusted forecast
Total forecast for all product items that meet forecast criteria plus a salesperson’s adjustment amount, which can be a positive or negative number.

adjusted territory quota
The quota amount assigned to the user plus the adjustment amount entered.

assemble
Refers to when, in the Sales Lightbox content library, content with pages from one or more different files is saved to the cart, potentially rearranged, and then downloaded. The content must be of the same file types. During assembly, in the background, the application compiles the files into a single file set.

B2B
Acronym for business-to-business. Indicates the type of customer relationship with a business, where the customer is a business rather than an individual consumer.

B2C
Acronym for business-to-consumer. Indicates the type of customer relationship with a business, where the customer is an individual consumer rather than a business.

burst
Refers to when, in the Sales Lightbox content library, the application displays the individual pages of a file as it’s opened. During this process, the application doesn’t just open the individual pages. Instead, after splitting a file into individual pages, the application analyzes the pages, saves the pages into the content management system, and creates records for the pages in the database.

competitor
An organization that competes with the deploying organization in sales situations.

deal size
Total monetary amount the customer is expected to spend.

eligibility rule
Rules that define what can or cannot be sold to what customers based on a set of eligibility or business criteria, such as due to company policy or customer eligibility constraints. Eligibility rules are evaluated before any recommendations can be made.
filmstrip
The single strip of icons above a page that you can use to open other pages.

global header
The uppermost region in the user interface that remains the same no matter which page you’re on.

industry codes
Industry codes gives you the flexibility to assign the most accurate industry to your account that defines your account better. You can add or remove industries from your account as long as you have edit access to your account.

infolet
A small, interactive widget on the home page that provides key information and actions for a specific area, for example social networking or your personal profile. Each infolet can have multiple views.

interface table
A database table that stores data during data transfer between applications or between databases that reside inside and outside of an Oracle Fusion application.

internal expert
Experts within your company who have previous experience with a specific competitor.

lead
A new prospect or existing customer who has interest or the potential for interest in a product or service being sold. The interest is represented in the application by a lead.

lead rank
A configurable set of values such as hot, warm, or cool used to prioritize leads for lead qualification and sales engagement.

line of business
A particular kind of commercial enterprise. For example, a broad grouping of sellable products such as hardware or training.

marketing activity
An instance of the execution of a campaign stage, such as delivering a specific treatment to a specific audience.

microsite
Individual web page or a small cluster of pages meant to function as a discrete entity within an existing website or to complement an offline activity.

nonrevenue quota
A type of quota typically assigned to a sales resource with overlay sales roles, such as sales consultants or telemarketing representatives, to measure their performance.
organization hierarchy
A tree structure that determines the relationship between organizations.

organization types
You can maintain multiple organization types for your account that can help you define your account better. You can add or remove organizations from your account as long as you have edit access to your account.

panel tab
A tab that provides supplemental information or functionality for the page. Each panel tab is on the right side of the page, has an icon as the tab label, and slides out when you open the tab.

prediction rules
A user-defined business logic that identifies target customer segments for target products based on a set of criteria. Prediction rules predict the likelihood of target customers to buy a product, the average revenue, and the average sales cycle that salespeople could expect.

prospect
A prospect can be account, contact, or household you haven’t sold to yet. A prospect is a potential customer, who you hope to convert into a selling relationship.

qualified lead
A qualified lead is one where the lead qualification status has been updated to qualified. Generally, a lead is considered qualified and ready for conversion to a sale when the need, purchase interest, and budget are confirmed.

quota
A revenue target, often tied to expected performance.

request call back
A marketing response form that can be inserted into an e-mail. E-mail recipients can click the link to request a call back.

resource
People designated as able to be assigned to work objects, for example, service agents, sales managers, or partner contacts. A sales manager and partner contact can be assigned to work on a lead or opportunity. A service agent can be assigned to a service request.

resource organization
An organization whose members are resources. Resource organizations are used to implement sales organizations, partner organizations, and so on.

resource quota
The revenue target associated with a territory resource. Resource quota can be either revenue resource quota or nonrevenue resource quota.
sales campaign
A sales campaign enables a salesperson to target customer contacts by email in a personalized campaign, using marketing generated collateral.

sales goal
A business or sales objective represented as a measurable goal. A sales goal is defined by how it’s measured (amount or quantity), and whether or not the goal has a focus such as on specific product groups.

sales quota plan
Plan that contains all quota activities for the fiscal year, created by the administrator. Actual sales and pipeline are tracked against only one quota plan for the year.

springboard
The grid of icons on the home page that you can use to open pages.

SWOT
Abbreviation for strengths, weaknesses, opportunities, and threats. SWOT analyses score the strengths, weaknesses, opportunities, and threats of a sales competitor, as compared to the selling company.

territory coverage
A territory coverage is a set of boundaries that define what is included or excluded in the territory and what can be sold. Selected customers or partners can be selected to be included or excluded from the territory being defined. For example, sell all products in North America.

territory coverage model
The coverage model selection identifies whether the territory jurisdiction is expressed in terms of what customers are covered, or what partners are covered. A Customer Centric model means that the territory covers all customers within the territory definition, as well as leads and opportunities for those customers. Partner Centric territories are typically defined for channel sales managers, where the channel sales manager is responsible for a set of partners, as well as for those partners’ deals.

territory quota
The revenue target associated with the expected performance of a territory.

territory team member function
The function the resource has on the territory team.

white space analysis
A type of analysis that enables salespeople to identify gaps in the customer’s portfolio so that they can focus on selling products or services that fill those gaps.